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ASG Support Numbers

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during normal
business hours and emergency support during non-business hours. To expedite response time,
please follow these procedures.

Please have this information ready:

. Product name, version number, and release number
J List of any fixes currently applied
. Any alphanumeric error codes or messages written precisely or displayed

. A description of the specific steps that immediately preceded the problem

o The severity code (ASG Support uses an escalated severity system to prioritize service to
our clients. The severity codes and their meanings are listed below.)

. Verify whether you received an ASG Service Pack for this product. It may include
information to help you resolve questions regarding installation of this ASG product. The
Service Pack instructions are in a text file on the distribution media included with the
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem.

2 Leave a detailed message including your name and phone number. A Support representative
will be paged and will return your call as soon as possible.

3 Please have the information described above ready for when you are contacted by the Support
representative.

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response
Time
1 Production down, Within 30 minutes

critical situation
2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours
work-around solution

4 "How-to" questions and enhancement Within 4 hours
requests

ASG provides software products that run in a number of third-party vendor environments. Support
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor
discontinues support for a hardware and/or software product, ASG cannot be held responsible for
problems arising from the use of that unsupported version.
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support@asg.com
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Canada
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Germany
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Japan/IDC

800.354.3578

65.332.2922
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00.800.3354.3578
001.800.9932.5536
00.800.9932.5536
014.800.9932.5536
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Japan/Telecom
Netherlands
New Zealand
Singapore
South Korea
Sweden/Telia
Switzerland
Thailand

United Kingdom

All other countries

0041.800.9932.5536
00.800.3354.3578
00.800.9932.5536
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001.800.9932.5536
009.800.9932.5536
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Visit http://www.asg.com, ASG’s World Wide Web site.
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Preface

This ASG-SmartTest for COBOL and Assembler User’s Guide provides user information
about ASG-SmartTest (herein called SmartTest). SmartTest brings a new approach to the
testing and debugging application programs. Alone or as part of the ASG-Existing
Systems Workbench (ASG-ESW), SmartTest has language-related features that support
COBOL and Assembler programmers in the development and testing phases of software
systems. The uniqueness of the SmartTest automated solution is due to the ability of the
product to gather and store knowledge, about the application being tested, in the
Application Knowledge Repository (AKR). This knowledge base provides SmartTest
with a foundation of information in these areas:

. Program relationships, logic and data, execution paths, etc.

. COBOL intelligence

. Testing/debugging session experience

This stored knowledge enhances the productivity and the quality of testing because it
provides programmers with an online programming expert to assist with testing.
SmartTest runs under MVS and uses ISPF as its standard user interface. Full-screen

source support is provided for COBOL and Assembler, as well as disassembled object
support for other languages.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical

support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

X
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About this Publication

This publication consists of these chapters:

Chapter 1, "Introduction," provides an introduction to SmartTest.

Chapter 2, "Test Session," describes how to set up a test session for the TSO
execution environment.

Chapter 3, "Test Session - Additional Environments," describes setup information
for other test environments.

Chapter 4, "Testing Techniques," presents common SmartTest testing and
debugging functions available with SmartTest.

Chapter 5, "Program Analysis Features," presents the basic problem investigation
features available with SmartTest.

Chapter 6, "Additional Testing Features." describes additional testing features that
are available with SmartTest.

Chapter 7, "Analyze." describes the analyze process that is required before a
program can be tested using SmartTest.

Chapter 8, "Additional Language Support," provides information on Assembler,
INTERSOLV APS, and PL/I programming languages support in SmartTest.

Chapter 9, "Help Facility." describes how to use the comprehensive and context
sensitive Help facility, including an online Help Tutorial.

Chapter 10, "COBOL Compiler Options," list the COBOL compiler options used
by SmartTest.

Related Publications

The documentation library for ASG-SmartTest consists of these publications (where nn
represents the product version number):

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-ESW suite of products.

ASG-SmartTest CICS User s Guide (STC0200-nn) contains specific commands and
test session setup information for the CICS environments.

ASG-SmartTest for COBOL and Assembler User s Guide (STA0200-nn) contains
introductory and usage information for COBOL and Assembler. It also contains test
session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS, and Batch
environments.
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. ASG-SmartTest IMS Users Guide (STM0200-nr) contains specific commands and
test session setup information for the IMS/DC environments.

. ASG-SmartTest Installation Guide (STX0300-nn) contains information for
installing and maintaining ASG-SmartTest.

o ASG-SmartTest PLI User s Guide (STL0200-nn) contains introductory and usage
information about how to use ASG-SmartTest with the PL/I language. It also
contains test session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS,
and Batch environments.

o ASG-SmartTest Quick Start for COBOL/ASM (STA0900-nn) summarizes how to
use ASG-SmartTest with the COBOL or Assembler language.

. ASG-SmartTest Quick Start for PL/I (STL0900-nn) summarizes how to use
ASG-SmartTest with the PL/I language.

. ASG-SmartTest Reference Guide (STX0400-nn) contains detailed reference
information about CUA pull-downs and pop-ups, ASG-SmartTest command
syntax, and pseudo code.

. ASG-SmartTest Reference Summary (STX0600-nn) summarizes the syntax and
usage of ASG-SmartTest commands.

o ASG-SmartTest TCA User’s Guide (STT0200-nn) contains procedures for using the
ASG-ASG-SmartTest-TCA (Test Coverage Analysis) option.

Note:
To obtain a specific version of a publication, contact the ASG Service Desk.

xi
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ASG-Existing Systems Workbench (ASG-ESW)

Xii

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

HI ASG-Insight for Program Understanding |

HI ASG-Estimate for Resource Estimation |

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
-TSO
-CICs

ASG-Center - IMS

- ASM

- APS

- PLI

-TCA

- DB2 Stored Procedure

N H ASG-SmartDoc for Program Documentation |
Application

Knowledge
Repository (AKR)

%| ASG-Recap for Portfolio Analysis |

HI ASG-Alliance for Application Understanding |

%I ASG-Encore |

HI ASG-AutoChange |

3} ASG-Bridge |
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This table contains the name and description of each ESW component:

ASG-Alliance

Alliance

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange

AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.
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ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

Xiv
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page xvi for more information about
using ESW.

XV
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance AL Understand » Application
AutoChange CcC Change P Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Re-engineer) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Understand) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Document) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartTest ST Test » Module/Transaction

ESW Product Integration

Xvi

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly or through the main ESW screen. As a result, you might see different
fields, values, action bar options, and pull-down options on a screen or pop-up depending
on how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed. Access to these integrated products requires only that they be installed and
executed in the same libraries.
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Example 1. Figure 2 shows the Encore Primary screen that displays when you access

Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,

Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

AEG-Encare
CoHHand ===
etttk e e Wbtk
Aotk debookk dobolelolk ebototck
eddoth eddotk dehdettck  tedetokk Hefok
oot oot debtsok etttk Hepok
Hefototok
etk

Copykight Allen Swsteds Graup, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Uizit the ASG Zupport Web fite at www.asg.cod

Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter

Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 « ESW Encore Primary Screen

File UView Edtract Generate Search Logic List Options Help

ASE-EIN - Prograd Re—engineering

CoHHand ===
Aottt Hetebbt bbb Aottt
Aettsick desteik etttk etetotek:
Aottt Aottt Hebetebbt bbbk Hebek
Aottt Aottt debebbebk bbbk Hebek
Atk
Aotk

Copyright Allen Systeds Group, Inc., an unpublished wark.
Visit the ASE Support Web Zite at wuw,asg.cod

A proprietary product of A2G, Inc. Wse restricted to authorized licensees.
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Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays

when you access SmartTest through ESW.

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4. This field is automatically customized to contain the ESW products

you have installed on your system.

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc
Options) is available on the File - Analyze Submit screen if the SmartDoc product is
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 « File - Analyze Submit Screen

File - Analyze SUbHiT
CorAdand ===

E - Edit JCL

CoMpile and link JoL (PDE or sequential):
Data set nane 'USER1Z2.REL.CGHNTL{VIAPCOBC)

Analyze features [v-M]i
REG—EMartTests ¥ Extended Analy=isl M

AKR data zet naWe 'UZERLZ,GEMERAL.AKR'

Analyze options:

2 - EUbHIit JCL

AKR prograd nade [if overriding PROGRAA-IO0)

Link l1oad Hodule reusable® [Y-M] T

CoHpile? [Y<H] o« v o« v o o o o T [¥ if needad by features)

Figure S« File - Analyze Submit Screen (Accessed through ESW)

File - Analwze ZubHit
CoHHand ===

CoHpile and link JCL [PDS or sequentiall:
Data sef nade 'USER1Z2.REL.CNTLIHTEST)

Analyze features [Y-M]:

AZG-snartDoct M ASG-Encorel M
AKR data =set nane 'UEER1Z.GEMERAL.AKR'
AKR progran nane

Analyze options:

E - Edit JCL ¥ - EubMiT JOL 0 - A%E-EnartDoc Options

AEG-In=sights T AEG-EHartTestl I Exdtended Analwsis:

[if owverriding PROGRAA-I0]

CoHpile? (YNl o« o o & «

e s ¥ [ if needed by features)
Link l1oad Hodule reusable® [veM] T [ASG-5HartTest
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Publication Conventions

Preface

ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
filename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YIN).

XIX
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Introduction

This chapter introduces SmartTest and contains these sections:

Topic Page

SmartTest Overview 2
Testing and Debugging 3
Screen Format 5
The Common User Access Interface 7
Insight Analysis 11
Reviewing Program Structure 12
Reviewing Data Usage 13
Reusing Command Results 16
Optimization Considerations 18
Command Targets 19

SmartTest is the Testing/Debugging component of ESW for COBOL, PL/I, Assembler,
and APS programs in the TSO, MVS Batch, CICS (including File Services), and IMS
environments. SmartTest features include program analysis commands, execution
control, intelligent breakpoints, test coverage, pseudo code with COBOL source update,
batch connect, disassembled object code support, and full screen memory display.
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SmartTest Overview

Testing and debugging application programs can be a difficult and time-consuming
process. SmartTest brings a new approach to the testing and debugging process. Alone or
as part of ESW, SmartTest has language-related features that support COBOL and
Assembler programmers in the development and testing phases of software systems.

SmartTest provides an electronic window through which COBOL, PL/I, and Assembler
programs are viewed, analyzed, tested, and debugged. SmartTest runs under MVS and
uses ISPF as its standard user interface. Full screen source support is provided for
COBOL and Assembler, as well as disassembled object support for other languages. It
executes in the TSO/ISPF environment and provides full ISPF compatibility. This
compatibility facilitates learning and usage through standard IBM interfaces.

SmartTest features optional Common User Access (CUA) screens, pull-downs, and
pop-ups designed to provide easy access to all of the product features. Powerful
SmartTest commands can be used as an alternative to the selections offered on the CUA
action bar.

The uniqueness of the SmartTest automated solution is based on its ability to gather and
store knowledge, about the application being tested, in the Application Knowledge
Repository (AKR). This knowledge base provides SmartTest with a foundation of
information in these areas:

. Program relationships, logic and data, execution paths, etc.
. COBOL intelligence

. Testing and debugging session experience

This stored knowledge enhances the productivity and quality of testing because it
provides programmers with an online programming expert to assist with testing.



Testing and Debugging
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SmartTest provides comprehensive testing and debugging capabilities, which includes
these features and functions:

Comprehensive The testing environment contains complete knowledge about

Program Knowledge the program including its syntax, logic relationships, and
execution flow. This knowledge is stored in the AKR.

COBOL Intelligence COBOL-compatible pseudo code can be temporarily added to

a program to test proposed changes, saved permanently in the
AKR, or automatically added to the existing program.
Dynamic breakpoints can be set based on COBOL syntax
statements or conditions.

Script Automation

A predefined command sequence can be included in any test
session. These script files can be created automatically during
a test session, then used for regression testing of a program.

Scrollable Window In-context windows for data display and logic provide easy
Displays access to related information.
Hot Key Branching Hot key branching between paragraphs, sections, and called

routines provides easy access to related logic.

Assembler Integration

Full screen Assembler integration of programs, called
modules, or memory display of data elements is provided.

ESW Integration

Integrates the ESW family of products that support the
automation of the software maintenance cycle.

If Insight is installed and specified during the analyze, the
Insight program analysis functions are available for viewing
logic/data relationships and execution paths.

If Alliance is installed, an interface to Alliance is provided.
SmartTest provides canned queries you can customize and run
in Alliance to extract information about a program.

Execution Review
(Backtrack)

Execution history can be viewed using the Backtrack Facility.
This feature allows you to step backward or forward through
the executed code and view data values as they existed when
specific statements were executed.

Automatic Setting of
Breakpoints

Breakpoints can be set with a dataname list produced in
Alliance, AutoChange, or Estimate; or produced by users.
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The dramatic advantage SmartTest has over conventional program testing and debugging
tools is that it is COBOL intelligent. It provides comprehensive analysis information
about a program.

SmartTest effectively presents information in an interactive environment for online
querying and/or testing on a display screen. The results of new code or enhancements can
be quickly and accurately tested to determine their impact on the rest of the program
logic. Program errors can be easily recognized and quickly corrected.

Testing Support
SmartTest runs under MVS ESA, TSO/ISPF (Release 3.5 through 4.8) and supports these
languages, execution environments, and databases:
. COBOL II
. COBOL/370
. COBOL for MVS and VM
. COBOL for OS/390
. CASE-generated COBOL (APS)
. High Level Assembler
. CA-Optimizer I (COBOL II)
. INTERSOLV APS
. OS PL/I Versions 2.3
. PL/IMVS & VM

Supported Execution Environments
. TSO
. BTS
. CICS Version 4.1
. CICS/TS 1.1, 1.2, 1.3, and 2.1
. CICS command level programs
. IMS/DB
. IMS/DC Version 3.1 through 7.1
. ISPF Dialog Manager
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. HOGAN
. LANGUAGE ENVIRONMENT Version 1.3 through 2.9

Supported Databases
. VSAM
. IMS Version 3.1 through 7.1
. DB2 Version 2.2 through 6.1
. CA-IDMS/DB Release 14.0
. SYSTEM 2000
. DATACOM/DB
. TOTAL/TIS

Screen Format

SmartTest screens are modeled after the TSO/ISPF edit screen. Figure 6 is an example of
the SmartTest Program View screen.

Figure 6 « SmartTest Screen Example

File View Test Search Logic List Options Help
(B) (B)

Program View VIAPCOB.VIAPCOB -A
Command ===> __ (C) (D) __ Scroll ===> CSR
000360 MOVE ALL '/?X!' TO SOC7-DATA.
>>>>>> ADD +1 TO DATA-PACKED-DEC. FALLTHRU
Vv +
trrrrv | 10 DATA-PACKED-DEC PIC S9(5)Vv99 C3 ADDR 000DO6AS8 |
AR VALUE > /2X! < * INVALID NUMERIC * I
VN +
0(F) 62 *——————mm—mm o m o *
000363 * *
000364 * THIS IS AN EXAMPLE OF A SO0C7 ABEND (DATA EXCEPTION). THE *
000365 * VALUES INVOLVED IN DATA RELATED ABENDS ARE AUTOMATICALLY *
000366 * DISPLAYED BY SMARTTEST (BY SIMULATING A 'ZD' LINE COMMAND) . *
000367 * *
000368 * THERE ARE SEVERAL WAYS TO FIX THIS S0C7: *
000369 * 1) OVERTYPE THE VALUE OF 'DATA-PACKED-DEC' IN THE ZOOMDATA*
(E)
(G)
e +
| STATUS: DATA EXCEPTION (0C7) PROGRAM: VIAPCOB DATE: DDMMMYYYY |
| STMT: 000361 OFF: 000D64 AMODE: 24 MODULE: VIAPCOB TIME: 10:33:00 |
| SOURCE: ADD +1 TO DATA-PACKED-DEC. |
Bt ettt e +
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This table describes the sections highlighted on the Program View screen:

(A) Program View

Specifies the name of the screen.

(B) VIAPCOB.VIAPCOB

Identifies the module.programbeing viewed. This area
of the screen is called the short message area and is also used
to temporarily display short informational or error messages.
A value of -A (Active program) following the
module.programname indicates that this program is
currently being tested. A value of -Q (Qualified) indicates
this program has been displayed for viewing on the Program
View screen while another program is being tested.

(C) Command ===>

Specifies the is the primary field for entering SmartTest
commands.

(D) Scroll ===>

Specifies the number of lines or columns to scroll the display
screen. The Scroll ===> field is omitted from screens that
cannot be scrolled. These are the valid values:

1 through 9999. Specifies the number of lines or columns
to scroll.

CSR. Specifies the screen is to be scrolled until the cursor is
at the top, bottom, left side, or right side of the screen.

MAX. Specifies that the top, bottom, right, or left margin is
the scroll value.

HALF. Specifies a scroll value of a half screen.
PAGE. Specifies a scroll value of one screen.

DATA. Specifies a scroll value of one line less than a screen.
This field is omitted from screens that cannot be scrolled.

(E) Long message area

Displays descriptive, informational, or error messages in this
area. Long messages are displayed when there are no
corresponding short messages, or when you type HELP in the
command input area while a short message displays.

(F) Line command input
area

Indicates the line command area, in which you can enter over
the displayed line numbers in columns 1 through 6 as with
other TSO/ISPF editor screens.

(G) Status box at the
bottom of the SmartTest
screen

Provides current status information about the program being
tested including the reason for an interruption in execution,
the current statement number and offset in the program, and
the text of the next source statement to be executed.




The Common User Access Interface
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SmartTest features Common User Access (CUA) screens, pull-downs, and pop-ups that

are designed to provide easy access to all of the product features.

SmartTest CUA Screens

CUA Action

File Pull-down

For CUA purposes, screen denotes the whole screen, as opposed to a pop-up. The action

bar is usually displayed at the top of SmartTest screens.

Bar

The Program View screen is shown in Figure 7. Notice the action bar, which designates
the primary functional organization of SmartTest. Each action is briefly described in

these sections.

You can remove the CUA action bar from the screen by typing SET CUA

OFF.

SmartTest functions will be available using the command interface. To reinstate the CUA

action bar, type SET CUA ON.

Figure 7 « SmartTest Screen Action Bar Example

File View Test Search Logic List Options Help
Program View VIAPCOB.VIAPCOB -A
Command ===> Scroll ===> CSR

001120 * VALIDATE EXECUTION PARAMETER.
001121 PARM-EDIT.

>>>>>> IF CURRENT-PARM-NUMBER = 0 THEN

001123 PERFORM BUILD-PADDED-PARM

001124 IF PADDED-PARM = 'ALL' THEN

001125 MOVE PADDED-PARM TO FIRST-PARM-TEXT

001126 ELSE

001127 PERFORM FIND-FIRST-PARAMETER

001128 VARYING SUBL FROM 1 BY 1

001129 UNTIL SUBl > VALID-PARMS-COUNT.

001130

001131 IF FIRST-PARM-TEXT = 'ALL' THEN RETURN
001132 MOVE CURRENT-PARM-NUMBER TO SUB1

001133 MOVE +0 TO CURRENT-PARM-NUMBER
e Tttt ittt e +
| STATUS: STOPPED BY STEP REQUEST PROGRAM: VIAPCOB  DATE: DDMMMYYYY |

| STMT: 001122 OFF: 001DOC AMODE: 24 MODULE: VIAPCOB TIME: 10:46:05 |
| SOURCE: IF CURRENT-PARM-NUMBER = 0 THEN |

Use the File pull-down to set up the test environment, select Test Coverage Analysis (if
the option is installed at your site), manage the AKR, open, view, and/or test a program,

update a source file, and to exit SmartTest.

View Pull-down

Use the View pull-down to access the various methods used to view a program and

related testing history in SmartTest.
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Test Pull-down

Use the Test pull-down to access the test setup wizards and the various methods used to
run or step through a program, manipulate data values in SmartTest, initiate a link to
Alliance, generate dumps, or begin the process of automatically setting breakpoints with
an impact dataset.

Search Pull-down

Use the Search pull-down to find, highlight, scroll, print, punch, or exclude a specified
target, which may be a dataname, label name, paragraph name, pattern, COBOL subset,
perform range, program, user mark, or line number.

Logic Pull-down

Use the Logic pull-down to follow the logical execution paths of a program.

Note:

This action displays on the action bar only if Insight is installed. See the ASG-Insight
User’s Guide for more information on the Logic pull-down.

List Pull-down

Use the List pull-down to access pop-ups that list information about the program and the
testing environment.

Options Pull-down

Use the Options pull-down to customize your SmartTest environment by setting certain
parameters and options.

Help Pull-down

Use the Help pull-down to access the online Help features.

CUA Pull-downs

Pull-downs are displayed by selecting items from the action bar. Action bar choices are
selected by positioning the cursor on the item and pressing Enter to display the
corresponding pull-down.

Actions on pull-downs are selected by typing the number of the action in the selection
field and pressing Enter, or by positioning the cursor on the line with the desired action
and pressing Enter.
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Figure 8 shows the SmartTest File pull-down.

Figure 8 « CUA Screen Features

{ajFile Uiew Test fearch List Options Help

3. Op&Efa..
4, Close
5. Save

« EHiT

[3) 1. Setup test enwironHent... rtTest Ré.0
2. Zelect Test Coverage...

6. CoWpilesAnalyZe... Hetdetch etttk
T« AKR Utilitya..
G. Execute...
9

]

Atk
Atttk
Attt

Copwright Allen Systens Group, INcC., an unpublished vork.
A proprietary product of AZG, InC. Use restricted to authorized licensess.
Visit the ASG Support Webk Site at wuw.asq.cod

(A) Action Bar

Presents selectable items that represent functions in SmartTest.

(B) Pull-down

Displays the selectable actions available for each action bar choice.

(C) Action Describes the SmartTest feature. When selected, an action followed
by an ellipsis (...) displays additional information; actions without the
ellipsis immediately execute the action.

Note:

Use the END PF key (usually PF3 or PF15) to exit a pull-down screen.
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CUA Pop-ups

Pop-ups contain entry fields and selection fields. In Figure 9, Data name is an entry field,
while References and Indirect impact are selection fields.

Figure 9 « Pop-up Example

File Wiew Test Search Logic List Options Help
Eeatch - Data Nade GE
[H GE
Type a data name and select =search aptions. Then press Enter. For
o | a selection list, enter a pattern [(e.g. ABCE] in the nane area.
a
a | Data nane
a
0 | References Indirect inpact Zize change
] 1 1. ALl 1. Hone levels o & . ___
1} 2. Defs 2. 0Of gize change
a 3. Uses 3. 0Of walue change
a 4. Hods
a
a | Direction options Action
a 1 1. ALl No data aliasing 1 1. Find
] 2. Nedt IN-Clauze... 2. Highlight
1} 3. Preuvious I, Ecroll
] d. First 4. Print
a 5. Last S. Punch
a 6. ExHClude
a
aaaale ELOCK CONTAINE: @ RECORDE.
(A) Entry Fields These are fields in which you type textual information, such as a

dataname, line range, or number of levels. Underscores indicate
the maximum length of the field.

(B) Selection Fields

These are fields in which you may select one or multiple choices.

If the selections are numbered, one choice is allowed. To make a
selection, type the number of the choice in the selection field.

If the selections are not numbered, more than one choice is
allowed. To make a selection, type a slash (/), or a non-blank
character, in the field you wish to select.

If the choices are contained on a scrollable list, use the S line
command to make a selection.

Note:

Use the END PF key (usually PF3 or PF15) to exit a pop-up.

10
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Insight Analysis

If Insight is installed with SmartTest, Insight analysis extends SmartTest to include
comprehensive analysis functions. To take advantage of the Insight functionality, select
Extended Analysis on the File - Analyze Submit screen.

Note:

If you do not plan on using this advanced analysis feature, ASG recommends that you
specify N in the Extended Analysis field because the advanced analysis requires
additional AKR space and analysis time.

Technology that captures and stores a complete summary of how a COBOL program
works (the underlying logic and data relationships, control flow, organization and
structure, etc.) and an interface of analysis functions are integrated directly into the test
session. This technology is the Analytical Engine, which automates the important and
otherwise time-consuming task of capturing and storing complete information about a
program.

Insight Analysis Benefits
Integrated analysis and testing provides these productivity and quality benefits:
. All logic paths are analyzed and tested, with or without data.

. Abends can be traced backward through the logic to their source.

. Data modification paths (including modifications, uses, and references in called
modules) are displayed.

. Program and COBOL sensitivity are included in each testing command.

SmartTest provides many valuable facilities for a test session, significantly reducing the
time required to perform testing and debugging tasks. SmartTest with Insight ensures the
full impact of new code or a change to existing code is analyzed and available to the
programmer when testing. It also provides a means of determining underlying causes for
problems while debugging a program.

SmartTest is an integrated analysis and testing system that brings intelligence to software
testing. Testing and debugging are based on a foundation of program knowledge.
Automation of the program understanding process improves the quality of the
testing/debugging session, resulting in additional productivity gains.

11



ASG-SmartTest for COBOL and Assembler User’s Guide

Reviewing Program Structure

12

SmartTest provides commands to reveal the structure of a COBOL program:
FINDXTND, ZOOMIN, ZOOMOUT, and BRANCH.

The highest level of structure can be displayed by typing FX referring to the subset
STRUCTURE, for example:

X; FINDXTND STRUCTURE

The Zoom functions show the subprograms' (COBOL II and above) divisions, sections,
paragraphs, and paragraph code exactly as they occur in the program. ZOOMIN and
ZOOMOUT functions can be used to view major structure statements one level at a time,
or to focus on specific areas of code within a paragraph.

If you begin with all source lines excluded from the screen and enter successive
ZOOMIN commands, source lines are displayed in hierarchical order. The
PROCEDURE DIVISION lines would be displayed in this order:

. Subprograms

. Division headings

. Sections

. Paragraphs

. Paragraph code

This feature provides a means of viewing various structure levels with or without the

corresponding code. Type ZOOMIN to see detailed information from one of these levels,
then type ZOOMOUT to return to the previous level.

Use the COBOL Intelligent Search function or the FINDXTND command to locate
specific subsets within the structure levels. For example, this command reveals all IO and
assignment statements:

FX IO + AS

Use the BRANCH function to scroll from any GO TO or PERFORM statement to the
label to which it transfers control. It can also be used to return to the location from where
the BRANCH primary command was issued. For example, this command positions the
display to the paragraph labeled P120-READ:

BRANCH P120-READ
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This BRANCH command causes the cursor to be repositioned to the P120-READ
paragraph. You can view the code within the paragraph, then type BRANCH BACKUP to
return. BRANCH and BRANCH BACKUP have also been assigned to PF keys. Instead
of entering the command in the command input area, you can place the cursor on a GO
TO P120-READ statement and press the PF key for BRANCH (default PF10/PF22).
Then press the BRANCH BACKUP key (default PF11/PF23) to return.

Reviewing Data Usage

The FINDXTND command searches the program in sequential order from the current
location for a target. A target is the object of a search and can be a set of lines, a path, a
dataname, or a pattern. Several target types are available.

The entire program can be searched for a target, or the scope of the search may be limited
by using the IN clause. The results of a FINDXTND primary command are all lines
containing the specified target. These lines are highlighted and the cursor is positioned
below the first target. Targets that were highlighted as a result of a previous command are
reset so only the results of the current command are highlighted.

Complex items can be located that would take many separate searches if done manually.

Every statement containing the 10 or ASsignment COBOL subset is searched for
FX-DATA or DEMO-STUFF with the single command. For example:

FX FX-DATA + DEMO-STUFF IN IO + AS

13
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The INDIRECT operand of the FX primary command can be used to locate the references
to a dataname and its aliases. It can also be used to locate other datanames that are
indirectly affected by the change in size, or the change in value, of a dataname. Figure 10
shows all datanames affected by the change in size of STOP-PAY-AMOUNT.

Figure 10 « FX INDIRECT Results

File View Test Search Logic List Options Help
Program View VIAPCOB.VIAPCOB -A

Command ===> Scroll ===>
CSR

000505 UNTIL STOP-PAYEE > STOP-MAX-INIT. DATA USE
--—- - - - - - - - - - - - - - - - - 3 LINES NOT DISPLAYED
000509 VARYING STOP-PAYEE FROM 1 BY 1

000510 UNTIL STOP-PAYEE > STOP-MAX-PAYEES. DATA USE
--- - - - - - - - - - - - - - - - - 34 LINES NOT DISPLAYED
000545 VARYING STOP-PAYEE FROM 1 BY 1

000546 UNTIL STOP-PAYEE > STOP-MAX-PAYEES. DATA USE
--—- - - - - - - - - - - - - - - - - 2 LINES NOT DISPLAYED
000549 VARYING STOP-PAYEE FROM 1 BY 1

000550 UNTIL STOP-PAYEE > STOP-MAX-PAYEES. DATA USE
--—- - - - - - - - - - - - - - - - - 2 LINES NOT DISPLAYED
000553 VARYING STOP-PAYEE FROM 1 BY 1

000554 UNTIL STOP-PAYEE > STOP-MAX-INIT. DATA USE
--- - - - - - - - - - - - - - - - - 10 LINES NOT DISPLAYED
| ASG0443I 29 DATA REFS: 16 DEFS, 11 USES, 2 MODS, 2 LEVELS FOUND FOR |

| STOP-PAY-AMOUNT. |

I |

000570 ADD STOP-PAY-AMOUNT (STOP-PAYEE) TO STOP-PAY-TOTAL. DATA MOD

This screen is the result of an X ALL;FX STOP-PAY-AMOUNT INDIRECT SIZE
command. All levels is the default for this command. All direct and indirect references of
the STOP-PAY-AMOUNT size change are displayed.

14
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The information is shown one level at a time to see the ripple effect. Figure 11 shows all
datanames that are affected in the first indirect level for STOP-PAY-AMOUNT.

Figure 11 « FX INDIRECT Levels

File View Test Search Logic List Options Help
Program View VIAPCOB.VIAPCOB -A
Command ===> Scroll ===> CSR

- 350 LINES NOT DISPLAYED

000565 COMPUTE STOP-PAY-AMOUNT (STOP-PAYEE) = DATA USE
000566 STOP-PAY-HOURS (STOP-PAYEE) * DATA USE
000567 STOP-PAY-RATE (STOP-PAYEE) . DATA USE
--=- - - - - - - - - - - - - - - - - 2 LINES NOT DISPLAYED
000570 ADD STOP-PAY-AMOUNT (STOP-PAYEE) TO STOP-PAY-TOTAL. DATA MOD
--=- - - - - - - - - - - - - - - - - 17 LINES NOT DISPLAYED
000588 MOVE 0 TO STOP-10-NUMBERS (STOP-PAYEE) . DATA USE

- -=- - - - - - - - - - - - - - - - - 386 LINES NOT DISPLAYED

KKK KKK KKK KKKk KXk kXX Kk Kk kX kkkxkkkx BOTTOM OF DATA ¥ * K ok %k ok % % k K % & % K % % % k% ok % &k & % % % & %

U

| ASG0443I 20 DATA REFS: 13 DEFS, 6 USES, 1 MOD, 1 LEVEL FOUND FOR |
| STOP-PAY-AMOUNT. [
| |

This screen shows the references to STOP-PAY-AMOUNT and the first level of indirect
references created with this command:

X ALL;FX STOP-PAY-AMOUNT INDIRECT LEVELS 1

A powerful feature of SmartTest is that command results can be used in a more detailed
examination. The results of a FINDXTND command can be used to perform these tasks:

L]

Scroll through highlighted lines using the SCROLL command.

Group highlighted lines together without intervening source code using the
EXCLUDE command X NHI (exclude non-highlighted lines).

Search for another target within the highlighted lines.
Save the highlighted lines for later use by naming them with the MARK command.
Save the results for later reference using the LPRINT and LPUNCH commands.

15
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Paragraph Cross-reference

The PREF command is used to view the View - Paragraph Cross Reference pop-up,
which shows program logic at the paragraph level and the control flow between
paragraphs. The paragraph cross-reference feature identifies this information:

. The paragraphs that transfer control to this paragraph and what mechanism is used
to transfer control.

. The paragraphs to which this paragraph can transfer control and what mechanism is
used to transfer control.

This command displays the labels of paragraphs to which the paragraph PARM-EDIT
can transfer control as shown in Figure 12:

PREF LABEL PARM-EDIT NEXT

Figure 12 » Paragraph Cross Reference with Direction NEXT

View - Paragraph Cross Reference
Command ===> Scroll ===> CSR

Target (s) : LABEL PARMAEDIT
Direction: NEXT

A : Add to target P : Execute PREF S : Select for viewing

S Target paragraph (s) How Goes to
PARM-EDIT RETURN PROGRAM-INIT

_ " " RETURN MAIN-ROUTINE-CHECKAALL
_ PERFORM BUILD-PADDED-PARM
_ PERFORM FIND-FIRST-PARAMETER
_ PERFORM FIND-NEXT-PARAMETER
*

KA KKK KKK KKk Xk kkkkk kX kkkkxkkkxx BOTTOM OF DATA * % % %k k% % %k ok % % k K % & % k% & % k k% % k&

Reusing Command Results
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A particularly useful feature SmartTest provides is the ability to reuse command results.
For example:

. Mark names are used to save sets and paths for later use when doing in-depth
searches.

. The IN clause of the FINDXTND and TRACE commands can be used to limit the
scope of a search to only the desired sets and paths.

This FINDXTND command results in a search for the string MAST-RPT occurring
within an 10O statement:

FX "MAST-RPT' ALL IN IO
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All input/output statements containing '"MAST-RPT" are highlighted. Since the results of
the FINDXTND command are highlighted, the HI screen subset can be specified in
another command to include them.

This FINDXTND command results in a search of the highlighted statements for the string
LINE2:

FX 'LINE2' ALL IN HI

Since the highlighted statements resulted from the search for the string ' MAST-RPT'
occurring within 10 statements, the result of the above FINDXTND command is all IO
statements that contain the string 'MAST-RPT' and the string 'LINE2'.

There is no limit to the number of times command results can be reused in this manner.
This table lists the different ways the IN clause is used with search commands and the
results:

FINDXTND '"WRITE' WORD IN IO  Finds all IO statements containing WRITE as a
distinct word (WRITE statements).

FLOW FROM 291 TO PROD-COST Highlights statements containing references to
PROD-COST and creates a NETWORK of all
paths from Line 291 to those statements.

TRACE ZIPCODE IN NETWORK Follows the execution paths in NETWORK to
references of ZIPCODE, stopping at each
branch for specification of a statement to
follow. A path called TRACK is created which
includes all statements that have been
followed.

17
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Optimization Considerations

18

SmartTest processes COBOL II and later programs compiled with the OPTIMIZE
compiler option, with these considerations:

Note:

Repeated Code Segments. When testing with the ASM option set ON, the
disassembled code that displays for repeated code segments (i.e., embedded
PERFORMSs or subprograms) are shown only for the first occurrence of such code
(i.e., the lowest address).

Pseudo Code User Labels. When inserting pseudo code into repeated code
segments (i.e., embedded PERFORM:s or subprograms), you may not insert user
labels. This is because all pseudo code variables and labels are global, and insertion
of multiple labels (one for each occurrence of the code) causes duplicate labels.

Pseudo Code in Repeated Segments. When inserting pseudo code into repeated
code segments (i.e., embedded PERFORMSs or subprograms), avoid the use of the
&COUNT internal variable. &COUNT maintains a separate instruction count for
each separate occurrence of the repeated code. Instead, create a pseudo code
variable, increment it on each pass through the pseudo code, and test the pseudo
code variable rather than the &COUNT variable.

Source Code Appears to be Unexecutable. On the Program View screen, it may
appear that certain source lines are not executable. Using commands such as STEP,
BREAK, and ZA (Zoom Assembler) on these lines may cause unexpected results.

GO Command. Use the SmartTest GO command with caution. Paragraphs and lines
of source code can be severely altered or eliminated in the optimization process. As
a result, unpredictable or erroneous results can occur with the GO command. As a
navigational tool for testing optimized programs, see the optimized Assembler
output generated by the compiler.

For specific SmartTest command syntax, see the online help or the ASG-SmartTest
Reference Guide. For additional information on the effects of optimization, see the
appropriate Application Programming Guide for your version of COBOL.
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Command Targets

A target is the object of a SmartTest primary command. Targets are defined in these
categories:

. Mark name

. Perfrange name
. Subset name

. Line range

. Label name

. Program name

. Dataname

. Pattern string

. Paragraph name

Mark Name Target

Note:

Mark name targets may be used only if Insight is installed and an Insight analysis has
been run on the COBOL program being tested.

A mark name target is any user-generated path or set of lines named with the COPY,
MARK, MERGE, or RENAME primary command; or an Insight system-generated path
created by the FLOW or TRACE command. System-generated paths are NETWORK,
SUBNETnN, and TRACK.

Marks can be listed, renamed, copied, deleted and merged with other Mark name targets.

All existing Mark names can be listed by using the LIST MARKS command, which
displays the List - User Marks pop-up.

19
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Perfrange Name Target

Note:

Perfrange name targets may be used only if Insight is installed and an Insight analysis has
been run on the COBOL program being tested.

A perfrange name target consists of all executable statements within a PERFORM range,
including all code that is executed by following that PERFORM. In this COBOL
statement, the PERFORM range includes the paragraphs beginning with
PARAGRAPH-ABC and continuing through the end of PARAGRAPH-XYZ, including
any paragraphs that are executed or performed from within these paragraphs:

PERFORM PARAGRAPH-ABC THRU PARAGRAPH-XYZ

A single paragraph that is PERFORMed should be referenced by its name. Perfrange can
also be a section contained in the Declaratives.

Subset Name Target

A subset name target is one of the COBOL language subsets, screen subsets, or tag
subsets.

Line Range Target

A line range target can be a single line or a group of lines. Line ranges are specified by
placing a hyphen (-) between the first and last line numbers in the range (e.g., 214-376).
Line numbers are shown in the first six columns on the Program View screen. If the
specified line number is greater than the last line in the program, the last line is assumed.

Label Name Target

A label name target in a COBOL program is any PROCEDURE DIVISION paragraph or
section name, as well as the literals PROCEDURE and PROC. A label name in an
Assembler program is any Assembler label. Label name specifies all transfers of control
to a paragraph or section.

Program Name Target

20

A program name target consists of all the code in all the divisions of the given program.
For example, a nested program name in COBOL II or later.
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Dataname Target

A dataname target can be any of these items:

. Elementary dataname
. File name

. Group name

. Table name

. Table element name

. Special name

Any legal COBOL reference for a data element can be specified as a dataname. If a
variable is redefined to another name, SmartTest searches for the specified variable name
and the redefined name. Any reference to an entry in a table is treated as a reference to the
entire table. When data items overlap so a name can refer to parts of multiple data items,
searches are performed on each part and all references are reported.

If a group item is specified in a search command, references to the group item as well as
the individual elements within the group are located. This is also true of modifications,
uses, or references to the data item. SmartTest locates valid references to the variable
item as opposed to simple pattern matching of the characters in the variable name.

Fully-qualified datanames can be specified using the standard COBOL syntax, for
example:

DATA-NAME-ELEMENT OF DATA-NAME-GROUP

For COBOL II or later programs, a data item, label name, or program that may be
ambiguous or used multiple times can be qualified with OF. If the COBOL label
P120-READ exists in VIAPDEM?2 and also in the program VIAPDEMI, it can be
qualified with OF as shown in this example:

P120-READ OF VIAPDEMI1

Multiple datanames can be located at the same time by concatenating the datanames with
a + (plus sign) between them as shown in this example:

DATA-NAME1l + DATA-NAMEZ2

21
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Datanames can be specified with one of these subordinate operands:

Operand Description

MODification  Occurrences of a data item where its value is being set or altered.

USE Occurrences of a data item where its value is being tested or used.

DEFinition Definitions of a data item and its aliases as specified in the DATA
DIVISION.

REFerence All MODIFICATION and USE occurrences. REFERENCE also

includes DEFINITION occurrences on some commands. This is the
default usage for datanames.

The BREAK, EXCLUDE, FINDXTND, HIGH, LPRINT, LPUNCH, and SCROLL
primary commands also offer ALIAS/NOALIAS and DIRECT/INDIRECT operands.
These are the valid operands:

Operand Description

ALIAS/NOALIAS ALIAS includes all aliases for the specified dataname and is the
default.

DIRECT/INDIRECT DIRECT includes only the specified dataname. INDIRECT
locates any dataname indirectly affected by the specified
dataname. INDIRECT data items can be further qualified using
SIZE, VALUE, and LEVELS subordinate operands.

SIZE Occurrences of a dataname indirectly affected by a
change in the size of the dataname.

VALUE Occurrences of a dataname directly or indirectly
affected by a change in the value of the dataname.

LEVELS Identifies the depth of the indirect references.




1 Introduction

Pattern String Target

A pattern string target is a sequence of characters, surrounded by single or double quotes
if it contains blanks. Strings of non-alphanumeric characters can be specified by the
X'string, T'string', and P'string' operands. The string can be further qualified
using the WORD, PREFIX, or SUFFIX subordinate operands.

Operand Description

X'string' A hexadecimal string, enclosed in single or double quotes.

T'string  Atextstring, which disregards upper and lowercase, enclosed in single or
double quotes.

P'string' A picture string, enclosed in single or double quotes. These are the valid
picture strings:

P'=" Any character

P—"  Any nonblank character
P Any nondisplay character
P'# Any numeric character

p- Any non-numeric character

P'@' Any alphabetic character (upper or lowercase)
P'<"  Any lowercase alphabetic character
P>'"  Any uppercase alphabetic character

P'$' Any special character (not alphabetic or numeric)

WORD A string preceded and followed by any non-alphanumeric character
(except hyphen).

PREFIX A word that begins with the specified string.

SUFFIX A word that ends with the specified string.

Paragraph Name Target

A paragraph name target is any paragraph or section name of the PROCEDURE
DIVISION, as well as the literals PROCEDURE and PROC. Paragraph name includes
the entire paragraph or section.
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This chapter describes how to set up a SmartTest test session for the TSO execution
environment and contains these sections:
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Test Session Overview

The steps necessary to invoke SmartTest vary by site. Check with the systems
administrator at your site for these details. The sample SmartTest session presented
assumes you are familiar with the terminology used by SmartTest. The sample session
assumes that your program has already been compiled, link-edited, and analyzed.

This section describes how to set up a test session for the TSO execution environment.
For information on how to set up a CICS test session, see the ASG-SmartTest CICS
User’s Guide. For information on how to set up a IMS/DC test session, see the
ASG-SmartTest IMS User’s Guide.

After setting up a program for testing the first time, subsequent test sessions may not
require all of these steps.

Note:

The steps involving a TSO file allocation CLIST relate only to execution in TSO
foreground.

Beginning a Test Session

The method you use to invoke SmartTest depends on your system setup. If you need
assistance to activate SmartTest, see your systems administrator.

If your site starts SmartTest directly, use the ISPF selection or CLIST as indicated by
your systems administrator. After you activate the session, the SmartTest Primary Screen
displays, as shown in Figure 13 on page 27.

26
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If your site uses the ESW screen to start SmartTest, initiate the ESW screen by using the
ISPF selection or CLIST as indicated by your systems administrator.

Figure 13 » Existing Systems Workbench Primary Screen

File Understand Change Test Docudent Re—engineer  Heasure Help

AEG-EXHisting 2ystens Morkbench - ASG-EZW

Condand ===F _
Atk Eass s I e o Aotk
Aotk Aebbt bbbk Aotttk
Aotttk Aottt Aebbtt deebbk Ak
Hetotetk Hetotetk Aetotettck sebeiclk A=tk
Atttk
Aotttk

Copwright ALlen Systens Group, INcC., an unpublished vork.
A proprietary product of ASG, InC. Use restricted to authorized licensess.
Visit the ASE Support Web Site at wuw.asq.cod

To start SmartTest, select Test » Module/Transaction. After you activate the session, the
SmartTest Primary Screen displays, as shown in Figure 14.

Figure 14 « SmartTest Primary Screen

File Uiew Test 3Zearch List Options Help

REG-EHartTest

ComHand ===
Aotk T e btk
etttk Atk Aotk etttk
edetetch ekt defebetstok etttk Hefok
Hefototok Hefotedoh: Hefokbedok Hetetiek Hefok
Heddoth
Hefetotah

copyright Allen systews Group, INC., an unpublished wark.
A proprietary product of ASG, InC. Use pestricted to authorized 1icensess.
Uizit the AEG Zupport Uebk Zite at www.asg.cod

Note:
If Insight is installed along with SmartTest, the action bar contains the Logic action.
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User Options

28

The first time you use SmartTest, you may need to customize options to reflect the
appropriate settings for your environment. Some options are initially set to default values

during product installation.

Use the Options pull-down to customize the SmartTest environment. Customization may

include these functions:

. Setting and verifying online operations parameters on the Options - Product

Parameters pop-up.

. Setting and verifying the Log, List, Punch, and Work file allocations in the

Options - Product Allocations pop-up.

. Setting and verifying Log, List, and Punch file processing options and provide a Job

card on the Options - Log/List/Punch Definition pop-up.

. Specifying Script file allocations on the Options - Script File Allocations pop-up.
. Setting and verifying values on the Options - PF Key Definition pop-up.

. Setting mode options on the Options - Modes screen.

To display the Options pull-down, follow this step:

» Select Options on the action bar. The Options pull-down, shown in Figure 15, displays.

Figure 15 » Options Pull-down

File Wiew Test Search List Options Help

« Froduct paraneters...
« Froduct allocations...
. Log-list-punch...

. ECRipt file allocations... | ek
. PF kews... etk
. Hodes - ZET Options...
. Equate...

CoMHand ===

= 3O R R

copwright AlLlen $ystens Group, IncC., an unpublished vork.
A proprietary product of ASGx Inc. Use restricted to authorized 1icensess.
Visit the ASE Support Web Site af wuW.asq.coH




2 Test Session

Online Operation Parameters

Use the Options - Product Parameters pop-up to set parameters affecting the online
operation of SmartTest. This includes specifying whether pseudo code and equates are to
be saved.

To set online operation parameters

1 Select Options » Product Parameters to display the Options - Product Parameters
pop-up.

2 Enter the appropriate information in the fields. For a description of the fields, see the
online help.

Log/List/Punch/Work File Allocations

Use the Options - Product Allocations pop-up to set and verify the DASD allocations for
the Log, List, Punch, and Work files. Some options are initially set to default values
established during product installation by the Systems Programmer.

To define the Log, List, Punch, and Work file allocations

1 Select Options » Product Allocations to display the Options - Product Allocations
pop-up shown in Figure 16.

Figure 16 « Options - Product Allocations Pop-up

options - Product Allocations
CodHand ===k _
Log file:
Generic unit . - . ERTDA [generic group naHe o unit address)
Volure serial . . ERTEOL [blank for authorized default volude]
Lizt file:
Generic unit « « « EVEDA [generic group name oF unit address)
Palune serial . « SRTEAL [blank for authorized default volure]
Funch filex
Generic unit . . . ERTOA [generic group naMe o unit address)
Valure serial . . ERTEOL [Blank for authorized default volure]
Mark file:
Generic unit . . . EYEDA [generic group naHe o unit address)
Volure serial o o ______ [blank for authorized default volude)]
Epace units . . . CYLE [BLEZ, TREZ or CrLE)
PriHary space . . 5 [space units]
Zecondary space 5 [space units]

2 Enter the appropriate information in the fields. For a description of the fields, see the
online help.
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Log/List/Punch Processing Options

Use the Options - Log/List/Punch Definition pop-up to set or change options and to
process the SmartTest Log, List, and Punch files. These files are used for system message
logging, error handling, and holding the results of several SmartTest commands. It is not
necessary to exit SmartTest to process these files.

To specify the Log/List/Punch processing options
1 Display the Options - Log/List/Punch Definition pop-up using one of these methods:

From the action bar, select Options » Log/list/punch.

Or

Type PRINTLOG (or PRINTLST) on any SmartTest screen that has a command
prompt and press Enter.

The Options - Log/List/Punch Definition pop-up, shown in Figure 17, displays.

Figure 17 » Options - Log/List/Punch Definition Pop-up

dptions - Log<List-Funch Definition
CoHHand ===

1 - Process log file 2 - Process list file 3 - Process punch file

options Liaig Li=st Funch
Process option . . . & . . K PE PE
Prinary tracks T | i i
EFecondary tracks - 2 5 5
Lines per page . . - « = 56 13 56
Epzout Class .o . 0 4 4 . o * * #*

Process options:  PE [print-keepl, PD [printsdeletel, K, or D.

Job statedent inforHation:
oUSERL TOB CACCTD, "USERL' ,PRTYV=C

ey HEGCLASE=K
<~ JOEPARH ZVEAFF=CPULC
R

2 Enter the appropriate information. For a description of the fields, see the online help.

Note:

If you specify the PK or PD option, a valid job card must be specified in the Job
Statement Information field prior to processing any Log, List, or Punch files.
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Customizing the Log, List, or Punch Dataset Name

If you specify K or PK process option, you can customize the dataset where the log, list,
or punch file is allocated. By default, SmartTest allocates the Log, List, and Punch files
as:

userid.STTnnnnn . VIAXXXXX
where:

nnnnn is a sequential number from 00001 to 99999.

xxxxx 18 LOG for Log, LIST for List, and PUNCH for Punch files.

If you have specified a TSO Prefix, the prefix will be appended to the beginning of the
file name allocated for the Log, List, and Punch files.

To customize dataset names

1 From the Options - Log/List/Punch Definition pop-up, type 4 and press Enter to
display the Options - Log/List/Punch Name Customization pop-up shown in

Figure 18.

Figure 18 « Options - Log/List/Punch Name Customization Pop-up

options = LogsList-Punch Mare CustoMization
CoHHand ===

You can define a custodized naWe when you choose option PE (print-keepl or
K [keepl by specifying U[ser]. Epecifying Y(es] on Prodpt later lets you

define 3 CUstoH naWe as wou process each log-listspunch file. Othervise,

specify data set name and file node. Then press Enter.

options Ly List Funch
File MAHING « = o o » o &« u u b Uizer] o f[wsteH)
Pronpt later for DEN . . Y N _ Ylesl or Nlol

The following are needed if U[ser] and Wio] are specified above

Log Data set naue [5eq]
File Hode . . _ afvervrite] or Alppend]

List Data set nane [zeq)
File Hode . . _ ofvervrite] or A(ppend]

Punch Data et nane [5eq]
File Hode . . _ afvervrite] or Alppend]

2 Type U in the File Naming field for Log, List, and/or Punch to indicate a user-defined
dataset name. If you type N in the Prompt later for DSN field, you must enter a
dataset name in the corresponding Data set name field, and specify Overwrite or
Append in the File Mode field.
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If you type Y in the Prompt later for DSN field, SmartTest prompts you for the
dataset name during file processing. If you specify Yes in the Prompt later for DSN
field for the Log file, the Log Name Customization pop-up shown in Figure 19
displays.

Figure 19 « Log Name Customization Pop-up

Log Mame Customization
connand ===

The current 1og file's data set naHe is shown below. To have a custod
naMe, specify a new sequential data set nawe. I it already edists, it
has to have LRECL=137 and RECFR=U; and specify the file Hode. Then praess
Enteat.

current Data set nawe @
custon  Data zet name
File Hode . o . _ ofveruritel ar Alppend)]

Specifying Script File Allocations
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Use the Options - Script File Allocations pop-up to display and/or modify the default
script file concatenation sequence for your session.

To specify your default script files

1 Select Options » Script file allocations to display the Options - Script File
Allocations pop-up as shown in Figure 20.

Figure 20  Options - Script File Allocations Pop-up

File Uiew Test Search List O0ptions Help

Options - ZCript File Allocations

c CorAand ===
R - Restore default 2cript allocations debicisioiicilolotoletoistoik
Aetebtettotcttetetbatatotck:
Enter desired Zcript file concatenation. Fekk
+t
FCript file data set nanes: #* Hetebotetotek
Hetetettstctek
= b oo
Aotk

Copyright ALlen $ystens Group, Inc., an unpublished work.
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2  Enter or modify the dataset names to be used for the default script files for your
session. To restore the default values for your installation, type R.

Note:

When initializing for defaults, the lines are filled beginning from the bottom to
allow concatenation.

Setting PF Key Values

Use the Options - PF Key Definition pop-up to display and/or redefine PF key values
used with SmartTest.

To set your PF Keys

1 Select Options P PF Keys or type KEY S on any SmartTest screen that has a command
prompt and press Enter. The Options - PF Keys Definition pop-up, shown in

Figure 21, displays.

Figure 21 « Options - PF Keys Definition Pop-up

options - PF kKew [©1-12] Definition
CoHHand ===k _

Press Enter to process changes and-<or to display alternate keys.
Press PF3-15 [END] to exit.

MuHber of PF kews: 24 TerHinal twpe: 3274

PFai HELP
PFa2 ZPLIT
PFAZ END
PFad RUN
PFO% RFIND
PFOE ZTEP
PFO? LUP
PFES DOMN
PFa% ZWAP
PF18 ERANCH
PF11 ERANCH EACKUP
PF12 RECGALL

2 Enter the appropriate PF key values in the fields. PF keys 1 through 12 are displayed
initially. To display PF keys 13 through 24, press Enter.
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Setting Mode Options

Use the Options - Modes screen to enable, disable, or enter a value for the mode of each
listed option.

To set your modes

1 Select Options » Modes to display the Options - Modes screen shown in Figure 22.

Figure 22 » Options - Modes Screen

options - Hodes

CoMnand ===x _ ECroll ===} CER
optian et Description

A=H OFF  Displayw Assebler code in status boM, and instruction STEP

AZHUIEW OFF  Dizplay Assenbler code for prograns not on the AKR

AUTOQUAL 0N QUALIFY to the ACtiwve Progran after a RUN or ZTEPR
BACKTRACK ~ OFF  BACKTrack Recording Hode is disabled with a buffer of 1H

EREAKE O The BRERKpoint facility i=s enabled

COLUHNE OFF  The COLUAMNE option is disabled

CUA oM The CUA Henu facility is enabled

DATA AUTO  Humber of lines for Zood Data windows, o AUTO

DELAY 1 Mumber of seconds to delaw between steps during STEP AUTO

FLOATING  OFF  Display floating point registers in the status box
GEMERATED o, | Display gener-ated code with the original Source Code

HEX OFF  Dizplay data in hexadecinal foruat

KEEP AUTO  HuHber of lines for KEEP Window, ar AUTO

LANGUREE COE  The current LAWGUAGE for the test sessiaon is COBOL
LE OFF  MarmWal Language Environdent erraor processing

LERRN OFF  Displaw internally generated PriHary CoHHands

LIHE OFF  Honitor LIWKed-to prograns for the test session
HAIN il | The prograd being tested iz a HAINLINE

HONITOR il | The default for- the RUN coWWand i= HONITOR

2  Type this command:
SET operand mode

where:
operand is the corresponding option.

mode is the desired mode. For example, SET ASM ON.

You can also modify an option's mode using the Set field on the Options - Modes
screen.

Note:

The current setting for each option is saved between sessions, with the exception of
BREAKS, PSEUDO, SCRIPT, and WHENS. The defaults for these options are
restored when you initiate a new session.
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Application Knowledge Repository (AKR)

Before programs can be tested, your program must be analyzed. Analyzed programs are
stored in the AKR for use by SmartTest when testing. An AKR can be allocated in a
BDAM or VSAM file organization. An AKR can be defined to be shared by all users, or
multiple AKRs can be defined for use by departments, groups, or individuals.

Online and batch utilities are provided for managing the AKR. These utilities furnish
these capabilities:

. Renaming and deleting programs
. Working with the AKR directory
. Allocating or expanding the AKR

To allocate an AKR

1 Select File » AKR utility or type UTTILITY. The File - AKR Utility pop-up, shown
in Figure 23, displays.

Figure 23 « File - AKR Utility Pop-up

File — AKR Utility
ConMand ===k

Blank - Display HeHber list 0 - Delete Redber
A - Allocate-edpand AER R — RenaHe Hedber

Application Knowledge Repository [AKR]EZ

Data sat nane . . 'USER1Z2,GEMERAL.AKR'

HerbBEF & & & & & [if "R" or "D" salected)
Mew naMe o« . 0 W __________ [if "R" selected)
Uolure serial . . ______ [if not cataloged]
Passwaord . . . . [if password protected]

2 Specify the member name of the AKR in the Data set name field.
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3  Display the File - AKR Allocate/Expand pop-up by typing A in the command input
area and pressing Enter.

Figure 24 « File - AKR Allocate/Expand Pop-up

File — AKR Allocate~<Expand
CoHHand ===k

% - BubHit JCL E - Edit JCL L - Epacify Catalog

Expand edisting AKR . . . MO [Tes or Mol
AKR data set nade . . . « "USERLZ.GENERAL.AKR’

POLUHE W w w0 om0 o0

Unit o w w0 0 m 12 [Generic unit nane)

Epace umits . . . . . RECORDE [Records, Tracks or Cylinders)

PriHary Space . . o . AR [Prinary aHount in abowve units)

Fecondary space . . . . 0 [#econdary adount in above units]
Job =statement infornationd

~/USERLZ_ TOE [ 1s

“r HEGCLASE=A

<ok INZERT ' ~tROUTE PRINT NODE.UZER' HERE IF NEEDED.

ok

4  Enter the appropriate information in these required fields:
a Type NO in the Expand existing AKR field.
b  Enter the AKR dataset name in AKR data set name field.

¢ Enter the appropriate SMS classes or the volume and space information as
required for your site.

d Enter a valid Job card in the Job statement information: field.

For more information on the File - AKR Allocate/Expand pop-up, see the FILE
command in the ASG-SmartTest Reference Guide.

5 Submit the JCL by typing S in the command input area and pressing Enter.

Or
Edit the JCL by typing E in the command input area and pressing Enter.

a  While in the editor, make the appropriate modifications and issue the standard
ISPF SUBMIT command.

b  Return to the File - AKR Allocate/Expand by issuing the END primary
command or pressing PF3.

6  Verify the AKR allocation results by examining the job output. Sample job outputs
are presented in "Verifying AKR Allocation Results" on page 37)
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Verifying AKR Allocation Results

After the AKR allocation batch job has completed, review the job output to verify
successful allocation and initialization. These examples show output excerpts with
messages that indicate successful allocation and initialization of a VSAM AKR.

Figure 25 shows the output of the IDCAMS step to allocate the AKR.

Figure 25 « IDCAMS Utility Condition Code Message Output

IDCAMS SYSTEM SERVICES

DEFINE CLUSTER -
(NAME (USER.TEST.AKR) -
CYLINDERS (5) -
CONTROLINTERVALSIZE (4096) -
NUMBERED -
RECORDSIZE (4089 4089) -
RECOVERY -
UNIQUE -
SHAREOPTIONS (3 3)) -
DATA -
(NAME (USER.TEST.AKR.DATA) )
IDC0508I DATA ALLOCATION STATUS FOR VOLUME SYSDA IS O
IDCO0O1I FUNCTION COMPLETED, HIGHEST CONDITION CODE WAS O

IDCO002I IDCAMS PROCESSING COMPLETE. MAXIMUM CONDITION CODE WAS O

Figure 26 shows the output of a successful initialization of the AKR.

Figure 26 » AKR Initialization Message Output

ASG-CENTER-0S (390) AKR UTILITY LOG

INIT DSNAME (USER.TEST.AKR)

ASG1316I AKR "USER.TEST.AKR" INITIALIZED.

ASG1314I *** END OF VIASYSIN ***

Figure 27 shows the output of the AKR utility after successful allocation of an AKR.

Figure 27 « AKR Utility Log Summary Message Output

ASG-CENTER-0S (390) AKR UTILITY LOG - SUMMARY
ASG1300I 1 AKR(S) INITIALIZED 0 FAILED.

ASG1315I *** END OF SUMMARY REPORT ***
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Analyze Facility

The Program Analyze extracts knowledge about the program and populates the AKR
with this information.

Program Analyze Requirements

The Program Analyze is similar to a COBOL compile or Assembler assembly. These
basic program standards are required:

COBOL II and later programs that receive error (E), severe (S), or unconditional
(U) messages from the IBM compiler cannot be successfully analyzed.

Note:

For information on the COBOL compiler options needed by SmartTest, see
"COBOL Compiler Options" on page 289.

Assembler programs that receive condition codes of 8 or greater from the IBM
Assembler cannot be successfully analyzed.

Program Analyze Input

These items are input to the Program Analyze:

38

JCL to compile and link the program. The JCL should be the complete JCL used to
compile and link the program, and should contain these appropriate steps:

. Retrieve the source from the source manager (such as Librarian or Panvalet)
»  Execute any preprocessors

. Invoke the compiler

. Invoke the linkage editor

Program Analyze features. These features indicate the type of analysis to be
performed.

An allocated Application Knowledge Repository to receive Program Analyze
output.

Program Analyze options.



2 Test Session

Analyzing a Program

The Program Analyze job can be submitted using these methods:

il

. From the File - Analyze Submit pop-up (see "Method 1 - Analyzing a Program
Using SmartTest" on page 39).

. From a TSO/ISPF edit screen by executing the VIASUB edit macro (see "Method 2
- Analyzing a Program from an Edit Session" on page 41).

. From any TSO/ISPF screen or user screen by executing the VIASUBDS CLIST

(see "Method 3 - Analyzing a Program from a User Screen" on page 43).

This table shows the conditions for using each method of analysis:

When the Compile JCL Resides in: Analyze the Program...

A PDS or Sequential Dataset From within SmartTest.

From within a TSO/ISPF edit session using
the VIASUB edit macro.

Using the VIASUBDS CLIST.

Librarian, Panvalet, or other user source From the edit session using the VIASUB

manager when editing the JCL edit macro.
Screen-driven submit facility that From the edit session using the VIASUB
generates the JCL edit macro.

By executing the VIASUBDS CLIST.

Method 1 - Analyzing a Program Using SmartTest

Use the File - Analyze Submit pop-up to specify the information necessary and submit a
program to be analyzed through SmartTest.

Note:
If the compile/link JCL resides in a source manager such as Librarian or Panvalet, use
"Method 2 - Analyzing a Program from an Edit Session" on page 41.

For information on the COBOL compiler options needed by SmartTest, see "COBOL
Compiler Options" on page 289.
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To analyze a program while in SmartTest

1

Select File » Compile/Analyze. The File - Analyze Submit pop-up, shown in
Figure 28, displays.

Figure 28 » File - Analyze Submit Pop-up

File - Analyze SubHit
CoHHand ===

E - Edit JCL ¥ — Eubmit TJCL

Codpile and link JGL [PDE or sequentiall:
Data set nawe

Analyze features [Yo-M]:
AZG-EHartTestl ¥ Extendad Analwszis:s N

AKR data set nane 'VIAL23.CEGOTEST AKR'
AKR prograd nade  WIAIDEHO [if owerriding PROGRAM-I0)]

Analyze options:

Codpile? [YMN] o o o 0 @ 0 & o i [% if neaded by features)
Link 1oad Aodule reusable® (7M1 T

Enter the appropriate information in the required fields:

a  Specify the PDS member or sequential dataset containing the compile/link JCL
in the Data set name field.

b  Specify the analyze feature by typing Y in the SmartTest field. If you have
Insight installed and want to take advantage of the extended analyze feature,
type Y in the Extended Analysis field.

Other analyze features are available on this screen when additional ESW
products are installed at your site.

c Specify the AKR dataset name in the AKR Data set name field.

For more information on the File - Analyze Submit pop-up, see "The Analyze
Process" on page 227.




2 Test Session

3 Submit the compile/link JCL by typing S in the command input area and pressing
Enter.

Or

Edit a temporary copy of the compile/link JCL by typing E in the command input
area and pressing Enter.

a While in the editor, make the appropriate modifications and issue the standard
ISPF SUBMIT command.

b  To return to the File - Analyze Submit pop-up, issue the END primary
command or press PF3/PF15.

Edits to the JCL are not saved.

4  Verify the analyze results by examining the output reports. (See "Verifying Analyze
Results" on page 44 for more information.)

Method 2 - Analyzing a Program from an Edit Session

You may submit an analyze job outside of SmartTest through your regular edit session
(ISPF, source manager) or user compile/linkedit dialog. Use the Analyze Submit
Parameters screen to specify SmartTest-specific information.

For information on the COBOL compiler options needed by SmartTest, see "COBOL
Compiler Options" on page 289 for more information.
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To analyze a program while in an edit session

1 Initiate an edit session on your standard compile/link JCL (see Figure 29).

Figure 29 « Sample JCL

EDIT —————-- ASG.VIACENXX.CNTL (VIAMECII) - 01.03 --—-—===—-———- COLUMNS 001 072
COMMAND ===> SCROLL ===> CSR

//ASG JOB (ASG), 'ASG-SMARTTEST DEMO'
//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.
*

//
[ ] KKK o ok kK K ok KK K o kK K K o kK KK Kk ok Rk K K K ok kK K ok ok kK K Kk ok ok K Kk kR K K Kk
/* ASG-SMARTTEST SAMPLE COBOL DEMO PROGRAM *

//********************************************************************
*

SUPPLY A VALID JOBCARD AND A 'USERLIB' OVERRIDE (IF NECESSARY) .

*
*
IF ASG-SMARTTEST'S COBOL COMPILE AND LINK PROC ('VIAPCII') WAS *
INSTALLED INTO A USER PROCLIB DURING INSTALLATION, JUST SUBMIT *
THIS JOB. OTHERWISE, COPY 'VIAPCII' FROM THE ASG 'CNTL' *
LIBRARY AFTER THESE COMMENTS, UNCOMMENT THE 'PEND', AND SUBMIT. *

*

*

RR Rk ik kb bk b ik b b b b b bk bk kb kb b b b Sk I I I I I I 2 I I I I I IR Ik I I I 2 2k I I I I I Ik Ik Ik ki i

R EE

IASUB EXEC VIAPCII,
USERLIB='USER.TEST.LOADLIB',
MEMBER=VIASUB

IAMERGE EXEC VIAPCII,
USERLIB='USER.TEST.LOADLIB',
MEMBER=VIAMERGE

RS S S O OO NON
\s\\\Ef\\s\\\\o\\c\\\\s\\\\
*

*

2 Make any changes necessary, such as job card information, program and/or load
module names, copybook and/or load library names, and so forth.

3  Type VIASUB in the command input area on your Edit screen and press Enter. The
Analyze Submit Parameters screen, shown in Figure 30, displays.

Figure 30 » Analyze Submit Parameters

Analyze SubHit Paradetars
ConHand ===

E - Edit JCL ¥ - EubRit TJCL

Analyze features [T-M]:
FHartTest: W Edtended Analwsi=sl N

AKR data zet nane 'VIAL23,GENERAL.AKR

AER prograd nade [if overriding PROGRAR-IO]

Analyze options:

CoHpile? [¥«<H] « « o« @ & o & o T [7 if needad by features)
Link l1oad Hodule reusable® (v-M] T

Di=zplay this panel by defadlt in the future? (YoMl ¥
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4  Enter the appropriate information in these required fields:

a Verify that the SmartTest field under Analyze features contains a Y. If you
have Insight installed and you want to use the extended analysis features, type
Y in the Extended Analysis field.

b Enter the AKR dataset name in the AKR Data set name field.

Other analyze features are available on this screen when additional ESW products
are installed at your site.

5  Submit the compile/link JCL by typing S in the command input area and pressing
Enter.

Or

Edit a temporary copy of the compile/link JCL by typing E in the command input
area and pressing Enter.

While in the editor, make the appropriate modifications and issue the standard ISPF
SUBMIT command.

6  Type END and press Enter to return to the editor screen.

Note:
Edits to the JCL are not saved.

7  Verify the analyze results by examining the output reports. (See "Verifying Analyze
Results" on page 44 for more information.)

Method 3 - Analyzing a Program from a User Screen

If you use compile/link dialogs to enter information and invoke job submission, an option
may be added to the user screens to specify that a SmartTest Analysis is to be performed.
Check with the systems administrator at your site for these details.

If no SmartTest options have been added to your compile/link dialog screens, and there is
an opportunity to edit the JCL prior to job submission, see "Method 2 - Analyzing a
Program from an Edit Session" on page 41.

For information on the COBOL compiler options needed by SmartTest, see "COBOL
Compiler Options" on page 289.
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Verifying Analyze Results

After the Compile/Link - Analyze batch job has completed, review the job output to
verify results. The output should be checked for these results:

. Acceptable compiler results.

. Acceptable linkage editor results.

. Messages indicating the program has been successfully analyzed.

. Program is stored in the AKR.

Storage in the AKR does not occur if the program does not compile and analyze

successfully. The message ASG02481 PROGRAM 'xxxxxxxx' WAS STORED...
indicates whether the program was stored successfully on the AKR.

DIAGNOSTICS LINES indicates the number of warnings, conditionals, errors, and
disasters that occurred.

Steps in Setting up the Test Session

44

These are the steps generally involved in setting up a test for the first time in SmartTest:
. Compile/link and analyze programs to be tested.

. Prepare execution JCL for conversion to a TSO file allocation CLIST.

. Prepare input data for testing.

. Activate SmartTest.

. Provide program, module, and testing environment information.

. Convert execution JCL to TSO file allocation CLIST.

. Initiate test session.

After you set up a program for testing, subsequent test sessions may not require all of
these steps.

The steps involving a TSO file allocation CLIST relate only to execution in TSO
foreground.

For these sections, assume the program has already been compiled, linked, and analyzed.



2 Test Session

File Pull-down

Use the File pull-down to access the screens to perform these functions:
. Set up test environments

—  Set up current environment.

—  Select an execution environment.

—  Specify AKR, LOADLIB, and/or PROCLIB names.

—  Select a saved test session profile.

—  Tailor a test session.

—  Specify load module intercepts.
. Select Test Coverage Analysis (if SmartTest TCA is installed at your site).
. Open and close analyzed programs.
. Save pseudo code, marks, and/or equates.
. Compile and analyze a program.
. Allocate and expand an AKR and delete and rename its members.
. Insert pseudo code into source code.
. Execute script files.

. Exit SmartTest.
To display the File pull-down, follow this step:

» Select the File action from the action bar and press Enter. The File pull-down, shown
in Figure 31, displays.

Figure 31 ¢ File Pull-down

File Uiew Test 3Zearch List options Help
- 1. =setup test environHent... | HartTest
2. Zelect Test Coverage...
I. OpEn...
4. Close
5. Fave
G GOHpile<ANalYZe... Hepdotok: Hettedok
T. AKR uUtility... Hetdok Hetetdck
. Edit pseudo...
?. EHecute...
i8. Exit ebtelob debobetck etk
ek
setetstok
setededok

copyright Allen systeds Group, INC., an unpublished work.
A proprietary product of ASG, InC. Use pestricted to authorized 1icensess.
Vizit the AEG Zupport Mebk Zite at www.asg.cod
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Actions

Action Description

Setup test Displays the Environment Selection pop-up to set up the test
environment... environment.

Select Test Displays the File TCA Test Plan Selection pop-up if the
Coverage... SmartTest-TCA (Test Coverage Analysis) option is installed at

your site. If it is not, this action displays a message indicating this
option is not installed at your site.

Open... Opens an analyzed program for viewing, inserting pseudo code,
inserting breakpoints, and performing non-executable functions.

Close Closes an open program.

Save Saves pseudo code, marks, and/or equates in the AKR.

Compile/Analyze... Displays the Analyze Submit pop-up that is used to submit a

compile/analyze job.
AKR utility... Allocates and expands an AKR, and deletes and renames members
of an AKR.
Edit pseudo... Inserts pseudo code into source code.
Execute... Displays pop-ups to Read and execute a SmartTest script file.
Exit Exits SmartTest.
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Selecting the Testing Environment

Options

To display the Environment Selection pop-up

1 Select File P Setup test environment action.

2 Type 2 in the Setup Options field or type ENV in the primary command area on any
screen and press Enter. The Environment Selection pop-up, shown in Figure 32,

displays.

Figure 32 « Environment Selection Pop-up

ConHand ===k

Environdent Zelection

P - Zpecify PROCLIES

Envirandent selection:

A - Zpecify additional AKR: L - Epecify additional LOADLIES

0 - Dizplay AKR Directory

Current envirandent is T20

'UZERL 2, GENERAL . LOAD"
'COEZ. U0, COEZLIE"

onlines 1 - T20 5 - IH:-0E Eatch Conmect: % - HUS Batch
2 - CICE & - BTS 18 - IH: Batch
3 - IZPF Dialog ¥ - DE2 11 - BT Batch
d - IHZ-DC & - DE2 Procedure 12 - DE2 Batch
Application Knowledge Repositories [AKR]: 1 specified
'IJZER12.GENERAL . AER"
Application Load Libraries: 2 zpecified

A - Specify additional AKRs

Displays the System AKR Libraries pop-up to specify
additional AKRs.

L - Specify additional
LOADLIBs

Displays the System Load Libraries pop-up.

P - Specify PROCLIBs

Displays the Procedure Libraries pop-up specifying the
PROCLIBs required for the test session.

Note:

If you do not enter any procedure libraries on the
Procedures Libraries pop-up, the libraries listed in the
PROCLIBS entry in VIASPRMS are used to search for
procedures.
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Option Description

D - Display AKR Directory  Displays the Environment - AKR Directory pop-up
showing members in the concatenated AKRs.

1-TSO Displays the TSO Session Setup screen to test MVS
programs in TSO foreground (see "Specifying TSO
Setup Information" on page 53 for more information).

2 - CICS Displays the CICS Session Setup screen to test programs
in the CICS environment. For more information, see the
ASG-SmartTest CICS User’s Guide.

3 - ISPF Dialog Displays the ISPF Session Setup screen to test programs
through ISPF Dialog Manager (see "Specifying ISPF
Dialog Manager Information" on page 68).

4 - IMS/DC Displays the IMS/DC Session Setup screen to test
programs in the IMS/DC environment. For more
information, see the ASG-SmartTest IMS User’s Guide.

5-IMS/DB Displays the IMS/DB Session Setup screen to test

IMS/DB programs in TSO foreground (see "Specifying
IMS/DB Setup Information" on page 79).

6 - BTS Displays the BTS Session Setup screen to test IMS/DC

programs with BTS in TSO foreground (see "Specifying
BTS Setup Information" on page 98).

7 -DB2 Displays the DB2 Session Setup screen to test DB2
programs in TSO foreground (see "Specifying DB2
Setup Information" on page 121).

8 - DB2 Procedure If the DB2 Stored Procedure test option is installed at
your site, displays the DB2 Stored Procedure Setup
screen (see "DB2 Stored Procedure Testing Option" on
page 123). If not, displays a message indicating that this
option is not installed at your site.

9 - MVS Batch Displays the Batch Session Setup screen to test MV'S
programs with batch connect (see "Specifying Batch
Connect Setup Information" on page 130).

10 - IMS Batch Displays the IMS Batch Session Setup screen to test
IMS/DB programs with batch connect (see "Testing DL/I
in the Batch Environment" on page 138).




2 Test Session

Option Description

11 - BTS Batch Displays the BTS Batch Session Setup screen to test
IMS/DC programs with BTS with batch connect (see
"Testing BTS in the Batch Environment" on page 139).

12 - DB2 Batch Displays the DB2 Batch Session Setup screen to test DB2
programs with batch connect (see "Testing DB2 in the
Batch Environment" on page 140).

Application Knowledge Specifies the AKR dataset name(s). The AKRs are

Repositories (AKRs) concatenated in the order they are entered. Additional
AKRs can be specified on the System AKR Libraries
pop-up by typing A in the command area.

Application Load Libraries  Specifies the application load libraries to be used for the
test session. Application load libraries are searched in the
order entered.

Note:

The Application Load Libraries field does not apply to
the CICS or batch connect environments.

Fields

Field Description

Specified Indicates the total number of AKRs or Load libraries specified,
including those specified on the System AKR Libraries pop-up or the
System Load Libraries pop-up, respectively.
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System AKR Libraries

To specify additional load libraries for the test session

1 Type A in the primary command area on the Environment Selection pop-up and press
Enter. The System AKR Libraries pop-up, shown in Figure 33, displays. These
libraries are concatenated to those specified on the Environment Selection pop-up.

Figure 33 » System AKR Libraries Pop-up

Ewsten AKR Libraries
CoHHand ===k _

Application Knowledge Repositoriesi

2 Press PF3/PF15 to return to the Environment Selection pop-up.

System Load Libraries

To specify additional load libraries for the test session

1 Type L in the primary command area on the Environment Selection pop-up and press
Enter. The System Load Libraries pop-up, shown in Figure 34, displays. These
libraries are concatenated to those specified on the Environment Selection pop-up.

Figure 34 » System Load Libraries Pop-up

Fwsten Load Libraries
CoHHand ===

—-

Load 1libraries:

2 Press PF3/PF15 to return to the Environment Selection pop-up.
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Procedure Libraries

Use the Procedure Libraries pop-up to specify procedure libraries to be used during the
test session. If you do not enter any procedure libraries on this screen, the libraries listed
in the PROCLIBS entry in VIA$SPRMS are used to search for procedures.

To specify procedure libraries

1 Type P in the command area and press Enter on the Environment Selection pop-up.
The Procedure Libraries pop-up, shown in Figure 35, displays.

2 Add, delete, or edit the procedure libraries.

Figure 35 ¢ Procedures Libraries Pop-up

Procedure Libraries
CoHHand ===

-

PROCLIES:

3 Press PF3/PF15 to return to the Environment Selection pop-up.
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Language Environment Testing

52

This section details the requirements for testing Language Environment enabled
programs in TSO.

Note:

On the Options - Modes screen, set the LE and LECOND Set options to ON (see
"Setting Test Session Options" on page 180 for more information). These options

affect testing of Language Environment enabled programs.

LE Allows the Language Environment to process all errors without
interpretation by SmartTest when set to ON. If set to OFF, SmartTest
processes program checks before the Language Environment does.
Setting LE to ON causes SmartTest to bypass monitoring of many CEE
modules and gives the Language Environment control.

LECOND Specifies whether SmartTest passes all errors to an error handler
(registered through the CEEHDLR callable service) upon notification
of the error from LE. When this option is set to OFF, SmartTest stops
on the error condition. This option is used in conjunction with LE. It
does not appear on the Options - Modes screen unless LE is enabled.

On the Test Session Tailoring screen, set the Break on Entry and Break on Return
options to YES. In addition, the Break on Entry option should be set to YES for the
COBOL routine that issues the CEEHDLR call. (See "Tailoring a Test Session by
Program" on page 179 for more information.)

On the Load Module Intercept List pop-up, request an intercept on the error handler
routine. (See "Specifying Programs to be Tested" on page 70 for more information.)

Execute the TSO test session using either the MONITOR or NOMONITOR method
(see "Testing with SmartTest" on page 145, "Testing Using the MONITOR
Method" on page 145, and "Testing Using the NOMONITOR Method" on

page 146) for more information. When an error occurs, you receive control in your
error exit. You may step or run in your error handler code. When a break on return
is encountered in the error handler, you must use the RUN NOMON command to
complete the test. This gives control back to SmartTest on any break that is
encountered in code that is executed after returning from the error handler. If there
are no breaks, the RUN NOMON command takes you to TEST ENDED.

It is very important to use the RUN NOMON command at a break on return from your
error handler. Results are unpredictable if you use a RUN MONITOR command at that
point, especially on program checks (as distinguished from LE conditions). If you use a
RUN MONITOR command, the next RUN command entered results in a ASG2153
message.




MVS Programs in TSO Foreground

Specifying TSO Setup Information

2 Test Session

Use the TSO Session Setup screen to specify the TSO test session parameters for MVS

programs and to initiate a test session.

To select the TSO environment

1 Select TSO on the Environment Selection pop-up to display the TSO Session Setup

screen shown in Figure 36.

Figure 36 « TSO Session Setup Screen

TE0 Zession EZetup
CoHHand ===k _

R - Beqin TE0 test session (RUN)
¢ - Conuvert batch JCL to TE0 CLIET

Execution: optians:

Execution paranetersi  [gquotes are optionall
B

File allocation CLIZETS
Data set nawe '"UEER.CLIZT®

Load Hodule  TESTCOBA Ereak an entry [Y<H] NO
Break CEECTpoM id

Herber . . o UIEMETCL Deallocate after test N0

2 Enter the Load module in the Load module field. Required.

3  Enter any desired options. This step is optional.

4 Enter the CLIST dataset name and member in the Data set name and Member fields,

respectively. Optional.

If a CLIST has already been created for the program to be tested, see "Initiating a Test
Session" on page 61 for more information. If a CLIST does not exist for the program to
be tested, see "Converting Batch Execution JCL to a TSO CLIST" on page 55.
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Options
R Initiates the IMS/DB test session. This is the equivalent of the RUN
command
C Displays the Convert Batch JCL screen. (See "Converting Batch Execution
JCL to a TSO CLIST" on page 55 for more information.)
Fields
Execution
Load module The initial load module to be tested. This should be the name
of the program that is specified on the EXEC statement in the
execution JCL for the program.
Options

Break on entry (Y/N) YES causes the test session to stop at the start of the test
session. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested.
The default value is YES.

Break CSECT/pgm id Entering a program name causes the test session to stop on
entry to the specified CSECT in a statically linked module.

File allocation CLIST
Dataset name The dataset containing the allocation CLIST for allocating
files to be used during testing. If the Convert Batch JCL
facility is used, the dataset specified is shown here.
Member The name of the allocation CLIST. If the Convert Batch JCL

facility is used, the member name specified is shown here.
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2 Test Session

Field Description

Execution parameters Any required application parameters can be entered in this
field.

Deallocate after test ~ YES causes the allocation CLIST to be automatically
executed to deallocate the test files when:

. At the end of the test session
. After a CANCEL command is entered

Issuing another RUN command causes the datasets to be
reallocated automatically.

The default is NO, which causes the CLIST to be
automatically executed to deallocate the test files before any
of these situations:

. Exiting SmartTest
. Switching test programs

. Switching test environments

Converting Batch Execution JCL to a TSO CLIST

Execution in TSO foreground requires the data files used during testing to be allocated to
the TSO session. This is accomplished by a TSO file allocation CLIST. The CLIST
allocates the datasets to the TSO session, making them available for testing.

A JCL to CLIST conversion facility is provided in SmartTest to automate the process of
CLIST creation. All DD statements in the JCL stream are converted regardless of the
number of steps, unless otherwise indicated. A comment statement is included for each
step.

Converting Batch JCL to CLIST

To specify the dataset containing the batch execution JCL to be converted

Note:

If the TSO Session Setup screen is already displayed, skip step 1 and step 2 and proceed
to step 3 on page 56.

1 Select File P Setup test environment and press Enter. The File - Setup Test
Environment pop-up displays.

2 Select Setup Options P Select current environment and press Enter. The Session
Setup screen displays.
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3  Type C in the primary command input area and press Enter to display the Convert

Batch JCL pop-up as shown in Figure 37.

Figure 37 « Convert Batch JCL Pop-up

Convert Batch JCL
CoHHand ===

¢ - Conwert batch JCL into CLISET z
E - Edit file allacation CLIST F
P - Epecify procedure libraries I
A - Execute allocation CLIET u}

Extract SETLIFI libraries
Edit CLIST using panels
Edit batch TCL

Evecute deallocation CLIST

Eatch Edecution JCL:
Data set nane 'DIAEOFT JUIACEMSE.CHTL
Herber . . . UIAHMETCL

File allocation CLISTI
Data set nane "USER.CLIZT®

HeHbelr . & o oo [Blank defaults to JCL Hewber)

options:
Delete [Y-N] HNO [Delete before cCreate 'DISP=NEM' datasets]
Etep  [Y-N] HNO [only convert step with prograd to be tested)
Eubsysted o . ____ [#ource Library Hanager subsysted nade)

Etep Nanme . . [Unique step nane in JOB to conuert)

4  Enter the Batch Execution JCL dataset name and member in the Data set name and
Member fields, respectively. This is the JCL to be converted.
5  Enter the File allocation CLIST dataset name and member in the Data set name and
Member fields, respectively. This is where the converted CLIST is stored.
Options

C Converts the specified batch execution JCL member into a file allocation
CLIST. The CLIST dataset name and member name must be entered in the
File Allocation CLIST fields.

E Invokes the ISPF editor for the specified allocation CLIST member.

P Displays the Procedure Libraries pop-up used to specify procedure libraries.
If you do not enter any procedure libraries on this screen, the libraries listed
in the PROCLIBS entry in VIASPRMS are used to search for procedures.

A Invokes the CLIST processor with the generated CLIST as input and uses the
ALLOC (allocate) parameter. This allocates the datasets to the TSO session
and provides the files for testing.

S Converts the specified batch execution JCL member and extracts Library
information, such as STEPLIB, DFSRESLB, and so forth.

F Displays the File Allocation screen, which enables you to edit the SmartTest
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2 Test Session

Option Description

J Displays the batch JCL for editing.

D Invokes the CLIST processor with the generated CLIST as input and uses the
DEALC (deallocate) parameter. This frees the datasets from the TSO session.

Fields

Field

Data set name

Description

Specifies the partitioned dataset containing the JCL to be
converted to a TSO CLIST. If the Subsystem option is to be
used, specify the subsystem library dataset name.

Member

Specifies the member to be converted to a TSO CLIST.

Data set name

Specifies the partitioned dataset where the generated CLIST will
be placed. Note that this dataset need not be defined by the TSO
SYSPROC DD statement.

Member

Specifies the partitioned dataset member containing the
generated allocation CLIST.

Delete (Y/N)

For datasets that are created NEW,CATLG', YES causes a
DELETE to be issued each time the CLIST is executed, before
the dataset is allocated. The default value is NO.

Step (Y/N)

YES causes only the step with the load module specified on the
Session Setup screen to be converted. NO causes all DD
statements in the JCL stream to be converted regardless of the
number of steps in the procedure. The default value is NO.

Subsystem

If the JCL to be converted is stored in a source library that is
installed with a subsystem option, enter the name of that
subsystem. Also, the dataset and member name used by the
source library management system must be specified in the
Batch Execution JCL field.

Step Name

Specifies the unique step name within the JCL to be converted.
This is applicable if Step is specified as YES.

Note:

The Edit Facility is not available for JCL stored in a library subsystem.
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Editing Allocation CLIST

Method 1. Selecting E on the Convert Batch JCL screen displays the generated
allocation CLIST, as shown in Figure 38, which allows you to edit the CLIST manually.

Figure 38 « Generated Allocation CLIST Example

EDIT ---- USER.CLIST (VIAMEJCL) - 01.00 ——————————————mm——————— COLUMNS 001 072
COMMAND ===> SCROLL ===> CSR
dAhhkhhkk hhkhkhkhkhkkhkhkhkhkrkkhhkhhkhhkrkhhrkhhhhhxkhxxk TOP OF DATA dFhhkhhkkhkhkhkhkhkhhkhhhkhkrhrhhhhhkhxkxkxk
000001 PROC 0 VIAPARM (ALLOC)

000002 /* ASG-SMARTTEST CLIST ALLOCATE PROCESSING ** %% %k kkkkkkkx
000003 IF &VIAPARM = ALLOC THEN DO

000004 CONTROL NOMSG

000005 /* PROGRAM=VIAMERGE

000006 FREE FILE (INFILE1l, INFILE2, INFILE3,OUTFILE, QUTRPT)

000007 FREE ATTRLIST (VATTR1,VATTR2)

000008 CONTROL MSG

000009 ATTRIB VATTR1 RECFM(F B) LRECL(230) BLKSIZE (460)

000010 ATTRIB VATTR2 RECFM(F B) LRECL(132) BLKSIZE (13200)

000011 ALLOC FI(INFILE1l) DA ('ASG.VIACENXX.CNTL (VIAMINO1)") -
000012 SHR KEEP

000013 ALLOC FI(INFILE2) DA ('ASG.VIACENXX.CNTL (VIAMINO2)") -
000014 SHR KEEP

000015 ALLOC FI (INFILE3) DA ('ASG.VIACENXX.CNTL (VIAMINO3) ") -
000016 SHR KEEP

000017 ALLOC FI (OUTFILE) DUMMY USING (VATTR1)

000018 ALLOC FI (OUTRPT) UNIT (SYSDA) SPACE(1,1) CYLINDERS -
000019 USING (VATTR2) NEW DELETE

000020 /* PROGRAM=VIAMERGE

000021 END

Special considerations apply for Generation Data Group (GDG) datasets. The TSO
ALLOCATE statement created for Generation Data Groups specifies the absolute
generation number represented by the catalog at the time of CLIST generation.
Automatic incrementing of GDG entries does not occur. Each time the CLIST is executed
the same generation is used unless the CLIST is manually edited or regenerated prior to
execution. For example:

//FILE1 DD DSN=ASG.VIACENxx.IN1 (0),DISP=SHR
converts to:

ALLOC FI(FILE) DA ('ASG.VIACENxx.IN1.GOOO6VOl’) SHR KEEP
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2 Test Session

Method 2. Selecting F on the Convert Batch JCL screen displays the Allocations from
JCL screen, as shown in Figure 39, which provides a user interface for editing the CLIST.
The basic editor provides a list of DDNAME and dataset information that corresponds to
the CLIST allocations.

Figure 39 « Allocations from JCL Screen

Allocations froM JCL  -——-————————— Row 1 to 5 of S
=== _ ECROLL ===} PAGE
Long,Ehort.ATTri b.CANCEL JEND

Datazet: " WIAUSE. TEST. DATACMIAMEICLY

Delete [Y<H] NO [Delete before create 'DISP=MEN' datasets)

dptions: Insert,Replace,Dbelete,Edit,liew,Brovse,delect
OO0 Mawe Data Zet MaWes in Order of Concatenation bi=p
INFILEL 'UIAINST.GES®TEO81 GNTLIVIAAINGL]" EHR KEEF
INFILEZ 'UIAINST.CESETOE1 . CNTLIVIAHINGZ]' EHR KEEF
INFILEZ 'UIAINST.CESETO81  CNTLIVIAHINGZ]" EHR KEEP
QUTFILE DURHHY
QUTRPT HEW DELETE

Botton of data

Fields

Delete (Y|N) For datasets that are created NEW,CATLG, type YES to cause a
DELETE to be issued each time the CLIST is executed, before the
dataset is allocated. The default value is NO.

DD Name The file name for the allocation entry. If this field is left blank, the
dataset is concatenated to the previous entry.

Data Set Names The name of the dataset to be allocated. If DISP=DATA, this field is

in Order of ignored.
Concatenation
Disp The disposition with which to allocate the dataset. The valid values

are SHR, OLD, NEW, MOD, DATA, and SYSOUT.
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Commands
Command Type Command Description
Primary
END Writes a CLIST from the current information and end
the edit session.
CANcel Ends the edit session without saving changes.
Attrib Displays an additional line of information for each
entry showing the dataset attributes, if present.
Long Displays all additional information for each entry in the
list.
Short Resets the display to one line per entry.
Line
I Inserts a new blank line after the selected line.
R Adds a new line after, and identical to, the selected line.
D Deletes the selected line.
S Invokes the attribute editor for the selected line.
E Invokes the ISPF editor for the dataset on the current
line.
Vv Invokes the ISPF view for the dataset on the current
line.
B {_nvokes the ISPF browse for the dataset on the current
ine.
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2 Test Session

Initiating a Test Session
After all information for testing a program in TSO foreground is specified, you must have
completed these tasks:

. Selected the environment. (See "Selecting the Testing Environment" on page 47 for
more information.)

. Specified the Load module, AKR, load libraries, and procedure libraries (if
needed). (See "System Load Libraries" on page 50 for more information.)

. Generated a CLIST. (See "Converting Batch Execution JCL to a TSO CLIST" on
page 55 for more information.)

Test initiation involves executing the TSO file allocation CLIST and displaying Program
View. When test initiation is complete, the test session is active and waiting for a
command. Program View displays program source or disassembled object code.

To initiate a test session, follow this step:

»  Type R in the primary command input area on the TSO Session Setup screen and
press Enter.

Or

Type RUN or STEP on any SmartTest screen or pop-up with a primary command
input area. You may also use the PF4 (RUN) or PF6 (STEP) key.

Setup Considerations

TSO Foreground

During setup for testing in TSO foreground, keep these input/output dataset and
execution JCL considerations in mind.

If a TSO file allocation CLIST does not exist at the time a test session is to be initiated,
one must be created. A JCL to CLIST conversion facility is provided to automate the
process.
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These points may require you to modify the batch execution JCL prior to CLIST
conversion:

The JCL to be converted must be valid and executable outside of SmartTest.

JCL SYSOUT designations of * (for example, /SYSPRINT DD SYSOUT=*) are

routed to the terminal by the CLIST. Output routed to the terminal displays as it is

written. It can only be scrolled forward, and is not available once the test session is
terminated. You may want to assign the SYSOUT destinations to sequential files or
the held output queue.

Make temporary datasets permanent to insure their availability outside the TSO
session.

When testing a multiple step job, complete these actions:

Specify YES in the Step field of the Convert Batch JCL pop-up or edit the multiple
step JCL so it contains only the step to be tested.

Execute programs/utilities invoked in other steps separately (for example, SORT,
IDCAMS). Those programs serving to allocate or delete files (for example,
IEFBR14) may be skipped and the appropriate statements manually added to the
CLIST after conversion.

Saving the SmartTest Testing Setup
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For testing programs running in multiple environments, SmartTest provides the LIST
PROFILE primary command. LIST PROFILE is used to save a test session setup and
restore it when you need to test the same program again or a different program using the

same setup.

To save the setup information in a profile dataset

1

Type LIST PROFILE in the primary command area of any SmartTest screen to
display the Profile Data Set Member List screen. The command may be abbreviated
LI PR.



2 Test Session

2 Type W in the line command area beside any line that says AVAILABLE. In the User
profile description field, enter any text that reminds you of the purpose of the setup
being saved. You can include the program being tested, the application or project ID,
and the date, as shown in Figure 40.

Figure 40 » Profile Data Set Member List Screen

Profile Data et Hednber List
ConHand ===

The current environdent isi TS0

Profile dataset name 'UZER1Z.IZPF.PROFILE"

COPY TO dataset name
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¢ - Copy selected nenber R - Replace Henber [Pending status)
0 - Delete Hedber * denotes TCA Profile
Profile  ERViran User profile description [optionall

UIAPETE1  AUAILAELE
UIAPETEZ2 AUAILAELE
UIAPETOZ  AUAILAELE

_ VIAPETO4  T=0 testl

_ VIAPETAS TE0 test for autatester

_ VIAPETEE TE0 test viapcob and keep window

_ VIAPETEY TE0 tca test tso profile

_ VIAPSTOS T30 this iz new stuff

_ VIAPSTE® T30 Q<A transfer for TESTCOE RELEASE 3.3
_ VIAPET1® T30 test count for torn

_ VIAPET11 T=0 analz test wobr

_ VIAPET12 CICE Cics test

_ VIAPETLZ ISFF IZPF setup £@-21 <00

Sharing Test Setups

To copy setup information from other profile datasets

1 In the Profile dataset name field on the Profile Data Set Member List screen, enter
the dataset name of the profile dataset containing the desired setup. The saved profile
list is refreshed to display the profiles from the new profile dataset.

2 In the line command area of the Profile Data Set Member List screen, select the
desired profile to copy to your profile dataset by typing C on the line containing the
profile.

The profile is now copied to your profile dataset and may be used and modified as
desired.

Sharing an Alternate Profile Dataset

SmartTest allows you to create an alternate profile dataset, to enable team members to
share test profile setups. The alternate dataset must be a non-ISPF dataset. Test profiles
may be copied from the individual users' profile datasets to the alternate dataset, and from
the alternate dataset to the ISPF datasets. The common dataset may replace the individual
profile datasets as the default.
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To copy test profiles to a common, alternate dataset

1 In the Profile dataset name field on the Profile Data Set Member List screen, type the
name of the profile dataset containing the desired test setup profiles, for example:

'USER.ISPF.PROFILE'

2 Inthe COPY TO dataset name field, type the name of the common, alternate dataset
to receive the profiles, for example:

'USER.TSO.CNTL'

Note:
The alternate must be a non-ISPF dataset.

The profiles are now copied to the common, alternate dataset.

To copy test profiles from a common, alternate dataset to an individual, ISPF
dataset

1 In the Profile dataset name field on the Profile Data Set Member List screen, type the
name of the common, alternate dataset containing the desired test setup profiles, for
example:

'USER.TSO.CNTL'

2 Inthe COPY TO dataset name field, type the name of the individual ISPF dataset to
receive the profiles, for example:

'USER.ISPF.PROFILE'

The profiles are now copied to the individual, ISPF dataset.

Restoring the Testing Environment

64

To restore a saved test session environment

1 Type LIST PROFILE in the primary command area of any SmartTest screen to
display the Profile Data Set Member List screen.

2 Select a profile by typing S in the line command area of the line containing the
profile and pressing Enter.

The saved setup is now restored. You can start the test session using the RUN or STEP
command.



2 Test Session

Terminating a Test Session

To end the active test session, follow this step:

P Select Test P Cancel, or type CANCEL on any command line.

To exit SmartTest, follow this step:

» Select File P Exit to end SmartTest. Any pseudo code, marks, or breaks are saved in the

AKR if the online operation parameters have been saved as the default. See "Online
Operation Parameters" on page 29 for more information on setting these parameters.

You can also exit SmartTest by pressing PF3 until you exit the product.
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Test Session - Additional Environments

This chapter describes how to set up a SmartTest test session for the other execution
environments and contains these sections:

Topic Page

ISPF Dialog Manager 68

IMS/DB Programs in TSO Foreground 79

BTS in TSO Foreground 98

DB2 Programs in TSO Foreground 121
DB2 Stored Procedure Testing Option 123
Testing Programs in a Batch Region 130
Testing DL/I in the Batch Environment 138
Testing BTS in the Batch Environment 139
Testing DB2 in the Batch Environment 140
Testing DFHDRP in the Batch Environment 141




ASG-SmartTest for COBOL and Assembler User’s Guide

ISPF Dialog Manager

Specifying ISPF Dialog Manager Information

Options

68

Use the ISPF Session Setup screen to specify the ISPF Dialog Manager test session

parameters and to initiate a test session.

To select the ISPF Dialog Manager environment

1

Option Description

Select ISPF Dialog Manager on the Environment Selection pop-up and press Enter.

The ISPF Session Setup screen, shown in Figure 41, displays.

Figure 41 « ISPF Session Setup Screen

ISPF Zession Setup
CoHHand ===k _

R - Begin ISPF test session [RUN) Il - Verify IZFF allocations
% - gelect prograns to be tested

Execution: Options:
Load Hodule . & & ________ Ereak on entry [YoN] YES
Break CEECT-pgm id ________
I:ZPF Options:
Test Praofile DEN
MEWAFFL . « « &« « N
Initial IZPF panel

Hoted The Test Profile DEM cannot be the same IEPF profile data set
that is in use by ASG-SHartTest [DOMAME=ISPPROF]. Enter HELP
for more infornation on the IEPF

OPTIONE.

Enter the initial load module to be tested in the Load module field.

Enter any appropriate option(s).

R Initiates the ISPF test session. This option is the same as issuing a RUN primary
command (see "Initiating an ISPF Test Session" on page 78).

S Displays the Load Module Intercept List pop-up (see "Specifying Programs to
be Tested" on page 70).

v Displays the ISPF Allocation pop-up (see "Specifying ISPF File Allocation

Information" on page 70).




3 Test Session - Additional Environments

Fields

Field Description

Execution

Load module The initial load module to be tested.

Options

Break on entry (Y/N) YES causes the test session to stop at the start of the test
session. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested.
The default value is YES.

Break CSECT/pgm id Entering a program name causes the test session to stop on
entry to the specified CSECT in a statically linked module.

ISPF Options

Test Profile DSN The dataset that contains your ISPF profiles for the
application to be tested (ISRPROF, VIASPROF, etc.). This
must not be the same dataset that is being used by ISPF for
the SmartTest test session. If none is entered, a temporary
dataset is allocated, so each application profile is created
when accessed. To access existing profiles, use ISPF's 3.2
option to allocate a library similar to your ISPPROF library,
then use ISPF's 3.3 option to copy the appropriate application
profile from ISPPROF to the new library. This dataset name
is optional.

NEWAPPL The ISPF application ID to use for the test (optional).

Initial ISPF panel The first ISPF screen to be displayed by the test session. If
none is entered, SmartTest's VPPISPFT screen displays. If
VPPISPFT cannot be located in ISPF's ISPPLIB
concatenation, then ISPF's Dialog Manager Test screen
displays. This screen ID is optional.
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Specifying Programs to be Tested

Use the Load Module Intercept List pop-up to list load modules that may be intercepted
by SmartTest for testing. A load module that is LINKed, ATTACHed, or invoked by an
ISPEXEC SELECT program may be entered on the Load Module Intercept List screen.
Entries must be made before the start of the test.

To list load modules that may be intercepted by SmartTest for testing

1 Type S in the primary command input area on the ISPF Session Setup screen and
press Enter to display the Load Module Intercept List pop-up shown in Figure 42.

Figure 42 » Load Module Intercept List Pop-up

Load Hodule Intercept List
CoHHand ===k _
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2 Enter the load modules to be dynamically intercepted in the Load Module field and
press Enter.

3 Press PF3/PF15 to return to the ISPF Allocation screen.

Specifying ISPF File Allocation Information

After selecting an item to be allocated to ISPF, the corresponding screen displays for
entry of pertinent information.

Note:
To obtain a list of files allocated to your session, type TSO VIASALCL.
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3 Test Session - Additional Environments

To select the ISPF datasets and libraries that are to be used by the ISPF test

1 Type V in the primary command input area on the ISPF Session Setup screen and
press Enter to display the ISPF Allocation pop-up shown in Figure 43.

Figure 43 « ISPF Allocation Pop-up

IZPF Allocation

CoHMand ===k _

1 - ISPF Prograd Load Library [required]

2 - I&PF Panel-Link Libraries [optionall

3 - ISPF TablerHessage-fkeleton Libraries [optionall
d - ISPF LIST Data et [required)

5 - IZPF LOG Data St [required]

A - ALL [Display all of the above in succession)

R - Restore ISPF systen variables

Select the appropriate option(s) for items to be allocated to ISPF. Typically, the

information on these screens is entered once and need not be re-entered each time a

test is performed.

3 Press PF3/PF15 to return to the ISPF Allocation pop-up after you have allocated the
ISPF datasets and libraries.

1-ISPF Program Load
Library

Displays the ISPF Program Load Library pop-up used to
specify the location of the load module ISPMAIN. (See "ISPF
Program [oad Library" on page 72.)

2-ISPF Panel/Link
Libraries

Displays the ISPF Panel/Link Library pop-up used to specify
panel and link libraries used by the ISPF test. (See "ISPF
Panel/Link Library" on page 73.)

3-ISPF Table/
Message/Skeleton
Libraries

Displays the ISPF Table/Message/Skeleton Library pop-up
used to specify table, message, and skeleton libraries used by
the ISPF test. (See "ISPF Table/Message/Skeleton Libraries"

on page 74.)

4-ISPF LIST Data Set

Displays the ISPF List Data Set Allocation pop-up used to
specify the ISPF list dataset that is used for the ISPF test. (See
"ISPF List Allocation" on page 75.)

5-ISPF LOG Data Set

Displays the ISPF Log Data Set Allocation pop-up used to
specify the ISPF log dataset that is used for the ISPF test. (See
"Allocating the ISPF Log Dataset" on page 77.)
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ISPF Program Load Library

72

Displays the ISPF allocation pop-ups in succession.

Executes the VIAPUSPF CLIST that restores the ISPF system
variables to the site defaults.

Note:
See the discussion on modifying installed CLIST libraries in
the ASG-SmartTest Installation Guide for detailed information
on the VIAPUSPF CLIST.

To specify the load library containing the member ISPMAIN

This information is required.

Type 1 in the command input area on the ISPF Allocation pop-up and press Enter to
display the ISPF Program Load Library pop-up shown in Figure 44.

Figure 44 « ISPF Program Load Library Pop-up

Conrand ===k _

I:ZPF Praogran Load Library

IZPF Prograd Load Library:  [Fequired)
Data set nane '"IFF.ISFLOAD'

Thiz library Hust contain the 1oad Hodule 'IEPHAIN'.

Enter the ISPF load library dataset name that contains the program ISPMAIN in the
ISPF Program Load Library field.

Press PF3/PF15 to return to the ISPF Allocation pop-up.



3 Test Session - Additional Environments

ISPF Panel/Link Library

ISPPLIB and ISPLLIB are the defaults. Typically, no entries are needed on this pop-up.
If left blank, the existing ISPF-defined libraries are used. If data is entered on this pop-up,
all libraries that are accessed during a test session must be supplied. These entries
override the existing definitions.

To specify panel and link libraries for the test

1 Type 2 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF Panel/Link Libraries pop-up, shown in Figure 45, displays.

Figure 45 » ISPF Panel/Link Libraries Pop-up

I:ZPF Panel-Link Libraries
CoHHand ===k _

I5PF panel libraries: [corresponds to ISPRLIE]

I5PF link libkraries: [corresponds to ISPLLIE]

2 Enter the ISPF panel library datasets that will be used for the ISPF test in the ISPF
panel libraries field.

3 Enter the ISPF link library datasets that will be used for the ISPF test in the ISPF link
libraries field.

4  Press PF3/PF15 to return to the ISPF Allocation pop-up.
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ISPF Table/Message/Skeleton Libraries

74

Note:

ISPTLIB, ISPMLIB, and ISPSLIB are the defaults. Typically, no entries are needed on
this pop-up. If left blank, the existing ISPF-defined libraries are used. If data is entered on
this pop-up, all libraries that are accessed during a test session must be supplied. These
entries override the existing definitions.

To specify table, message, and skeleton libraries for the test

1

Type 3 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF Table/Message/Skeleton Libraries pop-up, shown in Figure 46,
displays.

Figure 46 » ISPF Table/Message/Skeleton Libraries

LiFF Table<Hessage-Skeleton Libraries
CoHHand ===k _

I%PF Table libraries: [corresponds to ISPTLIE)

I%PF Hessage libraries:  [Corresponds to ISPHLIE]

I5PF skeleton likraries: [corresponds to ISPELIE]

Enter the ISPF table library datasets that will be used for the test in the ISPF Table
libraries field.

Enter the ISPF message library datasets that will be used for the test in the ISPF
Message libraries field.

Enter the ISPF skeleton library datasets that will be used for the test in the ISPF
Skeleton libraries field.

Press PF3/PF15 to return to the in the ISPF Allocation pop-up.



3 Test Session - Additional Environments

ISPF List Allocation

Fields

To specify an ISPF list file for the test

1 Type 4 in the primary command input area on the ISPF Allocation pop-up and press
Enter to display the ISPF List Data Set Allocation pop-up shown in Figure 47.

Figure 47 » ISPF List Data Set Allocation Pop-up

IZPF Li=st Data et Allocation
ConHand ===

—-

Enter Data set nane, DURHY, TEHP, TERH o ZVE0UTI
Nare . . « ZVE0UT

EVEQUT . . X best _____
DEN DIEP [Mew, 014, or Zhr)
nit . . .

Uolune . .

Ipace:

Units « « _________
Primary  _____
Zecondary _____

DCE:

- F
- 133

133

2 Enter the appropriate information in the fields and press Enter.
3 Press PF3/PF15 to return to the ISPF Allocation pop-up.
Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset, TERM can be specified to allocate the dataset to
a terminal, and SYSOUT can be specified to allocate the dataset to
JES.
SYSOUT Specifies a JES output class. An entry in this field is valid only if
SYSOUT is specified in the Name field.
DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, MOD, or SHR.
Dest Specifies a JES destination of the SYSOUT output. This can be a
remote ID or an NJE ID.
Unit Specifies the generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Field Description

Volume Specifies the volume serial number containing the allocated dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can

be specified as CYLINDER, TRACK, or BLOCK.

Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be

allocated.
DCB
RECFM Specifies the record format of the list dataset. Record format can be
specified as F (fixed) or V (variable).
LRECL Specifies the record length of the list dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the list dataset.

Note:

The SYSOUT and DEST entries are only allowed when the NAME entry is specified as
SYSOUT.
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Allocating the ISPF Log Dataset

Fields

To specify an ISPF log file for the test

1 Type 5 in the primary command input area on the ISPF Allocation pop-up and press
Enter to display the ISPF Log Data Set Allocation pop-up shown in Figure 48.

Figure 48 « ISPF Log Data Set Allocation Pop-up

Connand ===

IEZPF Log Data Zet Allocation

-

Hare . . o EVE0UT

EYEOUT . . M
DEM DIZP
Unit . . .
Wolude o . ______
Fpace:
Units . «
Primary  _____
Tecondary _____

DCE:

Enter Data set nane, DURHY, TEHP, TERH or ZVE0UTS

De=t

.« F
. 133
133

2 Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the ISPF Allocation pop-up.
Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset, TERM can be specified to allocate the dataset to
a terminal, and SYSOUT can be specified to allocate the dataset to
JES.
SYSOUT Specifies a JES output class. An entry in this field is valid only if
SYSOUT is specified in the Name field.
DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, MOD or SHR.
Dest Specifies a JES destination of the SYSOUT output. This can be a
remote ID or an NJE ID.
Unit Specifies the generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Field Description

Volume Specifies the volume serial number containing the allocated dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can

be specified as CYLINDER, TRACK, or BLOCK.

Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be

allocated.
DCB
RECFM Specifies the record format of the list dataset. Record format can be
specified as F (fixed) or V (variable).
LRECL Specifies the record length of the list dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the list dataset.

Note:

The SYSOUT and DEST entries are only allowed when the NAME entry is specified as
SYSOUT.

Initiating an ISPF Test Session

After all information for testing a program is specified, you must have completed these
tasks:

. Selected the ISPF Dialog Manager environment.
. Specified all appropriate testing options.

. Specified the Load module and AKR.

. Specified programs to be tested.

. Specified ISPF file allocation information.
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3 Test Session - Additional Environments
When test initiation is complete, the test session is active and waiting for a command.
Program View displays program source or disassembled object code.
To initiate a test session, follow this step:

»  Type R in the primary command input area on the ISPF Session Setup screen and
press Enter.

Or

Type RUN or STEP on any SmartTest screen or pop-up with a primary command
input area. You may also use the PF4 (RUN) or PF6 (STEP) keys.

IMS/DB Programs in TSO Foreground

This section details the setup process for testing IMS/DB programs in TSO foreground.

Specifying IMS/DB Setup Information

To set up the IMS/DB environment for testing

1 Select IMS/DB on the Environment Selection pop-up to display the IMS/DB Session
Setup screen shown in Figure 49.

Figure 49 « IMS/DB Session Setup Screen

IH%<DE Zession Setup
CoHHand ===k _

R - Begin IHE test session [RUN) C - Convert batch JCL to CLIST
W= WVerify IHE allocations

Execution: options:

Load Hodule  ________ Ereak on entry [YoN] YES

PEE Mame . . ________ EBreak CEECT-pgW id  ________
Data base region twpes DE2 paraneters:

DLI~DEB~EBHF OLI Flan nade .« « = &« &

Fubswsted nade . . .

File allocation CLIETE
Data =et nane
Henber . . . Deallocate after test N0

79



ASG-SmartTest for COBOL and Assembler User’s Guide

Options

Fields
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2 Specify these fields:
a  Required. Enter the load module in the Load module field.

b Enter the CLIST dataset name and member in the Data set name and Member
fields, respectively.

c Enter any appropriate options.
3  Press PF3/PF15 to exit.

Note:

If a CLIST has already been created for the program to be tested, see "Initiating a Test
Session" on page 61. If a CLIST does not exist for the program to be tested, see
"Converting Batch Execution JCL to a TSO CLIST" on page 55.

Option Description

R Initiates the IMS/DB test session. This is the equivalent of entering the RUN
command.

C Displays the Convert Batch JCL screen used to convert batch JCL to an
allocation CLIST. The converted allocation CLIST can be used to establish
the IMS/DB test session.

v Displays the IMS/DB Allocation Selection pop-up that is used to select the

datasets, libraries, and parameters to be defined for IMS/DB.

Execution
Load module Specifies the initial load module to be tested. This should be
the name of the program that is executed by IMS.
PSB Name Specifies the IMS Program Specification Block associated

with the program being tested.




3 Test Session - Additional Environments

Options
Break on entry (Y/N) Specifying YES causes the test session to stop on initial
entry at the start of the load module. Additional break on
entry options are available on the Session Tailoring screen
for each program to be tested. The default value is YES.
Break CSECT/pgm id Specifying a program name causes the test session to stop on

entry at the start of the specified CSECT in a statically linked
module.

Database region type

DLI/DBB/BMP

Specifies the mode of the IMS/DB test session.

e DLI Uses private databases with database access
through the TSO region; uses DBDLIB and
PSBLIB.

+ DBB Uses private databases with database access
through the TSO region; uses ACBLIB.

« BMP Uses public databases with database access
through the IMS Control Region.

DB2 parameters

Plan name

Specifies the DB2 Plan that was generated for the program
to be tested when the BIND was performed. If the type of test
specified is BMP, this field is not needed.

Subsystem name

Specifies the name assigned to DB2 when it was installed in
the MVS environment. If the type specified is BMP, this
field is not necessary.

File allocation CLIST

Data set name

Specifies the dataset containing the allocation CLIST for
allocating files to be used during IMS/DB testing. If the
Convert Batch JCL facility is used, the dataset specified is
shown here.
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Member Specifies the name of the allocation CLIST. If the Convert
Batch JCL facility is used, the member name specified is
shown here.

Deallocate after test Specifying YES causes the CLIST processor to be invoked

automatically to deallocate the test files at the end of the
transaction test session, or after a CANCEL command is
entered. Issuing another RUN command causes the datasets
to be reallocated. By default, the CLIST is automatically
invoked before exiting SmartTest. The default is NO.

Specifying IMS File Allocation Information

To specify the IMS datasets, libraries, and parameters to be defined to IMS

1 Type V in the primary command input area on the IMS/DB Session Setup screen and
press Enter to display the IMS Allocation Selection pop-up shown in Figure 50.

Figure 50 « IMS Allocation Selection Pop-up

IHE Allocation Eelection
CoHHand ===k _

DFEREZLE-DFZESL
PROCLIE~DF W EARP
PEE-DED Libraries
ACE Libraries
THZHON

IEFRDER

m N R B
L I I I I B |

- IHE Parns [BHR)
P - IHE Parns [DLI or DBE)
A - ALL [Display ALl OFf The Above In SUccession)

R - Restore IHE systed variables and pards.

2 Select the appropriate option(s) for items to be allocated to IMS/DB. Typically, the
information on these screens is entered once and need not be re-entered each time a
test is performed.

3 Press PF3/PF15 to return to the IMS Allocation Selection screen.

Note:
If you choose option A, PF3/PF15 displays the next screen.
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3 Test Session - Additional Environments

1 - DFSRESLB/DFSESL

Displays the IMS DFSRESLB/DFSESL Allocation
pop-up that is used to specify the IMS load library
dataset.

2 - PROCLIB/DFSVSAMP

Displays the IMS DFSVSAMP/PROCLIB Allocation
pop-up that is used to specify the VSAM buffer pool
dataset and any datasets to be concatenated, and to
specify the IMS procedure library dataset.

3 - PSB/DBD Libraries

Displays the IMS PSB/DBD Allocation pop-up that is
used to specify the PSB and DBD libraries used by
IMS.

4 - ACB Libraries

Displays the IMS ACB Allocation pop-up that is used
to specify the ACB libraries used by IMS.

5 - IMSMON

Displays the IMS IMSMON Allocation pop-up that is
used to specify the monitor dataset used by IMS to log
run-time activities.

6 - IEFRDER

Displays the IMS IEFRDER Allocation pop-up that is
used to specify the dataset that invokes the IMS logging
facility.

B - IMS Parms (BMP)

Displays the IMS BMP Parms pop-up that is used to
specify IMS BMP execution parameters.

P - IMS Parms (DLI or DBB)

Displays the IMS DLI/DBB Parms pop-up that is used
to specify the IMS execution parameters for DLI and
DBB programs.

A-ALL

Displays the pop-ups described above in succession.

R - Restore IMS system
variables and parms

Executes the VIAPUIMS CLIST that restores the IMS
system variables and parameters to their site defaults.

Note:

See the section on modifying installed CLIST libraries
in the ASG-SmartTest Installation Guide for detailed
information on the VIAPUIMS CLIST.
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IMS DFSRESLB/DFSESL Allocation

Fields

84

Use the IMS DFSRESLB/DFSESL Allocation pop-up to specify the IMS and DB2 load
library datasets. All IMS load modules, including DL/I, are expected to be accessed
through DFSRESLB.

This is an example of typical DFSRESLB and DFSESL DD statements from batch
execution JCL:

//DFSRESLB DD DSN=IMS.RESLIB,DISP=SHR
//DFSESL DD DSN=DSN.DSNLOAD, DISP=SHR

See your batch execution JCL and PROCs for the DFSRESLB and DFSESL dataset
names used at your site.

To specify the IMS and DB2 load library datasets

1 Type 1 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS DFSRESLB/DFSESL Allocation pop-up shown
in Figure 51.

Figure 51 « IMS DFSRESLB/DFSESL Allocation Pop-up

IH: DFEREZLE-DFEEEZL ALLOCATION
CoHHand ===

Enter IH: Load Library Data set nades:
'IRE.REZLIE’

Enter DE2 Load Library Data set nades:
'DENGDENLOAD!

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Enter IMS Load Library Data Specifies the IMS load library datasets to be allocated to
Set Names the DFSRESLB DDNAME.

Enter DB2 Load Library Data Specifies the DB2 load library datasets to be allocated
Set Names to the DFSESL DDNAME.




3 Test Session - Additional Environments

IMS PROCLIB/DFSVSAMP Allocation

Use the IMS PROCLIB/DFSVSAMP Allocation pop-up to specify the datasets for
VSAM buffer pools and IMS procedure libraries. The DFSVSAMP dataset must be
allocated if databases are allocated using VSAM. Cataloged procedures used by IMS are
contained in the PROCLIB dataset.

This is an example of typical DFSVSAMP and PROCLIB DD statements from batch
execution JCL:

//PROCLIB DD DSN=IMS.PROCLIB,DISP=SHR
//DFSVSAMP DD DSN=IMS.PROCLIB (DFSVSAMP),DISP=SHR

See your batch execution JCL and PROCs for the DFSVSAMP and PROCLIB dataset
names used at your site. The PROCLIB datasets may often be concatenated in a
STEPLIB DD statement.

To specify the datasets for VSAM buffer pools and IMS procedure libraries

1 Type 2 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS PROCLIB/DFSVSAMP Allocation pop-up
shown in Figure 52.

Figure 52 « IMS PROCLIB/DFSVSAMP Allocation Pop-up

IHE PROCLIE-DFEUEAHP Allocatian
CaoHMand ===

Enter IHE PROCLIE Data set nanes:
'IHZ.PROCLIE"

Enter DFZVZAHP Data set naWes:
'THE,PROCLIE [ DFEVEHOE ]

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
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Fields
Enter IMS PROCLIB Data Specifies the procedure library datasets to be allocated to
Set Names the PROCLIB DDNAME.
Enter DFSVSAMP Data Specifies the datasets to be allocated to the DFSVSAMP
Set Names DDNAME. Datasets to be concatenated to the
DFSVSAMP dataset can be entered on the remaining lines.
IMS PSB/DBD Allocation

86

Use the IMS PSB/DBD Allocation pop-up to specify the PSB and DBD library datasets.
PSB and DBD libraries must be allocated when the Database Region Type field on the
IMS Session Setup pop-up contains DLI.

This is an example of typical IMS DD statements from batch execution JCL:

//IMS DD DSN=DSN=USER.IMS.PSBLIB,DISP=SHR
// DD DSN=DSN=USER.IMS.DBDLIB, DISP=SHR
// DD DSN=IMS.PSBLIB,DISP=SHR
// DD DSN=IMS.DBDLIB,DISP=SHR

See your batch execution JCL and PROCs for the PSB and DBD dataset names used at
your site. These datasets may often be concatenated in an IMS DD statement.

To specify the PSB and DBD library datasets

1 Type 3 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS PSB/DBD Allocation pop-up shown in Figure 53.

Figure 53 « IMS PSB/DBD Allocation Pop-up

IH: PEE<DED Allocation
CoHHand ===k _

Enter PEE-DED Library Data set nanes:




3 Test Session - Additional Environments
2 Enter the PSB and DBD dataset names to be allocated for use by IMS in the Enter
PSB/DBD Library Data set names field.

Note:
The PSB and DBD datasets are concatenated to the IMS DDNAME.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

IMS ACB Allocation

Use the IMS ACB Allocation pop-up to specify the ACB library datasets. ACB libraries
contain the combined PSB and DBD information about the program. ACB libraries
should be allocated when the Database Region Type field on the IMS Session Setup
screen contains DBB.

This example shows a typical IMSACB DD statement from batch execution JCL:

//IMSACB DD DSN=USER.IMS.ACBLIB,DISP=SHR
// DD DSN=IMS.IMS.ACBLIB,DISP=SHR

See your batch execution JCL and PROCs for the ACB dataset name used at your site.
To specify the ACB library datasets

1 Type 3 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS ACB Allocation pop-up shown in Figure 54.

Figure 54 « IMS ACB Allocation Pop-up

IHE ACGE Allocation
CoHHand === _

Enter ACE Library Data et NaWes:

2 Enter the ACB dataset names to be allocated to IMSACB for DBB testing in the
Enter ACB Library Data Set Names field.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

&7



ASG-SmartTest for COBOL and Assembler User’s Guide

IMS IMSMON Allocation

Use the IMS IMSMON Allocation pop-up to specify the DB monitoring datasets for

output from the IMS monitor.

This is an example of a typical IMSMON DD statement from batch execution JCL:

/ / IMSMON

See your batch execution JCL and PROCs for the IMSMON dataset name and attributes
used at your site.

DD DUMMY

To specify the DB monitoring datasets

1 Type 5 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS IMSMON Allocation pop-up shown in Figure 55.

Figure 55 « IMS IMSMON Allocation Pop-up

Tpacel

DCE:

CorHand ===

—-

DEN DIEP
unit . . .
Uolume . .

Units .
Pri Hary
Zecandary

RECFH .
LRECL .
ELEZIZE

IHZ IHEHON Allocation

Enter Data zet nane, DUHHY, TEHP, or bBlank:
MaHe + . «

[Mew, 014, or Zhr)

. YL [Eylinder, Track, or Elock]

- VB
- 2odd

2045

2 Enter the appropriate information in the fields.

Note:

If the IMS monitor is to be used, it is necessary to allocate either a temporary
dataset or permanent dataset in the Name field. Additionally, if the IMS monitor is
to be invoked, it is necessary to specify Y in the MON field on the IMS DLI/DBB

Parameters pop-up.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
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3 Test Session - Additional Environments

Field Description

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset. No allocation is performed if this field is left
blank.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies the device type for the SYSOUT output such as SYSDA. A
device type is only specified for new or temporary datasets.

Volume Specifies the volume serial number containing the IMSMON dataset.

Space

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK.

Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.

DCB

RECFM Specifies the record format of the IMSMON dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the IMSMON dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the IMSMON

dataset.
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IMS IEFRDER Allocation

Use the IMS IEFRDER Allocation pop-up to specify an IEFRDER dataset to provide
backout and recovery for your IMS databases.

This example shows a typical IEFRDER DD statement from batch execution JCL:

//IEFRDER DD DSN=IMSLOG, DISP=(NEW,CATLG),
// UNIT=SYSDA, SPACE=(TRK, (3,2),RLSE),
// DCB= (RECFM=VB, LRECL=2044,BLKSIZE=2048)

See your batch execution JCL and PROCs for the IEFRDER dataset name and attributes
used at your site.

To specify an IEFRDER dataset

1 Type 6 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS IEFRDER Allocation pop-up shown in Figure 56.

Figure 56 « IMS IEFRDER Allocation Pop-up

IHE IEFRDER Allocation
Conrand ===

—-

Enter Data zet nade, DUHHY, TEHP, or bBlank:

MaHe . . « TEHP

OEN DIEP i [Mew, 014, ar Ehr]

unit . . - EYE0A

Uolume . o ______

Epace:

Units . . &¥L [Eylinder, Track, or Elock]

Prinary 1
Zecondary 1

DCE:

RECFH . . VB
LRECL . . 1916
ELEZIZE 1928

2 Enter the appropriate information in the fields.

Note:

Typing DUMMY in the Name field causes the IMS backout process to fail, should
there be a necessity to back out updates to your applications databases.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.



3 Test Session - Additional Environments

Fields
Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset. No allocation is performed if this field is left
blank.
DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
Unit Specifies the device type for the SYSOUT output such as SYSDA.
Volume Specifies the volume serial number containing the IEFRDER dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK.
Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.
Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.
DCB
RECFM Specifies the record format of the IEFRDER dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the IEFRDER dataset.
BLKSIZE Specifies the maximum length, in bytes, of a block for the IEFRDER
dataset.
IMS BMP Parameters
Use the IMS BMP Parameters pop-up to specify execution parameters for IMS BMP

programs.

This is an example of typical parameters from batch execution JCL:

//STEPNAME EXEC PGM=DFSRRC00, PARM= (BMP, &§MBR, &PSB, &IN,

// &OUT, OPT&SPIE&TEST&DIRCA, &PRLD,
// &TIMERS&, &CKPTID, &PARDLI, &CPUTIME,
// &NBA, &OBA, &§IMSID, &AGN, &SSM, §PREINIT)

See your batch execution JCL and PROC:s for the parms used at your site.
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To specify execution parameters for IMS BMP programs

1 Type B in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS BMP Parameters pop-up shown in Figure 57.

Figure 57 « IMS BMP Parameters Pop-up

IH: BHP ParaHeters

Condand ===k _

Enter IH: EHP Execution paraneters:

IN & . o __ [Input transaction code]

[u11) [Transaction code or logical terninal for output)
OPT . . C [Operatar option My M, or &)

EPIE 1} [ZPIE option @ or 1]

TE3T 1} [Ualidity check call list address 8 ar 1)
DIRCA 090 [Region interragion coMmrunication areal
FRLD . [DFSHPLHM suffid or leave blank)

ETIHER _ [Tiner to be set @ or 1)

CEPTID oo [Checkpaoint ID for restart oF leave blank]
PAROLI 1 [Parallel OL~<I option @ or 1]

CPUTIHE & [CPU tiHe for IHE]

MEA . . ___ [MURber Fast Path data buffers)

OBA . . ___ [MuHber additional page-fised buffers])
IHZID R [Zubsysten identifier

AEH . . [Application Group Hake)

EEH . . [DE2 subsystens Henber]
PREINIT __ [DFEINTHM suffis orF leave blank)
APARH [APARH walue oF blank]

2 Enter the appropriate information in the fields.

Note:

See the IBM IMS System Definition Reference Manual for additional information on
each of the IMS BMP execution parameters.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Fields

IN Use this parameter when the application program will be accessing
the message queues. The OUT parameter is ignored when you specify
this parameter.

OuT Indicates the transaction code or logical terminal name to which an
output message is to be sent. This parameter is needed when the
application program sends output without accessing the input queues.

OPT Indicates the action to be performed when the IMS control region is
unavailable. Valid options are N (notify), W (wait), or C (cancel). The
default value is N.
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SPIE

Indicates whether control is passed when a program exception
(0C1-0CF) occurs, thus allowing the program to correct the problem
without an abend occurring. The default value is 0 (zero), which
indicates control is passed.

TEST

Indicates whether the address in the user call list is checked for
validity. The address in the user call list must be greater than the high
address of the MVS nucleus and less than the highest virtual storage
address of the machine. 1 indicates the address is to be checked. The
default value is 0 (zero).

DIRCA

Specifies the interregion communication area of storage that is used
by IMS to communicate with the test. The default value is 000.

PRLD

Specifies a suffix for DFSMPL that can be two alphabetic characters.
The specified suffix is used to preload modules in the region. This
field can be left blank if a suffix is not needed.

STIMER

Specifies whether the timer is to be set. [f CPUTIME=n is specified,
the STIMER value must be 1. STIMER=1 results in performance
degradation and should only be specified when gathering statistics. 0
(zero) specifies that the timer is not to be set.

CKPTID

Specifies the checkpoint/restart ID used to restart a program.

PARDLI

Indicates where DL/I processing is to be performed. 0 (zero) specifies
that DL/I processing is to be performed within the BMP region. 1
specifies that all DL/I processing is to be performed in the IMS
control region.

CPUTIME

This parameter must be 0 (zero) for SmartTest.

NBA

Specifies the number of Fast Path data buffers. This field can be left
blank if Fast Path databases are not used.

OBA

Specifies the number of additional page-fixed buffers for Fast Path
applications when the standard buffers are all used.

IMSID

Indicates the subsystem identifier for the operating system being
used. This identifier is used instead of the IMS identifier specified
when the system was defined.

AGN

Indicates the Application Group Name used for resource access
security.
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Field Description

SSM Specifies a site-specific value that is used to allow access to selected
DB?2 subsystems under IMS. This field can be left blank or 1 to 4
alphanumeric characters can be entered.

PREINIT Specifies a suffix for DFSINT that can be two alphabetic characters.
DFSINT xx contains a list of preinitialization modules to which
control is to be given. This field can be left blank if a suffix is not

needed.
Execution Specifies the application parameter string. This is for IMS/ESA only.
parameters
(APARM)
Note:

See the IBM IMS System Definition Reference Manual for additional information on each
of the IMS BMP execution parameters.

IMS DLI/DBB Parameters
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Use the IMS DLI/DBB Parameters pop-up to specify execution parameters for IMS
DLI/DBB programs.

This example shows typical parameters from batch execution JCL:

//STEPNAME EXEC PGM=DFSRRC00, PARM= (DLI, §MBR, &PSB, &BUF,

// &SPIE&TEST&EXCPVR&RST, &PRLD, &SRCH,
// &CKPTID, &MON, & LOGA, & FMTO, &IMSID,
// &SWAP, &DBRC, & IRLM, & IRLMNM, &BKO, &I0OB)

See your batch execution JCL and PROCs for the parms used at your site.
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3 Test Session - Additional Environments

To specify execution parameters for IMS DLI/DBB programs

1 Type P in the primary command input area on the IMS Allocation Selection pop-up
and press Enter to display the IMS DLI/DBB Parameters pop-up shown in Figure 58.

Figure 58 « IMS DLI/DBB Parameters Pop-up

CoHAand ===

In: DLI-DBE Parameters

Enter IH: DLI-DEE Execution Paraneters:

ELF
EPIE
TEET
EHCPUR
RET
FRLD
2RCH
CEPTID
HON
LOGA
FHTO
IHZID
ENMAP
DERLC
IRLH
IRLHHH
EKO
AFPARH

[l I i ]

=l Zl =l EZox

[IZAN-05AH buffer pool size)

[ZPIE option @ or 1]

[Ualidity check call list address @ or 1)

[Long terd fid of buffer pool 8 o 1)

[UCF restart @ or 1)

[OFEHPLHM prefid of leave blank]

[Hodule search B=standard, 1=JPA and LPA first]
[Checkpoint ID for restart or leave blank]

[DE wmoni tor active ¥ or M)

[BZAH oF OFAH logging @ or 1]

[Fornatted dump option T, P, or N

[Zubsysten identifier]

[Address space swappable oF non-swappable ' or M)
[Data Base Recovery Contraol]

[v¥ or N to use IRLH]

[IRLH =subsysteW nane o leave blank]

[Ownanic backout ¥ or M)

[APARH walue oF blank]

2 Enter the appropriate information in the fields.
Note:
See the IBM IMS System Definition Reference Manual for additional information on
each of the IMS execution parameters.
3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
BUF Specifies the ISAM/OSAM buffer pool size. The default value is 8.
SPIE Indicates whether control is passed when a program exception
(0C1-0CF) occurs, thus allowing the program to correct the problem
without an abend occurring. The default value is 0 (zero), which
indicates control is passed.
TEST Indicates whether the address in the user call list is checked for

validity. The address in the user call list must be greater than the high
address of the MVS nucleus and less than the highest virtual storage
address of the machine. 1 indicates the address is to be checked. The

default value is 0 (zero).
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EXCPVR

Indicates if real storage is to be reserved for use by IMS ISAM/OSAM
buffers. The default value is 0 (zero), which indicates storage is not
reserved.

RST

Indicates if the UCF (Utility Control Facility) is to be used for restarts.
The default value is 0 (zero), which indicates UCF is not to be used.

PRLD

Specifies a suffix for DFSMPL that can be two alphabetic characters.
The specified suffix is used to preload modules in the region. This
field can be left blank if a suffix is not needed.

SRCH

Indicates where the system is to search for modules. 0 (zero) specifies
the search is first in the JOBLIB/STEPLIB, then LINKLST, and then
LPA. 1 specifies that the search begins first in JPA/LPA, then
JOBLIB/STEPLIB, and then LINKLST. LPA (Link Pack Area)
modules are loaded into a high storage area that is available for use by
all jobs on the machine. JPA (Job Pack Area) modules are loaded into
storage for a job. The default value is 0 (zero).

CKPTID

Specifies the checkpoint/restart ID used to restart a program.

MON

Indicates if the IMS monitoring option is active. The default value is
N.

LOGA

Specifies the logging access method. This parameter is no longer used
and is ignored if specified.

FMTO

Specifies whether formatted dump output is to be produced.

T indicates IMS data areas are formatted and other areas are
suppressed by the FDDL (Formatted Dump Delete List). P indicates
no areas are suppressed and IMS data areas are formatted.

N suppresses the formatted dump output.

IMSID

Indicates the subsystem identifier for the operating system being
used. This identifier is used instead of the IMS identifier specified
when the system was defined.

SWAP

Indicates if the address space can be swapped when the System
Resource Manager (SRM) determines that an overload exists. An
overload occurs when the CPU utilization or the paging rate is too
high. The default value is Y (YES), which indicates the address space
can be swapped.
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Field Description

DBRC Indicates whether Database Recovery Control will be used for this
execution of IMS. Y specifies that Database Recovery Control is to be
used and must be entered if Y is specified for the IRLM option. N
specifies that Database Recovery Control is not to be used for this
execution of IMS. C is used only for batch backout type runs of IMS.

IRLM Indicates if the IRLM (IMS Resource Lock Manager) is to be used. Y
specifies that the IRLM is to be used. The default value is N, which
specifies that the IRLM is not to be used.

IRLMNM Specifies the name of the IRLM subsystem if IMS is sharing the
database with other IMS systems. The IRLM subsystem name is first
specified in the IMSCTRL macro that controls the IMS system. This
field can be left blank if the IRLM option is not used.

BKO Specifies whether database updates are backed out when an abend
occurs. The default value is N, which indicates the dynamic backout
option is not active.

Execution Specifies the application parameter string. This is for IMS/ESA only.
parameters
(APARM)
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BTS in TSO Foreground

Specifying BTS Setup Information

To specify the TSO test session parameters for BTS, and to initiate a test session

1 Select BTS on the Environment Selection pop-up to display the BTS Session Setup
screen shown in Figure 59.

Figure 59 « BTS Session Setup Screen

BTE Fession setup
CoHHand ===k _

R - B=qgin BETE test session [RUN] ¢ = Convert batch JCL to CLIET

P - Preuvied ETEIN data zet W= Leprify BTE-IHE allocations
Executian: optionsi

Load module  ________ Ereak on entry [YoN] YES

Ereak CEECT-pgW id  ________
Data base region typel
OLI -DEE~EHF OLI

File allocation CLIETI
Data =set nane
Henber . . . Deallocate after test NO

ETZINM:
Data set nane
Henbet-

2 Specify these fields:
a  Enter the load module in the Load module field. This is a required field.

b Enter the CLIST dataset name and member in the Data set name and Member
field, respectively.

¢  Enter any appropriate options.

Note:

If a CLIST has already been created for the program to be tested, see "Initiating a Test
Session" on page 61. If a CLIST does not exist for the program to be tested, see
"Converting Batch Execution JCL to a TSO CLIST" on page 55.
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3 Test Session - Additional Environments

Initiates the BTS test session. This is the equivalent of
entering the RUN command.

Displays the Preview BTSIN Data Set pop-up that is used to
select the BTS transactions and programs to be tested. Before
selecting this option, specify the BTS dataset name and
member.

Displays the Convert Batch JCL screen used to convert batch
JCL to an allocation CLIST. The converted allocation
CLIST can be used to establish the BTS test session.

Displays the BTS Allocation Selection pop-up that is used to
select the datasets, libraries, and parameters to be defined for
BTS and IMS.

Execution:

Load module

Specifies the initial load module to be tested. This should be
the name of the program that is executed by IMS.

Options: Specifying YES causes the test session to stop at the start of
the test session. Additional break on entry options are
Break on entry (Y/N) available on the Session Tailoring screen for each program to
be tested. The default value is YES.
Break CSECT/pgm id Specifying a program name causes the test session to stop on
entry to the specified CSECT in a statically linked module.
Database region type: Specifies the mode of the IMS/DB test session.
DLI/DBB/BMP DLI - Uses private databases with database access through

the TSO region. Uses DBDLIB and PSBLIB.

DBB - Uses private databases with database access through
the TSO region. Uses ACBLIB.

BMP - Uses public databases with database access through
the IMS Control Region.
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Option Description

File allocation CLIST: Specifies the dataset containing the allocation CLIST

Dataset name generated by the Convert Batch JCL facility.

Member Specifies the name of the allocation CLIST generated by the
Convert Batch JCL facility.

Deallocate after test ~ Specifying YES causes the CLIST processor to be
automatically invoked to deallocate the test files at the end of
the test session, or after a CANCEL command is entered.
Issuing another RUN command causes the datasets to be
reallocated. By default, the CLIST is automatically invoked
to deallocate the test files before exiting SmartTest. The
default value is NO.

BTSIN
Dataset name Specifies the BTS input control statement dataset that
contains the PSBs and transactions available during the test
session.
Member Specifies the BTSIN dataset member.

Selecting BTS Transactions to Monitor

Use the Preview BTSIN Data Set screen to display ./T commands residing in the BTSIN
dataset. Select the transactions to be tested with SmartTest. Selected transactions are
saved from session to session. The BTSIN data may need altering to reflect these items.

. Specify a PSB= parameter on the appropriate ./T statement, even if the PSB has the
same name as the program to be tested, for example:

./T TC=TRNX MBR=TEST1 PSB=TEST1 PLC=25 LANG=CBL TYPE=DLI

. Add the TSO=NO parameter on a ./O statement to prevent BTS from prompting at
the terminal for input during the test, for example:

./0 TSO=NO

The BTSIN dataset may not be altered from this screen.
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3 Test Session - Additional Environments

To display ./T commands residing in the BTSIN dataset

1 Type P in the primary command input area on the BTS Session Setup screen and
press Enter to display the Preview BTSIN Data Set screen shown in Figure 60.

Figure 60 « Preview BTSIN Dataset Screen

wh

CoHHand ===

Zelect the Transactions and Prograds to be tested.

Trancode

Praview ETSIN Data Set
Ecroll ===} IR

Prograd  PEZEMAME  Lang Type PLC  &#PAR  Edit rtn DEZX PLAM

ADDI
ADDINLY
ACDOFPART
ADDOPN
ER1d
CLOZE
COEZ0ES
DIZEURZE
OLETI
OLETINU
DLETPART
OLETFN
DEPALLI
LINKAZHY
LINKCOE
LINKIHE

TETZAHEd  TETZAMEd CEL HEG
TETZAHEd  TETZAMEd CEL HEG
TETEZAHEd  TETEAMEd  CEL HEG
TETEAHE4  TETEAMEd  CEL HEG
IEFER14  DFEZAMOZ2 REH H2G
TETEZAHES  TETZAMES CEL HEG
COEZDSE  DFEZAMO2 CEL HEG
TETEZAHOE TETZAMEE CEL  HEG
TETZAHEd  TETZAMEd CEL HEG
TETEZAHEd  TETEAMEd  CEL HEG
TETEAHEd  TETEAMEd  CEL HEG
TETEZAHEd  TETEAMEd CEL H2G
TETEZAHOT TETEZAMEY CEL  HEG
LINKAZH4 DF2ZAME2  REH HEG
LINKCOE  DF2ZAHe2 CEL  HEG
LINKIHE  DF2ZAME2 CEL  HEG

I e e e e e e ol

2 Select the transaction(s) to be tested by typing S in the S line command area.

3 Press PF3/PF15 to return to the BTS Session Setup screen.

S Selects transaction for testing.

Trancode Specifies the transaction code name of the primary or secondary
transaction.

Program Specifies the load module of the application program that processes
the transaction named by the TC= operand.

PSBNAME Specifies the alphanumeric PSB name to be used when processing
the transaction named by the TC= operand.

Lang Specifies the programming language of the module named by the
MBR= operand. The default is ASM.

Type Specifies the type of application program being defined, or the

alternate logical terminal type. The default is MSG.
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PLC Specifies the processing limit count for this transaction. The default
is 1.

SPA Defines the size of the scratch pad area, in bytes, for the transaction
named by the TC= operand.

EDIT rtn Specifies the member name of the user-written transaction code
(input) edit routine that is called to edit each input message
segment.

DB2 PLAN Specifies the DB2 plan name for the corresponding transaction.

Note:

If the program uses DB2, the DB2 name should be specified on the
BTSIN transaction './T' cards. The subsystem name should be
defined to BTS or specified in the BTSIN Patch './P' cards.

Specifying BTS File Allocation Information
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To select the BTS datasets, libraries, and parameters to be defined to IMS

1 Type V in the primary command input area on the BTS Session Setup screen and
press Enter to display the BTS Allocation Selection pop-up shown in Figure 61.

Figure 61 « BTS Allocation Selection Pop-up

-

CoMnand ===x _
1 - BT% Load library
2 = FORHAT
3 - QIOPCE
4 - QALTPCE
5 - QALTRAN
& - BT=0UT
7 = BTEPUNCH
& - BT=DEEUG
- BTEENAP

ETZ Allocation Zelection

IHE allocations and parHs
ALL [DOisplay ALl Of The Above In Succession)

Restore BTE and IWE systed variables and pards.

Select the appropriate option(s) for items to be allocated to BTS. Typically, the
information on these screens is entered once and need not be re-entered each time a

test is performed.

Press PF3/PF15 to return to this screen or to display the next screen.
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3 Test Session - Additional Environments

1 - BTS LOAD LIBRARY

Displays the BTS Load Library pop-up that is used to
specify the BTS load library dataset.

2 - FORMAT

Displays the BTS Format Libraries pop-up that is used to
specify the IMS MFS (Message Format Services)
datasets.

3 - QIOPCB

Displays the BTS QIOPCB Allocation pop-up that is used
to specify the BTS work file dataset.

4 -QALTPCB

Displays the BTS QALTPCB Allocation pop-up that is
used to specify the BTS work file dataset for alternate
PCBs.

5 - QALTRAN

Displays the BTS QALTRAN Allocation pop-up that is
used to allocate the dataset to be used for alternate PCB
output.

6 - BTSOUT

Displays the BTS BTSOUT Allocation pop-up thatis used
to specify the pop-up and message output dataset.

7 - BTSPUNCH

Displays the BTS BTSPUNCH Allocation pop-up that is
used to specify the dataset used to capture all BTS input.

8 - BISDEBUG

Displays the BTS BTSDEBUG Allocation pop-up that is
used to specify the dataset used to capture SNAP dumps
of the Trace table and various control blocks taken by
BTS.

9 - BTSSNAP

Displays the BTS BTSSNAP Allocation pop-up that is
used to specify the dataset used to capture all other SNAP
dumps taken by BTS.

I - IMS allocations and
parms

Displays the IMS Allocation Information pop-up that is
used to specify the datasets, libraries, and parameters that
are to be defined to IMS.

Note:

See "Specifying IMS File Allocation Information" on
page 82 for more information on the IMS Allocation
Selection pop-up.
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A -ALL Displays the pop-ups described above in succession.

R - Restore BTS and IMS ~ Executes the VIAPUBTS CLIST that restores the BTS
system variables and parms and IMS system variables and parameters to their site
defaults

Note:
See the section on modifying installed CLIST libraries in the ASG-SmartTest Installation
Guide for detailed information on the VIAPUBTS CLIST. See the IBM IMS Batch
Terminal Simulator: Program Reference/Operations Manual for more information on
BTS datasets and parameters.

BTS Load Library
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Use the BTS Load Library pop-up to specify the BTS load library and STAX indicator
for BTS.

This is an example of a typical BTS load library DD statement from batch execution JCL:
//STEPLIB DD DSN=BTS.BTSLIB,DISP=SHR

See your batch execution JCL and PROCs for the BTS load library dataset used at your
site.

To specify the BTS load library and STAX indicator

1 Type 1 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS Load Library pop-up shown in Figure 62.

Figure 62 « BTS Load Library Pop-up

ETE Load Library

Connand ===k _

Enter ET% Load Library Data Set Naned
'BT5.BTELIE!

Enter BETE ETAX indicator: _  [¥,N, o blank]

2  Enter the load library dataset that contains the programs used by BTS.
3 Type Y or N in the Enter BTS STAX indicator field, or leave it blank.
Entering Y specifies that BTS is to process the TSO terminal attention exit. When

this field is left blank, BTS does not allow the selection of the TSO terminal attention
exit.



3 Test Session - Additional Environments

Ifthe BTS0015A INVALID KEYWORD ON PARM STRING, 'DLI'
ASSUMED message displays when the BTS test session is initiated, the STAX

indicator contains the wrong value. If this message displays, change the value in this
field to Y, N, or blank.

4  Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

BTS Format Libraries

Use the BTS Format Libraries pop-up to specify the format datasets from the IMS/ESA
Message Format Service (MFS) library.

This is an example of a typical FORMAT DD statement from batch execution JCL:

//FORMAT DD DSN=USER.TEST.FORMAT, DISP=SHR
// DD DSN=IMS.FORMAT, DISP=SHR

See your batch execution JCL and PROCs for the Format dataset name used at your site.
To specify the format datasets from the IMS/ESA MFS

1 Type 2 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS Format Libraries pop-up shown in Figure 63.

Figure 63 « BTS FORMAT Libraries Pop-up

ETE FORHAT Libraries
CoHMand ===

Enter ETE FORHAT Data set names:
*IHELFORHAT*

2 Enter the MFS datasets used to format screen message in the Enter BTS FORMAT
Data set names field.

3 When all necessary information is specified, press PF3/PF15 to return to the BTS
Allocation Selection pop-up.
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BTS QIOPCB Allocation

Use the BTS QIOPCB Allocation pop-up to allocate the dataset containing the output
message queue for BTS.

This is an example of a typical QIOPCB DD statement from batch execution JCL:

//QIOPCB

//

DD UNIT=SYSDA, SPACE=(CYL,1,1),RLSE),
DCB= (RECFM=FB, LRECL=1024,BLKSIZE=3072)

See your batch execution JCL and PROCs for the QIOPCB dataset name and attributes

used at your site.

To allocate the dataset containing the output message queue

1 Type 3 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS QIOPCB Allocation pop-up shown in Figure 64.

Figure 64 « BTS QIOPCB Allocation Pop-up
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name

Specifies the name of the dataset. TEMP indicates a temporary dataset
is to be allocated. No allocation is performed if this field is left blank.

DSN disp

Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
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Field Description

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset. The default value

is 1024.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset. The default value is 3072.

BTS QALTPCB Allocation

Use the BTS QALTPCB Allocation pop-up to allocate the alternate message queue
dataset used by BTS.

This is an example of a typical QALTPCB DD statement from batch execution JCL:

//QALTPCB DD UNIT=SYSDA, SPACE=(CYL, (1,1),RLSE),
// DCB= (RECFM=FB, LRECL=1024, BLKSIZE=3072)

See your batch execution JCL and PROCs for the QALTPCB dataset name and attributes
used at your site.
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Fields

108

To allocate the alternate message queue

1 Type 4 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS QALTPCB Allocation pop-up shown in

Figure 65.

Figure 65 « BTS QALTPCB Allocation Pop-up
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2 Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP indicates a temporary dataset
is to be allocated. No allocation is performed if this field is left blank.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.

Space

Units

Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
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Field Description

Primary Specifies the number of primary cylinders, tracks, or blocks allocated.
The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset. The default value

is 1024.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset. The default value is 3072.

BTS QALTRAN Allocation

Use the BTS QALTRAN Allocation pop-up to allocate the dataset used for alternate PCB
output.

This is an example of a typical QALTRAN DD statement from batch execution JCL:

//QALTRAN DD UNIT=SYSDA,SPACE=(CYL(1l,1),RLSE),
// DCB= (RECFM=U, LRECL=1024, BLKSIZE=536)

See your batch execution JCL and PROCs for the QALTRAN dataset name and attributes
used at your site.
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Fields
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To allocate the dataset used for alternate PCB output

1 Type 5 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS QALTRAN Allocation pop-up shown in

Figure 66.

Figure 66 « BTS QALTRAN Allocation Pop-up
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2 Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP indicates a temporary dataset
is to be allocated. No allocation is performed if this field is left blank.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.

Space

Units

Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
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Field Description

Primary Specifies the number of primary cylinders, tracks, or blocks allocated.
The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset. The default value

is 1024.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset. The default value is 3072.

BTS BTSOUT Allocation

Use the BTS BTSOUT Allocation pop-up to allocate the dataset used for BTS program
output. Output includes input verification and formatted IMS call information.

This is an example of a typical BTSOUT DD statement from batch execution JCL:

//BTSOUT DD SYSOUT=*,
// DCB=RECFM=FBA, LRECL=133,

See your batch execution JCL and PROCs for the BTSOUT dataset name and attributes
used at your site.
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To allocate the dataset used for BTS program output

1 Type

6 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS BTSOUT Allocation pop-up shown in Figure 67.

Figure 67 « BTS BTSOUT Allocation Pop-up
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2  Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset, TERM can be specified to allocate the dataset to
aterminal, and SYSOUT can be specified to allocate the dataset to the
output spool.

SYSOUT Specifies a SYSOUT class value such as A. An entry in this field is
valid only if SYSOUT is specified in the Name field.

DEST Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered in
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.




3 Test Session - Additional Environments

Field Description

Space
Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset. If BTSOUT is allocated to SYSOUT, a block size must be
specified. A fixed record format (RECFM=F) and a block size of 133
(BLKSIZE=133) outputs an unblocked file to the spool. A BLKSIZE
must be specified if the allocation is specified as anything other than
TERM.

BTS BTSPUNCH Allocation

Use the BTS BTSPUNCH Allocation pop-up to allocate the dataset containing all input
received by BTS.

This is an example of a typical BTSPUNCH DD statement from batch execution JCL:
//BTSPUNCH DD DSN=USER,BTSPUNCH,DISP=(,CATLG),
// UNIT=SYSDA, SPACE=(CYL, (10,2),RLSE)
// DCB= (RECFM=FB, LRECL=80, BLKSIZE=6800)

See your batch execution JCL and PROCs for the BTSPUNCH dataset name and
attributes used at your site.
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To allocate the dataset containing all input received by BTS

1 Type 7 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS BTSPUNCH Allocation pop-up shown in

Figure 68.

Figure 68 « BTS BTSPUNCH Allocation Pop-up
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2 Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset, TERM can be specified to allocate the dataset to
the terminal, and SYSOUT can be specified to allocate the dataset to
the output spool.

SYSOUT Specifies a SYSOUT class value such as B. An entry in this field is
valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered in
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.




3 Test Session - Additional Environments

Field Description

Volume Specifies the volume serial number containing the allocated dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset.

BTS BTSDEBUG Allocation

Use the BTS BTSDEBUG Allocation pop-up to allocate the dataset used for SNAP
dumps of the Trace table and various control blocks taken during BTS execution.

This is an example of a typical BTSDEBUG DD statement from batch execution JCL:
//BTSDEBUG DD DUMMY

See your batch execution JCL and PROCs for the BTSDEBUG dataset name and
attributes used at your site.
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To allocate the dataset used for SNAP dumps

1 Type 8 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS BTSDEBUG Allocation pop-up shown in

Figure 69.

Figure 69 « BTS BTSDEBUG Allocation Pop-up
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2 Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset, TERM can be specified to allocate the dataset to
the terminal, and SYSOUT can be specified to allocate the dataset to
the output spool.

SYSOUT Specifies a SYSOUT class value such as A. An entry in this field is
valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered in
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.




3 Test Session - Additional Environments

Field Description

Volume Specifies the volume serial number containing the allocated dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset.

BTS BTSSNAP Allocation

Use the BTS BTSSNAP Allocation pop-up to allocate the dataset containing SNAP
dumps taken by BTS during execution.

This is an example of a typical BTSSNAP DD statement from batch execution JCL:
//BTSSNAP DD SYSOUT=*

See your batch execution JCL and PROCs for the BTSSNAP dataset name and attributes
used at your site.
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To allocate the dataset containing SNAP dumps

1 Type 9 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter to display the BTS BTSSNAP Allocation pop-up shown in

Figure 70.

Figure 70 « BTS BTSSNAP Allocation Pop-up
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset, TERM can be specified to allocate the dataset to
the terminal, and SYSOUT can be specified to allocate the dataset to
the output spool.

SYSOUT Specifies a SYSOUT class value such as A. An entry in this field is
valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered in
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Field Description

Volume Specifies the volume serial number containing the allocated dataset.
Space
Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.
Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default value is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default value is 1.

DCB
RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).
LRECL Specifies the record length of the allocated dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset.
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Specifying IMS File Allocation Information

Select option I on the BTS Allocation Selection pop-up to display the IMS Allocation
Selection pop-up shown in Figure 71. Use this screen to select the IMS datasets, libraries,
and parameters to be defined to IMS.

Figure 71 « IMS Allocation Selection Pop-up
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Note:
If your IMS file allocations were not entered previously or you need to change them, see
"Specifying IMS File Allocation Information" on page 82. See the IBM IMS Batch
Terminal Simulator: Program Reference/Operations Manual for more information about
BTS about BTS datasets and parameters.

120



DB2 Programs in TSO Foreground

Specifying DB2 Setup Information

3 Test Session - Additional Environments

To specify the TSO test session parameters for DB2 programs and initiate a test

session

1 Select DB2 on the Environment Selection pop-up to display the DB2 Session Setup

screen shown in Figure 72.

Figure 72 « DB2 Session Setup Screen
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2 Specify these fields:

a Enter the load module in the Load module field. This is a required field.

b Enter the CLIST dataset name and member in the Data set name and Member
field, respectively. This is an optional field.

¢  Enter any appropriate options. This is an optional field.

Note:

If a CLIST has already been created for the program to be tested, see "Initiating a
Test Session" on page 61. If a CLIST does not exist for the program to be tested, see
"Converting Batch Execution JCL to a TSO CLIST" on page 55.
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Options
R Initiates the DB2 test session. This is the equivalent of typing RUN.
C Displays the Convert Batch JCL pop-up used to convert batch JCL to
an allocation CLIST. The converted allocation CLIST can be used to
establish the DB2 test session.
Fields

Field Description

Execution

Load module

Specifies the initial load module to be tested. This should be
the name from the TSO RUN PROGRAM command.

DB2 plan name

Specifies the DB2 Plan that was generated for the program
to be tested when the BIND was performed.

DB2 subsystem

Specifies the name assigned to DB2 when it was installed in
the MVS environment.

Options

Break on entry (Y/N)  Specifying YES causes the test session to stop at the start of
the test session. Additional break on entry options are
available on the Session Tailoring screen for each program
to be tested. The default value is YES.

Break CSECT/pgm id  Specifying a program name causes the test session to stop
on entry to the specified CSECT in a statically linked
module.

Execution parameters Specifies any required application parameters.
File allocation CLIST

Data set name

Specifies the dataset containing the allocation CLIST
generated by the Convert Batch JCL facility.
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Member Specifies the name of the allocation CLIST generated by the
Convert Batch JCL facility.

Deallocate after test Specifying YES causes the CLIST processor to be
automatically invoked to deallocate the test files at the end
of the test session, or after a CANCEL command is entered.
Issuing another RUN command causes the datasets to be
reallocated. By default, the CLIST is automatically invoked
to deallocate the test files before exiting SmartTest. The
default value is NO.

DB2 Stored Procedure Testing Option

SmartTest has an optional feature that enables a programmer/analyst to interactively test
and debug a DB2 Stored Procedure.

A Stored Procedure is a user-written program that resides on a DB2 server. An SQL
CALL interface allows an SQL requester to invoke the stored procedure at a DB2 server.
The Stored Procedure is a Language Environment compliant program, written in
COBOL, C/370, Assembler, or PL/I. The procedure name is defined to DB2 in a table,
SYSIBM.SYSPROCEDURES. When the client executes an SQL CALL, DB2 searches
this table for the procedure name contained in the SQL CALL.

Normally, a stored procedure executes in a special DB2 address space. However,
SmartTest tests the stored procedure in TSO foreground.

Requirements

Before setting up a DB2 Stored Procedure test, make sure these preliminary operations
have been performed:

. The SmartTest DB2 option is installed at your site.

. The Stored Procedure name is defined to DB2 in the SYSIBM.SYSPROCEDURES
table.

. The Stored Procedure is bound as a plan or a package. (If the Stored Procedure is
bound as a package, the package must be bound within a plan.)

. The Stored Procedure program is Analyzed and stored in an AKR.

Note:

If you are unsure of the completion of any of the above tasks, check with your DB2
Database Administrator.
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Setting Up the DB2 Stored Procedure Test

To specify the test session parameters for a DB2 Stored Procedure program and
initiate a test session

1 Select DB2 Procedure on the Environment Selection pop-up to display the DB2
Stored Procedures Setup screen shown in Figure 73.

Figure 73 « DB2 Stored Procedures Setup Screen
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2  Under Execution, make these required entries:

a  Enter the initial Load module to be tested; the entry must be the name of the
DB?2 stored procedure to be tested.

b  Enter the DB2 Plan name that was generated for the Stored Procedure program
to be tested.

¢ Enter the DB2 Subsystem where the Stored Procedure program is to run.

d  Enter the DB2 Schema name, which is the name of the DB2 entry in the
SYSIBM.SYSROUTINES table that contains the information about the store
procedure program. This field defaults to your TSO user ID.

e  Enter the DB2 Procedure name — that is, the DB2 entry in the

SYSIBM.SYSPROCEDURES table that contains the information about the
Stored Procedure program.
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Under Options:

a

In the Break on entry (Y/N) field:

Type YES to stop the test session at the start of the test execution (such as, to
change test data values). YES is the default. Type NO to run the test execution
to completion (end or abend).

Additional break options are available. See "Tailoring a Test Session by
Program" on page 179.

Type the program name in the Break on CSECT/pgm id field to stop the test
session on entry to a specified CSECT in a statically linked module.

Type Y in the Use RRSAF field to perform resource recovery using the
Recoverable Resource Manager.

The Use RRSAF field is valid only if you have DB2 Version 5.1 or later.

If non-DB2 resources are used by the stored procedure, convert that JCL to a CLIST
and make the CLIST available to the test. To allocate a CLIST:

a

b

Make these entries under File allocation CLIST:
—  Enter the dataset name for the CLIST.
—  Enter the member name of the CLIST.

—  Todeallocate the test files at the end of this test session or aftera CANCEL
command, type YES in Deallocate after test. To deallocate the test files
at the end of the SmartTest session, type NO. (NO is the default.)

To display the Convert Batch JCL pop-up, type C. See "Converting Batch
Execution JCL to a TSO CLIST" on page 55 for more information.

Enter an action:

a

Type D to display parameters:
— If the stored procedure is expecting input parameters.

—  To review output.

Type R to begin the test session. Proceed to "Initiating the DB2 Stored
Procedures Test" on page 129.
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Reviewing DB2 Stored Procedure Parameters

To review input and output parameters

1 On the DB2 Stored Procedures Parameters screen, shown in Figure 74, review the
parameters displayed. Each parameter specified in the PARMLIST column on the
SYSIBM.SYSPROCEDURES table displays.

Figure 74 « DB2 Stored Procedures Parameters Screen
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This table describes the fields on the DB2 Stored Procedures Parameters

screen:

Column Description

Name Specifies the optional parameter name that can be used by DB2
for diagnostic messages.

Type Defines the parameter as IN (input), OUT (output), or INOUT
1/0).

Address Specifies the main storage location acquired by SmartTest for the
data.

Structure Provides information on the parameter's data attributes:
character, integer, floating point, decimal, or variable character
data.

Value Specifies the character format (maximum 8 characters) of the
data at that storage location.

Hex Value Specifies the hexadecimal representation of the data at that

storage location.
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2 To select a parameter, type S in the line command area to the left of the parameter

Name and press Enter.

a If the data is defined as numeric, the DB2 Stored Procedures Numeric Display

screen displays.
b  If the data is not defined as numeric, the Memory Display screen displays.

c Go to "Changing Test Data Values" on page 127.

Changing Test Data Values

If the parameter you selected on the DB2 Stored Procedures Parameters screen is defined
as numeric, the DB2 Stored Procedures Numeric Display screen displays. If the
parameter you selected is non-numeric, the Memory Display screen displays.

To review/change numeric values

1 Review the selected parameter on the DB2 Stored Procedures Numeric Display
screen, shown in Figure 75.

Figure 75 « DB2 Stored Procedures Numeric Display Screen

Command ===>

Numeric Data

DB2 Stored Procedures Numeric Display

000E0000

SMALLINIT

This table describes the fields on the DB2 Stored Procedures Numeric Display

screen:

Numeric Data

Displays the current numeric value for the parameter. You
may change the value in this field.

Address

Specifies the hexadecimal address of this parameter.

Type

Provides the parameter's data definition to DB2 (i.e., integer,
decimal, float, etc.).

Length

Specifies the data length defined to DB2 (used only if the
Type is decimal).

2 If desired, change the numeric value for the parameter in the Numeric Data field.

3 Press Enter to save your change.
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4  Press PF3 twice to return to the DB2 Stored Procedures Setup screen.

5 Proceed to "Initiating the DB2 Stored Procedures Test" on page 129.

To review/change non-numeric values

1 Review the selected parameter on the Memory Display screen, shown in Figure 76.

Figure 76 « Memory Display Screen

Memory Display
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000D5188 00000000 00000000 00000000 00000000 00000000 *

EE

This table describes the fields on the Memory Display screen:

Column Description

Area Displays the hexadecimal address of this parameter.
Offset Displays the relative address of this parameter.
Length Displays the data length as defined to DB2.

To make a change to these fields, type over the values displayed.

2  Press Enter to save your change.
3 Press PF3 twice to return to the DB2 Stored Procedures Setup screen.

4 Proceed to Initiating the DB2 Stored Procedures Test.




3 Test Session - Additional Environments

Initiating the DB2 Stored Procedures Test

Your DB2 Stored Procedures test is set up and you are ready to initiate the test session.
The Break on entry option stops the session for interactive data entry. All SmartTest
functions (e.g., breakpoints, session tailoring, pseudo code, searching, etc.) can be used
during your DB2 test session.

To initiate the DB2 Stored Procedures test

1

On the DB2 Stored Procedures Setup screen, type R to begin DB2 Stored Procedure
session (RUN).

Watch the test session execute the Stored Procedure in Program View.

If you did not set breaks during set up, the program executes until:
. An abend error condition
. An address stop

. Completion of the stored procedure

If you set Break on entry, the test session stops at the beginning of PROCEDURE
DIVISION (and at other breakpoints, as specified).

Note:

You must execute the PROCEDURE DIVISION or entry statement prior to using
the ZD (ZOOM DATA) command.

To use additional SmartTest functions, see these sections:

a "Testing Techniques" on page 143

b "Program Analysis Features" on page 187

c "Additional Testing Features" on page 217

At the breakpoint at the end of the test, press PF4 (RUN) to return to the DB2 Stored
Procedures Setup screen (see "Setting Up the DB2 Stored Procedure Test" on

page 124).

On the DB2 Stored Procedures Setup screen, type D to review output parameters on
the DB2 Stored Procedures Parameters screen (see "Reviewing DB2 Stored
Procedure Parameters" on page 126).
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Testing Programs in a Batch Region

Batch Connect Facility

The Batch Connect facility in SmartTest allows your original JCL to be executed in a
batch region. Use of this facility provides significant reductions in setup requirements
and TSO resource consumption. The tradeoff is the job remains active in the batch region
for the entire test session.

Consider using the SmartTest Batch Connect when these conditions occur:

. The program(s) to be tested requires too much region for execution in TSO
foreground.

. The test requires media not accessible through TSO foreground (tape datasets).
. The test must consist of multiple interdependent steps.
. The test requires the use of special output forms.

. Running a DB2 test under Batch where there is a PROC in the JCL. The SYSTSIN
DD statement must be in the PROC and may not be overridden after the execute of
the Procedure. The DD for SYSTSIN in the Procedure may use the DDNAME
parameter to allow the DD statement to be placed after the execute.

. There is a limit of one program to test for each SmartTest batch execution.

The Batch Session Setup screens are used to establish a test session in a batch region.
Once the test session is established, an online session can be connected to it. Batch
program testing can be performed interactively. Note that symbolic support may be
unavailable for programs loaded from read protected libraries.

Specifying Batch Connect Setup Information

130

Because the MVS, IMS, BTS, and DB2 Batch Session Setup screens are identical except
for the screen title, this discussion pertains to setup in all Batch environments. MVS
Batch is used as the example.

Use the Batch Session Setup screen to specify the information necessary to establish a
batch test session in an MVS batch region. Once the batch session is established, an
online interactive TSO test session can be connected to it.



Options

To establish a batch test session

3 Test Session - Additional Environments

1 Select MVS BATCH on the Environment Selection pop-up to display the Batch

Session Setup screen shown in Figure 77.

Figure 77 « Batch Session Setup Screen
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2 Specify these required fields:

a Enter the load module in the Load module field.

b Enter the batch execution JCL dataset name and member in the Batch
Execution JCL, Data set name and Member fields, respectively.

¢  Enter any appropriate options.

S Submits the specified execution JCL. The JCL dataset name and member
name must be entered in the Batch Execution JCL fields.

C Displays the Connect to Job pop-up used to connect the online test session

with a batch test session.

P Displays the Procedure Libraries pop-up used to specify procedure libraries.
If you do not enter any procedure libraries on this screen, the libraries listed
in the PROCLIBS entry in VIASPRMS are used to search for procedures.

E Invokes the TSO/ISPF editor with the batch execution JCL prior to SmartTest

changes.
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Fields
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Option Description

G Generates the batch JCL and saves the output in the specified GENERATED
JCL member without executing it. The SG (Submit Generated JCL) option
can be used to pass the generated output directly to the operating system for
execution. Job submission does not occur.

EG Generates batch connect JCL and invoke the TSO/ISPF editor with the
generated JCL. Job submission does not occur.

SG Submits the specified generated JCL. The generated JCL dataset name and
member name must be entered in the Generated JCL fields.

Field Description
Execution
Load module Specifies the initial load module to be tested.

Procedure Name  Specifies the PROC name of the procedure containing the
execute statement for the load module to be tested.

Step Name Specifies the step name in the batch job that executes the load
module to be tested.

Options

Break on entry Specifying YES causes the test session to break on entry at the

(Y/N) start of the load module. Additional break on entry options are
available on the Session Tailoring screen for each program to be
tested. The default value is YES.

BREAK Specifying a program name causes the test session to stop on

CSECT/pgm id entry at the start of the specified CSECT in a statically linked
module.

Region size Modifies the region size in the execution JCL. The region size
of the step containing the program to be tested is changed to the
value specified in this field. The default is 4 megabytes.

Library Manager Specifies the library manager. If the JCL to be converted is

stored in a source library that is installed with a subsystem
option, enter the name of that subsystem. Also, the dataset and
member name used by the source library management system
must be specified in the Batch execution JCL field.
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Batch execution JCL

Data set name

Specifies the partitioned dataset containing the member to be
submitted or edited, or from which JCL is to be generated. If the
Subsystem option is to be used, specify the subsystem library
dataset name.

Member

Specifies the member to be submitted or edited, or from which
JCL is to be generated.

Generated JCL

Data set name

The partitioned dataset that will contain the generated JCL.

Member

Specifies the member that will contain the generated JCL.

Session name for
batch communications

TSO Userid

Specifies the TSO user ID that is placed in the SmartTest disk
file used to transfer data to and from the TSO address space.
This is the ID with which the batch session communicates and
typically is the user ID of the person submitting the job. Another
user ID can be specified if desired. If another user ID is
specified, note that the AKR and the test load libraries are those
specified by the user submitting the batch job(s). The AKR and
load libraries for another user ID could be different from those
being used by the person submitting the job.

Note:

When you select option S or G, SmartTest modifies the specified batch execution JCL for
the first occurrence in the JCL of the program to be tested.

To test a later occurrence

1 Generate the JCL.

2  Edit the generated JCL and move the changes to the step to be tested.

3 Submit the edited JCL.
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These JCL changes are made by SmartTest:

. A STEPLIB DD statement for the step to be tested is added or updated to
concatenate the SmartTest load library to the user load library.

. The REGION size is changed to the value specified on this screen.

A DD VIAQUEUE statement is added for the SmartTest queue dataset used during
communication between the TSO and Batch test sessions.

. The EXEC PGM is altered for the step to be tested to allow SmartTest to gain
control at the appropriate step.

. PROC:s are expanded using the procedure libraries specified on the Procedure
Libraries pop-up.

When submitting execution JCL or submitting generated execution JCL, the TSO
SUBMIT command is issued from a CLIST so the system standard TSO SUBMIT exit
receives control and can process the JCL. The submitted JCL must have a JOB card with
a job name that will not be changed by the exit.

If you use the EG (edit generated JCL) option to generate the JCL to the specified dataset,
the JCL can then be edited and the job name can be changed in the generated JCL.

You should verify that the work file allocation information entered on the Options -
Product Allocations pop-up is valid for the batch test session. Inappropriate work file
allocations can cause unpredictable results during the batch test session.

Note:
See the online help for detailed information on the Options - Product Allocations pop-up.

Submitting and Connecting to a Batch Job

134

A batch job can be connected with the online portion of a test session by submitting it for
execution, then connecting to it.
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Submit a Job

To submit the batch job for execution

1 Type S or SG on the primary command input area on the Batch Session Setup screen
and press Enter.

Note:

Record the TSO message displaying the job name and assigned job number, for
future reference.

Figure 78 « Connect To Job Screen

+ASG20761I Batch JOB <jobname> is waiting for connection by ASG-SmartTest
* KK

2  Press Enter to return to the Batch Session Setup screen.
Connect to Job

To connect the online TSO test session with a batch test session

1 Type C in the primary command input area on the Batch Session Setup screen and
press Enter to display the COnnect to Job screen shown in Figure 79.

Figure 79 « Connect to Job Screen

Connect to Job
Command ===> Scroll ===> CSR

TSO Userid TSOUSERD (Required for TSO/ISPF monitor)

Enter 'S' to select a job to be tested.
Enter 'P' to purge a job from the ASG-SmartTest queue file.

Select Jobnum Jobname Status
- Jg244 TSOUSERB BEGINNING EXECUTION
- Jg8268 TSOUSERC WAITING FOR CONNECTION
- J8286 TSOUSERD CONNECTED, TEST ACTIVE
- Jg301 TSOUSERA JOB SUBMITTED TO BATCH

2 Select a job by typing S in a Select field with the status WATITING FOR
CONNECTION and pressing Enter.
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Options

Option Description

S Connects to an available batch session. The selected job
becomes active in SmartTest. (See "Batch Test Initiation"
on page 136.)

P Purges (deletes) a batch session or submitted job.

Status

CONNECTED, TEST Indicates that the job is currently connected to the online

ACTIVE test session by the specified TSO user ID.
BEGINNING Indicates that the job has a batch initiator, but is not ready
EXECUTION for connection.

JOB SUBMITTED TO Indicates that the job is waiting for a batch initiator.
BATCH

TEMPORARILY Indicates that the job was previously connected to the
SUSPENDED online test session by the specified TSO user ID. A job can

be suspended by pressing the PA1 or ATTN key.
WAITING FOR Indicates that the job has a batch initiator and is ready to be
CONNECTION connected to the online test session.

Batch Test Initiation
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After all information for testing a program in the batch environment has been specified on
the appropriate Batch Session Setup screens, test initiation can be invoked by connecting
to the batch job.

When test initiation is complete, the program displays in Program View; the test session
is active and waiting for a command. Program View displays program source or
disassembled object code, as shown in Figure 80 on page 137.
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To display Program View, you must connect to the batch job. For details, see "Connect to
Job" on page 135.

Figure 80 « Batch Connect Program View Screen

File View Test Search Logic List Options Help
Program View VIAMERGE.VIAMERGE -A (A)
===> SCROLL ===> CSR
000163 001-MAIN-LOGIC.
(B) >>> PERFORM 1000-INITIALIZE THRU 1000-INITIALIZE-X.
000165 PERFORM 2000-PROCESSING-LOOP THRU 2000-PROCESSING-LOOP-X
000166 UNTIL FINISHED-READING-ALL-FILES.
000167 PERFORM 9000-TERMINATION THRU 9000-TERMINATION-X.
000168 GOBACK. PGM EXIT
000169 1000-INITIALIZE.
000170 OPEN INPUT INFILEL,
000171 INFILE2,
000172 INFILE3.
000173 OPEN OUTPUT OUTFILE,
000174 OUTRPT.
000175 MOVE ZEROS TO COMPARISON-KEY-1, COMPARISON-KEY-2,
000176 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF,
000177 MASTER-EOF-SWITCH,
000178 HASH-TEST-A, HASH-TEST-B, HASH-TEST-C,
(C) == mmm o +
| STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAMERGE DATE: DDMMMYYYY |
| STMT: 000164 OFF: 001450 MODULE: VIAMERGE TIME: HH:MM:SS |
| SOURCE: PERFORM 1000-INITIALIZE THRU 1000-INITIALIZE-X. |
o +

Screen Description

(A) VIAMERGE.VIAMERGE -A. The short message reflects the module and program
(module.program) being viewed and indicates the program is in an active (-A) test
session.

(B) PERFORM 1000-INITIALIZE. The next statement to be executed is highlighted
and chevrons appear in the number column.

(C) STATUS: BREAK. The Status Box displays, by default, when a test session is
initiated. This is the information shown in the Status Box:

STATUS Indicates the current status of the test.
STMT Specifies the statement number of the next statement to be executed.
OFF Specifies the offset into the CSECT/load module where the next

statement to be executed is located.

SOURCE Specifies the source for the next statement to be executed.

PROGRAM Specifies the name of the program/CSECT currently active in the test.

MODULE Specifies the name of the load module currently active in the test.
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DATE Specifies the current date.

TIME Specifies the time the last program statement was executed.

Testing DL/I in the Batch Environment

To use the IMS Batch environment

1 Select the IMS BATCH environment on the Environment Setup Menu to display the
IMS Batch Session Setup screen shown in Figure 81.

Figure 81 « IMS Batch Session Setup Screen

IHs Batch Zes=ion Setup

Conrand ===
% - ZubHit ekecution JCL G - Genet-ate frod edecution JCL
¢ - Connect to subHitted job EG — Edit generated JCL
P - specify procedure libraries &G - SubHit generated JCL
E - Edit eHecution JCL
Execution: options:
Load Hodule  ________ Ereak on entry [YoN] YES
Procedura MaMe ________ Ereak CIECT-pgH id  ________
Etep Mame . . ________ Reqion SiZe .« & o« & _____

Libtrary Hanager
Batch execution JCL:
Data set nane
HeHber « o o

Generated JCLI
Data set nawe
HeHbel o & & .

feszion name for batch ComMunications:
TE0 Userid . . USERLZ_

2 Submit the JCL from the Batch Submit screen.

3 Connect to the batch session using the batch Connect to Job option.
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Testing BTS in the Batch Environment

To use the BTS Batch environment

1 Select the BTS BATCH environment on the Environment Setup Menu to display the

BTS Batch Session Setup screen shown in Figure 82.

Figure 82 « BTS Batch Session Setup Screen

ETZ Batch fession Setup

Library Hanager . .
Eatch edecution JCLI
Data set nade
HeHbar . . . .

Generated JOLI
Data set nane
Henber .« o . .

Fesgion nade for batch CoMAuni cations:
TE0 Userid . o USERLZ_

CoHHand ===
% - ZubHit edecution JCL G - Generate froW edecution JOL
C — Connect to subkitted job EG - Edit generated JCL
P - gpecify procedure libraries 3G - ZubRit generated JCL
E - Edit execution JCL
Execution: options:

Load Wodule  ________ Ereak on entry [YoN] YEE

Procedure Mame ________ Ereak CIECT-pgn id ________

Etep Mame . . ________ Reqion Size . . . & _____

2 Submit the JCL from the Batch Submit screen.

3  Connect to the batch session using the Connect to Job option.
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Testing DB2 in the Batch Environment

To test DB2 using the Batch Submit screen

1 Select DB2 BATCH as the environment on the Environment Setup Menu to display
the DB2 Batch Session Setup screen shown in Figure 83.

Figure 83 « DB2 Batch Session Setup Screen

DEZ Batch Session Setup
CoHHand ===

% - BubMit eMecution JCL G - Generate frod edecution JOL
¢ - Connect to subkitted job EG - Edit generated JGL
P - Epecify procedure libraries EE - EubHit generated JCL
E - Edit eHecution JCL
Executiaon. options:

Load Wodule  ________ Ereak on entry [YoN] YES

Procedure Mame ________ Ereak CEECT-pgW id  ________

Etep MaHe . Reqion SiZe . . & & _____

Libtrary Hanager
Batch execution JCL:
Data set nade
Henber « o «

Generated JCLI
Data =et nane
Herbelr . & . .

Fezsion naWe for batch CoWMUni cations:
TE0 Userid . . USERLZ_

2 Submit the JCL from the Batch Submit screen.
3 Connect to the batch session using the Connect to Job option.

Note:
There is a limit of one program to test for each SmartTest batch execution.

When running a DB2 test under Batch, the JCL that is submitted is automatically
changed. If there is a PROC in the JCL, the SYSTSIN DD statement must be in the
PROC and may not be overridden after the execution of the Procedure. The DD for
SYSTSIN in the Procedure may use the DDNAME parameter to allow the DD statement
to follow the execute PROC statement in the JCL.

Note:

SmartTest does not recognize the LIB() field of the SYSTSIN dataset. Load libraries
specified in the LIB() field must be specified in the STEPLIB DD concatenation.
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Testing DFHDRP in the Batch Environment

To test DFHDRP using the Batch Submit screen

1 Select MVS Batch as the environment on the Environment Setup Menu.
2  Edit the JCL from the Batch Session Setup screen and change the program to be
tested to VIAPDLI. This is done by changing the PGM=pgmname parameter in the
PARM statement to PGM=VIAPDLI.
3 Submit the JCL from the Batch Submit screen.
4  Connect to the batch session using the Connect to Job option.
DFHDRP Batch JCL

Figure 84 shows the DFHDRP batch JCL before the modifications are made to test DB2

using

the Submit Job screen.

Figure 84 « DFHDRP Batch JCL Before Modifications

//*
//*

//SYS
//

//DRP
//SYS
//REP
//D12

//ASG JOB (ASG), 'ASG-SMARTTEST DFHDRP'
/*ROUTE PRINT DEST

//DFHDRPB PROC SYSOUT=A
//STEPO1 EXEC PGM=DFHDRP, REGION=1M,

// PARM='SSA=254, PGM=TPGM22, PSB=TPGM22,CICS=CICS1l, CMPAT=Y, LANG=C'
//STEPLIB DD DSN=USER.PGMLIB,DISP=SHR

//DFHLIB DD DSN=CICS.LOADLIB, DISP=SHR

DD DSN=IMS.RESLIB,DISP=SHR

DD DSN=CICS.RESLIB, DISP=SHR
DD DSN=USER.PSBLIB, DISP=SHR
DD DSN=USER.DBDLIB,DISP=SHR

UDUMP DD SYSOUT=&SYSOUT
PEND
TEST EXEC DFHDRPB
ouT DD SYSOUT=&SYSOUT
ORT DD SYSOUT=&SYSOUT
1PART DD DSN=APRT.DB10V09,DISP=SHR
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Figure 85 shows the DFHDRP batch JCL after the modifications are made to test DB2
using the Submit Job screen.

Figure 85 « DFHDRP Batch JCL After Modifications

//ASG JOB (ASG), 'ASG-SMARTTEST DFHDRP'
/*ROUTE PRINT DEST

/*

//DFHDRPB PROC SYSOUT=A

/*

//STEPO01  EXEC PGM=DFHDRP,REGION=2M,
//

PARM="'SSA=254, PGM=VIAPDLI, PSB=TPGM22,CICS=CICS1l,CMPAT=Y, LANG=C'
//STEPLIB DD DSN=ASG.VIACENxx.LOADLIB,DISP=SHR,

// DCB=BLKSIZE=32760

// DD DSN=USER.PGMLIB, DISP=SHR
// DD DSN=IMS.RESLIB, DISP=SHR
// DD DSN=CICS.RESLIB,DISP=SHR
//IMS DD DSN=USER.PSBLIB, DISP=SHR
// DD DSN=USER.DBDLIB, DISP=SHR

//DFHLIB DD DSN=CICS.LOADLIB, DISP=SHR
//SYSUDUMP DD SYSOUT=&SYSOUT

// PEND

//DRPTEST EXEC DFHDRPB

//SYSOUT DD SYSOUT=&SYSOUT

/ /REPORT DD SYSOUT=&SYSOUT

//D121PART DD DSN=PART.DB10V09,DISP=SHR
//VIAQUEUE DD DSN=ASG.VIACENxx.QUEUE,DISP=SHR
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Testing Techniques

This section presents common SmartTest testing and debugging functions available with
SmartTest, and contains these sections.

Topic Page

Learning the SmartTest Commands 144
Controlling Program Execution Using SmartTest 144
Controlling Program Execution 148
Viewing and Changing Test Session Data 162
Execution History (Backtrack) 167
Using Pseudo Code 173
Using Multiple Programs 178
Setting Test Session Options 180
Displaying Program and Test Information 181
Printing Displayed Information (LPRINT Command) 182
Linking to Alliance 183

You may re-create the examples presented by using the VIAMERGE program for the
TSO environment.

Note:

This chapter assumes that you have completed the appropriate setup and analyze
procedures.
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Learning the SmartTest Commands

Most procedures in this section emphasize the CUA implementation of SmartTest
functions. As you gain experience, you may find the SmartTest command syntax more
convenient for frequently used functions.

To assist you in learning commands, SmartTest includes a learn mode showing primary
commands equivalent to your CUA selections.

To turn learn mode on, follow this step:

» Type SET LEARN ON inthe command input area and press Enter. The short message
area displays the message LEARN ON.

To turn learn mode off, follow this step:

» Type SET LEARN OFF in the command input area and press Enter. The short
message area displays the message LEARN OFF.

Controlling Program Execution Using SmartTest

144

SmartTest allows you to control execution by walking-through the program statement by
statement, or executing the program continuously while checking for problems. You may
end a test session at any time without waiting for end-of-job. You may perform
maintenance and debugging tasks interactively during the test, rather than waiting until
the test is over and the output is delivered.

Controlling execution consists of these procedures:

. Continuous program execution until an interrupt condition occurs. (See "Executing
the Program Continuously Using RUN" on page 148.)

. Executing a specified number of statements. (See "Executing a Specified Number
of Statements Using STEP" on page 149.)

. Specifying the statement to execute next rather than following the normal execution
sequence. (See "Changing Program Execution Sequence Using GO" on page 149.)

. Interrupting execution. (See "Interrupting Test Execution Using Keystrokes" on
page 150.)

. Inserting breakpoints to interrupt execution. (See "Inserting Breakpoints to
Interrupt Execution" on page 153.)

. Locating the next executable statement. (See "Locating the Next Executable
Statement" on page 160.)

. Ending the test session. (See "Exiting a SmartTest Test Session" on page 162.)
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Testing with SmartTest

At the start of a test session, SmartTest attaches an execution monitor to run the
application program as a subtask to SmartTest's user interface code. Execution of the
application program is controlled by commands entered into SmartTest, which in turn
controls the application code.

SmartTest has two distinct methods for controlling execution of the application program,
MONITOR and NOMONITOR. Each method has a strength and a weakness and is
designed to help get the most out of debugging sessions. SmartTest allows mixed
methods during a single test session to offer benefits of each technique for individual test
situations.

Both MONITOR and NOMONITOR are specified by an operand of the RUN function.
The SET MONITOR command determines the default. Guidelines for choosing either
MONITOR or NOMONITOR are included in this manual (see "Guidelines for Using the
MONITOR/NOMONITOR Methods" on page 146).

MONITOR AND NOMONITOR can also be controlled on the program level using the
Session Tailoring option.

Testing Using the MONITOR Method

The MONITOR method is designed to help during the detailed debugging stage, after a
problem has been isolated to a specific program or to a specific subroutine within a
program.

Using the MONITOR method, SmartTest executes the application program one
instruction at a time. Executing instructions individually gives SmartTest the ability to
create an execution history (LIST TRACKING), to count each statement as it executes
(LIST COUNTS), and to provide storage protection for user-specified locations (LIST
ADSTOP) by monitoring instructions that modify memory.

Additional advantages to the MONITOR method include minimal test setup requirements
and detection of INVALID BRANCH situations.

Since monitoring requires execution of several instructions by SmartTest for each
application instruction, the CPU overhead of monitoring a large application (e.g.,
processing millions of records) may become prohibitive. If performance becomes an
issue, use the NOMONITOR method (RUN NOMON).
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Testing Using the NOMONITOR Method

The NOMONITOR method is designed to execute the application at native speed with
negligible CPU overhead added by SmartTest. In the NOMONITOR method, SmartTest
gives control to the application program and waits for an application abend, a breakpoint,
or completion of the test.

In the NOMONITOR method, certain facilities are not available (LIST TRACK, LIST
COUNTS, etc.). However, abends are intercepted, and COBOL-compatible pseudo code
can be inserted to control the flow of the test program.

In the NOMONITOR method, SmartTest places intentional abend instructions
(breakpoints) at various points in the object code and gains control when the code abends
(SOCT) during execution. Because this technique is used, each program tested using the
NOMONITOR method must be link edited with the REUS parameter. This parameter is
automatically supplied by the SmartTest Compile and Analyze process, but can be
overridden with an option on the List-Analyze Submit pop-up.

Guidelines for Using the MONITOR/NOMONITOR Methods
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In general, you should use the MONITOR method for most testing and debugging. The
CPU overhead in relation to the value of the debugging information is acceptable.

The Execution Tracking screen shows all of the statements that have been executed
during the test in the reverse sequence. This screen can be used to follow the execution
path backward to see the execution path to the current statement.

To reduce the overhead of a test session, place a breakpoint at a paragraph where a
suspected problem exists and then execute using the NOMONITOR method. The test
executes at native speed until it reaches the breakpoint set. Then, use the STEP primary
command or RUN MONITOR primary command to find the problem. After finding the
problem, either CANCEL the test or RUN NOMONITOR to completion. This technique
uses the strengths of both methods, while reducing the overall CPU utilization.

Note:

The NOMONITOR method makes problem determination difficult when the application
program issues its own SPIE/ESTAE. This intercepts the intentional abends before
SmartTest can examine them, yielding unpredictable results.

To test such programs, disable the SPIE and restart the test using the NOMONITOR
method. If there is no way to disable the SPIE, it will be necessary to run the application
using the MONITOR method.
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Testing LINKed, ATTACHed, and CALLed Load Modules

SmartTest includes the Load Module Intercept List screen for specifying load module
intercepts to allow support for load modules that are LINKed, ATTACHed, or
dynamically loaded and CALLed. The Load Module Intercept List screen allows up to 24
load modules intercept to be specified. Entries must be made before the start of the test.

When running using the MONITOR method, it is not necessary to list load modules on
the Load Module Intercept List screen since SmartTest detects when an external module
is called and maintains control of the test session. When running using the
NOMONITOR method, SmartTest cannot determine when control is transferred from
one load module to another. If you are using the NOMONITOR method and want
SmartTest to detect when a particular load module is entered, the load module must be
listed on the Load Module Intercept List screen.

These considerations apply to load module intercepts:

. It is necessary to specify the exact load module name to be intercepted. Generic
entries (e.g., VIA*) are invalid on the Load Module Intercept screen.

. Load module intercepts must be entered before the first RUN command of the test.

. It is necessary to specify the load module name for any load modules to be tested
that are ATTACHed.

. Load module intercepts are not necessary for programs that are LINKed to (SVC 6),
as long as SmartTest is running MONITORed. Enable monitoring of LINKed
modules by using the SET LINK ON primary command.

. Only one subtask may be tested at a time. If you wish to test a subtask, the primary
task must run NOMONITOR and may not include breakpoints or pseudo code.

. Testing of Dialog Management programs requires entries on the Load Module
Intercept List screen if you are testing different load modules than the one specified
on the setup screen. Selecting 'S' from the setup screen automatically displays the
Load Module Intercept List screen.

. Once a load module is intercepted, SmartTest starts running MONITORed. Use
LIST TAILOR entries to Break on Entry to the intercepted load modules.

Note:

For more information on load module intercepts, see the List section of the
ASG-SmartTest Reference Guide.

147



ASG-SmartTest for COBOL and Assembler User’s Guide

Controlling Program Execution

You can control execution using the Test pull-down or by using primary commands. The
Test pull-down is shown in Figure 86.

Figure 86 * Test Pull-down Menu

File Uiew Test Search List O0ptions Help

__ 1. setup Vizards...
CoHHand === Za RUMus
3. Etep...
d. Cancel
5. Break...
E. &top... Hetededok
Te Glaus Hetetobok
* &. Houe,.. ok ktetskck shetedetobobek
Heke . Adda .. ok ebeick Hetstobobotstok
e 18. Zubtracta.. * etk Hetek
Hetedek 11. Where... Aetetdok Aotk
Hetstokok 12. Testpoints... etstobototststobottstolotottotok
Hetettoh 13. AEE-ALLliance Interface... Hetstebotoietstobotstst ootttk
1d. CICE HNewcopy...
15. DuHp
Cop unpublished work.

A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Meb Site at wuW.asg.cod

Selecting Test Environment Using the Setup Wizards

Use the Setup Wizards option to save time in setting up common types of test
environments. Setup wizards are available for IMS, CICS, and programs in TSO
foreground or using batch connect. These wizards are self-explanatory and walk you
through the process of setting up the appropriate environment.

Executing the Program Continuously Using RUN

Use the Run action to begin test execution or to resume execution after an interrupt. An
interrupt results from any of these situations:

. Abend error condition

*  Address Stop (see "Setting Program Address Stops" on page 152)

. Breakpoint (see "Inserting Breakpoints to Interrupt Execution” on page 153)

. Completion of program

You can enter the RUN command any time program execution is suspended.
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The RUN MON command allows all execution features to be available. The primary
command RUN TO 1432 establishes line number 1432 as the stopping point. Execution
continues to line 1432 unless other interrupts occur before the line is reached.

Note:
See the ASG-SmartTest Reference Guide for additional information.

Executing a Specified Number of Statements Using STEP

Use the STEP primary command to execute a specified number of statements. When
there are no abends or breakpoints, the program executes the number of verbs specified or
executes until program completion.

The STEP command executes the next statement and stops. For example, STEP 5
executes the next 5 statements before stopping. The STEP AUTO command executes one
statement and pauses for the time period specified using the SET DELAY command.

Note:
See the ASG-SmartTest Reference Guide for additional information.

Changing Program Execution Sequence Using GO

Use the Go action on the Test pull-down, the GO line command, or the GO primary
command to change execution sequence during a test. When you type GO for a statement,
the chevrons indicating the next executable statement are moved to that statement.
Typing RUN or STEP causes execution to begin with the newly specified statement.

Note:
To use the GO command, you must be in an active test session.

You can only enter a GO command for executable source lines (i.e., not on COMMENT
lines).

Note:

Altering execution flow may cause some statements to be re-executed or by-pass
statements that initialize data fields, resulting in abend conditions or unpredictable
results.

It is recommended you use the GO command within the paragraph or block currently
being executed.

See the ASG-SmartTest Reference Guide for GO command descriptions.
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Interrupting Test Execution Using Keystrokes
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Use the PA1/ATTN key to interrupt program execution during a test session.

For foreground testing, when you press PA1/ATTN after a RUN MONITOR primary
command is issued, the RUN command is changed to a STEP command and the program
is suspended at the next COBOL verb or Assembler instruction.

When you press PA1 or ATTN after a STEP n command is issued, the remaining steps
are not executed and the program is suspended at the next COBOL verb or Assembler
instruction.

Program execution may be interrupted at any time. If after initiating execution of a
program with a RUN command you realize the test dataset being used contains more
records than you wanted to process, you can stop execution by pressing PA1/ATTN.

Note:

The interrupt keys do not apply to CICS or IMS/DC, or when executing using the
NOMONITOR method.

For Batch testing, the ATTN key suspends the test. This frees your TSO User ID,
allowing you to view other programs or perform other work. The program continues
execution until a breakpoint, abend, or completion of the test. At this point, the message
...WAITING FOR CONNECTION. .. displays. You can then reconnect to the batch
session.
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Intercepting Program Abends

SmartTest automatically intercepts all program abend and suspends test execution. When
the test is suspended, you may take action to correct or bypass the error condition. It is
possible to detect multiple abend conditions in a single test session and continue program
execution, by correcting data or coding temporary work-arounds.

In Figure 87, a Data Exception (0C7) abend condition has been detected, and the program
has been suspended. You may not continue program execution until the abend condition
is corrected or bypassed.

Figure 87 « SOC7 Abend Screen

File View Test Search List Options Help

Program View VIAMERGE.VIAMERGE -A
Command ===> Scroll ===> CSR
000432 MOVE ZERO TO READ-INFILE1-SWITCH.
() >>> ADD 1 TO END-FILE-COUNT.
(B) ' e +
trrrrr | 10 END-FILE-COUNT PIC 9(8) ADDR 000B9450
rrorrr VALUE > VMERGE < * INVALID NUMERIC *
LT T T T +
000434 READ INFILEl INTO INFILE1-WORK-REC
000435 AT END FALLTHRU
000436 MOVE INFILE1-EOF-MSG TO OUTRPT-WORK-DATA
000437 MOVE ZERO TO OUTRPT-WORK-KEY
000438 WRITE OUTRPT-REC FROM OUTRPT-WORK-AREA
000439 MOVE 1 TO INFILE1-EOF
000440 MOVE EOF-KEY TO INFILE1-WORK-KEY. FALLTHRU
000441 3100-READ-INFILE1-X.
(C) == mmmmm oo +
| STATUS: DATA EXCEPTION (0C7) PROGRAM: VIAMERGE DATE: DDMMMYYYY |
| STMT: 000433 OFF: 0028D2 AMODE: 24 MODULE: VIAMERGE TIME: HH:MM:SS |
| SOURCE: ADD 1 TO END-FILE-COUNT. |
- +

This table describes the sections highlighted on the Program View screen:

Screen Section Description

(A) Chevrons(>>>>>>) The chevrons indicate the next statement to be executed.
Execution of this statement caused an 0C7 abend.

(B) 10 END-FILE-COUNT For data related abends (i.e., 0C7, 0C4), a data window
displaying the data field values displays below the
statement causing the abend.

(C) STATUS The STATUS line in the status box specifies the Abend
condition.

You may use SmartTest techniques described in later sections to modify incorrect data.
See "Inserting Breakpoints to Interrupt Execution" on page 153 and "Viewing and

Changing Test Session Data" on page 162.
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Setting Program Address Stops

Use the Test - Stop Request pop-up or the STOP command or the Address Stop Entry
screen to specify an absolute address and length of storage to be monitored.

All storage areas listed on the Address Stop Entry screen (shown in Figure 88) are
monitored by SmartTest, and the test execution is interrupted before a specified storage
area is actually updated. The address stop facility is unavailable when the MONITOR
option is set OFF or the NOMONITOR operand is used with the RUN command.

Figure 88 « Address Stop Entry Screen

Addrass Stop Entry
CoMMand === ECh0ll ===} CER

Enter the address and length of storage areas to be nonitored. Use the ETOP
coHHand to enter this data autonaticallw. The stops are autonaticallw deleted
at the end of the test session, or Hanually with a 'D°.

ACti ve Length  Length
ToH-D Addrezz in hex in decinal Descri Flti on

(A) Arrow(===>). This symbol indicates the storage location causing the address stop.

Figure 89 shows interruption of the VIAMERGE program with an address stop.

Figure 89 » Program Execution Stopped Before an Address Modification

File View Test Search List Options Help
Program View VIAMERGE .VIAMERGE -A

Command ===> Scroll ===> CSR
000179 OPEN OUTPUT OUTFILE OUTRPT.
(A) >>> MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME.
000181 ACCEPT BEGIN-DATE FROM DATE.
000182 WRITE OUTRPT-REC FROM BEGIN-MESSAGE.
000183 IF BEGIN-DATE = 0 THEN
000184 MOVE +16 TO ABEND-CODE
000185 PERFORM 9999-ABEND-IT
000186 MOVE 0 TO END-FILE-COUNT. DEADCODE
000187 MOVE ZEROS TO COMPARISON-KEY-1, COMPARISON-KEY-2,
000188 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF,
000189 MASTER-EOF-SWITCH,
000190 HASH-TEST-A, HASH-TEST-B, HASH-TEST-C,
000191 HASH-TOTAL,
000192 COMPARISON-CODES,
(B) —======== === +
| STATUS: STOPPED BEFORE ADDRESS MODIFIED PROGRAM: VIAMERGE DATE: DDMMMYYYY |
| STMT: 000180 OFF: 001692 AMODE: 24 MODULE: VIAMERGE TIME: HH:MM:SS |
| SOURCE: MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME.
e +
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This table describes the sections highlighted on the Program View screen:

Screen Section Description

(A) Chevrons(>>>>>>) The chevrons indicate the next statement to be
executed is the MOVE. This statement modifies the
address specified in the address stop.

(B) STATUS: STOPPED STATUS message indicates the program is
BEFORE ADDRESS suspended before an address modification.
MODIFIED

See the ASG-SmartTest Reference Guide for more information on the Address Stop Entry
screen and the STOP command.

Inserting Breakpoints to Interrupt Execution

These two methods can be used to insert breakpoints into your program to interrupt
execution:

. Manually, at specific lines
. Automatically, based on program knowledge

Breakpoints remain active until deactivated or deleted. You may save breakpoints on the
AKR for later test sessions with the program.

Manually Inserting Breakpoints in the Program

Use the BR line command to insert a breakpoint before a specific source code statement.
You may use the BR line command to set unconditional interrupts in any program. When
you type BR on a line containing a paragraph name or label, the BREAK is inserted
before the first executable statement in the paragraph.

When you type BR on a non-executable line, the BREAK is inserted before the next
executable statement in the program.

Automatically Inserting Breakpoints in the Program

Use the Break option on the Test pull-down or the BREAK command to set breakpoints
before or after statements containing a specified target. The Break facility uses the
Intelligent Search Function to insert multiple breakpoints with a single command.

Breakpoints can be inserted BEFORE or AFTER the specified target. The target may be

limited or extended by the use of the operands such as USE, MOD, NOALIAS, ALL,
NEXT, and PREV.
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The BREAK facility has several options to specify the target where breakpoints are to be

inserted. For example, to insert a breakpoint before paragraph 1000-INITIALIZE is
executed, type this command:

BREAK 1000-INITIALIZE

You may check variables, change data values, or enter pseudo code whenever program
execution is suspended.

Figure 90 shows the Program View screen after 33 breakpoints have been inserted using

the BREAK primary command.

Figure 90 « Break Before all Paragraphs Results Screen

File View Test Search List Options Help
Program View 33 BREAK(S) INSERTED (A)

Command ===> Scroll ===> CSR
(B)''1 BREAK.
000178 OPEN INPUT INFILE1l INFILE2 INFILES3.
000179 OPEN OUTPUT OUTFILE OUTRPT.
(B)y''1 BREAK.
000180 MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME .
000181 ACCEPT BEGIN-DATE FROM DATE.
000182 WRITE OUTRPT-REC FROM BEGIN-MESSAGE.
000183 IF BEGIN-DATE = 0 THEN
000184 MOVE +16 TO ABEND-CODE
000185 PERFORM 9999-ABEND-IT
000186 MOVE 0 TO END-FILE-COUNT. DEADCODE
000187 MOVE ZEROS TO COMPARISON-KEY-1, COMPARISON-KEY-2,
000188 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF,
000189 MASTER-EOF-SWITCH,
o +
| STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAMERGE DATE: DDMMMYYYY |
| STMT: 000165 OFF: 0014CC AMODE: 24 MODULE: VIAMERGE TIME: HH:MM:SS |
| SOURCE: PERFORM 1000-INITIALIZE THRU |
o +

This table describes the sections highlighted on the Program View screen:

(A) 33 BREAK(S) The short message indicates 33 breakpoints have been inserted.

INSERTED

(B)"1 BREAK The screen has scrolled to the first executable statement in the

first paragraph in the program, and a pseudo code BREAK
statement has been inserted. Scrolling through the program
shows the other BREAKS inserted by this command.

Note:
BREAKS inserted by other techniques remain.
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Inserting Breakpoints with Impact Datasets

SmartTest provides facilities for automatically setting breakpoints with lists of data
items. The lists are called impact datasets. You can create impact datasets yourself or
import them from AutoChange, Alliance, or Estimate.

Impact Datasets from Other Programs

Execution JCL supplied with these ESW products is used to run batch jobs for creating
impact datasets:

. AutoChange—VIAMEXPJ
. Alliance—VIAMEXP]J
. Estimate—VIAMEXP]J

Note:

Please consult the ASG-AutoChange User’s Guide, the ASG-Alliance User’s Guide, or
the ASG-Estimate User’s Guide for information on creating impact datasets.

User-supplied Impact Datasets

The name of an impact dataset must match the name of the program to which it will be
applied. When creating an impact dataset, create it as a member of a PDS and name it
appropriately.

Figure 91 is an example of a user-supplied impact dataset. The member contains a list of
fully qualified datanames, one fully qualified dataname per line. Each dataname must
begin in column ten. Lines beginning with an asterisk are comment lines. All lines that
are not comment lines must contain an X in each of the first four columns.

Figure 91 ¢ User-supplied Impact Dataset

* THIS IS A COMMENT LINE

XXXX TEST-DATE

XXXX NUMBER1 OF TEST-NUM1
XXXX

XXXX
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Steps to Set Breakpoints with Impact Datasets

To set breakpoints with impact datasets

1 Type TESTPOINT on the command line, or choose TESTPOINTS from the TEST
menu. The Test - SmartTest Testpoint Generation pop-up displays.

2 Edit the field entries in the Test - SmartTest Testpoint Generation pop-up. When
finished, press Enter. The Test - SmartTest Testpoint Generation pop-up is shown in

Figure 92.

Figure 92 » Test - SmartTest Testpoint Generation Pop-up

Test - AEG-ZnartTest Testpaint Generation
CoHHand ===

Enter PrograH, Attribute, IWpact type and POE, then ENTER to generate point
Fress END to return.

Generate Testpoints:

Progradls)eeeeeeaen. *

Data nadMe Attribute. HOD [HOD-REF]

IHpact TYPEaeesnnuns AUTO [AUT 0-ALL-EST ~USER )
FDEasanannns 'AfGUSF. REL. TESTFNT'

HEHBRN e e s s e e vnnmnnns

These are the fields on the Test - SmartTest Testpoint Generation pop-up:

Program(s) Selects programs listed in the impact dataset. Enter the name of
a single program or use an asterisk to select all of them. The
names you select must match the names of the programs to
which you will apply the breakpoints.

Data Name Specifies where to set breakpoints. One of two entries is

Attribute allowed, MOD or REF. MOD sets a breakpoint in the code
wherever an impacted data item is modified. REF sets a
breakpoint in the code wherever the impacted data item is
referenced.

Addto Track List Allows you to associate specific programs with a TCA plan if
the TCA option for SmartTest is installed. If the TCA option is
not installed, this field defaults to NO.
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TCA AKR Name Ifthe TCA option for SmartTest is installed, this field contains
the name of a TCA AKR. Ifthe TCA option is not installed, this
field defaults to N/A.

TCA Plan Name Ifthe TCA option for SmartTest is installed, this field contains
the name of the TCA Plan you want to use. If the TCA option
is not installed, this field defaults to N/A.

Impact Type Indicates the source of the imported impact dataset. These are
the valid values for this field:

AUTO: AutoChange
ALL: Alliance
EST: Estimate
USER: User-supplied

PDS Specifies the PDS containing the impact dataset to be imported.

Member Lists the PDS member name containing the impact dataset for
Impact Types of ALL, EST, or USER,

3 After appropriately editing the field entries in the Test - SmartTest Testpoint
Generation pop-up and pressing Enter, the Test - Testpoint Qualified Program List
pop-up shown in Figure 93, displays.

Figure 93 » Test - Testpoint Qualified Program List Pop-up

Test - Testpoint Qualified Prograd List
CoHMand ===k _ scroll ===} CIR

felect prograd(s] froH the list, then Press ENTER to generate points. Press
EHD to return.

FOSn e cennnen ‘R4 SER.REL . TESTENT
Progran Speci fication: #

Felected Prograd Etatus
_ COBSCIEd READY
— TEETCOE READY
- TEETCOBA READY
_ TESTCOEY READY

EOTTOH OF DATA

4  Type S next to the names of those programs you want to select and press Enter. The
Breakpoints List screen, shown in Figure 94 on page 158, displays for the first
program you selected.
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158

5

Make adjustments in the Breakpoints List screen as necessary.

Figure 94 » Breakpoint Lists Screen

Ereakpoints List

COOSCEEd . COOSCIad

CoHHand ===k _ === CER
et pzeudo . . ON Pzeudo active:
Zet breaks . . ON Breaks active:
et whens . . . ON Vhens active:
% Line  Pseudo Code [breakpoints highlighted) A Count
_ BRaIve
trrry ERERAE . ¥ OBaa0E
_ B0a3ga ENTRY *CD@SC UZING L-PARH-ARER
_ DeageyT IF L-BACE-DATE = ZPACES
""" 1 BRERAK. T EREaaE
_ DRaGBS HOVE ‘HOT INPUT® TO MPCD-NARR
_ DHaGEw ELZE
trrry ERERE. ¥ OBaa0E
_ B00&18 HOVE L-BACE-00 TO WPCOD-OO
_ Deagla HOVE L-BACE-DD TO WPCD-DD
""" 1 BRERAK. T EREaaE
_ Bo0el1l HOVE L-BACE-HH TO WRPCO-HH

The Breakpoints List screen allows you to make these adjustments:

. Change the status of SET PSEUDO, SET BREAKS, or SET WHENS.

. Deactivate individual breakpoints.

. Remove individual breakpoints.

When finished, exit the Breakpoints List screen. The Program View screen

displays.
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6  The Program View screen, shown in Figure 95, displays breakpoints and the source
code or disassembled object code and data. Inspect the breakpoints settings in the
Program View screen.

Figure 95 « Program View Screen

File Wiew Test &earch List Options Help
Progr-ad Uiew CORSCE5d . CORSCTEE

CoHHand ===k _ Ecroll ===k GER
""" 1 ERERE .
HERZEa ENTRY 'cCDBSC’ UEING L-PARH-AREA
208351 L-ERROR-RELC.
000352 AALE-TEST-CALL.
000353 IF L-CALL-TYPE = @
aa035d PERFORH EA-INITIALIZE.
HO83ES IF L-CALL-TYPE =1
HOR356 FERFORH EE-ERROR-REFT.
HORIET IF L-CALL-TYPE = 2
HERIEE PERFORH EC-CMTRL-REPT.
B0a3I5 EKIFL
000388 ARYE-END.
000Fa1 GOBACK. PGH EXIT
HE0I92 ETECT
B083%3  BA-INITIALISE SECTION.
0aa3ad
HORIPS 44+  THIE SECTION OPENE THE PRIMT FILEE AMD ZETE UP THE ek
HEEIPE 4= TITLE LIMEZ. Hek
A003IH7

7  Press PF3/PF15 to exit the Program View screen. You are returned to the Test -
Testpoint Qualified Program List pop-up.

After successfully applying an impact dataset to a program, you see an IMPACT
APPLIED message in the Test - Testpoint Qualified Program List pop-up, indicating that
breakpoints have been saved into the program's source code in the AKR. You have these
options:

. If you selected multiple programs in step 3, those programs are still selected. Press
Enter and repeat step 4 and step 6 for the next selected program.

. Select one or more program, press Enter, and proceed.

. Exit.

Inserting Breakpoints at Date-related Data ltems

To set breakpoints at date-related data items, use the EXECUTE command to run the
STFINDAT script while in a test. The STFINDAT script sets breakpoints wherever it
finds date identifiers and special keywords unique to date processing across IMS (PCB
date fields), CICS (EXEC CICS asktime), and COBOL (CURRENT DATE, etc.).

When executed, the STFINDAT script:

. Finds all data items listed in the script.
. Highlights the data items.

. Issues a BREAK HI ALL command.
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Use the STFINDAT script to interrupt processing at key points so that you can examine
or change date information. The STFINDAT script can be tailored to locate these items:

. Calls to user-written date routines.
. Date-related comments.
. Changes having a common pattern that are also date sensitive, such as in CALL

routines and copybook areas.

Locating the Next Executable Statement

When a test is suspended, you may want to scroll through the program examining other
statements or data values. To reposition the screen to the next statement to be executed,
type LOCATE * in the primary command input area and press Enter.

Displaying Breakpoints

You may want to deactivate some breakpoints during the test session but still keep them
in the program. From the List pull-down menu, shown in Figure 96, select

List » Breakpoints to display the Breakpoints List screen showing all breakpoints for the
program currently being displayed in Program View.

The Breakpoints List screen enables you to activate and deactivate individual or all
breakpoints in a program.

Figure 96 » List Pull-down Menu

File Ujew Test Eearch List Opltions Help

- All...

. RAddress stops

= AKR Herbers

« BackTrack History... Hetetototolek

« Breakpoints Hetetedotok

. CICE features...

. COBOL intelligence features...

. CoHpile infordation etk

« Equates Hetk
ek
*

e e B B S

* 18, Execution counts...
Lad 11. Execution tracking...
Hetebodok etk 12. IHE-DC queues
Hetetok 13. Herory
1d. Hodule directory...
15. Profiles
copytight Allen 2 16. Pzeudo code
A praoprietary praduct of 17. Registers... iCencess.
Uizit the AZG 2u 1&. Test session tailoring
19. When conditions
28. TCA infornation

Note:

For more information on the Breakpoints List screen, see the List section in the
ASG-SmartTest Reference Guide.
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Removing Breakpoints Individually

Use the D line command to delete individual breakpoints from a program. This command
operates in the same manner as the D (delete) line command in TSO/ISPF.

Removing All Breakpoints

Use the View - Reset Request pop-up or the RESET BREAKS primary command to
remove all breakpoints from a program. Breakpoints included in blocks of pseudo code
are only deleted if the BREAK statement is the first statement in the block.

Generating a Dump

Use the DUMP command, or select Test » Dump, to generate a symptom and a snap
dump of the program being tested, along with its control blocks. The symptom dump
includes general program information and REGISTER information. The REGISTER
information contained in the snap dump is limited to the current values at the time you
issue the dump and might not include the user’s register values. The snap dump consists
of all PDATA and some SDATA SNAPX options and is appended to the symptom dump
data. All dump data is copied to the log file. See "Log/List/Punch Processing Options" on
page 30 for information about processing the log file.

Canceling a Test Session

Use the Cancel action on the Test pull-down or the CANCEL command to terminate the
current test session at any time. When you execute the Cancel action, testing ends and the
program remains displayed in Program View. Use RUN or STEP to restart the test if
desired.

To terminate a test session, follow this step:
» Type CANCEL in the command input area and press Enter.
Any open test files are closed and any allocated storage freed. The short message reflects

the cancellation of the test session. The data window and status box are removed from the
Program View Screen.

Note:

For more information regarding controlling execution and these commands, see the Test
section in the ASG-SmartTest Reference Guide.
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Exiting a SmartTest Test Session

To terminate a test session and exit from SmartTest, follow this step:
» Select File P Exit.

Any pseudo code, marks, or breaks are saved in the AKR if the online operation
parameters have Save as the default. You can also end SmartTest by pressing PF3 until
you exit the program.

Viewing and Changing Test Session Data

SmartTest provides the ability to interactively view and change data, allowing you to test
all program conditions, including conditions not exercised by the established test data.
You can view and change data by opening data windows within the program and typing
over the values presented in the data window.

Use the ZD, ZH, ZG, ZGH, ZOOMDATA, K, and KEEP commands to perform these
functions.

Viewing Test Session Data Values

You can open windows to view the program data any time program execution is
suspended.

Data windows can be displayed inline in the Procedure Division (where the data is used),
in the Data Division (where the data is defined), or at the top of your screen. You may
open windows on individual data items or on group level data and in display or hex
format.

You can specify the size of each data window to conserve space on the screen, or let
SmartTest size data windows based on the amount of data to be displayed. When a data
window cannot accommodate all the data to be displayed, you may scroll the data
window.

The values shown in the data window are always current and change as the program
executes.
Viewing Test Session Data Items Inline

Use the ZD line command to open display format data windows to show the value and
address of data items. Use the ZH line command to open hexadecimal format data
windows to show the value and address of data items.
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The result of a ZD or ZH line command is a data window positioned at the line where the
command was entered. When the screen is scrolled, the data window moves with the
display.

When you type ZD or ZH on a subscripted or indexed data item, the occurrence number is
shown to allow you to change the entry being displayed.

You may use the n (number) operand to display one data item in a statement containing
multiple data items. Data items are assigned relative numbers from left to right in the
statement, and the number entered represents the relative number of the data item to be
displayed.

The data window, shown in Figure 97, is opened after the last line of the statement where
you entered the ZD or ZH line command.

The VALUE area of the data window contains the value of the data item. Alphanumeric
values are shown in character format and numeric values are shown in decimal format
with leading zeroes suppressed. If the length of the data item is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

Figure 97 « Sample Zoom Data Screen - Data Division

File View Test Search List Options Help

Program View VIAMERGE .VIAMERGE -A
Command ===> Scroll ===> CSR
000095 05 OUTRPT-WORK-DATA PIC X(117).
LT +
rrrrrr | 05 OUTRPT-WORK-DATA PIC X (117) ADDR O0OE158F |
AR VALUE > 4ttt et tttie e et iiae et iiae e < |
T 50 > e < |
rrrrer +100 > i e < |
L S +
000096 01 OUTFILE-WORK-AREA.
000097 05 OUTFILE-WORK-KEY PIC 9(10).
000098 05 OUTFILE-WORK-DATA-1 PIC X (70)
000099 05 OUTFILE-WORK-DATA-2 PIC X(70).
000100 05 OUTFILE-WORK-DATA-3 PIC X(70)
000101 COPY VIAMSGS.
000102 01 MESSAGE-DEFINE-AREA.
e +
| STATUS: BREAK AT START OF TEST SESSION  PROGRAM: VIAMERGE DATE: DDMMMYYYY |
| STMT: 000165 OFF: 0014CC AMODE: 24 MODULE: VIAMERGE TIME: HH:MM:SS |
| SOURCE: PERFORM 1000-INITIALIZE THRU |
e +

An effective picture clause displays on the dataname line. For example:
. A numeric edited field with PIC ZZ,7Z79 displays as PIC X(6).

. An alphanumeric field PIC XXXX displays as X(4).

. A field defined as COMP displays as COMP-4.

. A field with a long dataname defined as COMP-3 displays as C3.

When you enter another ZD or ZH line command on the same statement, the existing data
window is replaced.
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Data windows may be removed, individually or globally, from the program being
viewed. (See "Removing Zoom Data Windows" on page 165.)

Viewing Group Level Data Items Inline

Type ZG to open display format data windows to show the levels, value, and address of
group data items and all of their subordinate data items.

Type ZGH to open hexadecimal format data windows to show the levels, value, and
address of group data items and all of their subordinate data items.

The result of a ZG or ZGH line command is a data window positioned where the
command was entered. When the screen is scrolled, the data window moves with the
display.

When you type ZG or ZGH on a subscripted or indexed data item, the occurrence number
is shown to allow you to change the entry being displayed.

You may use the n (number) operand to display one data item in a statement containing
multiple data items. Data items are assigned relative numbers from left to right in the
statement, and the number entered represents the relative number of the data item to be
displayed.

The VALUE area of the data window contains the value of the data item. Alphanumeric
values are shown in character format and numeric values are shown in decimal format
with leading zeroes suppressed. If the length of the data item is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

When you enter another ZG or ZGH line command on the same statement, the existing
data window is replaced.

A ZD or ZH command is executed when you enter a ZG or ZGH line command for a data
item with no subordinate data items.

Viewing Data Values in the DATA DIVISION

164

Use the ZOOMDATA primary command to reposition the screen to the definition of a
specified data item, and open a data window to display the data item and its current value.

The result of a ZOOMDATA primary command is a data window positioned in the Data
Division. When the screen is scrolled, the data window moves with the display.

Alphanumeric values are displayed in character format and numeric values are displayed
in decimal format with leading zeroes suppressed. If the length of the data item is greater
than fifty bytes, additional lines are displayed for each group of fifty bytes.
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The effective picture clause displays on the dataname line:

A numeric edited field with PIC ZZ,ZZ9 displays as PIC X(6).
An alphanumeric field with PIC XXXX displays as X(4).

A field defined as COMP displays as COMP-4.

A field with a long dataname defined as COMP-3 displays as C3.

These are the abbreviations for the ZOOMDATA command:

ZD dataname for display format.
ZH dataname for hex format.
7G dataname for group level items in display format.

ZGH dataname for group level items in hex format.

Removing Zoom Data Windows

To remove individual Zoom Data windows, follow this step:

» Type ZO to close a data window opened as a result of a ZOOM line or primary

command.

To remove all Zoom Data windows, follow this step:

» Type RESET ZOOM to close all data windows opened as a result of a ZOOM line or

primary command.

Viewing Data Values at the Top of the Screen

Use the Keep option from the View pull-down, the K line command, or the KEEP
primary command to retain the value and address of data items in a KEEP window at the
top of the screen. These are the variations of the K line command:

K for data value in display format
KH for data values in hex format
KG for group level items in display format

KGH for group level items in hex format

The result of the Keep option, KEEP command, or the K, KH, KG, or KGH line
commands is a data window positioned at the top of Program View. When the screen is
scrolled, the data window remains at the top of the screen.

When you enter the K, KH, KG, or KGH command for a subscripted or indexed data
item, the occurrence number is shown to allow you to change the entry being displayed.
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When entering the line commands, you may use the n (number) operand to display one
data item in a statement containing multiple data items. Data items are assigned relative
numbers from left to right in the statement, and the number entered represents the relative
number of the data item to be displayed.

New data items are added to an existing data window after the last data item placed in the
window.

When you enter another K, KH, KG, or KGH line command on the same statement, the
information for those data items is added to the data window.

Alphanumeric values are shown in character format and numeric values are shown in
decimal format with leading zeroes suppressed. If the length of the data item is greater
than fifty bytes, additional lines are displayed for each group of fifty items.

An effective picture clause displays on the dataname line. For example:

. A numeric edited field with PIC ZZ,7Z79 displays as PIC X(6).

. An alphanumeric field PIC XXXX displays as X(4).

. A field defined as COMP displays as COMP-4.

. A field with a long dataname defined as COMP-3 displays as C3.

The entire KEEP data window may be removed, or individual data items may be removed
from the data window. (See "Removing KEEP Data Windows from the Display" on

page 167.)

You can issue the KEEP command using these abbreviations:

. K for data value in display format.

. KH for data values in hex format.

. KG for group level items in display format.

. KGH for group level items in hex format.

As an example of the KEEP command, KG COMPARISON-KEYS displays the levels,

values, and addresses of the data item COMPARISON-KEY'S and its subordinate data
items.
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Removing KEEP Data Windows from the Display

To remove individual data items from a Keep Data window, follow this step:
» Type D beside the data item you want to remove from the display.
To remove all Keep Data windows at one time, follow this step:

» Use the View - Reset Request pop-up or type RESET KEEP to close the entire Keep
data window.

Changing Test Session Data Values

The value(s) shown in the data window is always current and changes as the program
executes. You may alter data values by typing over the value displayed in any data
window. The new values take effect immediately.

Data values can be changed to allow you to perform these functions:

. Modify the results of calculations.

. Alter the execution path by changing the value of counters and/or switches.

. Test error handling code by forcing bad data.

. Correct the data exceptions that are encountered.

Execution History (Backtrack)

Program execution history for COBOL programs may be displayed on the Program View
screen during an active test session using the SmartTest Backtrack facility. This facility
allows you to step backward and forward through the executed code whenever execution
is suspended and to view data values as they existed at the time the statement was
executed.

The SmartTest Backtrack Facility has two distinct operating modes - recording and
reviewing.

Recording Program Execution History

Type SET BACKTRACK (abbreviated SET BA) to toggle the Backtrack Recording mode
ON or OFF.

The Backtrack Facility recording mode can be turned on or off whenever an active test
session is suspended - at entry to the program, a breakpoint, an address stop, or an ATTN
key. Toggling the Backtrack Recording mode OFF causes the recorded history to be
discarded.
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When a test is canceled using the CANCEL command or reaches END OF TEST,
Backtrack Recording mode is automatically turned OFF and the Backtrack recorded
history is discarded. The Backtrack Recording facility is OFF by default when SmartTest
is entered.

The SET BACKTRACK primary command may also include the desired size of the
Backtrack Recording memory buffer where data is collected (i.e., SET BACKTRACK
2 MB for a 2 Meg buffer). This buffer is in memory with a default size of 1 Megabyte
(100 KB for CICS). The buffer size affects how much statement execution history is
available to the Backtrack Review facility.

After setting Backtrack mode on, continue the active test using the normal RUN or STEP
primary commands. When the test execution is suspended by an error condition, a
breakpoint, an address stop, an ATTN key, or the end of the program, you can review the
Backtrack history as desired.

Reviewing Backtrack History

After turning Backtrack Recording Mode ON and executing the program until a
breakpoint is encountered, you can review Backtrack history using either of these
methods:

. Enter the Backtrack Review mode using the RUN or STEP function. (See
"Backtrack Recording/Review Session" on page 168.)

. Type LIST BACKTRACK to display statements which modified a selected
variable. (See "Using the BackTrack Variable History Function" on page 172.)

Execution history can be reviewed using Backtrack Review Mode in either a backward or
a forward direction. After switching to Backtrack Review Mode, the status box at the
bottom of the Program View screen displays the direction of the review: FWD or BWD.
While in Backtrack Review Mode, you can open KEEP and ZOOM windows to view the
contents of modified data fields at the time a particular statement is executed.

Note:

Before experimenting with this example, make sure all breakpoints and pseudo code
statements are deleted by issuing the RESET PSEUDO primary command.

Backtrack Recording/Review Session
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To review the recorded Backtrack history
1 Initiate a SmartTest test session. This example uses the program VIAMERGE.
2 Turn Backtrack Recording Mode ON and change the Backtrack history buffer size

from the default to one megabyte by typing SET BACKTRACK 1M in the primary
command input area and press Enter.
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The amount of Backtrack buffer used depends upon the number of instructions
executed, how much data is modified, number of file 10s, and the amount of data
read during the recording of Backtrack history. When the buffer fills, SmartTest
begins overwriting the oldest information, thus saving the more recent execution
history.

Note:

The default buffer size for TSO is 1 MB and for CICS is 100 KB. The maximum
buffer size is 8 MB for TSO and 1 MB for CICS. Your site can customize the
maximum and default Backtrack sizes during product installation. For more
information, see your Systems Programmer.

For the demonstration program VIAMERGE, 1 MB is sufficient to record the
history of the entire program.

You can also set the Backtrack mode on using the CUA implementation:
a Select Options » Modes and press Enter. The Options - Modes screen displays.

b  Move the cursor to the Set field on the line containing BACKTRACK and type
ON and press Enter.

¢  Press PF3/PF15.

The status box at the bottom of the Program View screen indicates that Backtrack
Recording Mode is ON as shown in Figure 98.

Figure 98 « Program View in Backtrack Recording Mode

File View Test Search List Options Help

Program View VIAMERGE .VIAMERGE -A
Command ===> Scroll ===> CSR
000164 PROCEDURE DIVISION.
>>>>>> PERFORM 1000-INITIALIZE THRU
000166 1000-INITIALIZE-X.
000167 PERFORM 2000-PROCESSING-LOOP THRU
000168 2000-PROCESSING-LOOP-X
000169 UNTIL FINISHED-READING-ALL-FILES.
000170 PERFORM 9000-TERMINATION THRU
000171 9000-TERMINATION-X.
000172 IF END-FILE-COUNT = 0 THEN
000173 MOVE +8 TO ABEND-CODE
000174 PERFORM 9999-ABEND-IT.
000175 GOBACK. PGM EXIT
000176
000177 1000-INITIALIZE.
e +
| STATUS: BREAK AT START OF TEST SESSION  PROGRAM: VIAMERGE BACKTRACK: @)1
| STMT: 000165 OFF: 0014CC AMODE: 24 MODULE: VIAMERGE RECORDING |
| SOURCE: PERFORM 1000-INITIALIZE THRU |
o +

BACKTRACK: RECORDING. The usual Date and Time fields are replaced to
indicate that Recording Mode is ON.
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3  Begin recording Backtrack history by typing RUN TO nnnn to execute the test to
line number nnnn.

When the execution is suspended because the program reached line nnnn, you can
review the Backtrack history and view the value of data items at the time each
statement was executed.

4  Begin reviewing Backtrack history by selecting Test on the action bar and pressing
Enter.

5 Select Test » Run and press Enter to display the Test - Run Request pop-up as shown
in Figure 99.

Figure 99 » Test - Run Request (BackTrack Recording Mode Active) Pop-up

File View Test Search List Options Help

[ Test - Run Request (Backtrack Recording Mode Active)

\ \
| Enter Direction and any "Run To" choices, as needed. Then press Enter.|
\ \
| NOTE: * indicates an option that invokes BackTrack Review Mode.

| |
| Direction: |
| 2 1. Forward (Default)

| 2. *Backward |
\ \
| Run To Choices:

| *Run To Top . . . . Enter non-blank to select

| —

\ \
\ \

Run to Line Number
*Run to Data Name . END-FILE-COUNT

| STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAMERGE BACKTRACK: |
| STMT: 000165 OFF: 0014CC AMODE: 24 MODULE: VIAMERGE RECORDING |
| SOURCE: PERFORM 1000-INITIALIZE THRU

o +

6 Select Backward in the Direction field.

7  Type END-FILE-COUNT in the Run to Data name field and press Enter.
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These specifications direct SmartTest to scroll backward through the executed statements
until the first statement in reverse order which modifies the field END-FILE-COUNT.
The status box at the bottom of the Program View screen indicates that the first statement
found was 13 statements backward from the statement where execution is suspended as
shown in Figure 100.

Figure 100 « Reviewing Program Execution in Program View

File View Test Search List Options Help
Program View VIAMERGE.VIAMERGE -A
Command ===> Scroll ===> CSR
000179 OPEN OUTPUT OUTFILE OUTRPT.
BKTR=> MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME.
000181 ACCEPT BEGIN-DATE FROM DATE.
000182 WRITE OUTRPT-REC FROM BEGIN-MESSAGE.
000183 IF BEGIN-DATE = 0 THEN
000184 MOVE +16 TO ABEND-CODE
000185 PERFORM 9999-ABEND-IT
000186 MOVE O TO END-FILE-COUNT. DEADCODE
000187 MOVE ZEROS TO COMPARISON-KEY-1, COMPARISON-KEY-2,
000188 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF,
000189 MASTER-EOF-SWITCH,
000190 HASH-TEST-A, HASH-TEST-B, HASH-TEST-C,
000191 HASH-TOTAL,
000192 COMPARISON-CODES,
e +
|STATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAMERGE DIRECTION: BWD |
| STMT: 000180 OFF: 001692 AMODE: 24 MODULE: VIAMERGE SEQ# -13
| SOURCE: MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME.
fo——————————_———_———_———————— - +

BKTR==>. This indicator is placed on the statement found as the result of the Run
backward action.

DIRECTION: BWD SEQ# -13. This indicates that Backtrack Review Mode is in effect
and that the review direction is backward. The current statement (with the BKTR==>
indicator is 13 statements back from the statement where execution is suspended.

The Run function can be repeated to scroll to each statement in turn which modified the
field END-FILE-COUNT. The same result can be obtained using the RUN BACK TO
END-FILE-COUNT MOD primary command.

To move forward in the execution history, use the Run function as shown in Figure 99 on
page 170 specifying Forward as the Direction.

To return to the statement where execution is suspended, type RUN TO *. This scrolls
the display to the statement where execution is suspended and turns Backtrack Review
Mode OFF. Back Recording Mode remains ON.

Note:

For more information on BackTrack commands, see the ASG-SmartTest Reference
Guide.
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Using the BackTrack Variable History Function

To review BackTrack execution history using the LIST BACKTRACK primary
command

1 Type LIST BACKTRACK to display the List - BackTrack Variable History pop-up
shown in Figure 101.

Figure 101 « List - BackTrack Variable History Pop-up

List - BackTrack Variable History
Type a fully qualified data name with any applicable subscripts
in the Target area. For a list of data names, type a "pattern"
in the Target area. Then press Enter.

Target END-FILE-COUNT

2 On the List - BackTrack Variable History pop-up, enter a dataname to search the
BackTrack execution history for statements which modified the specified data item.
You may enter a pattern to select from a list of datanames.

Press Enter to display the List - BackTrack Variable History screen, shown in
Figure 102, showing the statements which modified the selected data item.

Figure 102 » List - BackTrack Variable History Screen

List - BackTrack Variable History VIAMERGE.VIAMERGE -A
Command ===> Scroll ===> CSR
Variable: END-FILE-COUNT Desc: PIC 9(8)
Index:
S RELMOD VALUE LINE STATEMENT CONTENTS

KAKAK KK KA KK KK KKK AKA KA KA R KRk K Ak TOP OF DATA ** Ak *kkkkkhkhkkkhkhkkk kA hkhkxk kK * Kk %
VIAMERGE.VIAMERGE
it A 000180 MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME.

0 VMERGE >>>>>> <CURRENT VALUE OF VARIABLE>
FAK KK KA KA KKK KA KA KKK AR KX KA KA ** BOTTOM OF DATAX * %, %k k kK kk &k &k kkkk Kk &k &k kxkkk*k%

o +
| STATUS: DATA EXCEPTION (0C7) PROGRAM: VIAMERGE BACKTRACK:

| STMT: 000433 OFF: 0028D2 AMODE: 24 MODULE: VIAMERGE RECORDING |
| SOURCE: ADD 1 TO END-FILE-COUNT. |
o +

3 The List - BackTrack Variable History screen lists the statements which modified the
selected data item. You may view a statement in the program source by selecting the
statement and pressing Enter.

You may review other statements in BackTrack execution history by typing LIST
BACKTRACK and repeating the steps shown above.
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After completing your review of the selected statements, you may continue the test by
pressing PF3/PF15 on the List - BackTrack Variable History screen or by typing RUN
TO * on the Program View screen.

Using Pseudo Code

SmartTest provides the ability to interactively modify the logic of a program while it is
being tested. This gives you the opportunity to temporarily fix problems and test
hypothetical situations.

Pseudo Code Concepts

To interactively modify the logic of a program, SmartTest provides COBOL compatible
statements called pseudo code. You may enter these statements into COBOL and
Assembler source code. Inserted code may change the execution sequence of the
program, temporarily fix a data problem.

You can enter pseudo code statements in the Procedure Division of any COBOL or
Assembler program displayed in Program View. Each pseudo code statement is
associated with the executable source statement (COBOL verb or Assembler instruction)
following it. Multiple pseudo code statements may be associated with an executable
source statement to form a pseudo code block. Pseudo code statements follow standard
COBOL syntax rules.

The LIST PSEUDO command displays the pseudo code List screen showing all pseudo
code for the program currently in Program View. Pseudo code remains active until
deactivated or deleted and may be saved with any program stored on the AKR.

Note:
For more setup options on automatically saving pseudo code, see "Introduction" on
page 1.
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Pseudo Code Statements Available

SmartTest provides these pseudo code statements:

. ADD

. BREAK

. GO TO

. IF/THEN/ELSE
. MOVE

. SUBTRACT

e WHEN

. pslabel

. 77 (item)
. &COUNT

You can also use the ADD, SUBTRACT, MOVE, GO TO, and WHEN statements as
primary commands.

Pseudo Code Statements

Code Description

ADD Adds the value contained in or represented by the first operand to the
value contained in or represented by the second operand. The value is
converted to the proper format for the specified data item.

BREAK Forces a breakpoint before a specific statement. A pseudo code
BREAK statement causes an unconditional interrupt in the program
execution.

GO TO Transfers control to the statement containing the specified COBOL

paragraph name, pseudo code label, or line number.

IF/THEN/ELSE  Tests conditional expressions. Nested IF statements are supported.
Supported condition tests include Relation, Class and Sign.

MOVE Assigns the value contained in or represented by the first operand to
the area represented by the second operand. The value is converted to
the proper format for the specified data item, if possible. If the value
cannot be converted to the proper format, program execution stops
and an error message displays.
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SUBTRACT

Subtracts the value contained in or represented by the first operand
from the value contained in or represented by the second operand. The
value is converted to the proper format for the specified data item.

WHEN

Tests conditional expressions in the same manner as COBOL
conditional expressions. Use of the WHEN statement causes the test
to be performed after the execution of every COBOL verb that
modifies data.

Note:
Processing WHEN statements is resource intensive. Use sparingly.

pslabel

Defines a pseudo code paragraph name. These names are entered in
Area A and are used by GO TO pseudo code statements. A pseudo
code label can consist of one to thirty alphanumeric characters, the
first being alphabetic. The specified name cannot be an existing
COBOL data or label name. Pseudo code labels cannot be defined in
WHEN statements.

77

Defines a pseudo code data item. These data items are entered in Area
A. Each 77 level dataname must be unique and cannot be qualified.
77 level data definitions can be entered in either the Data Division or
the Procedure Division. Pseudo code data items must be defined
before being referenced and cannot be defined in WHEN commands.

&COUNT

Specifies the &COUNT SmartTest operand which is provided for use
in pseudo code statements. This variable is a counter used to indicate
the number of times each pseudo code statement has been executed.
&COUNT is useful in tests for specifying alternative logic based on
its value. The value of &COUNT is automatically initialized to zero
each time the pseudo code line is modified or entered. It is
incremented before the corresponding verb is executed.

&COUNT can be referenced as required in any pseudo code
statement, but cannot be modified (e.g., MOVE 2 TO & COUNT is
invalid).
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COBOL RESERVED WORDS in Pseudo Code

Many standard COBOL reserved words can be used in pseudo code. These reserved
words are used in pseudo code statements in the same manner they are used in standard
COBOL programs. These COBOL reserved words are supported by SmartTest pseudo

code:
ALL ELSE PIC
ALPHABETIC EQUAL PICTURE
COMP FROM POSTIVE
COMP-1 GREATER SPACE
COMP-2 IS SPACES
COMP-3 LESS THAN
COMP-4 LOW-VALUE THEN
COMPUTATIONAL LOW-VALUES TO
COMPUTATIONAL-1 NEGATIVE USAGE
COMPUTATIONAL-2 NEXT SENTENCE ZERO
COMPUTATIONAL-3 NOT ZEROS
COMPUTATIONAL-4 NUMERIC ZEROES

You can use these symbols in conditional pseudo code statements:

. = (equals)

A

(less than)

. > (greater than)

Entering and Editing Pseudo Code
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Pseudo code statements can be entered inline with existing COBOL or Assembler source
code while viewing a program in Program View. During a test session, pseudo code
statements can be entered whenever program execution is suspended. Pseudo code
statements are in standard COBOL format.

The C (copy), D (delete), I (insert), M (move), and R (repeat) line commands are

available to you for entering and manipulating pseudo code statements in a program. You
can also use the C (copy) and R (repeat) line commands with existing lines of COBOL
source code (the new lines are then considered pseudo code). These commands operate in
the same manner as in TSO/ISPF, including block format.
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Pseudo code statements can contain numeric and non-numeric literals. If the data element
being tested is a character field (non-numeric), the second operand in the pseudo code
statement must be in quotes. For example:

IF OUT CNT 4 = '001' THEN BREAK.

If the data element being tested is a decimal field (numeric), then the second operand in a
pseudo code statement does not need to be in quotes or zero padded. For example:

IF OUT CNT 3 = 1 THEN BREAK.

Executing Pseudo Code in a Test Session

Pseudo code is executed as part of the program logic when any execution control
commands (RUN or STEP) are issued.

Each statement is associated with the source statement (COBOL verb or Assembler
instruction) following it, which means it gets executed before the next verb. For example,
when a breakpoint occurs, processing stops and the chevrons are positioned in the line
number area of the next statement to be executed. If a block of pseudo code is inserted
immediately before this statement, the RUN function starts executing with the first
pseudo code statement and the STEP function repositions the chevrons to the first pseudo
code statement.

Pseudo code is syntax-checked when a command is entered referencing a pseudo code
statement or variable, and when saving the pseudo code to the Application Knowledge
Repository (AKR). These commands reference pseudo code: RUN, STEP, ZOOM
commands, LIST BREAKS, LIST PSEUDO, LIST WHENS, LPRINT PSEUDO,
QUALIFY.

Pseudo code statements with correct syntax are executed as part of the program logic.
These statements are not validated to determine if they are logically correct. When a
pseudo code statement causing a program execution error is encountered, the current test
is interrupted and an error message displays.

Viewing Pseudo Code in a Test Session

Use the pseudo code action on the List pull-down or the LIST PSEUDO primary
command to display the Pseudo Code List showing all pseudo code for the program in
Program View.

Pseudo code statements may be activated/deactivated individually or globally on the
Pseudo Code List.

You may also use the SET PSEUDO command to globally activate/deactivate pseudo
code. (See "Setting Test Session Options" on page 180.)
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Removing Pseudo Code from a Program

You can remove pseudo code from a program individually or globally.
To remove individual lines of pseudo code, follow this step:

» Use the D line command. This command operates in the same manner as the D (delete)
line command in TSO/ISPF, including block format.

To remove all pseudo code, follow this step:

P Select View P Reset, or type RESET using the PSEUDO operand to delete all pseudo
code, including breakpoints, within a program.

Note:

For more information regarding pseudo code and related commands, see the View section
in the ASG-SmartTest Reference Guide.

Using Multiple Programs
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Use the Open option on the File pull-down or the QUALIFY primary command to
display another program in Program View. Programs to be displayed in source code
format must reside on the AKR specified for the current session. Programs not stored on
the AKR may be displayed in disassembled object code.

The program currently being tested remains the active program. If a STEP, RUN, GO, or
CANCEL primary command is issued, it is executed for the active program being tested,
not the program being viewed; and, the status box changes to indicate the status of the
active program being tested. All other commands are performed on the displayed
program.

The QUALIFY * primary command is used to redisplay the active program. The
QUALIFY CANCEL primary command is used to remove the program being viewed
from qualification for viewing.

These are two examples of the QUALIFY primary command:

QUALIFY loadmod.program, which brings a program from a different load
module into Program View.

Q CANCEL ALL, which removes all programs from qualification and exit Program
View.
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Tailoring a Test Session by Program

The Test Session Tailoring screen, shown in Figure 103, is used to turn SmartTest
features selectively ON or OFF for a set of modules and/or programs. This screen
displays using one of these methods:

. Selecting TAILOR on the Test Facilities List screen
. Entering the LIST TAILOR command on any SmartTest screen
. Selecting Test session tailoring on the List pull-down

Session tailoring can reduce the execution time for a test providing options at the
individual program level.

A sample input line is provided on the first data line displayed to indicate how to specify
information for a program. Use the I (Insert), R (Repeat), and D (Delete) line commands
when editing the list of programs. Block forms of these commands are not supported.

Note:
For details of the Test session tailoring screen, see the ASG-SmartTest Reference Guide.

Figure 103 « Test Session Tailoring Screen

Test Zeszion Tailoring

CoHHand ===k _ Ecpoll ===k CER
Honi tor Track Count Break Break Break Pseudo Zingle
Hodule.Prograd id ACt ACt ACt Act  Entry  RTn ACt Etep
Hetetck TOF OF DATH
' TESTCOEE.TESTCOBE TEE NO YEZ HO NO NO NQ NO
' TESTCOEA.TESTCOBA TES N0 YES N0 N0 N0 NO N0
Attt BOTTOH OF DATA
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Setting Test Session Options
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Use the Modes action on the Options pull-down or the SET primary command with no
operands to display the Options - Modes screen. This facility allows you to enable or
disable any mode on the list.

Typing SET with an operand functions as a toggle switch for the mode specified.

The Options - Modes screen displays when the SET command is entered without
operands. This screen shows the current setting for each test session mode. The Options -
Modes screen can be used to change the setting for any mode by entering the desired
value in the Set field. Modes changed from the default setting are highlighted on the
Options - Modes screen.

The current setting for each option is saved between sessions in your PROFILE member
on the AKR, with the exception of BREAK, PSEUDO, SCRIPT, and WHENS. Default

values for these four options are restored when a new session is initiated.

This is how the test session options can be grouped:

Capture/Replay SCRIPT

Data Display DATA, HEX, KEEP, OPERANDS, SCALE, VALUES, ZEROFILL

Test Execution ~ASM, BACKTRACK, BREAKS, DELAY, LINK, MAIN,
MONITOR, PSEUDO, TRACK, WHENS, STOPEXEC (CICS
only), STOPHAND (CICS only)

Program View = ASMVIEW, AUTOQUAL, CUA, GENERATED, OUTLINE,
REFRESH, SHADOW, XMODE

Status Box ASM, FLOATING, REGISTERS, STATUS

For example, change the SCRIPT mode by typing SET SCRIPT. Reset all test session
options to their default values by typing SET DEFAULTS.

Note:

For more information regarding the test session options, see the Options section in the
ASG-SmartTest Reference Guide.
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Displaying Program and Test Information

To select program and test information about the program in Program View, for display,
use the actions on the List pull-down. You may also use the LIST primary command with
no operands to display the Test Facilities List screen as shown in Figure 104.

Figure 104 « TSO Test Facilities List Screen

CoMRand ===

Test Facilities List

FCroll ===k CER

Keyuord Description

AZG23431 USE THE DOWN COMMAND FOR ADDLTIOMAL TEST SESZIOM OPTIOME,
Enter & before the kewword to select a list category

AKRHEH List the AKR HEHEER: in the concatenated data baszes

ACCESE List the ACCEE: REGIETERE for the active prograd

ADETOF List ADDREZ: ETOPE for the current test session

EBACKTRACK List BACKTRACK wariable history by wariable nade

EREAKS List BREAKpoints in the current progran

CALLE List prograns that are CALLed by the current prograd
CORPILE List COHPILEF or Assenbler options for the current prograd
COUNT = List statement edecution COUNTE and histograd

EQUATES List EQUATEE for the current prograd

FLOATING List the FLOATING point registers for the active progrand
INTERCEPTE List the load modules to be INTERCEFTed

HEHORY List an area of HEHORY in a dunp farnat

HODULES List directary of 1oad HODULES in current 1oad libraries
FERFORHE  List PERFORH ranges in the current COBOL pragrad

PROFILE List the Wedbers of the PROFILE data set

PROGRARE  List PROGRAME and subprogrhads in the current COBOL prograd
PEEUDO List PSEUDD code in the curtent prograd

The LIST command is used to display program related information in a consolidated
format. Entering the LIST command with an operand results in the display of the

specified list screen.

The COUNTS, FLOATING, MEMORY, and REGISTERS operands pertain to the active
program, not necessarily the program being viewed in Program View.

This is how the test facilities lists may be grouped:

COBOL Verb List

SUBSET

CICS Environment Lists

EIB, FILE, LIMITS,TABLE (USER/GLOBAL)

IMS/DC Environment List

QUEUE

Program Knowledge Lists

CALLS, COMPILE, EQUATE, PERFORMS,
PROGRAMS
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List Type Operands

Test Control Lists ADSTOP, AKRMEM, BREAKS, INTERCEPTS,
PSEUDO, TAILOR, WHEN

Test Execution Lists ADSTOP, BACKTRACK, COUNTS, FLOATING,
MEMORY, MODULES, REGISTERS, TRACKING

Note:

For more information on lists, see the LIST command in the ASG-SmartTest Reference
Guide.

Printing Displayed Information (LPRINT Command)

Issuing the LPRINT * primary command results in the entire virtual screen (all data
viewed by scrolling forward and backward) to be copied to the List File. All excluded
lines are copied to the List file as excluded lines (as they appear on the screen at the time
the LPRINT * command is entered).

The LPRINT * primary command can be entered on these screens to copy them to the
List File:

. BackTrack Variable History screen

. Breakpoints List screen

. Execution Counts screen

. Execution Tracking screen

. List - CALL Statements pop-up

. List - COBOL Subsets Names pop-up
. List - Equates pop-up

. List - Perform Range Names pop-up

. List - Program/Subprogram Names pop-up
. List - User Marks pop-up

. Pseudo Code List screen

. When Conditions List screen

Note:

For more information regarding this command, see the Commands section in the
ASG-SmartTest Reference Guide.
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Linking to Alliance

If Alliance is installed, SmartTest provides a dynamic link to it that can be used to display
program analysis information. SmartTest automatically runs script queries appropriate for
the current execution environment upon entry to Alliance.

Prior to establishing the link, a complete Alliance application analyze must be done for
the program you wish to process in Alliance, including the load module libraries and
execution JCL. Also, you must first copy the VIAPALSC and VIAPQ* members from
the CNTL library into a user-defined PDS and appropriately customize them for your
needs.

To link with Alliance

1 Select Options P Script File Allocation on the SmartTest primary panel, as shown in
Figure 105.

Figure 105 « Selecting the Script File Allocation Menu Item

File Uiew Test Search List 0Options Help

« Product paraneters...
« Product allocations...
. Log-list<puncha...

. ZCRipt file allocations... | ek
. PF keys... Hepedek
. Hodes - ZET Options...
. Equate...

CoHHand ===

=1 AR R

Copwright AlLlen Systens Group, INcC., an unpublished vork.
A proprietary product of ASG, InC. Use restricted to authorized licensees.
Visit the ASG Support Web Site af wuW.asq.coH
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2 Inthe Options - Script File Allocations pop-up, enter the name of the user-defined
PDS containing the VIAPALSC and VIAPQ* members. The Options - Script File
Allocations pop-up is shown in Figure 106.

Figure 106 « The Options - Script File Allocations Pop-up

File Uiew Test Search List O0ptions Help

Options - ZCript File Allocations

c CorAand ===
R - Restore default 2cript allocations debicisioiicilolotoletoistoik
Aetebtettotcttetetbatatotck:
Enter desired Zcript file concatenation. etk
+t
FCript file data set nanes: #* Hetebotetotek
Hetetettstctek
= b oo
Aotk

Copyright ALlen $ystens Group, Inc., an unpublished work.
A proprietary product of ASG, IncC. Use restricted to authorized licensees.
Vigit the ASG Support Meb Site at wuw.asg.coH

3 Exit to the SmartTest primary panel. On the command line, issue the ALLIANCE
command. The SmartTest/Alliance Interface pop-up shown in Figure 107 displays.

Figure 107 « The SmartTest/Alliance Interface Pop-up

AEG-EHartTest-ASG-Alliance Interface
ConMand ===

Pleaze enter the following .

Alliance AKR.... . . gAEG-FRartTest-ASG-ALliance Interface.
Application MarWe . .

Prograd Hade .......

Query MaHE wsaaas UIAPQIHE

4  Press Enter, verify the information, and press Enter again. The VIAPALSC script
executes and runs the query listed in the SmartTest/Alliance Interface pop-up. A
series of screens flash by, ending with an Alliance query display appropriate for the
load module, JCL, transactions, and current SmartTest execution environment.

5  To exit the query display, type END on the command line. The Alliance primary

panel displays. Exit the Alliance primary panel to return to the SmartTest primary
panel.
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Field Description

Alliance AKR Specifies the AKR containing the analysis information produced
by Alliance for the specified application and program.

Application Name  Specifies the name of the application containing the program to be
processed in Alliance.

Program Name Specifies the name of the program to be processed in Alliance.

Query Name Specifies a query name other than the one SmartTest selects from
the PDS specified in the Options Script File Allocations pop-up.
The Query Name field is automatically filled with the name of a
query script appropriate for the current environment, however,
you can specify another.
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Program Analysis Features

This chapter presents the basic problem investigation features available with SmartTest.
Examples are provided for many of the commands shown. You may re-create most of
these examples using the VIAMERGE program.

COBOL Intelligent Search Function 187
Finding Program Information Using the Search Function 195
Printing Program Information 209
Repositioning the Display 210
Following Branching Logic 211
Searching the Program in Execution Sequence 215

COBOL Intelligent Search Function

The COBOL Intelligent Search function uses SmartTest's built-in understanding of
COBOL. The search function can be used to search the program for relevant information
about COBOL verbs, data items, labels, and other program details. The search function
recognizes and does not search COMMENT statements, unless specifically requested.

The six primary commands that use the COBOL Intelligent Search Function are BREAK,
EXCLUDE, FINDXTND, HIGH, LPRINT, and SCROLL. The BREAK command is
described in "Testing Techniques" on page 143. Descriptions of the other commands and
examples of command usage are contained in later sections.
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Search for COBOL Subsets

188

SmartTest classifies COBOL statements into COBOL subsets by grouping together
COBOL verbs of a similar nature. For a complete list of the verbs included in each of the
COBOL subset names, select List » COBOL intelligence features and Subsets from the
List COBOL Features pop-up, or type LIST SUBSETS, to display the Subsets List
screen. This table describes each of the COBOL subsets and the entities to which they

correspond:

ASsignment Includes statements that assign a value to a data item; e.g.
MOVE, ADD, or COMPUTE.

CALL Includes statements related to subprogram calls such as CALL
and CANCEL.

Clcs Includes any CICS or DL/I command level command.

COBOLII Includes COBOL II, including CONTINUE, END, and
INITTIALIZE verbs.

COBOL/370 Includes statements and clauses unique to COBOL/370, such as
intrinsic function calls, procedure pointers, and calls to LE/370
run-time environment.

COMment Includes statements having no run-time effect such as all lines
with an * (asterisk) in column 7, the entire IDENTIFICATION
DIVISION, and NOTE statements.

CONditional Includes statements or parts of statements that conditionally
change the flow of control in a program such as IF, ELSE, and
WHEN.

COPy Includes COPY, COPY IDMS, SQL INCLUDE, ++INCLUDE,
-INC statements.

DB2/SQL Includes EXEC SQL statements.

DDL Includes SQL Data Definition Language statements, such as
CREATE, ALTER, DECLARE, and DROP.

DEAD Includes statements containing dead code and dead data.

DEADCode Includes statements containing code that cannot be executed

under any conditions.
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DEADData Includes DATA DIVISION statements containing datanames
and their aliases that are not referenced in the PROCEDURE
DIVISION.

DEBug Includes statements containing a DEBUG, EXHIBIT, ON,
READY, or RESET verb, as well as statements containing a D
in column 7.

DEFinition Includes declaratives of data items including the
SPECIAL-NAMES paragraph in the ENVIRONMENT
DIVISION, as well as the entire DATA DIVISION.

DIRective Includes statements that direct the compiler to take specific
actions during compilation such as BASIS, EJECT, and TITLE.

DL/ | DL/1 Includes EXEC DL/I commands, ENTRY 'DLITCBL', CALL
'CBLTDLI.

DML Includes SQL Data Manipulation Language statements, such as
SELECT, UPDATE, INSERT, and COMMENT.

ENtry Specifies the PROCEDURE DIVISION statement and all
ENTRY statements.

EXit|PGMExit Includes statements containing a STOP RUN, GOBACK, or
EXIT PROGRAM verb, as well as CALL statements that are
indicated as NORET (non-returning).

FALLthrough Includes statements of PERFORMed paragraphs or units that
fall through to the next paragraph.

GOto Includes statements containing an ALTER or GOTO verb.

IDMS Includes IDMS statements.

INClude Includes COPY, COPY IDMS, SQL INCLUDE, ++INCLUDE,
-INC statements.

INPUTOutput Includes COBOL IO statements (10, Input, or Output) including

10 CALL statements that are indicated as containing 10, Input, or

Input Output.

Output

LABel Includes statements containing DIVISION or SECTION

DIVision headers, or PARAGRAPH labels. LABEL refers to the

PARagraph PROCEDURE DIVISION line and all section and paragraph

SECtion names in the PROCEDURE DIVISION.
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MAINIine Includes mainline code statements that are reachable from the
PROCEDURE DIVISION line to the program units by
following FALLTHROUGHsSs and GO TOs, but not

PERFORMs.

PERform Includes statements containing the PERFORM, SORT or
MERGE verbs.

RETurn Includes statements of a PERFORMed paragraph ranges that

return control.

STructure Includes a group of COBOL subsets that together help show the
general structure of the program. These COBOL subsets include
CALL, PERFORM, DIVISION, SECTION, PARAGRAPH,
EXIT, and GO TO.

TESted Identifies the lines of code that have been tested based on
information created and updated with TCA reports.

UNTested Identifies the lines of code that have not been tested based on
information created and updated with TCA reports.

Screen Subsets

Screen subsets generally are the result of an interactive command. To specify one of these
subsets, type the entire name or the minimum abbreviation:

. Highlighted or HI

. NONHighlighted or NHI
e Excluded or X

e NONExcluded or NX

Tag Subsets

Tag subsets are displayed in columns 73 through 80 on the Program View screen, which
SmartTest uses to provide immediate information about the source code. Command
results show tags in these columns. Data items that are never referenced, statements
containing dead code, and statements containing program exits are also tagged in
columns 73 through 80. PERFORMed paragraphs use columns 73 through 80 to indicate
if they fall through or return. Specific tags are provided for the TRACE option facility.
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These tags can be used in commands that accept subsets as targets:

Tag Description

TAGged or TAGS Refers to all lines having information tags on them.

DECision Refers to a line where the TRACE facility has stopped and is
waiting for a decision.

OPTions Refers to lines that are the optional choices for the decision point
of the TRACE facility.

STArt Refers to a line where the FLOW or TRACE facility started.

TARGet or TGT Refers to a line containing the target for the FLOW or TRACE
commands.

When a SUBSET is specified as the target of these commands, the entire program is
searched for all occurrences of verbs associated with the SUBSET. All information
pertaining to a COBOL function may be presented with a single command.

Search for Dataname References

When a dataname is specified as the target, the program is searched for all occurrences of
the specified field. This search includes all aliases of the dataname, by default. The
targets found are highlighted and tagged as a reference.

Reference tags are placed in columns 73 through 80 indicating the type of target found.
These are the valid dataname reference tags:

Tag Description

DATA MOD Specifies the value of the data item is being set or altered.

DATA USE Specifies the value of the data item is being tested or used.

DATA DEF Specifies the definitions of a data item or its aliases.

Search for Indirect Dataname References

Using the SIZE operand with the search function locates all datanames directly or
indirectly affected by a change in the size of the specified dataname. This results in a
complete list of all data items to be reviewed for a size change of the specified dataname.
By including the LEVELS operand, the indirect impact of a size change to a dataname
can be seen one level at a time.
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Using the VALUE operand with the search function locates all occurrences of a dataname
directly or indirectly affected by a change in the value of the specified dataname.

Limit the Search Scope

The search function may be limited to direct dataname references with the NOALIAS
operand. ALIAS is the default.

The MOD, USE, and DEF operands limit the search function to include only the specified
data item reference type. REF is the default and includes MOD, USE, and DEF.

The search function may be limited in direction using the operands NEXT and PREV to
start the search from the current position and locate the closest occurrence in the specified
direction. The FIRST and LAST operands locate the first and last occurrence in the
program respectively. ALL is the search function default, with the exception of the
BREAK command where the default is NEXT.

The search function can be limited to a particular statement type through the use of the IN
clause.

Excluding Lines from the Display

192

To examine only desired information on the screen, you can remove unneeded statements
from the display. The exclude function can suppress the display of statements meeting
specified criteria in Program View.

Select Test » Exclude or use the EXCLUDE command to remove all lines from the
display that meet the specified criteria. Lines may be excluded from the display before or
after issuing other commands.

Excluded lines are represented by shadow lines stating n LINE(S) NOT DISPLAYED
and a line of dashes. The dashed line can be suppressed with the SET SHADOW
command (see the Options section of the ASG-SmartTest Reference Guide).

Excluded lines may be redisplayed as desired. (See "Redisplaying Excluded Lines" on
page 194.)

The EXCLUDE primary command may be abbreviated as X. For example, to remove all
non-highlighted lines from Program View, type this command:

X NHI
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Removing Lines from the Display

To remove all lines from the display using the program VIAMERGE
1 Type EXCLUDE in the primary command input area and press Enter.
Or

Select View » Exclude and press Enter. The View - Exclude Request pop-up, shown
in Figure 108, displays.

Figure 108 « View - Exclude Request Pop-up

Uiew — EWcClude Request

To eHClude specific lines frod the progran being
viewad, select the desired option. Then press
Enter. For the “string" option, type the string
to be eHcluded.

aptiaon
1 1. A1l lines

2. A1l highlighted lines
I, All non-highlighted lines

d. A1l lines containing a string

FTring

2 Specify All lines in the Options field and press Enter to remove all lines from the
display.

Figure 109 « Program View Lines of Code Omitted

File Uiew Test =earch List Options Help

Progran Uiew 2525 LINE: EMCLUDED
CoHHand ===k _ Ecroll ===k GER

-=-= = = = = = = = = - = = = = = = 2525 LINEZ NOT DIZPLAYED
EOTTOH OF DATA

This table describes the messages displayed on the Program View screen:

2525 LINES EXCLUDED  Reflects the number of lines excluded from the
display.

--...-2525 LINES NOT Indicates how many lines are not displayed at that
DISPLAYED point in the program. In Figure 109, the entire
program has been removed from the display.
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Redisplaying Excluded Lines

Use the F (First), H (Hidden), L (Last), and S (Show) line commands to redisplay lines

excluded from the display.

The F and S line commands redisplay a specified number of lines in a block of excluded
lines, starting from the top of the block. The H or L line command redisplays the last lines

of a block of excluded lines.

For example, the command F2 in the line command area of the shadow line to display the
first two lines of an excluded block. The command L5 in the line command area of the
shadow line to display the last five lines of an excluded block.

Displaying All Excluded Lines

To redisplay all excluded lines

194

1 Select View P Reset and press Enter to display the View - Reset Request pop-up.

2 Type / in the Excluded lines field and press Enter as shown in Figure 110.

Or

Type RES X in the primary command area and press Enter to redisplay all excluded

lines.

Figure 110 * View - Reset Request Pop-up

Uiew - Reset Request
To reset display features, select an Option.

eset Options

I~ 3

All Lines
Excluded Lines
Highlighted Lines
Tag Codnents
Hessages

Labels

Keep Mindows

ZooH Mindows
Fseudo Code [Including Breaks and Whens)
Ereaks

Mhens

ALl [Excluded lines, Highlighted lines, Tags, Hessages)

Then press Enter.
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Finding Program Information Using the Search Function

The search function commands are used to locate statements that meet specified criteria.
These commands can be used to display and highlight specific program information,
datanames, set of lines or patterns.

Use the Search pop-ups or the FINDXTND primary command to invoke the search
function to find one or all occurrences of the specified target. Statements that meet the
criteria are displayed, tagged and highlighted.

This function searches the program in source code sequence for occurrences of the
specified target. A target is the object of a search and can be a set of lines, a dataname, or
a pattern. Several target types and operands are available.

Use of the FINDXTND command results in all lines containing the specified target being
tagged and highlighted with the cursor positioned on the first target. If lines containing
targets have been excluded from the screen, they are redisplayed. Targets highlighted as a
result of a previous command are reset, so only the results of the current FINDXTND
command are highlighted. Reference tags are placed on the source code lines in columns
73 through 80, specifying the type of target found.

The FINDXTND primary command may be abbreviated as FINDX or FX.

Finding All Input and Output Statements

To remove all statements from the display and redisplay, tag, and highlight all
statements containing Input and Output verbs using the program VIAMERGE

1 Type X; FX I0 inthe primary command input area and press Enter. See Figure 113
on page 197 for an illustration of the result.

Or

Select Options » Modes to display the Options - Modes screen.
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2 Scroll down to the XMODE option and set to ON, as shown in Figure 111.

Figure 111 « XMODE Option

options - Hodes COBSAZEE

CoHHand === Ecroll ===} CIR
option et Description

OFERANDE OFF  Display walues for the data itens on the current statewnent
OUTLINE 0N Display outline around itens on the Progran View screen
PROHPT OFF  Frompt to save Environnent profile
PEELDO aM Thie PEEUDO code facility i= enabled
REFREZH oM Refraskh full IEPF screen after eackh ETEP or RUN CoMHand
RESGIZTERE OFF  Display the genetral registers in the status box
ECALE OFF  Display =cale line above data values
SCRIPT OFF  The SCRIPT facility is dizabled
SHADOW 0N Display a dashed line for excluded lines
ETATUS ol Display the current status bod on screens
TRACE, 1} Nurber of edecution tracking entries [9-299% or OK-512K]
VALUES AUTO MuMber of lines for displaving data values, of AUTO
WHEWE ] The WMHEW condition facility i=s enabled
WRAF OFF Break when tracking table full
¥HODE oM, Edclude all lines before edecuting Pridary CoWdands

ZEROFILL OFF  Display nuMeric data itens with leading zeros
EOTTOH OF DATA

3 Press PF3 to exit and return to the SmartTest main screen.

Note:

You can also use the SET XMODE ON primary command. This command causes
SmartTest to exclude all lines that do not meet the criteria of the search to be performed.
For the CUA method of excluding all lines from the display, see "Excluding Lines from
the Display" on page 192.

To search for all statements containing Input and Output verbs

1 Select Search P Subset and press Enter to display the Search - COBOL Subset Name
pop-up, shown in Figure 112.

Figure 112 « Search - COBOL Subset Name Pop-up

fearch - Subszet Hane

Type a subset nane and select search options. Then press Enter.
For a selection list, type a pattern [2.9. ARECGF) in the nane area.

Jubset naHe

Oirection aptions ACtion
1 1. Al _ IN-clauze... 1 1. Find
2. HMent 2. Highlight
3. Previous 3. Ecroll
4. First d. Print
5. Last 5. Punch
6. EHClude
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Complete these fields:

a Type I0 in the Subset name field.

b  Specify A11 in the Direction field.

¢ Make certain the Options field is blank.

d Specify Find in the Action field and press Enter.

Figure 113 shows the results of a COBOL subset search.

Figure 113 « Program View with Input and OQutput Search Result

File View Test Search List Options Help

——————————————————————————————————————————————————————————————————————————— ()
Program View 26 STATEMENTS FOUND
Command ===> Scroll ===> CSR

- - - - - 177 LINES NOT DISPLAYED
000178 OPEN INPUT INFILEl INFILE2 INFILE3. (B) IO

000179 OPEN OUTPUT OUTFILE OUTRPT. 10
--- - - - - - - - - - - - - - - - - - 1 LINE NOT DISPLAYED
000181 ACCEPT BEGIN-DATE FROM DATE. 10
000182 WRITE OUTRPT-REC FROM BEGIN-MESSAGE. 10
--= - - - - - - - - - - - - - - - - 51 LINES NOT DISPLAYED
000234 WRITE OUTRPT-REC FROM END-MESSAGE. 10
000235 CLOSE INFILEl INFILE2 INFILE3 OUTFILE OUTRPT. 10
--- - - - - - - - - - - - - - - - - 136 LINES NOT DISPLAYED
000372 WRITE OUTRPT-REC FROM OUTRPT-WORK-AREA. 10
--= - - - - - - - - - - - - - - - - 3 LINES NOT DISPLAYED
000376 WRITE OUTFILE-REC FROM OUTFILE-WORK-AREA. 10
--—- - - - - - - - - - - - - - - - - 5 LINES NOT DISPLAYED
000382 WRITE OUTRPT-REC FROM OUTRPT-WORK-AREA. 10
--—- - - - - - - - - - - - - - - - - 3 LINES NOT DISPLAYED
000386 WRITE OUTFILE-REC FROM OUTFILE-WORK-AREA. 10
--= - - - - - - - - - - - - - - - - 5 LINES NOT DISPLAYED
000392 WRITE OUTRPT-REC FROM OUTRPT-WORK-AREA. 10

This table describes the messages displayed on the Program View screen:

(A) 26 STATEMENTS Reflects 26 Input/Output statements were found in the
FOUND program.

(B)IO Each Input/Output statement is highlighted and tagged
as 10.

With a single search all Input and Output verbs such as: OPEN, READ, WRITE,
CLOSE, ACCEPT, and DISPLAY statements are highlighted with all non-search
related line excluded.
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3  Toredisplay all excluded lines, type RES X in the primary command area and press
Enter.

Note:

For the CUA method of redisplaying all excluded lines, see "Displaying All Excluded
Lines" on page 194.

Determining References to a Data Field

198

To display, tag, and highlight all statements that reference a data field or its
aliases

Note:
This example uses the program VIAMERGE.

1 Type X; FX HOW-MANY-FILES-READ in the primary command input area and
press Enter.

Or

Select Options » Modes to display the Options - Modes screen. Scroll down to the
XMODE option and set to ON, as shown in Figure 111 on page 196. Press PF3 to
exit and return to the SmartTest main screen.

Note:

You can also use the SET XMODE ON primary command. This command causes
SmartTest to exclude all lines that do not meet the criteria of the search to be
performed. For the CUA method of excluding all lines from the display, see
"Excluding Lines from the Display" on page 192.

2 Select Search on the action bar and press Enter.
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3 Select Search » Data and press Enter to display the Search - Data Name pop-up as
shown in Figure 114. (See "Determining References to a Data Field" on page 198.)

Figure 114 » Search - Data Name Pop-up

Fearch - Data Mane

Type a data naWe and select search options. Then press Enter. For
a zelection 1ist, enter a pattern [e.g. AEC] in the nade area.

Data nane HOM-HANY-FILEZ-READ

References Indirect inpact Fige change
1 1. A1l 2 1. HNone levels « .« 1__
2. Defs 2. 0Of =iZe change
3. Uses 3. 0f value change
4. Hods
Direction options ACtion
1 1. A1l - HNo data aliazing 1 1. Find
2. Mert IN-Clauze... 2. Highlight
3. Previous 3. BCroll
d. First d. Print
5. Last 5. Punch
E. EHClude

4  Complete these fields:
a Type HOW-MANY-FILES-READ in the Data name field.
b  Specify A1l in the References field.
c Specify None in the Indirect Impact field.
d  Make certain the Size change levels blank.
e Specify A11 in the Direction field.

f Make certain the Options field blank.
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g  Specify Find in the Action field and press Enter to display the result as shown

in Figure 115. (See "Determining References to a Data Field" on page 198.)

Figure 115 » Program View with Data Item Information Search Result

File View Test Search List Options Help

Program View VIAMERGE .VIAMERGE
Command ===> Scroll ===> CSR
ASG0443I 10 DATA REFS: 5 DEFS, 3 USES, 2 MODS, FOUND FOR HOW-MANY-FILES-READ. (A)
--— - - - - - - - - - - - - - - - - 95 LINES NOT DISPLAYED
000187 MOVE ZEROS TO COMPARISON-KEY-1, COMPARISON-KEY-2,
000188 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF,
000189 MASTER-EOF-SWITCH,
000190 HASH-TEST-A, HASH-TEST-B, HASH-TEST-C,
000191 HASH-TOTAL,
000192 COMPARISON-CODES,
000193 HOW-MANY-FILES-READ. DATA MOD
--— - - - - - - - - - - - - - - - = 22 LINES NOT DISPLAYED
000216 COMPUTE HOW-MANY-FILES-READ = INFILEl-EOF DATA MOD
000217 + INFILE2-EOF
000218 + INFILE3-EOF.
000219 IF READ-3-FILES DATA USE
--— - - - - - - - - - - - - - - - = 2 LINES NOT DISPLAYED
000222 ELSE IF READ-2-FILES DATA USE
--— - - - - - - - - - - - - - - - = 2 LINES NOT DISPLAYED
000225 ELSE IF READ-1-FILE DATA USE
--- - - - - - - - - - - - - - - - - 243 LINES NOT DISPLAYED
AR SRS SRS EE RS RS EEEEEEEEEEEERESEEES] BOTTOM OF DATA LR R RS R EEE SRS EEEEREEREEEEEEEEEE]

(A) ASG04431 2 DATA MODS FOUND. The long message reflects the number of
references and a breakdown of the type of references to the data field in which they were
found.

These DATA modes apply to statements:

Statements tagged with DATA MOD may change the value of the data field
indicated.

Statement tagged with DATA USE are an Alias of the specified dataname.

Statements tagged with DATA REF are uses and modifications of the dataname
specified.

Statements tagged with DATA DEF are definitions of the specified dataname or an
alias.
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Determining Where a Data Field is Modified

To display, tag, and highlight statements that change the value of a data item

Note:
The example uses the program VIAMERGE.

1 Type X; FX HOW-MANY-FILES-READ MOD in the primary command input area
and press Enter.

Or

Select Options » Modes to display the Options - Modes screen. Scroll down to the
XMODE option and set to ON, as shown in Figure 111 on page 196. Press PF3 to
exit and return to the SmartTest main screen.

Note:
You can also use the SET XMODE ON primary command. This command causes
SmartTest to exclude all lines that do not meet the criteria of the search to be
performed. For the CUA method of excluding all lines from the display, see
"Excluding Lines from the Display" on page 192.

2 Select Search » Data and press Enter to display the Search - Data Name pop-up as

shown in Figure 114. (See "Determining Where a Data Field is Modified" on
page 201.)

3  Complete these fields:
a  Type HOW-MANY-FILES-READ in the Data name field.
b  Specify Mods in the References field.
c Specify None in the Indirect impact field.
d  Make certain the Size change levels is blank.
e Specify 211 in the Direction field.

f Make certain the Options field is blank.

201



ASG-SmartTest for COBOL and Assembler User’s Guide

g  Specify Find in the Action field and press Enter to display the result shown

in Figure 116. (See "Determining Where a Data Field is Modified" on
page 201.)

Figure 116 * Program View with Search Result

File View Test Search List Options Help
Program View VIAMERGE .VIAMERGE
Command ===> Scroll ===> CSR
ASG0443I 2 DATA MODS FOUND FOR HOW-MANY-FILES-READ. (a)
--- - - - - - - - - - - - - - - - - 186 LINES NOT DISPLAYED

000187 MOVE ZEROS TO COMPARISON-KEY-1, COMPARISON-KEY-2,

000188 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF,

000189 MASTER-EOF-SWITCH,

000190 HASH-TEST-A, HASH-TEST-B, HASH-TEST-C,

000191 HASH-TOTAL,

000192 COMPARISON-CODES,

(B)193 HOW-MANY-FILES-READ. DATA MOD
--=- - - - - - - - - - - - - - - - - 22 LINES NOT DISPLAYED
(B) 216 COMPUTE HOW-MANY-FILES-READ = INFILE1-EOF DATA MOD
000217 + INFILE2-EOF

000218 + INFILE3-EOF.

- - - - - - - - - - - - - - - - 250 LINES NOT DISPLAYED
KKK KKK KK KKK KK KKK KKK KKK KKK KKK KK * k% BOTTOM OF DATA ** KK K % ok ok k ok ok ok ok ok & ok ok ok ok ok ok ok ok & ok k%

This table describes the messages displayed on the Program View screen:

Message Description

(A) ASG044312 DATA  Reflects the number of statements found.
MODS FOUND FOR

(B) DATA MOD Statements that modify the value of the specified data
item.
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Determining if a Data Field is Used in Conditional Logic

To display, tag, and highlight conditional statements containing a specified data
item

Note:
The example uses the program VIAMERGE.

1 Type X; FX HOW-MANY-FILES-READ IN COND in the primary command
input area and press Enter.

Or

Select Options » Modes to display the Options - Modes screen. Scroll down to the
XMODE option and set to ON, as shown in Figure 111 on page 196. Press PF3 to
exit and return to the SmartTest main screen.

Note:

You can also use the SET XMODE ON primary command. This command causes
SmartTest to exclude all lines that do not meet the criteria of the search to be
performed. For the CUA method of excluding all lines from the display, see
"Excluding Lines from the Display" on page 192.

2 Select Search on the action bar and press Enter.

3 Select Search P Data and press Enter to display the Search - Data Name pop-up as

shown in Figure 114 on page 199. (See "Determining if a Data Field is Used in
Conditional Logic" on page 203.)

4  Complete these fields:
a  Type HOW-MANY-FILES-READ in the Data name field.
b  Specify 211 in the References field.
c Specify None in the Indirect impact field.
d  Make certain the Size change levels field blank.
e Specify A11 in the Direction field.

f Select IN-clause by typing / or any non-blank character in the Options field.
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g  Specify Find in the Action field and press Enter to display the IN-Clause

n

Option pop-up. (See "Determining if a Data Field is Used in Conditional
Logic" on page 203.)

Figure 117 « IN-Clause Option Pop-up

IN-Clauze Option

Ta pestrict the source lines to be considered, type one or Hoke
IN-Clause nares. Then press Enter. For a selection list, tupe a
pattern in the appropriate nade field.

Line range . . .
Zubset nane . . .
Patagraph Nawe
Prograd nane

5  Type COND in the Subset field as shown in Figure 117 and press Enter. Figure 118
shows the result of a COBOL dataname search for dataname modifications. (See
"Determining if a Data Field is Used in Conditional Logic" on page 203.)

Figure 118 « Program View with Search Result

File View Test Search List Options Help
Program View VIAMERGE.VIAMERGE
Command ===> Scroll ===> CSR
ASG0443I 3 DATA REFS: 3 USES, FOUND FOR HOW-MANY-FILES-READ IN COND. (A)
- - - - - - - - - - - - - - 218 LINES NOT DISPLAYED

000219 IF READ-3-FILES (B) DATA USE
T 2 LINES NOT DISPLAYED
000222 ELSE IF READ-2-FILES (B) DATA USE
S 2 LINES NOT DISPLAYED
000225 ELSE IF READ-1-FILE (B) DATA USE

--- - - - - - - - - - - - - - - - - 243 LINES NOT DISPLAYED
Kk kkhkk KKk KKk Kk kkkk Kk kkkkkk Xk kX k*k* BOTTOM OF DATA * % * %%k &K k% k& %k & Kk % Kk k% kk & Kk k %k %

This table describes the messages displayed on the Program View screen:

(A) ASG04431 3 Reflects the number of references found.
DATA REFS: ...

(B) DATA USE Conditional statements that use Aliases of the specified data
item.
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Determining the Impact of a Data Field Size Change

To display, tag, and highlight the first level of data items affected by a change in
the size of a specified data field

Note:
The example uses the program VIAMERGE.

1 Type X; FX HOW-MANY-FILES-READ SIZE LEVEL 1 in the primary
command input area and press Enter.

Or

Select Options » Modes to display the Options - Modes screen. Scroll down to the
XMODE option and set to ON, as shown in Figure 111 on page 196. Press PF3 to
exit and return to the SmartTest main screen.

You can also use the SET XMODE ON primary command. This command causes
SmartTest to exclude all lines that do not meet the criteria of the search to be
performed. For the CUA method of excluding all lines from the display, see
"Excluding Lines from the Display" on page 192.

2 Select Search on the action bar and press Enter.

3 Select Search » Data and press Enter to display the Search - Data Name pop-up as

1

shown in Figure 119. (See "Determining the Impact of a Data Field Size Change" on
page 205.)

4  On the Search - Data Name pop-up:
a  Type HOW-MANY-FILES-READ in the Data name field.
b  Select All in the References field.
c Select Of size change in the Indirect impact field.
d  Type 1 in the Size change levels field.
e Select All in the Direction field.
f Leave the Options field blank.

g  Select Find in the Action field and press Enter to display the results shown in

Figure 120. (See "Determining the Impact of a Data Field Size Change" on
page 205.)
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Figure 119 shows the Search - Data Name pop-up for determining the impact of a
change in size in the field HOW-MANY-FILES-READ.

Figure 119 * Search Data Name Pop-up

Fearch - Data Mane

Type a data naWe and select search options. Then press Enter. For
a zelection 1ist, enter a pattern [e.g. AEC] in the nade area.

Data nane HOM-HANY-FILEZ-READ

References Indirect inpact Fige change
1 1. A1l 2 1. HNone levels « .« 1__
2. Defs 2. 0Of =iZe change
3. Uses 3. 0f value change
4. Hods
Direction options ACtion
1 1. A1l - HNo data aliazing 1 1. Find
2. Mert IN-Clauze... 2. Highlight
3. Previous 3. BCroll
d. First d. Print
5. Last 5. Punch
E. EHClude

Figure 120 shows the result of a search for the impact of a size change in the field
HOW-MANY-FILES-READ.

Figure 120 » Program View Showing the Effect of a Change in Size

File View Test Search List Options Help

Program View VIAMERGE .VIAMERGE
Command ===> Scroll ===> CSR
ASG0443I 18 DATA REFS: 15 DEFS, 3 USES, 1 LEVEL FOUND FOR HOW-MANY-FILES-READ.
a - - - - - - - - - - - - - - - - - 124 LINES NOT DISPLAYED
(B)216 COMPUTE HOW-MANY-FILES-READ = INFILEl1-EOF DATA USE
000217 + INFILE2-EOF DATA USE
000218 + INFILE3-EOF. DATA USE

- - - - 250 LINES NOT DISPLAYED

KR KKk Kk KKKk XK Kk kX kkXkkkkxkkkxkkkxx BOTTOM OF DATA * * % %k ok %k kK s sk k K o % % % K % % % % % % % & % %

This table describes the messages displayed on the Program View screen:

(A) ASG04431 18 Reflects the number and type of references found.
DATA REFS: ...

(B) DATA USE Indicates that the data fields INFILE1-EOF, INFLE2-EOF,
and INFILE3-EOF are affected by changing the size of the
data field, HOW-MANY-FILE-READ.
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Determining the Impact of a Data Field Value Change

To display, tag, and highlight all statements affected by a change in the value of
a specified data field

Note:
The example uses the program VIAMERGE.

1 Type X; FX HOW-MANY-FILES-READ MOD VALUE in the primary command
input area and press Enter.

Or

Select Options » Modes to display the Options - Modes screen. Scroll down to the
XMODE option and set to ON, as shown in Figure 111 on page 196. Press PF3 to
exit and return to the SmartTest main screen.

You can also use the SET XMODE ON primary command. This command causes
SmartTest to exclude all lines that do not meet the criteria of the search to be
performed. For the CUA method of excluding all lines from the display, see
"Excluding Lines from the Display" on page 192.

2 Select Search on the action bar and press Enter.

3 Select Search P Data and press Enter to display the Search - Data Name pop-up
shown in Figure 120 on page 206.

4  Complete these fields:
a Type HOW-MANY-FILES-READ in the Data name field.
b  Select Mod in the References field.
c Select Of value change in the Indirect impact field.
d  Leave the Size change levels field blank.
e Select All in the Direction field.
f Leave the Options field blank.

g  Select Find in the Action field and press Enter to display the result. (See
"Determining the Impact of a Data Field Value Change" on page 207.)
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Figure 121 shows the Search - Data Name pop-up for determining the impact of a
change in the value of the data item HOW-MANY-FILES-READ.

Figure 121 * Search Data Name Pop-up

Fearch - Data Mane

Type a data naWe and select search options. Then press Enter. For
a zelection 1ist, enter a pattern [e.g. AEC] in the nade area.

Data nane HOM-HANY-FILEZ-READ

References Indirect inpact Fige change
1 1. A1l 2 1. HNone levels « .« 1__
2. Defs 2. 0Of =iZe change
3. Uses 3. 0f value change
4. Hods
Direction options ACtion
1 1. A1l - HNo data aliazing 1 1. Find
2. Mert IN-Clauze... 2. Highlight
3. Previous 3. BCroll
d. First d. Print
5. Last 5. Punch
E. EHClude

Figure 122 shows the result of a search to determine the impact of a change in the
value of the data item HOW-MANY-FILES-READ.

Figure 122 » Program View Showing Modification of a Data Item

File View Test Search List Options Help

Program View VIAMERGE.VIAMERGE
Command ===> Scroll ===> CSR
ASG0443I 8 DATA MODS FOUND FOR HOW-MANY-FILES-READ. ()
000188 INFILE1-EOF, INFILE2-EOF, INFILE3-EOF, DATA MOD
000189 MASTER-EOF-SWITCH,
000190 HASH-TEST-A, HASH-TEST-B, HASH-TEST-C,
000191 HASH-TOTAL,
000192 COMPARISON-CODES,
000193 HOW-MANY-FILES-READ. DATA MOD
--— - - - - - - - - - - - - - - - - 22 LINES NOT DISPLAYED
000216 COMPUTE HOW-MANY-FILES-READ = INFILE1-EOF DATA MOD
000217 + INFILE2-EOF
000218 + INFILE3-EOF.
---- - - - - - - - - - - - - - - - = 220 LINES NOT DISPLAYED
(B)439 MOVE 1 TO INFILE1-EOF DATA MOD
--— - - - - - - - - - - - - - - - - 11 LINES NOT DISPLAYED
000451 MOVE 1 TO INFILE2-EOF DATA MOD
--— - - - - - - - - - - - - - - - = 11 LINES NOT DISPLAYED
000463 MOVE 1 TO INFILE3-EOF DATA MOD
--— - - - - - - - - - - - - - - - - 5 LINES NOT DISPLAYED
AR SRS S S SR SRR EEEEEEEEEEEEREEEEES] BOTTOM OF DATA R R RS R EEE SRR EEEEREEREEREEEEEEE]
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This table describes the messages displayed on the Program View screen:

Message Description

(A) ASG04431 8 DATA Reflects the number of statements found.

MODS FOUND FOR

HOW-MANY-FILES-READ

(B) DATA MOD Statements modifying the specified data field or
fields used to value the data field (see the previous
COMPUTE statement).

Highlighting Search Results

Select Highlight on the Search pop-ups or use the HIGH primary command to search the
program in source code sequence and display, tag and highlight all occurrences of the
specified target. Previously highlighted lines remain highlighted.

A target is the object of a search function and can be a set of lines, a dataname, or a

1

pattern. Several target types and operands are available. (See "Command Targets" on
page 19.)

The HIGH function tags and highlights all lines containing the specified target. The
cursor is positioned on the first target. If lines containing targets have been excluded from
the screen, they are redisplayed.

The HIGH primary command may be abbreviated as HI. For example, this command
displays, highlights, and tags all COBOL Assignment statements:

HI ASSIGN

Note:
For more information on the HIGH command, see the ASG-SmartTest Reference Guide.

Printing Program Information

Select Print on the Search pop-up or use the LPRINT primary command to copy one or
all occurrences of the specified target to the List File. To print the List File use the
Option - Log/List/Punch Definition pop-up.

The LPRINT primary command may be abbreviated as LP.

As an example, the command LP PERFORM copies all PERFORM statements in the
program to the List File for subsequent printing.
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The command LPRINT * primary command copies the current virtual screen (all
displayed lines that can be viewed by scrolling forward and backward) to the List File.
Excluded line messages are copied to the List file as they appear on the screen at the time
the LPRINT * command is entered.

The LPRINT * primary command can be entered on these screens to copy those screens
to the List File:

. BackTrack Variable History Screen

. Breakpoints List screen

. Execution Counts screen

. Execution Tracking screen

. List - CALL Statements pop-up

. List - COBOL Subsets Names pop-up
. List - Equates pop-up

. List - Perform Range Names pop-up

. List - Program/Subprogram Names pop-up
. List - User Marks pop-up

. Pseudo Code List screen

e View - Paragraph Cross Reference

. When Conditions List screen

Note:
For more information regarding this command, see the ASG-SmartTest Reference Guide.

Repositioning the Display

210

Select Search » Scroll or use the SCROLL primary command to position the display to
the first line containing the specified target. The most frequent use of the SCROLL
command is to position the display to the next occurrence of a highlighted statement.

You can abbreviate the SCROLL command as SC.
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As an example, the command SC HI NEXT positions the display to the next occurrence
of a highlighted statement.

Note:

For more information regarding the COBOL intelligent Search Function and these
commands, see the Commands section in the ASG-SmartTest Reference Guide.

Following Branching Logic

Select Search » Branch or use the BRANCH primary command to position the display at
the specified target paragraph. This command can be used to scroll from a statement such
as a PERFORM, to the paragraph being PERFORMed. Use the BRANCH BACKUP
command to redisplay the statement from which a BRANCH was issued.

If the target paragraph is already on the screen, the cursor is placed on the first line of the
paragraph. If the target paragraph is not on the screen, the specified paragraph is scrolled

to the top of the screen.

The BRANCH function is cursor sensitive. If the cursor is positioned in excluded lines,
the first line of the excluded block is selected.

The BRANCH function can be used to track branching logic several levels deep into
PERFORMed code and then return to each PERFORM statement.

The screen position is saved for use with the BACKUP operand if a LABEL name is
entered on the command line or the cursor is placed on a GOTO or PERFORM statement.

The PROCEDURE DIVISION label displays when the BRANCH command is entered
with no operands and the cursor is positioned in a part of the program other than the

PROCEDURE DIVISION, or when the BRANCH PROC command is entered.

By default, PF10/PF22 is assigned as the BRANCH command. PF11/PF23 is the default
for the BRANCH BACKUP command.

The BRANCH primary command may be abbreviated as B or BRA.
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Using the Branch Function

212

To position the display to the first statement in a specified paragraph

Note:

This example uses the paragraph 2000-PROCESSING-LOOP in the demonstration
program VIAMERGE.

1 Type BRANCH 2000-PROCESSING-LOOP in the primary command input area
and press Enter to display the result shown in Figure 123. (See "Using the Branch
Function" on page 212.)

Or

Select Search » Branch and press Enter to display the Search - Branch Request
pop-up shown in Figure 122. (See "Using the Branch Function" on page 212.)

2 Select Branch to target in the Option field.
3  Type 2000-PROCESSING-LOOP in the Target name field.

4 Select Label name in the Target type field and press Enter. (See "Using the Branch

Function" on page 212.)

Figure 123 shows the Search - Branch Request pop-up for branching through
program logic.

Figure 123 « Search - Branch Request Pop-up

fearch - Branch Request

To branch to another area of the prograd, select the Option desired.
For Option 1, type the branch location [Target) inforration.  Then
press Enter. FoOr a nane selection list [for Target twpe 2, 3 or 4],
tupe a pattern [e.q. ABCGE] in the naWe field.

option
1l 1. Eranch to target
2. Return to previous "Branch to target” location
3. Eranch to transfer(s] of control to cursor position

Target nadne

Target typa

1 1. MNonme - use Cupksor
2. Label nane
3. Perfrange naHe
d.  Prograd nade




5 Program Analysis Features

Figure 124 shows the result of a Branch function.

Figure 124 « Program View with Cursor Positioned by Branch Function

File View Test Search List Options Help
——————————————————————————————————————————————————————————————————————————— (A)
Program View CURSOR POSITIONED
Command ===> Scroll ===> CSR
(B)204 2000-PROCESSING-LOOP.
000205 IF NOT-END-INFILEl AND READ-INFILEl
000206 PERFORM 3100-READ-INFILE1l THRU
000207 3100-READ-INFILE1-X.
000208 IF NOT-END-INFILE2 AND READ-INFILE2
000209 PERFORM 3200-READ-INFILE2 THRU
000210 3200-READ-INFILE2-X.
000211 IF NOT-END-INFILE3 AND READ-INFILE3
000212 PERFORM 3300-READ-INFILE3 THRU
000213 3300-READ-INFILE3-X.
000214 MOVE SPACES TO OUTFILE-WORK-AREA,
000215 OUTRPT-WORK-AREA.
000216 COMPUTE HOW-MANY-FILES-READ = INFILE1-EOF
000217 + INFILE2-EOF
000218 + INFILE3-EOF.
000219 IF READ-3-FILES
000220 PERFORM 2100-COMPLEX-MERGE THRU
000221 2100-COMPLEX-MERGE-X FALLTHRU
000222 ELSE IF READ-2-FILES

(A) CURSOR POSITIONED. Message area indicates the cursor has been
positioned on the specified label.

(B) 2000-PROCESSING-LOOP. The target paragraph is scrolled to the top of

the screen. If the specified paragraph was already on the screen, the cursor would be
moved to the paragraph and the display would not be scrolled.

Using the BRANCH Command

To indicate the label to be the target of the BRANCH function
1 To position the display on paragraph 3100-READ-INFILE1 using the cursor
location, type BRANCH in the command area, place the cursor on the statement

containing the paragraph name PERFORM 3100-READ-INFILE]1, and press Enter.

If you use the standard SmartTest PF Key settings, you can also place the cursor on
the statement containing the label desired and press PF10.
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Figure 125 shows the result of a Branch to the paragraph indicated by cursor
placement.

Figure 125 « Program View with Cursor Positioned by Branch Function Key

File View Test Search List Options Help
——————————————————————————————————————————————————————————————————————————— (a)
Program View CURSOR POSITIONED

Command ===> Scroll ===> CSR
(B)431 3100-READ-INFILEL.

000432 MOVE ZERO TO READ-INFILE1-SWITCH.

000433 ADD 1 TO END-FILE-COUNT.

000434 READ INFILEl INTO INFILE1-WORK-REC

000435 AT END FALLTHRU
000436 MOVE INFILE1-EOF-MSG TO OUTRPT-WORK-DATA

000437 MOVE ZERO TO OUTRPT-WORK-KEY

000438 WRITE OUTRPT-REC FROM OUTRPT-WORK-AREA

000439 MOVE 1 TO INFILE1-EOF

000440 MOVE EOF-KEY TO INFILE1-WORK-KEY. FALLTHRU
000441 3100-READ-INFILE1-X.

000442 EXIT. RETURN
000443 3200-READ-INFILEZ2.

000444 MOVE ZERO TO READ-INFILE2-SWITCH.

000445 ADD 1 TO END-FILE-COUNT.

000446 READ INFILE2 INTO INFILE2-WORK-REC

000447 AT END FALLTHRU
000448 MOVE INFILE2-EOF-MSG TO OUTRPT-WORK-DATA

000449 MOVE ZERO TO OUTRPT-WORK-KEY

(A) CURSOR POSITIONED. Message area indicates the cursor has been
positioned on the specified label.

(B) 3100-READ-INFILE1. The target paragraph is scrolled to the top of the
display (because it was not already on the display).

2 To return the display to the paragraph where the last BRANCH command was
issued, type BRANCH BACKUP in the command input area and press Enter. The
Program View screen, shown in Figure 126 displays. If you use the standard
SmartTest PF Key settings, you can also press PF11 to execute a BRANCH
BACKUP command.

Figure 126 » Program View with Cursor Positioned by Branch Function

File View Test Search List Options Help
Program View VIAMERGE .VIAMERGE

Command ===> Scroll ===> CSR
000204 2000-PROCESSING-LOOP.
000205 IF NOT-END-INFILE1l AND READ-INFILEl
(A)206 PERFORM 3100-READ-INFILEl THRU
000207 3100-READ-INFILE1-X.
000208 IF NOT-END-INFILE2 AND READ-INFILEZ2
000209 PERFORM 3200-READ-INFILE2 THRU
000210 3200-READ-INFILE2-X.
000211 IF NOT-END-INFILE3 AND READ-INFILE3
000212 PERFORM 3300-READ-INFILE3 THRU
000213 3300-READ-INFILE3-X.
000214 MOVE SPACES TO OUTFILE-WORK-AREA,
000215 OUTRPT-WORK-AREA.
000216 COMPUTE HOW-MANY-FILES-READ = INFILE1-EOF
000217 + INFILE2-EOF
000218 + INFILE3-EOF.
000219 IF READ-3-FILES
000220 PERFORM 2100-COMPLEX-MERGE THRU
000221 2100-COMPLEX-MERGE-X FALLTHRU
000222 ELSE IF READ-2-FILES
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(A) 2000-PROCESSING-LOOP. The previous BRANCH target paragraph is
scrolled to the top of the display.

Note:

For more information regarding branching, see the BRANCH command in the
Commands chapter of the ASG-SmartTest Reference Guide.

Searching the Program in Execution Sequence

This section describes how to use the FLOW primary command to display, tag, and
highlight specific targets in the execution sequence of the program. The FLOW command
requires that the program be analyzed using the Extended Analysis option. The program
must be the active program.

Note:

If Insight is installed with SmartTest, the Flow function is available as an action on the
Logic pull-down.

By default, the cursor location is used as the starting point for the search. When the cursor
is in the command input area, the search starts with the source line at the top of the
display. If the cursor is positioned on an non-executable COBOL statement, the starting
point of the search is the first executable statement physically prior to the cursor position.

The starting point for the FLOW command may be specified using the FROM operand.
The FLOW command accepts datanames as targets. The operand MOD indicates a search
for statements that modify the specified dataname. The operand PREV indicates the
search is performed for data item modifications in reverse execution sequence.

The FLOW command locates the first target on each path in the program.

The FLOW primary command may be abbreviated as FL.

For example, if the program VIAMERGE is suspended at an 0C7 abend, you want to

search the program in reverse execution sequence and displaying the statements where
the specified data field may have been previously modified.
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To begin the search, type FLOW END-FILE-COUNT MOD PREV in the primary
command area and press Enter to display the result shown in Figure 127.

Note:

The result indicates that multiple statements modifying the data field are reachable. This
means that there are multiple execution paths in the program that access the field.

Figure 127 « Highlighted Statements in Reverse Execution Sequence

File View Test Search List Options Help

——————————————————————————————————————————————————————————————————————————— (A)
Program View 4 MOD (S) REACHABLE
Command ===> Scroll ===> CSR
(B)180 MOVE 'VMERGE ' TO BEGIN-PROGRAM-NAME. DATA MOD
--- - - - - - - - - - - - - - - - - 252 LINES NOT DISPLAYED
>>>>>> ADD 1 TO END-FILE-COUNT. DATA MOD
VN +
virtrr |10 END-FILE-COUNT PIC 9(8) ADDR 000C8450 |
rrerer VALUE > VMERGE < * INVALID NUMERIC * |
L +
--- - - - - - - - - - - - - - - - - 11 LINES NOT DISPLAYED
000445 ADD 1 TO END-FILE-COUNT. DATA MOD
--- - - - - - - - - - - - - - - - - 11 LINES NOT DISPLAYED
000457 ADD 1 TO END-FILE-COUNT. DATA MOD

. 11 LINES NOT DISPLAYED

Kok ok kok ok kok ok k ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok kkk BOTTOM OF DATA * ¥ Ak A XA XXX XX XX AKX XXX XA XXX Xk Xk *

B ettt e e +
| STATUS: DATA EXCEPTION (0C7) PROGRAM: VIAMERGE DATE: DDMMMYYYY |
| STMT: 000433 OFF: 0028D2 AMODE: 24 MODULE: VIAMERGE TIME: HH:MM:SS |
| SOURCE: ADD 1 TO END-FILE-COUNT. |
o +

(A) 4 MODS REACHABLE. The short message reflects the number of lines containing
the target that are reachable from the Start Point.

(B) MOVE 'VMERGE' TO BEGIN-PROGRAM-NAME. The lines that modify the
specified data item are highlighted and tagged.

Note:

For more information regarding execution sequence processing, see the FLOW command
in the Commands section in the ASG-SmartTest Reference Guide.
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This chapter describes additional testing features and contains these sections:

Topic Page

Capturing and Replaying Command Sequences 217
Locating the Next Executable Statement (LOCATE * Command) 220
Simplifying Commands 221
Other Primary Commands 223
Other Line Commands 224
Commands Available Only with Insight 224

Capturing and Replaying Command Sequences

SmartTest provides a Script facility to capture and replay primary command sequences.
The captured commands are saved in a script file that you can execute later to replay the
recorded primary commands.

SmartTest assigns a dataname for the script dataset and displays it in the long message
area when you issue the SET SCRIPT ON primary command. The Script facility
allocates and opens a dataset to record all SmartTest primary commands as you enter
them. To stop recording the primary commands and close the script file, issue the SET
SCRIPT OFF primary command. Note the dataset name for future reference; you must
specify this dataset name when you request script file playback.
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Script files are sequential datasets or members of partitioned datasets. Script files can be
used to initialize a session, set default values, set up a session, execute or re-execute a
session, or execute a predefined command sequence. The name of the dataset displays
when the dataset is opened or closed. This name is in the format:

TSOUSERID.STTnnnnn.VIASCRIP

where nnnnn is a number beginning with 00001 that is incremented by 1 for each new
script file. After the dataset is closed, you can use it as an input dataset name with the
EXECUTE command.

Note:

If a TSO prefix is not set to the user ID, the prefix is added to the beginning of the dataset
name.

Comments can be included in script files by entering an asterisk (*) in the first column of
the command by the comment text.

The next section describes how to execute the script file.

Note:
Functions executed using CUA and line commands are not recorded in the script file.

For information on the primary commands, see the ASG-SmartTest Reference Guide.

Replaying a Script File

218

Use the Execute facility to replay a primary command sequence stored in a script file.

The Execute facility reads and executes a script file. Each script file can contain
EXECUTE commands that execute lower level (nested) script files. Script files that
create loops are recognized, and an error message displays.
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To execute a script file using the CUA method

1 Select File » Execute and press Enter. The File - Execute Script pop-up, shown in
Figure 128, displays.

Figure 128 « File - Execute Script

File - Execute script
To edecute a script file, type a Data Set MaWe, a Data Zet Nane with a
HeHber nade, or just a HeWber naWe in parentheses. Medt specify any
desired Options. Then press Enter.

Data Zet Mame _

options
_ 1. =TEP
2. REZUHE

2 Type the name of the script file in the Data Set Name field and press Enter:

3 Select the STEP option to invoke the debug option that allows you to step through
each primary command in the script file.

The primary commands are displayed in the primary command input area, where you
can change or erase each displayed command. You must press Enter to execute the
displayed primary command. Continue processing of the script file in this manner
until all primary commands have been displayed and executed.

While stepping through the script file, select the RESUME option to execute the
remaining script file primary commands without stepping through each one.
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To execute a script file using the command method

1 Type EXECUTE (or EXEC) and the name of the script file dataset and press Enter.
For example:

TSOUSERID.STTnnnnn.VIASCRIP

Note:

The STEP operand allows step-by-step execution of each script file, one command
at a time. When you use the STEP operand, each command displays in the
command input area.

2 Press Enter to execute the displayed primary command. You can also modify or
erase any displayed command.

While in STEP script execution mode, you can issue an EXECUTE command with
the RESUME operand to execute the remaining script commands without stepping
through them.

For more information about the EXECUTE primary command, see the ASG-SmartTest
Reference Guide.

Locating the Next Executable Statement (LOCATE * Command)

Use the LOCATE * (or L *) primary command during a test session to position the
display at the next statement to be executed. The next executable statement is denoted by
the chevrons (>>>>>>).

During a test session, chevrons are placed in the line number area of the Program View
screen to indicate the next statement to be executed. If the display has been scrolled and
the chevrons are not visible, the LOCATE * command positions the display to the
statement containing the chevrons.

You can use this command only from the Program View screen during an active test
session.
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Simplifying Commands

This section describes how to reduce the number of keystrokes needed to process
commands. You can use cursor substitution, or the EQUATE, & (RETAIN), or RECALL
commands to reduce the keystrokes you type.

Using the Cursor Substitution Character

When you are using the command syntax, use the Cursor Substitution character while in
the Program View screen to bypass typing datanames and paragraph names as command
targets.

Search Function commands allow you to type the Cursor Substitution character in place
of a dataname or paragraph name. You place the cursor in the displayed source code on
the name to be used as the target. When the command is processed, the substitution
character is replaced with the name at the cursor location.

By default, the Cursor Substitution character is an % (percent sign). For example, typing
FX % MOD, moving the cursor to END-FILE-COUNT, and pressing Enter finds all
statements that modify this data item.

Note:

You can substitute multiple tokens (i.e., qualified datanames such as MYDATA OF
MYSTRUCTURE) by specifying multiple cursor substitution characters, each separated
by a blank. When substituting multiple tokens, the tokens must be contiguous in the
source code.

Creating Short Names for Character Strings (EQUATE Command)

Use the EQUATE (or % primary command) to define a substitute name for any character
string.

Equated names are used in the same manner as any dataname is used. They can be saved
in the AKR, and may be viewed on the Equates List by typing LIST EQUATES.

To delete an equate, follow this step:
» Type EQUATE using the equate name without any other operands.

This command may be abbreviated as EQ, for example:
EQ FILES HOW-MANY-FILES-READ
assigns the substitution short name FILES to the long field name

HOW-MANY-FILES-READ. Each time you need to reference the long field name use
the short name.
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Keep Commands in the Command Input Area (& Command)

Use the & (retain) primary command in conjunction with any other primary command to
reuse the command specified.

The & command is useful when the same primary command is to be executed repeatedly,
or if minor changes to a command are desired. It removes the necessity of re-entering the
entire command. For example:

& FX END-FILE-COUNT USE

executes a FINDXTND command targeting field uses and leaves the command displayed
in the command input area.

You can type over the USE with MOD to execute a FINDXTND command for the same
field targeting field modifications.

Recall Primary Commands and Messages (RECALL Command)
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Use the RECALL primary command to redisplay previously issued primary commands
or long messages or pop-ups.

The last 20 primary commands and the last 20 long messages, are stacked in a recall
buffer. Any commands or messages in the buffer may be displayed using the RECALL
command. After a command displays in the command input area, it can be executed with
or without modification.

Use the MESSAGE operand to redisplay messages instead of primary commands. The
NEXT operand can be used to move forward rather than backward through the stack.

When the RECALL command has passed through the entire command or message stack,
further RECALL commands process the stack again. After you type a RECALL
command with operands, subsequent RECALL commands with no operand use the last
operand entered until you specify a different operand or another command is executed.

PF12/PF24 is the default installation for the RECALL command. You can abbreviate this
command REC.

For example, this command displays the last message in the long message area:
REC MSG
This command redisplays the last pop-up:

REC POPUP
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These commands are not stacked for use by the RECALL command:

ANALYZE KEYS PRODLVL
RESET RIGHT UPDATE
DOWN LEFT RECALL
RETURN RSCROLL END
PLOG REDO RFIND
HELP PLIST REPEAT
RIGHT UP

Displaying Product Release and Level Numbers (PRODLVL Command)

Use the PRODLVL primary command to display the current SmartTest product level.

The PRODLVL command displays the product name, operating system, product release
number, and release level on the message line, in this format:

ASG15541 ASG-SMARTTEST-0S (390) Rn.n AT Lnnn, ASG-Center Rn.n AT Lnnn,
where:

Rn. nis the release number.

Lnnn is the release level.

This information is requested if you need to contact the ASG Service Desk for assistance.

Other Primary Commands

DISPLAY FIND LPUNCH
MERGE PREF REDO
REFRESH REPEAT RFIND
RHIGH RPREF RSCROLL
SAVE WHERE ZOOMIN
Z00OMOUT KEEP RESET
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Other Line Commands

label H (highlight)

Commands Available Only with Insight

COPY DELETE
RENAME RTRACE
TRACE FLOW
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ZA (zoom Assembler)

MARK
SELECT
EQUATE



Analyze

This chapter describes how to set up a SmartTest test session for the TSO execution
environment and contains these sections:

Topic Page

Analyzing a COBOL Program 225
The Analyze Process 227
Using the File - Analyze Submit Pop-up 228
Using ISPF 231
Using ISPF/PDF Edit 232
Automatic JCL Modifications 237
Analyze Summary Report 244
Adding Analyze Facilities to a Standard Compile Mechanism 246
Assembler Analyzer 248
Analyze Options 252

Analyzing a COBOL Program

A program must be analyzed before ESW products can provide intelligent information
about it. The analyze process gathers information about the program, including program
relationships, logic, data and execution paths, and stores this information in the
Application Knowledge Repository (AKR). After the analyze information is placed in the
AKR, it is available to ESW products in online and batch environments, where it is
accessed to provide valuable information about the design and operation of user systems.
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You can test a program using SmartTest if it has not been analyzed, however, SmartTest
is not able to show the COBOL source statements or display on datanames. The program
displays in disassembled object with SET ASMVIEW ON. You can set breakpoints and
view memory areas.

The analyze process is similar to a COBOL compile. The process has these three primary
inputs:

. Source COBOL program (including copybooks)
. JCL used to compile and link the COBOL program

. Options and features that tailor the analyze steps

Analyze Input Descriptions

Input 1 - COBOL Source Program

The analyze process requires these basic program standards:

. The COBOL language as specified in the COBOL II Language Reference manual is
accepted by the analyze job. It correctly processes any program that can be
compiled without warnings or errors by the IBM COBOL II compilers.

. COBOL II and later programs that receive error (E), severe (S), or unrecoverable

(U) messages from the IBM compiler cannot be successfully analyzed.

These are the Program Analyzer resource estimates to process COBOL programs of
various sizes:

Version: ASG-Center Release 6.0
CPU Type: 3090-600 running OS/390
Disk Type: 3390

Analyze Parms: AKR_ Buffer Mask=4096

Compiler Parms: BUF=256 KB,SIZ=1024 KB

Input 2 - Compile/Link JCL
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The compile and link JCL should be the complete JCL used to compile the program.
Specifically, the JCL should contain steps to fetch the source from the source manager
(such as Librarian or Panvalet), execute the preprocessor, invoke the compiler with the
appropriate options and COPY libraries, then invoke the linkage editor.

The SmartTest analyze forces some COBOL compiler options to certain values so that
sufficient data is available for the use of all product features. For a description of the
COBOL compiler options used by the SmartTest analyze, see "COBOL Compiler
Options" on page 289.
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Input 3 - Analyze Options and Features

The analyze features indicate the type of analysis to be performed.

. An Encore analysis provides the information required for code extraction and
execution flow capabilities.

*  An Insight analysis provides logic and execution flow capabilities.

. A SmartTest analysis provides the testing and debugging information required by
SmartTest.

. A SmartTest Extended analysis provides an Insight analysis.

. A SmartDoc analysis provides the information required for SmartDoc reports.

. An Extended SmartDoc analysis provides data flow analysis.

. A Recap analysis provides the inventory analysis data required for Recap reports.
. An Alliance analysis provides the entity-relationship data required for impact

assessment.

Default options for the analyze process are established at installation time. Options that
are to be overridden are specified when submitting the analyze job.

The Analyze Process

The analyze process consists of setting up and executing a batch job. There are three
methods used to invoke the analyze process. The method used depends primarily on the
environment from which the analyze process is invoked, but may depend on the access
method containing the compile/link JCL. These are the three methods used to invoke the
analyze process:

Method Description

Analyze Option Select File » Analyze or type ANALYZE from any screen, to display
or Command the File - Analyze Submit screen. Enter the required input and output
information, then submit the job.
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ISPF From any ISPF screen, execute the VIASUBDS CLIST. This CLIST
is executed by typing this command:

TSO VIASUBDS dsn parms
where:

dsn is a PDS member or sequential dataset containing the
compile JCL

parms represents any of the available execution parameters
described in the table in "Using ISPF/PDF Edit" on page 232.

ISPF/PDF Edit  Execute the VIASUB PDS edit macro. This edit macro is executed by
entering VIASUB parms, where parms represents any of the
available execution parameters described in the table in "Using
ISPF/PDF Edit" on page 232.

Using the File - Analyze Submit Pop-up

To begin an analyze, follow this step:

» Select File » Analyze or type ANALYZE on any screen. The File - Analyze Submit
pop-up displays as shown in Figure 129.

Figure 129 « File - Analyze Submit Pop-up

File - AnalyZe ZubHit
CoHHand ===

E - Edit JCL % - Bubnit JCL D - A%G-EHartDoc Options

Codpile and link JCL [PDE oF sequentiall:
Data set nane 'USER1Z.REL.CHTL[HTEST]'

Analyze features [v-M]:
AEG-Insights Y ASG-EHartTests Y Extended Analysizs M
AEG-EHartDocs M AZG-Encores N

AKR data zet naWe 'USER1Z2.GEMERAL.AKR'

AKR prograd nade [if overriding PROGRAA-IO)

Analyze options:

CoHpile? [YN] o « & o @ 0 & o & ¥ [v if needed by features)
Link l1oad Aodule reusable® (YoMl Y [AEG-EHartTest
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These are the default analyze values on the Analyze Submit screen:

Y Insight
Y SmartTest
N SmartDoc
N Encore

Options

Option Description

E - Edit JCL Displays the compile/analyze JCL to review or change the JCL, if
necessary. When the E option is selected, the JCL to be edited is
generated from the JCL member specified in the Data Set Name field,
applying the rules outlined in the Automatic JCL Modifications
section. The generated JCL is then displayed on the Edit screen.

When editing is complete, type ISPF SUBMIT to submit the edited
JCL for execution. Optionally, the edited JCL can be saved in a
partitioned dataset by using the CREATE command. Otherwise, any
changes made at this time are not saved.

S - Submit JCL  Submits the JCL to compile/analyze the specified program. The JCL
submitted is generated from the JCL member specified in the Data Set
Name field, applying the rules outlined in the Automatic JCL
Modifications section.

D - SmartDoc Displays only if SmartDoc is installed. Type D to display the File -

Options SmartDoc Options pop-up that is used to request an Extended
SmartDoc analysis and to specify which reports (if any) are to be
generated.
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Fields

Data Set Name

Specifies the PDS member or sequential dataset containing the
JCL to compile and link the program. If the JCL resides in a
source manager such as Librarian or Panvalet, use the VIASUB
edit macro to submit the compile/analyze job.

Analyze Features

An analyze feature product field is listed for each ESW product
installed.

SmartTest

Displays only if SmartTest is installed. Y indicates that a
SmartTest compile/analysis is to be performed. This type of
analysis provides the testing and debugging information required
by SmartTest. If SmartTest is the only product installed, this
field contains Y and cannot be changed. The defaultis Y.

Extended
Analysis

Displays only if SmartTest is installed. This type of analysis
provides comprehensive program analyzing capabilities in
addition to the testing and debugging of SmartTest. The default
is N.

AKR Data Set Name

Specifies the AKR that is to contain the information for the
analyzed program.

AKR Program Name

Specifies an alias name used by the analyze process to save its
results in the AKR. If a value is not entered in this field, the
analyze job uses the program name from the PROGRAM-ID
statement in the COBOL source as the name under which to save
results in the AKR.

Note:

This field is only used for the AKR program name and does not
change the COBOL program name in the source.

Analyze Options

Specifies the analyze options that are to be overridden. Default
options for the analyze job are established at installation time.
Analyze options that can be entered in this field are described in
the "Input 3 - Analyze Options and Features" on page 227.
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Field Description

Compile? Indicates whether the program is to be compiled. A program
need not be compiled if Insight, Encore, or SmartDoc are the
only features specified. The compile step can be suppressed by
specifying N in this field. This field is forced to a value of Y if
SmartTest and/or Extended analysis is selected.

Link load module Tests a program under SmartTest that is dynamically loaded. It

reusable is necessary to mark the load module as reusable so that the
breakpoints are retained across calls. The defaultis Y. If the JCL
used for an analyze includes a linkedit step, the REUS parameter
is inserted.

Using ISPF

From any ISPF screen, the VIASUBDS CLIST can be used to submit the analyze job.
This is the syntax for VIASUBDS:

TSO VIASUBDS input.jcl.dsn parms

where:

Parameter Value Description

input.jcl.dsn Specifies the dataset containing the compile/link JCL. This
must be a sequential dataset or a member of a PDS.

parms Specifies one or more parameter that controls the operation
of VIASUBDS. Typically, the PANEL parameter is entered
to display the Analyze Submit Parameters screen for entry
of any necessary parameters. The parameters are saved in
the ISPF profile and used as defaults for the next analyze
submission. The table in "Using ISPF/PDF Edit" on
page 232 contains a list of these parameters, with default
parameters underlined.

Note:

Using the VIASUBDS CLIST requires the ESW CLIST library to be available through
the standard SYSPROC allocations.
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Using ISPF/PDF Edit

232

From the ISPF/PDF Edit screen, the VIASUB edit macro can be used to submit the
analyze job. This is the syntax for VIASUB:

VIASUB parms

where parms is one or more parameter that controls the operation of VIASUB.
Typically, the PANEL parameter is entered to display the Analyze Submit Parameters
screen for entry of any necessary parameters. The parameters are saved in the ISPF
profile and used as defaults for the next analyze submission.

Note:

Using the VIASUB edit macro requires the ESW CLIST library to be available through
the standard SYSPROC allocations.

This table contains a list of these parameters, with default parameters underlined:

AKR(XXXXX)

Indicates the AKR where the results of the analyze job will be
placed. The specified name must conform to the standard TSO
dataset naming conventions.

AOPT(XXXXX)

Specifies the options to be supplied to the analyze job. The
COBOLII option is automatically added if the compiler specified
in the input JCL is COBOL II. When specifying more than one
analyze option, the options should be separated by commas and
enclosed in single quotes; for example:

AOPT ('XMEM, RECUR, SUBSYS=D239")

See "Analyze Options" on page 252, for information on each
analyze option.

CMPL
NOCMPL

CMPL indicates a COBOL compile and an analysis is to be
executed by the new JCL. NOCMPL indicates the new JCL is to
bypass the compile step and only execute the analyze job. When
NOCMPL is specified, a return code of 1000 (decimal) greater
than the analyze return code is produced. This causes the
subsequent job steps (e.g., a link edit) to be bypassed based on a
successful compilation. NOCMPL cannot be specified if a
SmartTest analysis is being executed.
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DSCHK
NODSCHK

DSCHK indicates datasets needed by the resulting JCL are to be
verified to ensure they exist. Specifically, the AKR and the load
library containing VIASMNTR are checked. When NODSCHK
is specified, the AKR and the load library need not exist at the
time VIASUB or VIASUBDS is executed. NODSCHK is useful
when the JCL is being prepared for submission on another system,
or for delayed execution when an AKR does not yet exist. Note
that the cataloged procedure libraries must exist and be accessible
to VIASUBDS or VIASUB.

EDIT

EDIT specifies that the resulting JCL is not to be submitted for
batch processing. The PDF editor is invoked for the resulting JCL.
Any desired changes can be made and then the JCL can be
submitted by typing SUBMIT. You must enter EDIT each time it
is needed. Note that the edits made to the JCL are not saved. The
CREATE command must be used to save the modified JCL
elsewhere. The EDIT option is ignored if the Analyze Submit
Parameters screen displays. In this case, the E command must be
entered to edit the JCL.

ENS
NOENS

ENS specifies that an Encore analysis is to be performed.

INS
NOINS

INS specifies that an Insight analysis is to be performed.

OUTPUT(XXXXX)

Specifies that the resulting JCL is not to be submitted for batch
processing. The JCL is written to the specified dataset. The
specified name must conform to the standard TSO dataset naming
conventions. A dataset is created if it does not already exist.
OUTPUT must be entered each time it is needed.

PANEL
NOPANEL

PANEL indicates that the Analyze Submit Parameters screen is to
be displayed for entry of parameters for the analyze job. The
Analyze Submit Parameters screen displays even if a valid AKR
name is specified as a parameter, or can be obtained from the ISPF
profile when PANEL is specified.

PGM(XXXXX)

Specifies a name to be used when storing the program in the AKR.
This name overrides the program name in the PROGRAM-ID
paragraph.

PROCONLY

Indicates the JCL contains only a cataloged procedure rather than
a complete job. PROCONLY suppresses the generation of the
VIAIN DD statement. PROCONLY must be entered each time it
is needed.
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REUS REUS specifies that when the program is tested using SmartTest,
NOREUS it is dynamically loaded and tested with RUN NOMONITOR.
SD SD specifies that a SmartDoc analysis is to be performed.
NOSD

SDR SDR specifies that SmartDoc reports will be run.

NOSDR

SDX SDX specifies that a SmartDoc Extended analysis is to be
NOSDX performed.

ST ST specifies that a SmartTest analysis is to be performed.
NOST

STX STX specifies that a SmartTest Extended analysis is to be
NOSTX performed. When the INS and ST parameters are specified, a

SmartTest Extended analysis is automatically performed.

Analyze Submit Parameters Screen

Figure 130 shows the Analyze Submit Parameters screen. This screen displays when the
PANEL parameter is specified when executing VIASUBDS or VIASUB, or when the
NOPANEL option is used and an error condition is detected. You can also access this
screen by selecting File » Compile/Analyze.

Figure 130 » Analyze Submit Parameters Screen

File - Analyze SubHit
CoHHand ===k

E - Edit JCL % - EUBHit JCL

Conpile and link JGL (PDE or sequentialll
Data set nane 'USERLZ.REL.CNTL[VIAPCOEC]®

Analyze features [Y-M]i
AEG-3HartTestl ¥ Edtended Analwsi=l N

AER data =set nade *USER12,GEMERAL .AKR’
AKR prograd nade [if ouertiding PROGRAM-IO0)]

Analyze options:

Codpile? [T«M] « v & o @ o« & & ¥ [ if needed by features)
Link 1oad Hodule reusable® [Y-M] Y
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These are the default analyze options:

Default Analyze Option

N Extended Analysis

Y SmartTest

Options

Option Description

E - Edit JCL Displays the compile/analyze JCL for edit. When you select option E,
the JCL to be edited is generated from the JCL specified when the
VIASUBDS CLIST or VIASUB edit macro was invoked, applying
the rules outlined in the Automatic JCL Modifications section of this
topic. The generated JCL is then displayed on the Edit screen.

When editing is complete, type ISPF SUBMIT to submit the edited
JCL for execution. Optionally, the edited JCL can be saved in a
partitioned dataset by using the ISPF CREATE command. Otherwise,
any changes made at this time are not saved.

S - Submit JCL  Submits the JCL to compile/analyze the specified program. The JCL
submitted is generated from the JCL specified when the VIASUBDS
CLIST or VIASUB edit macro was invoked, applying the rules
outlined in the Automatic JCL Modifications section of this topic.

D - SmartDoc Displays only if SmartDoc is installed. Select option D to display the

Options SmartDoc Options screen that is used to request an Extended
SmartDoc analysis and to specify which reports (if any) are to be
generated.

Fields

Field Description

Analyze features An analyze feature product field is listed for each ESW product
installed.

SmartTest Displays only if SmartTest is installed. Y indicates that a
SmartTest compile/analysis is to be performed. This type of
analysis provides the testing and debugging information
required by SmartTest. If SmartTest is the only product
installed, this field contains YES and cannot be changed. The
default is Y. This field is optional.
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Extended Analysis

Displays only if SmartTest is installed. This type of analysis
provides comprehensive program analyzing capabilities in
addition to the testing and debugging of SmartTest. The default
is N.

AKR dataset name

Specifies the dataset name of the AKR that is to contain the
information for the analyzed program. This field is required.

AKR program name

Specifies the alias name to be used by the analyze job to save
its results in the AKR. If a value is not entered in this field, the
analyze job uses the program name from the PROGRAM-ID
statement in the COBOL source as the name under which to
save results in the AKR.

Note:

This field is only used for the AKR program name and does
not change the COBOL program name in the source.

Analyze options

Specifies analyze options that are to be overridden. Default
options for the analyze job are established at installation time.
Analyze options that can be entered in this field are described
in the Analyze Options topic.

Compile?

Indicates whether to perform a compile. A program need not be
compiled if Insight, Encore, or SmartDoc are the only features
specified. The compile step can be suppressed by typing N in
this field. This field is forced to a value of Y if SmartTest is
selected.

Link load module

Tests a program under SmartTest that is dynamically loaded. It

reusable? is necessary to mark the load module as reusable so that the
breakpoints are retained across calls. The default is Y. If the
JCL used for an analyze includes a linkedit step, the REUS
parameter is inserted.

Display this panel by = Determines whether the ISPF profile is updated to display this

default in the future?

screen whenever subsequent executions of VIASUBDS or
VIASUB are invoked. When this field contains N, this screen is
not displayed on subsequent executions of VIASUBDS or
VIASUB unless an error condition is encountered.
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Automatic JCL Modifications

The analysis process automatically modifies the JCL based on the specified parameters
and analyze options. If problems arise, this procedure can be used as a checklist to
perform the analyze process manually until the problem can be determined and resolved.

To make changes to the JCL, the compile procedure, or a copy of the compile
procedure

1 Replace the PGM= parameter in the compile step(s) as shown:

PGM= parameter: Replace with:

PGM=IGYCRCTL PGM=VIACOBII
PGM=CPXUPTSM PGM=VIAOPT3
PGM=CAOTSMON PGM=VIAOPTII
PGM=CAOMSON PGM=VIAOPTII

2 Add DD statements to the compile step(s) for these datasets (VIAUT2 DD statement
is Encore only):

//VIALOG DD SYSOUT=*
//VIAMRPT DD SYSOUT=*
//VIAPRINT DD SYSOUT=*
/ /VIAAKR DD DSN=[specified AKR name], DISP=SHR

3  Ifthe SYSIN DD statement contains FREE=CLOSE, change it to FREE=END.

4  Ensure that the ESW load libraries are available to the modified step by adding a
//[STEPLIB DD statement specifying the ESW load libraries, or by concatenating
these libraries to an existing STEPLIB DD.

5 Ensure that the JOB and the modified STEP EXEC statements have a minimum of
REGION=4096K.

6  Adda VIAIN DD statement that designates the features and options to be used
during analysis. This is the format for this statement:

//VIAIN DD *

* ANALYZE FEATURES:
ST, STX

/*
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You can also modify the COBOL parameter string to include the appropriate ESW
parameter by using this command:
VPARM= (vopt,vopt,vopt...)

where vopt can be:

INS Specifies an Insight only analysis (no COBOL compile).

ST Specifies a SmartTest only analysis (no Extended
analysis).

STX Specifies a SmartTest Extended analysis.

SD Specifies a SmartDoc analysis.

SDX Specifies a SmartDoc Extended analysis.

SDR Specifies a SmartDoc report generation.

ENS Specifies an Encore analysis (no COBOL compile).

[analyze parms] Specifies valid analyze parameters (using the standard
analyze options)

CMPL Specifies a COBOL compile (forces a COBOL compile
and an analysis to be executed by the JCL).

NOCMPL Suppresses the COBOL compile (JCL bypasses the
compile and executes only an analyze job).

(NO)SYSPRINT Creates separate compiler output file.

(NO)VIADCOMP Creates SmartDoc intermediate compiler output file. The
intermediate compiler output file is used to produce the
SmartDoc Compiler Output.

DPARM Specifies SmartDoc run-time parameters.

Note:

If you do not specify a feature (i.e., INS, ST, SD, SDX, SDR, or ENS), all processing is
suppressed. This means the procedure executes a compile as it did before.
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Figure 131 is an example of compile JCL with Panvalet as it might appear in a dataset at
your site.

Figure 131 « Compile JCL with Panvalet

// ASG JOB (ASG),'PANVALET COMPILE'
/*ROUTE PRINT DEST
//* PANVALET EXTRACT

//*

//PANEXT EXEC PGM=PAN#1,REGION=256K

//PANDD1 DD DSN=COBOL.PANLIB, DISP=SHR

//PANDD2 DD DSN=&&COBIN, UNIT=SYSDA, SPACE=(CYL, (1,1)),

// DISP=(NEW, PASS) , DCB= (RECFM=FB, LRECL=80, BLKSIZE=3120)
//SYSPRINT DD SYSOUT=*

//SYSIN DD *

++WRITE WORK, VIASDDMO

/*

//*

//* COBOL COMPILE

//*

//COBCOMP  EXEC PGM=IKFCBL0OO,REGION=1024K,COND= (8, LT, PANEXT),
// PARM='SIZE=512K, BUF=128K, LANGLVL (2) , LIB, DYNAM'
//STEPLIB DD DSN=SYS1.COBOLII.COMPILER,DISP=SHR

//SYSIN DD DSN=&&COBIN, DISP= (OLD, DELETE)

//SYSLIB DD DSN=COBOL.COPYLIB, DISP=SHR

//SYSLIN DD DSN=&&LINKIN,UNIT=SYSDA, SPACE=(CYL, (1,1)),

// DISP=(NEW, PASS) , DCB= (RECFM=FB, LRECL=80, BLKSIZE=3120)
//SYSPRINT DD SYSOUT=*,DCB=(RECFM=FBA, LRECL=121,BLKSIZE=1573)
//SYSUT1 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//SYSUT2 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//SYSUT3 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//SYSUT4 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//SYSUT5 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//*

//* LINK EDIT

//*

//LINKED EXEC PGM=IEWL,REGION=1024K,COND=(8,LT, COBCOMP)
//SYSLIB DD DSN=SYS1.COBOLII.COBLIB,DISP=SHR

//SYSLMOD DD DSN=USER.LOADLIB,DISP=0LD
//SYSPRINT DD SYSOUT=*, DCB=(RECFM=FBA, LRECL=121,BLKSIZE=1573)

//SYSUT1 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSLIN DD DSN=&&LINKIN, DISP=(OLD, DELETE)
// DD *

NAME VIASDDMO (R)

/*
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Figure 132 is an example of the compile JCL, as it would appear after the

Panvalet/compile/analyze JCL has been generated according to the rules in this section.
Statements that have been added or modified are tagged to the right with ASG NEW and

ASG MOD.

Figure 132 « Generated JCL after the Panvalet/Compile/Analyze

//ASG JOB

( ),'VIASANLZ'

//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

/1%

//*********

LR R S i S S S S S S S

//* THIS JCL HAS BEEN MODIFIED BY THE ASG ANALYZE *
//* SUBMIT FACILITY, WHICH CONVERTS COMPILE JCL INTO *
*

//* COMPILE
//* CONTAIN

//*********

AND ANALYZE JCL. NEW OR MODIFIED LINES
'VIA' IN COLUMNS 74 THROUGH 76. *

khkkhkkkhkkhkkhkkhkkhkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkkhkkhkkk

//VIAIN EXEC PGM=IEBGENER

//SYSIN

DD DUMMY

//SYSPRINT DD DUMMY
//SYSUT2 DD DSN=&&VIAIN,DISP=(,PASS),UNIT=SYSDA,

//
//
//SYSUT1

SPACE=(TRK, (1,1)),
DCB= (RECFM=FB, LRECL=80, BLKSIZE=7440)

DD *

* ANALYZE FEATURES:

ST, STX

* ANALYZE OPTIONS:
NORET= (ABENDPGM) , SEQ

/*

//* PANVALET EXTRACT

//*
//PANEXT
//PANDD1
//PANDD2
//
//SYSPRINT
//SYSIN

EXEC PGM=VIASPAN1l,REGION=4096K
DD DSN=COBOL.PANLIB, DISP=SHR
DD DSN=&&COBIN, UNIT=SYSDA, SPACE=(CYL, (1,1)),

DISP= (NEW, PASS) , DCB= (RECFM=FB, LRECL=80, BLKSIZE=3120)

DD SYSOUT=*
DD *

++WRITE WORK, VIASDDMO

/*
//STEPLIB
//

//
//VIAINCLS
//
//VIALOG

/ /VIAMRPT
//VIAPRINT
//*

//* COBOL
//*
//COBCOMP
//
//STEPLIB
//

//

//SYSIN
//SYSLIB
//SYSLIN
//

DD DSN=ASG.VIACENxx.LOADLIB,
DISP=SHR, DCB=BLKSIZE=19069

DD DSN=DB2TEST.DSNLOAD, DISP=SHR

DD DSN=&&VIAINCLS, DISP=(MOD, PASS),
UNIT=SYSDA, SPACE=(CYL, (1,1)

DD SYSOUT=*

DD SYSOUT=*

DD SYSOUT=*

COMPILE

EXEC PGM=VIACOBVS,REGION=4096K, COND= (8, LT, PANEXT),
PARM="'SIZE=512K, BUF=128K, LANGLVL(2) ,LIB, DYNAM'

DD DSN=SYS1.COBOLII.COMPILER,DISP=SHR

DD DSN=ASG.VIACENxx.LOADLIB,DISP=SHR

DD DSN=DB2.DSNLOAD, DISP=SHR

DD DSN=&&COBIN,DISP=(OLD, DELETE)

DD DSN=USER.COPYLIB, DISP=SHR

DD DSN=&&LINKIN, UNIT=SYSDA, SPACE=(CYL, (1,1)),

DISP= (NEW, PASS) , DCB= (RECFM=FB, LRECL=80, BLKSIZE=3120)
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ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
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ASG
ASG
ASG

ASG

ASG
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ASG
ASG

ASG

ASG
ASG

NEW
NEW
NEW
NEW
NEW
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NEW
NEW
NEW
NEW
NEW

MOD

NEW
NEW
NEW
NEW
NEW
NEW
NEW
NEW

MOD

NEW
NEW



//SYSPRINT DD SYSOUT=*, DCB=(RECFM=FBA, LRECL=121,BLKSIZE=1573)

//SYSUT1 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSUT2 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSUT3 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSUT4 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSUT5 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//VIAINCLS DD DSN=&&VIAINCLS,DISP=(MOD,DELETE),
// UNIT=SYSDA, SPACE=(CYL, (1,1)

//VIALOG DD SYSOQUT=*

//VIAMRPT DD SYSOUT=*

//VIAPRINT DD SYSOUT=*

//VIAAKR DD DSN=ASG.VIACENxx.AKR,DISP=SHR
//VIAIN DD DSN=&&VIAIN,DISP=(OLD, PASS)

//*

//* LINK EDIT

/1%

//LINKED EXEC PGM=IEWL,REGION=1024K, COND=(8,LT, COBCOMP)
//SYSLIB DD DSN=SYS1.COBOLII.COBLIB,DISP=SHR

//SYSLMOD DD DSN=USER.LOADLIB, DISP=0OLD
//SYSPRINT DD SYSOUT=*, DCB=(RECFM=FBA, LRECL=121,BLKSIZE=1573)

//SYSUT1 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSLIN DD DSN=&&LINKIN, DISP=(OLD, DELETE)
// DD *

NAME VIASDDMO (R)

/*

7 Analyze

ASG
ASG
ASG
ASG
ASG
ASG
ASG

NEW
NEW
NEW
NEW
NEW
NEW
NEW

Figure 133 « Compile JCL with CICS

Figure 133 is an example of compile JCL with CICS as it might appear in a dataset at
your site.

//ASG JOB (ASG),'CICS COBOL '

//*

//* LR SRS S SR SRS SR SRS R SRR SRS SRR R EE SRR RS EE SRS EEEEEESEEE S
//* * DFHEITCL PROC INVOCATION *
//* * *
//* * STANDARD CICS COBOL COMMAND LEVEL PROCEDURE FOR *
//* * TRANSLATING, COMPILING AND LINK EDITING SOURCE. *
//* Ak hkhkhkhkhkhkhkhkhkhhhkhkhkhkrhhhkhhkhkhrhkrhkhkhkhkhrhkrhhkhkhkhkhkrhhkhkhhkkhxkx*k
//*

//COBOLC EXEC DFHEITCL,

// PARM.LKED="'"LET'

//TRN.SYSIN DD DSN=ASG.VIACENxx.CNTL (VIACDEMO) , DISP=SHR

//LKED.SYSLMOD DD DSN=USER.LOADLIB, DISP=SHR
//LKED.SYSIN DD *

NAME VIACDEMO (R)
/*
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Figure 134 is an example of the compile JCL as it would appear after the
CICS/compile/analyze JCL has been generated according to the rules in this section.
Statements that have been added or modified are tagged to the right with ASG NEW and
ASG MOD. Similar additions and modifications are made when DB2 and CA-IDMS

precompilers are used.

Figure 134 « Generated JCL after CICS/Compile/Analyze

//ASG JOB ( ),'VIASANLZ'
//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.
//*

//*****************************************************

//* THIS JCL HAS BEEN MODIFIED BY THE ASG ANALYZE *
//* SUBMIT FACILITY, WHICH CONVERTS COMPILE JCL INTO *
//* COMPILE AND ANALYZE JCL. NEW OR MODIFIED LINES  *
//* CONTAIN 'VIA' IN COLUMNS 74 THROUGH 76. *
//*****************************************************
//VIAIN EXEC PGM=IEBGENER

//SYSIN DD DUMMY

//SYSPRINT DD DUMMY

//SYSUT2 DD DSN=&&VIAIN,DISP=(,PASS),UNIT=SYSDA,

// SPACE=(TRK, (1,1)),

// DCB= (RECFM=FB, LRECL=80, BLKSIZE=7440)
//SYSUT1 DD *

* ANALYZE FEATURES:

ST, STX

//*

//* LR SRS S S S S RS SR SRS R SRR SRS EEEEEE SRR R SRR SRS EEEEEESESE S
//* * DFHEITCL PROC INVOCATION *
//* * *
//* * STANDARD CICS COBOL COMMAND LEVEL PROCEDURE FOR *
//* * TRANSLATING, COMPILING AND LINK EDITING SOURCE. *
//* Ak hkhkhkhkhkhkhkhkhkhhhkhkhkhkrhhhkhhkhkrhkrdhkhkhkhkhkhkrhhkhkhkhkhkrhhkhkhhkkhxkx*k
//*

//DFHEITCL PROC SUFFIX=1$,
// INDEX='CICS',
// INDEX2='CICS',

// OUTC=A,

// REG=4096K,

// LNKPARM="XREF',

// WORK=SYSDA, VIAPGMA=VIACICS

//*

//TRN EXEC PGM=&VIAPGMA,

// REGION=&REG

//STEPLIB DD DSN=&INDEX2..LOADLIB,DISP=SHR, DCB=BLKSIZE=32760
// DD DSN=ASG.VIACENxx.LOADLIB,DISP=SHR

// DD DSN=DB2.DSNLOAD, DISP=SHR

//SYSPRINT DD SYSOUT=&OUTC
//SYSPUNCH DD DSN=&&SYSCIN,

// DISP=(, PASS),UNIT=&WORK,
// DCB=BLKSIZE=400,
// SPACE= (400, (400,100))

//VIATIN DD DSN=&VIATIN, DISP=(MOD,PASS), SPACE=(CYL, (1,1)
// UNIT=SYSDA, DCB= (RECFM=FB, LRECL=80, BLKSIZE=7440)

//VIAPRINT DD SYSOUT=*
//VIAPGM DD DSN=&&DFHECP&SUFFIX,DISP=(NEW, DELETE),
// UNIT=SYSDA, SPACE= (TRK, (1,1))
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7 Analyze

//COB EXEC PGM=VIACOBVS,REGION=&REG, ASG MOD
// PARM="'NOTRUNC, NODYNAM, LIB, SIZE=256K, BUF=16K, APOST, DMAP, XREF'
//SYSLIB DD DSN=&INDEX..COBLIB,DISP=SHR

// DD DSN=SYS1.COBCOMP, DISP=SHR

//SYSPRINT DD SYSOUT=&QUTC

//SYSIN DD DSN=&&SYSCIN, DISP=(OLD, DELETE)

//SYSLIN DD DSN=&&LOADSET,DISP=(MOD, PASS),

// UNIT=&WORK, SPACE= (80, (250,100))

//SYSUT1 DD UNIT=&WORK, SPACE= (460, (350,100))
//SYSUT2 DD UNIT=&WORK, SPACE= (460, (350,100))
//SYSUT3 DD UNIT=&WORK, SPACE= (460, (350,100))
//SYSUT4 DD UNIT=&WORK, SPACE= (460, (350,100))
//SYSUT5 DD UNIT=&WORK, SPACE= (460, (350,100))

//STEPLIB DD DSN=ASG.VIACENxx.LOADLIB, ASG NEW
// DISP=SHR, DCB=BLKSIZE=19069 ASG NEW
// DD DSN=DB2.DSNLOAD, DISP=SHR ASG NEW
//VIALOG DD SYSOUT=* ASG NEW
//VIAMRPT DD SYSOUT=* ASG NEW
//VIAPRINT DD SYSOUT=* ASG NEW
//VIAAKR DD DSN=ASG.VIACENxx.AKR, DISP=SHR ASG NEW
//VIAIN DD DSN=&&VIAIN,DISP=(OLD, PASS) ASG NEW

//COPYLINK EXEC PGM=IEBGENER,COND= (7, LT, COB)
//SYSUT1 DD DSN=&INDEX..COBLIB (DFHEILIC),DISP=SHR
//SYSUT2 DD DSN=&&COPYLINK, DISP=(NEW, PASS),

// DCB=(LRECL=80,BLKSIZE=400,RECFM=FB),

// UNIT=&WORK, SPACE= (400, (20,20))

//SYSPRINT DD SYSOUT=&OUTC

//SYSIN DD DUMMY

//LKED  EXEC PGM=IEWL,REGION=&REG,

// PARM=&LNKPARM, COND= (5, LT, COB)
//SYSLIB DD DSN=&INDEX2..LOADLIB,DISP=SHR
// DD DSN=SYS1.COBLIB,DISP=SHR

//SYSLMOD DD DSN=&INDEX2..LOADLIB,DISP=SHR
//SYSUT1 DD UNIT=&WORK, DCB=BLKSIZE=1024,

// SPACE= (1024, (200,20))

//SYSPRINT DD SYSOUT=&OUTC

//SYSLIN DD DSN=&&COPYLINK,DISP=(OLD, DELETE)

// DD DSN=&&LOADSET, DISP (OLD, DELETE)

// DD DDNAME=SYSIN

// PEND ASG NEW
//COBOLC EXEC DFHEITCL,

// PARM.LKED='LET’

//TRN.SYSIN DD DSN=ASG.VIACENxx.CNTL (VIACDEMO) , DISP=SHR

//COB.VIATIN DD DSN=&&VIATIN,DISP=(MOD, DELETE) , SPACE=(CYL, (1,1)), ASG NEW
// UNIT=SYSDA, DCB= (RECFM=FB, LRECL=80, BLKSIZE=7440) ASG NEW

//LKED.SYSLMOD DD DSN=USER.LOADLIB, DISP=SHR
//LKED.SYSIN DD *

//NAME VIACDEMO (R)

/*
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Analyze Summary Report

Information about the analyzed program is placed in the AKR when the analyze job
completes. A summary report of the run-time statistics and diagnostic messages is also
produced. This report varies depending on whether the SOURCE or NOSOURCE option
was specified when the analyze job was submitted.

Figure 135 shows the Analyze Summary Report with the SOURCE option used.

Figure 135 « Analyze Summary Report with the Source Option

(A)

000100 IDENTIFICATION DIVISION.

000200 PROGRAM-ID. VIASDDMO.

000300 AUTHOR. WRITTEN BY ASG
000400%
000500
000600
000700
000800
000900
001000

00001
00002
00003
00004
00005
00006
00007
00008
00009
00010

ENVIRONMENT DIVISION.

INPUT-OUTPUT SECTION.

FILE-CONTROL.
SELECT INFILEL
SELECT INFILE2
SELECT INFILE3

ASSIGN TO
ASSIGN TO
ASSIGN TO
*STATISTICS* SOURCE RECORDS = 466
DIVISION STATEMENTS =
EFFECT* SIZE = 1048576,
EFFECT* SOURCE, DMAP,
EFFECT* APOST, NOTRUNC, NOFLOW,
EFFECT* NOSTATE, RESIDENT,
EFFECT* NOTEST, VERB, ZWB,
EFFECT*
EFFECT*
(B)
PROGRAM VIASCOPR
PROGRAM VIASCOPR
PROGRAM IKFCBLOO
PROGRAM IKFCBLOO
PROGRAM VIASSYMB
PROGRAM VIASSYMB
PROGRAM VIASANLZ
PROGRAM VIASANLZ

DATA
220
*OPTIONS BUF =
*OPTIONS
*OPTIONS
*OPTIONS
*OPTIONS
*OPTIONS
*OPTIONS

IN
IN
IN
IN
IN
IN
IN L120,
ASG15341
ASG15191
ASG15341
ASG15191
ASG15341
ASG15191
ASG15341
ASG15191
ASG1025T
ASG14351
ASG13991
ASG13941
ASG13951

STARTED
STARTED
STARTED
STARTED
ASG-CENTER-0S) XA)
OPTIONS IN EFFECT ARE:

98 DATA NAME SYMBOLS PROCESSED.
ASG1396I 33 PROCEDURE SYMBOLS PROCESSED.
ASG13971 131 TOTAL SYMBOLS.

ASG1436 DIAGNOSTICS: 0 TOTAL -
ASG14371 ASG-CENTER-OS (XA)

0 WARNING,
Rx.x LVLO0OO - END

(C)
ASG CENTER-OS (XA) Rx.x LVL00O
(D)
LINE ERROR MESSAGE
ASG02371I 131 SYMBOLS PROCESSED.
ASG0238I 131 SYMBOLS MATCHED.
ASG02401I 199 VERBS PROCESSED.
(E)
DIAGNOSTICS LINES: 0O TOTAL - 0 WARNINGS,
(F)

SOURCE LINES:

262144,
PMAP, NOCLIST,

DYNAM, LIB, NOSYNTAX, NOOPTIMIZE,
SYST,

NOLST, NOFDECK, NOCDECK,
DUMP, NOADV, NOPRINT, NOCOUNT,

THE PRODUCT LEVEL FOR ASG-CENTER-OS (XA)
Rx.x LVLO0O -SUMMARY REPORT- PROGRAM=VIASDDMO
SOURCE, NODMAP, NOPMAP.

SUMMARY OF COBOL II SYMBOLS EXTRACTED FROM VIASDDMO.

0 ERROR,

PROGRAM: VIASDDMO

0 CONDITIONALS,

466 TOTAL - 120 DATA DIVISION STATEMENTS,

IN LANG LEVEL 2.

UT-S-INFILEL.
UT-S-INFILE2.
UT-S-INFILE3.
DIVISION STATEMENTS = 120  PROCEDURE
LINECNT = 54, SPACEl, FLAGW, SEQ
SUPMAP, NOXREF, NOSXREF, LOAD, NODECK
NOTERM, NONUM, NOBATCH, NONAME, COMPILE=0
NOSYMDMP
NOADV
LCOL1
LANGLVL (1)

NOENDJOB, NOMIGR, NOLVL, DUMP,
LCOL1, L120, NOFDECK, NOCDECK,
NOVBSUM, NOVBREF,

COMPLETED WITH RETURN CODE 0000

COMPLETED WITH RETURN CODE 0000

COMPLETED WITH RETURN CODE 0000

COMPLETED WITH RETURN CODE 0000

Rx.x IS 000.

0 SEVERE, 0 CATASTROPHE
OF SYMBOL EXTRACTION FOR VIASDDMO

DDMMMYYYY HH:MM:SS PAGE 1

0 ERRORS, 0 DISASTERS

220 PROCEDURE

DIVISION STATEMENTS

(G)
PARAMETERS PASSED:

(H)
OPTIONS IN EFFECT: BUFMAXK=2000K,

LINECNT=60, NORECUR,
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FEATURES= (INSIGHT,
NOSEQ,

NOCOBOLII, LANGLVL (1), FEATURES=(I, S, X)

SMARTTEST, EXTENDED) , FLAG (W),

NOSOURCE, SPACEl, LANGLVL (1),



ENTRY POINTS:

7 Analyze

(1)
VIASDDMO
(J)

EXTERNAL CALLS: VIASUB

(K)

END OF PROCESSING: DDMMMYYYY HH:MM:SS

This table describes the areas highlighted in the JCL:

(A)

A complete listing of the program is produced and shows statement

numbers generated by the analyze job in the first six columns. These
numbers are referenced in diagnostic messages. These notations can
also appear on the source listing:

. C Statement was inserted with a COPY statement.
. **  QOriginal source statement number is out of sequence.

. I Statement was inserted with an INSERT statement.

(B)

This portion of the Analyze Summary is the report from the ESW
monitor facility. The job steps that were executed by the monitor
facility are listed along with the return codes produced.

©

The Center (Analyze) release and product level is shown along with
the date and time the analysis was performed.

(D)

LINE and ERROR MESSAGE - This information is shown only if
there were error conditions encountered. If so, this area lists the line
number on which the error occurred and the error message.

(E)

DIAGNOSTICS LINES - Indicates the total number of messages
issued with subtotals for each type.

(F)

SOURCE LINES - Indicates the number of source lines in the
program. The number of statements within the DATA DIVISION and
PROCEDURE DIVISION are also shown. Each level number is
counted as one statement in the DATA DIVISION. Each verb is
counted as one statement in the PROCEDURE DIVISION.

(G

PARAMETERS PASSED - Lists all of the analyze options specified
for this analyze job.

(H)

OPTIONS IN EFFECT - Lists all options in effect, including default
and user-specified options.

@

ENTRY POINTS - Lists the entry points in this program.
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Notes Description

J) EXTERNAL CALLS - Lists the programs that this program CALLSs.

(K) END OF PROCESSING - Lists the day, month, year, and time the
analyze job completed. This date and time is also reflected in the
online AKR statistics.

Adding Analyze Facilities to a Standard Compile Mechanism

CLIST Compile Mechanism

246

The Analyze Submit Facility can be incorporated into many existing in-house compile
mechanisms. This provides users with access to ESW analysis without the complications
of learning a new or different compile sequence.

Most ISPF Dialogs that use combinations of panels, CLISTs and the TSO SUBMIT
command are easily adapted to invoke the Analyze Submit facility.

The first step is to add a line in a panel to query whether an ESW analysis should be
performed. The compile panel can be used for this purpose. The new line in the panel
definition may look like this example:

+ ASG ANALYZE ===> 7+ ($Y+OR%N+)
Add this line to the )INIT section of the panel definition:
.ZVARS = ' (VSVANLYZ)'

If there is already an assignment to .ZVARS, VSVANLYZ should be added to the list in
the appropriate place. This is assuming the VSVANLYZ variable will be used to record
the response to this question. If another variable name is to be used, the description below
would need to change so it corresponds.

It may be appropriate to perform a VGET (VSVANLYZ) PROFILE before the panel
displays, and a VPUT (VSVANLYZ) PROFILE after it displays.



7 Analyze

The CLIST should then be changed to invoke VIASUBDS instead of SUBMIT, if the
VSVANLYZ variable has a Y value. Assume the CLIST contains this code:

IF &E = Y THEN DO
WRITE EDITED JCL WILL NOT BE SUBMITTED BY CLIST
ISPEXEC EDIT DATASET (&ZUSER..CNTL (MEMBERX) )
END
IF &E —-= Y THEN DO
SUBMIT &ZUSER..CNTL (MEMBERX)
END

The code should be changed to read as shown in this example:

IF &VSVANLYZ = Y THEN DO
IF &E = Y THEN DO
WRITE EDITED JCL WILL NOT BE SUBMITTED BY CLIST
SVIASUBDS &ZUSER..CNTL (MEMBERX) EDIT
END
ELSE DO
SVIASUBDS &ZUSER..CNTL (MEMBERX)
END
END
ELSE DO
IF &E = Y THEN DO
WRITE EDITED JCL WILL NOT BE SUBMITTED BY CLIST
ISPEXEC EDIT DATASET (&ZUSER. .CNTL (MEMBERX) )
END
IF && —-= Y THEN DO
SUBMIT &ZUSER..CNTL (MEMBERKX)
END
END

Many JCL skeleton generators can have the required Analyze features imbedded easily.
The JCL modifications typically done by the ESW JCL converter can be added to
existing skeletons to create JCL that executes an ESW analysis. Use the Automatic JCL
Modifications described in the next topic as a guide for making these additions.

ISPF Compile Mechanism

The Analyze Submit facility can also be installed to emulate the standard ISPF Compile
Option (option 5), by adding this line to the appropriate ISPF menu panel:

V5, 'CMD (%ASGSISP5 ISRJPA) NOCHECK'

This option functions exactly like the ISPF Compile Option except that the resulting JCL
is not submitted directly. Instead, it is passed to the Analyze Submit facility. Review the
VIASISPS CLIST for other required modifications.
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If emulation of the ISPF Compile Option is not sufficient for your site, the Analyze
Submit facility can also be configured to replace the ISPF option directly. Contact the
ASG Service Desk for details.

Assembler Analyzer

The Assembler Analyzer gathers and stores Assembler source code and data information
in the AKR.

Assembler source code can be displayed on the Program View screen. The source code
displays as output by the Assembler, and can be stepped through at the Assembler
instruction level. Data fields can be displayed and modified.

Assembler Analyzer Input

This input is included to the Assembler Analyzer:
. JCL to assemble and link the program

This JCL should be the complete JCL used to assemble the program. Specifically,
the JCL should contain steps to fetch the source from the source manager (such as
Librarian or Panvalet), invoke the Assembler with the appropriate options, then
invoke the linkage editor.

. Assembler Analyzer options
Analyze options are not used by the Assembler Analyzer.
. Assembler Analyzer features

SmartTest is the only available Assembler analyze feature.

An analyze job can be executed using one of these methods:
. Using the File - Analyze Submit pop-up.
. Executing the VIASUBDS CLIST by typing TSO VIASUBDS <dsn><parms>

where:
dsn is a PDS member or sequential dataset containing the Assemble JCL.
parms represents any of the available execution parameters.

. Executing the VIASUB PDF edit macro on an ISPF/PDF edit screen when editing
the Assemble JCL from any source manager. This edit macro is executed by typing
VIASUB parms, where parms represents any of the available execution
parameters.
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7 Analyze

Using the VIASUBDS CLIST and the VIASUB edit macro requires the ESW CLIST
library to be available through the standard SYSPROC allocations.

Automatic JCL Modifications

The analysis process automatically modifies the JCL based on the specified parameters.
If problems arise, this procedure can be used as a checklist to perform the analyze process
manually until the problem can be determined and resolved.

To make changes to the JCL, the assemble procedure, or a copy of the assemble
procedure

1 Replace the PGM parameter in the assemble step(s) as shown:
PGM= parameter: Replace with:

PGM=IEV90 VIAASMH
PGM=ASMA90 VIAHLASM

2 Add DD statements to the assemble step(s) for these datasets:

/ /VIAAKR DD DSN=[specified AKR name], DISP=SHR
/ /VIALOG DD SYSOUT=x*
//VIAMRPT DD SYSOUT=*
//VIAPRINT DD SYSOUT=*

3 If the SYSIN DD statement contains FREE=CLOSE, change it to FREE=END.

4  Ensure that the ESW load libraries are available to the modified step by adding a
STEPLIB DD statement specifying the ESW load libraries, or by concatenating
these libraries to an existing STEPLIB DD statement.

5 Ensure that the JOB and modified STEP EXEC statements have a minimum of
REGION=4096 KB.

6  Adda VIAIN DD statement that designates the features and options to be used
during analysis. This is the format:

//VIAIN DD *

ST
/*
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Assembler Analyze JCL
Figure 136 shows Assembler/analyze JCL before submitting the Assembler analyze job.

Figure 136 * Assembler/Analyze JCL Before Analyze

//ASG JOB (ASG),'ASG ASSEMBLER'
/*ROUTE PRINT DEST

/1%
//ASM EXEC PGM=IEV90,REGION=512K, PARM="'0BJ, XREF (SHORT) , TEST"'
//SYSIN DD DSN=ASG.VIACENxx.CNTL (VIAPASM),DISP=SHR

//SYSLIB DD DSN=SYS1.MACLIB,DISP=SHR

//SYSPRINT DD SYSOUT=*

//SYSPUNCH DD DUMMY

//SYSLIN DD DSN=&&SYSLIN,UNIT=SYSDA, SPACE=(CYL, (1,1)),

// DISP=(MOD, PASS) , DCB= (RECFM=FB, LRECL=80, BLKSIZE=2480)
//SYSUT1 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//SYSUT2 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//SYSUT3 DD UNIT=SYSDA, SPACE=(CYL, (1,1))

//*

//LINK  EXEC PGM=IEWL,PARM='LIST,MAP,CALL,LET',COND=(5,LT,ASM),
// REGION=300K

//SYSLIN DD DSN=&&SYSLIN,DISP=(OLD, DELETE)

// DD DDNAME=SYSIN

//SYSLMOD DD DSN=USER.LOADLIB,DISP=SHR
//SYSPRINT DD SYSOUT=*
//SYSUT1 DD UNIT=SYSDA, SPACE=(CYL, (1,1))
//SYSIN DD *

NAME VIAPASM (R)
/*
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Figure 137 shows Assembler/analyze JCL after submitting the Assembler analyze job.

Figure 137 « Assembler/Analyze JCL After Analyze

//ASG JOB

//* COMPILE AND ANALYZE JCL.

//* CONTAIN

(ASG), 'ASG ASSEMBLE'
/*ROUTE PRINT DEST

//*****************************************************
//* THIS JCL HAS BEEN MODIFIED BY THE ASG ANALYZE *
//* SUBMIT FACILITY, WHICH CONVERTS COMPILE JCL INTO *

'VIA' IN COLUMNS 74 THROUGH 76.

//*****************************************************

PGM=VIAASMH, REGION=4096K, PARM="'0BJ, XREF (SHORT) , TEST'

DSN=ASG.VIACENxx.LOADLIB, DISP=SHR

NEW OR MODIFIED LINES *

*

DSN=ASG.VIACENxx.CNTL (VIAPASM) , DISP=SHR

DSN=SYS1.MACLIB, DISP=SHR
SYSOUT=*
DUMMY

DSN=&&SYSLIN, UNIT=SYSDA, SPACE=(CYL, (1,1)),

DISP=(MOD, PASS) , DCB= (RECFM=FB, LRECL=80, BLKSIZE=2480)

UNIT=SYSDA, SPACE=(CYL, (1,1))
UNIT=SYSDA, SPACE=(CYL, (1,1))
UNIT=SYSDA, SPACE=(CYL, (1,1))
SYSOUT=*

SYSOUT=*

SYSOUT=*
DSN=ASG.VIACENxx.AKR, DISP=SHR

*

* ANALYZE FEATURES (ST):

//*

//ASM EXEC
//STEPLIB DD
//SYSIN DD
//SYSLIB DD
//SYSPRINT DD
//SYSPUNCH DD
//SYSLIN DD
//

//SYSUT1 DD
//SYSUT2 DD
//SYSUT3 DD
//VIALOG DD
//VIAMRPT DD
//VIAPRINT DD
//VIBRAKR DD
//VIAIN DD
ST

/*

//*

//LINK  EXEC
//

//SYSLIN DD
// DD
//SYSLMOD DD
//SYSPRINT DD
//SYSUT1 DD
//SYSIN DD

*

PGM=IEWL, PARM='LIST,MAP, CALL, LET"
REGION=300K
DSN=&&SYSLIN, DISP= (OLD, DELETE)
DDNAME=SYSIN
DSN=USER.TEST.LOADLIB, DISP=SHR
SYSOUT=*

UNIT=SYSDA, SPACE=(CYL, (1,1))

NAME VIAPASM (R)

/*

, COND= (5, LT, ASM) ,
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Analyze Options

Buffers

252

The Analyze job uses many of the same options as the IBM COBOL compilers. These
compile-time options are available to control the output format and to describe COBOL
options. Default options for the Analyze job were established when ESW products were
installed.

To override the default installation options, enter the desired options on the File -
Analyze Submit pop-up. Separate the options with a comma (,).

If an invalid option is entered, it is ignored by the analyze job. If a valid option is entered
more than once, the last one is processed.

Options that accept program names as parameters, with the exception of PROGRAM,
accept wildcard characters. The asterisk (*) represents zero or more characters. The
question mark (?) represents a single character, for example:

DBA* All programs that begin with DBA and end with any number of other
characters.
D?A* All programs that begin with D followed by any one character, followed

by A, then followed by any number of other characters.

DBA??? All programs that begin with DBA and end with any three characters.

The analyze options are summarized in the rest of this topic. In this summary,
abbreviations are shown in uppercase (abbreviations comply with compiler standards).
The Analyze Summary Report printed at the end of each analyze job lists the actual
options in effect, and the options that were passed to it (the override options).

BUF(nnnnnK)
BUF=nnnnnK

where nnnnn is a number from 20 to 20000.
BUF is used only as an override. The amount of main storage allocated to buffers

and internal tables is dynamically allocated. Use BUF if an override is necessary.
The minimum BUF value is 20K; the maximum is 20000K.
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COBOL Level

COBOLMVSVM
COBOLOS390
COBOL370
COBOLII
COB2R3
NOCOBOLII

COBOL370 overrides the LANGLVL option and processes the input program as
COBOL/370.

COBOLII overrides the LANGLVL option and processes the input program as
COBOL 11

COB2R3 overrides the LANGLVL option and processes the input program as
COBOL II Release 3.0 or Release 3.1.

NOCOBOLII overrides the LANGLVL option and processes the input program as
VS COBOL.

The default is based on the compiler being used and is determined automatically by
the submit process.

DB2 Load Library

DB2LIB=xXXXXX.XXXXX.XXXXXX
where xxxxxx.xxxxx.xxxxxx is the dataset name of the DB2 load library.

DB2LIB specifies the load library that is used to invoke the DB2 preprocessor at
your site.

DB2 Application Plan

DB2PLAN=xxxxxXXX
where xxxxxxxx is the name of the ESW application plan.

DB2PLAN specifies the ESW application plan that was created at installation time
by the VIASBIND job. You can use DB2PLAN to override the default plan name.
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Dynamic CALLs

DYNecall
NODYNcall

The minimum abbreviation is DYN or NODYN.

DYNCALL specifies whether the analyzer will use the variable name in dynamic
calls as the name of the called program. If NODYNCALL is specified, dynamic
calls are not processed by the analyze and information for them is not available to
ESW product functions. The default is DYNCALL.

The analyze process for this code proceeds differently, depending on whether
DYNCALL is specified:

77 MYPROG PIC X(8).
CALL MYPROG USING PARM1, PARMZ2.

In this example, if DYNCALL is in effect, the analyze process assumes that the
program being called is “MYPROG,” regardless of the data value that MYPROG
contains at run-time. The analyze process looks up the analysis results of MYPROG
in the AKR to determine whether PARM1 and PARM?2 are used or modified.

If NODYNCALL is in effect, the analyze process assumes that the program being
called could be anything, and treats both PARM1 and PARM2 as used and
modified on the call statement.

Note:
The DYNCALL option is unrelated to the COBOL compiler option DYNAM.
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Flag Messages

Input

fLAGW
fLAGE
fLAG(x)

where x is a specified message level. The minimum abbreviations are LAGW,
LAGE, and LAG(x). These are the valid message levels:

. I - Informational

. W - Warning

. E - Error

. S - Severe

. U - Unrecoverable
FLAG specifies the types of messages to be listed for the Analyze job.

FLAGW indicates all warning and diagnostic messages are listed. This is the
default.

FLAGE indicates diagnostic messages are listed; all other messages are suppressed.
FLAG(x) indicates all messages of the specified level or above are listed.

Note:
Some informational messages are produced regardless of the flag setting.

Input(x, x, .. .x)
Input=x

NOInput(x, x, . . . x)
NOInput=x

where x is a program name. The minimum abbreviation is I or NOI, with at least
one program name. Wildcard characters are allowed in the program name.

INPUT lists the CALLed programs that contain INPUT statements. When
commands that search for INPUT are issued, statements that CALL these programs
are shown in the command results. The specified programs are in addition to those
specified at installation time.

NOINPUT overrides the installation default list of CALLed programs that contain
INPUT statements. The specified programs are deleted from the default list.
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10

0(x,x,...x)

10=x

Language Level

256

NOIO

where x is a program name. Wildcard characters are allowed in the program name.

10O lists the CALLed programs that contain INPUT and OUTPUT statements. When
commands that search for INPUT and OUTPUT are issued, statements that CALL
these programs are shown in the command results. The specified programs are in
addition to those specified at installation time.

NOIO overrides the installation default list of CALLed programs that contain
INPUT and OUTPUT statements. The specified programs are deleted from the
default list.

LANGLVL(1)
LANGLVL(2)

LANGLVL specifies whether to use the 1968 or 1974 American National Standard
COBOL definitions when analyzing source elements with meanings that have
changed.

LANGLVL(1) indicates the 1968 standard is used; LANGLVL(2) indicates the
1974 standard (X3.23-1974) is used.

The default is based on the compiler being used and is determined automatically by
the submit process.



Line Count

Main

7 Analyze

lineCNT=nn

where nn is a number from 01 to 99. The minimum abbreviation is CNT, with a
line count number.

LINECNT indicates the number of lines to be printed on each page of the source
listing. The default is 60.

MAIN

MAIN is used only as an override. The EXIT PROGRAM statements in COBOL
programs are treated as GOBACKs by the Analyze job, because the program is
treated as a CALLed subprogram. If the program is the main program, using the
MAIN option treats the EXIT program as a fallthrough.

Maximum Number of Errors

Output

MBRERCNT=nnnn

where nnnn is a number from 01 to 4000. MBRERCNT specifies the maximum
number of analysis errors allowed for a member during an analyze job. If this
number of errors is exceeded, the analyze terminates processing for that member.
The number specified must be between 1 and 4000. The default is set at installation.

Output(x, x, .. .x)
Output=x
NOOutput(x, x, . . .x)
NOOutput=x

where x is a program name. The minimum abbreviation is O or NOO, with at least
one program name. Wildcard characters are allowed in the program name.

OUTPUT lists the CALLed programs that contain OUTPUT statements. When
commands that search for OUTPUT are issued, statements that CALL these
programs are shown in the command results. The specified programs are in addition
to those specified at installation time.

NOOutput overrides the installation default list of CALLed programs that contain
OUTPUT statements. The specified programs are deleted from the default list.

257



ASG-SmartTest for COBOL and Assembler User’s Guide

Program

Recursion

Return
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PROgram(xxxxxxxxxx)
PGM=xxXXXXXXXX

where xxxxxxxxxx 1s a program name up to 10 characters. The minimum
abbreviation is PRO, with a program name.

Analyzed programs are stored in the AKR and identified by the program name
coded in the PROGRAM-ID statement. PROGRAM is used to override the name
coded in the PROGRAM-ID statement.

Note:

SmartTest will not find this member in the AKR. SmartTest searches for the
program or CSECT name in the load module.

RECur
NORECur

The minimum abbreviation is REC or NOREC.

RECUR specifies whether the recursion report should be included in the Analyze
Summary Report.

If RECUR is specified and recursion is not found, a message is issued that indicates
no recursion was detected. If RECUR is specified and recursion is found, a message
is issued and the recursive code is printed on the report.

The default is NORECUR.

RETumn(x, x, . . .x)
RETurn=x
NORETurmn(x, x, . . . x)
NORETurn=x

where x is a program name. The minimum abbreviation is RET or NORET, with at
least one program name. Wildcard characters are allowed in the program name.

RETURN overrides the installation list of programs or entry points that do not
return when CALLed. The system defaults are overridden by listing the desired
programs or entry points that are to return when CALLed.



Sequence

Source

Spacing

7 Analyze

NORETURN lists the additional programs or entry points that are not to return
when CALLed. When any of these programs are CALLed by the program being
analyzed, they are treated as non-returning CALLs. The specified programs are in
addition to the system defaults for programs that do not return when CALLed.

NOSEQ

SEQ specifies whether the analyze job checks the source module statement number
sequence. A warning message is printed if the statements are not in sequence. If the
Source option is also specified, a flag (**) is placed between the Analyze job
sequence numbers and the source sequence numbers.

The default is SEQ.

SOUrce
NOSOUrce

The minimum abbreviation is SOU or NOSOU.

SOURCE specifies whether the source program is to be listed. The SOURCE
option is specified if a full program listing is desired at Analyze time.

The default is NOSOURCE.

spACE1
spACE2
spACE3

The minimum abbreviations are ACE1, ACE2, and ACE3.

SPACE specifies the spacing for the source listing that is generated when the
SOURCE option is used.

SPACEIL specifies single spacing.

SPACE2 specifies double spacing; that is, one blank line displays between every
source line.
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SPACES3 specifies triple spacing; that is, two blank lines appear between every
source line.

SPACEI] (single spacing) is the default.
SQL Authorization ID

SQLID=nnnnnnnn
SQLID(nnnnnnnn,nnnnnnnn,nnnnnnnn)

where nnnnnnnn is an 8 character name.

SQLID specifies the authorization ID or owner that is used by the analyze process
to qualify unqualified table and view references in your program.

DB2 Subsystem
SUBSYS=xxxx
where xxxx is the name of the subsystem or location of the DBMS.
SUBSYS specifies the subsystem or location that designates the DBMS in which

the tables accessed by a specified program are stored. SUBSYS overrides the name
provided at installation time.

Live Exit
XLIVE

XLIVE is used as an override and should only be used with programs that contain
live exits. Live exits are exits from perform ranges that are left dangling by
imbedded PERFORMSs or GO TOs in the original performed paragraph.

If XLIVE is not used, code that is unprocessed because of the live exit is ignored. If
XLIVE is used, unprocessed code is saved.

Note:
Using XLIVE can significantly increase resource usage.
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Memory
XMEM

XMEM is used only as an override. If a program is extremely large (i.e., 30,000
source lines) and there is insufficient memory, increase the region space. If there is
still insufficient memory, enter the XMEM option. This results in more disk I/O and
additional CPU usage, but less memory consumption.
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Additional Language Support

This chapter describes how SmartTest supports Assembler, INTERSOLV APS, and PL/I
programming languages, and contains these sections:

SmartTest and Assembler Language 263

SmartTest and INTERSOLV APS 269

SmartTest and PL/I 273
Note:

For more detailed information on the SmartTest-PLI option, see the ASG-SmartTest PLI
User’s Guide.

SmartTest and Assembler Language

The SmartTest-ASM option is designed to alleviate the burden of testing and debugging
Assembler and High Level Assembler Language Code programs by providing an online,
interactive testing environment with powerful features suited to the needs of Assembler
programmers. The Assembler component is fully integrated with SmartTest. All testing
and debugging functions are available with Assembler including: Program View,
execution control, breakpoints, monitoring, and changing data and abend processing. The
only difference between using SmartTest with COBOL programs and SmartTest with
Assembler or High Level Assembler programs is certain analysis and debugging
facilities, such as the COBOL intelligent search, are limited by their COBOL orientation.

SmartTest with Assembler enables you to work with the source level display of your
programs in Program View. When a lower level of detail is necessary, SmartTest allows
viewing and manipulation of memory, input data, and the general purpose and floating
point registers.
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Analyzing an Assembler Program

The analyze process for Assembler programs is the same as the analyze process for
COBOL programs, except the Assembler is invoked instead of the COBOL compiler.

Starting a Test Session

The steps to set up a test of your Assembler program are identical to the steps required for
testing COBOL programs. For more information, see "Test Session" on page 25.

Assembler Source Testing and Debugging

SmartTest allows you to test and debug your Assembler programs at the source code level
using Program View. Program View, the Status Box, screen manipulation, and command
entry methods are no different than those shown in other sections of this guide.

You can review many of the capabilities of SmartTest using the SmartTest Assembler
tutorial program VIAPASM.

To set up VIAPASM for a test session
1 Assemble/Link and Analyze the ESW program VIAPASM.

2 Convert the ESW execution JCL member VIAPASMJ to a CLIST. (See "Converting
Batch Execution JCL to a TSO CLIST" on page 55.)

3 Setup and run a SmartTest TSO test session and specify ALL in the EXECUTION
PARAMETERS entry on the TSO Session Setup screen. (See "MVS Programs in
TSO Foreground" on page 53.)
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Figure 138 shows VIAPASM suspended at the beginning of the test session.

Figure 138 « Program View Screen with an Assembler Program

File View Test Search List Options Help

Program View VIAPASM.VIAPASM -A
===> SCROLL ===> CSR
000149 *
>>>>>> B BYINFO-VIAPASM(R15) BRANCH AROUND PGM INFORMATION
000152 F-—-—m—m oo *
000153 * *
000154 * Kk k ok ok ok ok ok ok ok ok ok ok ok ok ok READ T HTI S Kkhkkkhkkkhkkkhkkkhkkkkkkkkx *
000155 * * * *
000156 * * PLEASE READ THE INSTRUCTIONS AT THE TOP OF THIS * *
000157 =* *  PROGRAM. THEY WILL HELP YOU GET THE MOST VALUE * *
000158 ~* * FROM THIS DEMONSTRATION. * *
000159 * * * *
000160 ~* * ENTER 'UP MAX' ON THE PRIMARY COMMAND LINE. * *
000161 * * * *
000162 * LR SRR SRR EEEEE SR R E A D T H I S ER R R EEEEEEEEEEEEEE] *
000163 * *
000164 Fommmmmm oo *
000165 DC CL8'VIAPASM ' PROGRAM NAME
B ettt i +
| STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAPASM DATE: DDMMMYYYY |
| STMT: 000151 OFF: 000000 AMODE: 24 MODULE: VIAPASM  TIME: HH:MM:SS |
| SOURCE: B BYINFO-VIAPASM(RLS) BRANCH AROUND PGM INFORMATION |
o +

Note:

Follow the tutorial instructions given throughout the program VIAPASM to learn more
about using SmartTest with Assembler.

Display Expanded Assembler Macros

Use the SET GENERATED ON primary command to display the generated Assembler
source statements. The SET GENERATED OFF primary command display the
Assembler macro statements only.

When the GENERATED mode is ON, SmartTest functions such as STEP and BREAK
operate at the generated statement level. When the GENERATED mode is OFF,
SmartTest functions operate at the macro statement level.
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To illustrate the effect of using the SET GENERATED primary command

Note:
These steps use the Assembler tutorial program VIAPASM.

1 Scroll the screen to line 878 (the ATTACH macro), shown in Figure 139, by typing
L 878 in the primary command input area and pressing Enter.

Figure 139 « Program View with an Assembler Program at the Macro Statement Level

File View Test Search List Options Help

Program View VIAPASM.VIAPASM -A
Command ===> Scroll ===> CSR
000877 *-———————— *
000878 ATTACH ECB=(R2),EPLOC=(R3),SF=(E,ATTACHL)
000889 LTR R15,R15 ENSURE VALID RETURN CODE
000890 BNZ ABENDA AND ABEND IF NO GOOD ?2?7?7?
000891 ST R1, WORKTCB SAVE ADDRESS OF ATTACHED TCB
000892 WAIT 1,ECB=(R2) WAIT FOR ATTACHED TASK TO COMPLETE
000897 PAUSEDO8 LA R1, WORKTCB POINT TO ADDRESS OF ATTACHED TCB
000898 F——————— o *
000899 * *
000900 * 'SET ASMVIEW OFF' TO TURN OFF THE DISPLAY OF DISASSEMBLED OBJECT. *
000901 ~* *
000902 * ENTER 'RUN' TO CONTINUE THE DEMONSTRATION. *
000903 * *
000904 F-———m - oo *
e +
|STATUS: BREAK AT START OF TEST SESSION  PROGRAM: VIAPASM  DATE: DDMMMYYYY |
| STMT: 000153 OFF: 000000 AMODE: 24 MODULE: VIAPASM  TIME: HH:MM:SS |
| SOURCE: B BYINFO-VIAPASM (R15) BRANCH AROUND PGM INFORMATION |
e +

2  Type SET GEN ON in the command input area and press Enter. The Assembler
expanded macro statements, shown in Figure 140, are displayed.

Figure 140 « Program View with an Assembler Program at the Generated Statement Level

File View Test Search List Options Help

Program View GENERATED ON
Command ===> Scroll ===> CSR
000877 *-———————— e *
000878 ATTACH ECB=(R2),EPLOC=(R3),SF=(E,ATTACHL)
000879 +* /* MACDATE 01/06/86 @Lic*
000880 +* /*
000881 + LA 15,ATTACHL LOAD LIST ADDRESS @G860PX
000882 + ST R3,0¢(,15) INSERT EPLOC INTO LIST @G860PX
000883 + ST R2,8(,15) ECB INTO LIST @G860PX
000884 + MVI 55(15),72 SET LENGTH OF THIS PARM LIST @G860PX
000885 + oI 8(15),x'80" SET NEW FORMAT BIT @G860PX
000886 + NI 60 (15),127 CLEAR UNWANTED BITS Q@QZA7242
000887 + MVI 61(15),1 SET FORMAT NUMBER @G860PX
000888 + SvC 42 ISSUE ATTACH SVC @G860PX
000889 LTR R15,R15 ENSURE VALID RETURN CODE
000890 BNZ ABENDA AND ABEND IF NO GOOD 22?7
o +
|STATUS: BREAK AT START OF TEST SESSION  PROGRAM: VIAPASM  DATE: DDMMMYYYY |
| STMT: 000153 OFF: 000000 AMODE: 24 MODULE: VIAPASM  TIME: HH:MM:SS |
| SOURCE: B BYINFO-VIAPASM(R15)  BRANCH AROUND PGM INFORMATION I
e +




8 Additional Language Support

3  Type SET GEN OFF and press Enter to display only the Assembler macro
statements.

Note:

See "Testing Techniques" on page 143 for more information regarding SmartTest testing
features.

The Assembler Specific Commands

The USING and DROP commands apply only when working with Assembler programs.

Use the USING command to specify the base register to be used for addressing of data
fields within Assembler DSECTs. For example:

USING TESTMOD 1
uses register 1 as the base of addressability for the DSECT named TESTMOD.

The DROP command ends addressability to any Assembler DSECT currently addressed
by base register n, where n is the register as set by the USING command. For example:

DROP 1
stops using register 1 as the base of addressability for the DSECT named TESTMOD.

Note:
The USING and DROP commands are only available for Assembler H.

Commands with Limited Use in Assembler

Some commands are limited when working with Assembler programs. Certain target
types and operands may not be used with these commands, due to their COBOL
orientation:

. BREAK
. EXCLUDE
. FINDXTND

. HIGH

. LIST

. LOCATE
. LPRINT
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. LPUNCH
. SCROLL
SmartTest-ASM distinguishes between labels with associated executable statements and

those without for the purpose of inserting breakpoints and for the Execution Tracking
screen.

The only subsets available in SmartTest-ASM as target operands are screen subsets. The
screen subsets include; HI, NHI, X, and NX.

Commands Not Available with Assembler

268

These commands are not available when working with Assembler programs because of
their COBOL orientation:

. BRANCH
. COPY

. DELETE
. FLOW

. MARK

. MERGE

. PREF

. RENAME
. RPREF

. RTRACE
. TRACE

. SELECT
. UPDATE
. ZOOMIN
Note:

For further information regarding SmartTest test facilities, see "Testing Techniques" on
page 143.
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SmartTest and INTERSOLV APS

INTERSOLV APS programs may be accessed at generated source code level through
SmartTest. The SmartTest-APS option is designed to ease testing and debugging of
programs generated by the INTERSOLV APS product, by providing an interactive
testing environment able to display both Program Painter code and generated COBOL
source code.

All testing and debugging functions are available with APS including: Program View,
controlling execution, setting breakpoints, monitoring and changing data, pseudo code,
abend processing, and the COBOL intelligent search function.

Analyzing an INTERSOLV APS Program

To invoke the proper SmartTest processing during the compile process, the final
jobstream must be submitted using the ESW job submit utility VIASUBDS.

Use the APS Generator Options screen to integrate the SmartTest analyze submit facility
into the APS product. The APS Debug field on this screen is used to invoke the analyze
submit facility. The APS Generator Options screen is provided by INTERSOLYV, Inc.

Figure 141 shows the APS Generator Options screen.

Figure 141 « APS Generator Options Screen

————————————————————————————— APS Generator Options -----------—--—--—-——————————
OPTION ===>
TARGET 0S ===> (MVS, 0S2, PCDOS, 0S400, VSE)
DC ===> (IMS, CICS, DLG, DDS, MVS, or ISPF (prototyper))
DB ===> (IMS, DLI, VSAM, or IDMS)
SQL ===> (0S2DM, XDB, SQLDS, DB2)
JOB CLASS ===> JOB DEST ===>
MSG CLASS ===> CARDIN MEMBER ===>
LISTGEN ===> (Yes or No) COBOL-II ===> (Yes or No)
COBOL ===> CICS RELEASE ===> (1.7, 2.1 or 3.1)
OBJECT ===> IMS RELEASE ===> (2 or 3)
MFS/BMS ===> SUPRA ===> (Yes or No)
GENSRC ===> EBCDIC ===> (Yes or No)
APS DEBUG ===> PC CICS ===> (IBM, MFOCUS)
APS Parm ===>
COBOL Parm ===>

Type YES in the APS Debug field on the APS Generator Options screen to process the
APS compile JCL. If you type NO in the APS Debug field, the compile JCL is submitted
without performing the SmartTest analyze.

Starting an INTERSOLV APS Test Session

The steps to set up a test of your APS program are identical to the steps required for
testing standard COBOL programs. For more information, see "Test Session" on page 25.
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APS Testing and Debugging

SmartTest allows you to test and debug your APS programs at either the Program Painter
code or generated COBOL source code levels. Program View, the Status Box, screen
manipulation, and command entry methods are the same as for other languages and
environments.

Displaying Painter Code

Use the SET GENERATED ON primary command to display the generated COBOL
source code with the Program Painter code interspersed as COMMENTS. The SET
GENERATED OFF primary command displays the Program Painter code only.

When the GENERATED mode is ON, the program functions as a standard COBOL
program and all SmartTest features and functions are available. When the GENERATED
mode is OFF, the program functions at the Program Painter statement level. The STEP
and BREAK commands apply to Program Painter statements, not generated COBOL
source.

As arule, the ZOOM and KEEP commands attempt to parse out valid variable names
from the Painter statement. If none are found, it operates on the next generated COBOL
source statement, which normally contain the variables in the Program Painter statement.
An exception to this rule is the APS macro statement (abbreviated and full format). With
this statement, SmartTest parses the abbreviated and full format macro statement and
attempt to open a Zoom data window on all referenced datanames.

APS Program
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This exercise can be reproduced using the INTERSOLV supplied demonstration program
DLGINQ.
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Figure 142 shows the APS program DLGINQ suspended at the start of the test session.
The default GENERATED mode is OFF. Only the Painter source code displays.

Figure 142 » Program View Screen at Start of Test Session

File View Test Search List Options Help

Program View DLGINQ.DLGINQ -A
Command ===> Scroll ===> CSR
000002 SYMl% RS RS SRS RS RS RS RS RS RS RS EE RS EEEEEEEEEEEEEEEEEEEEEE]
000004 % SET INFO - DLGINQ - APS1803 - 12/13/89 - INTERSOLV
000006 % KAk hkhkrkhkhkhhkhkhkhkkhkhkkhkhhhhkhhkhkhrhhkhkhkhkhkhhkhhkhkhkhkhkhkhkhhkkhhkkhkkhkhkkhkkhhkhhkhkxk
000008 g *
000010 % * COPYRIGHT 1986 TO 1988, 1989
000012 % * INTERSOLV, INC.
000014 % * ALL RIGHTS RESERVED.
000016 g *
000018 % khkhkhkhkhkhkhhkhkhkhkkhkhkhkhhhhkhhkhkhrhhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhkhkdhkkhhkkhhkkhhkhhkkkxxk
000020 SYM1% &DLG-PROGRAM-TRANSFER-OPTION = "SELECT"
000079 REC SAVE-PART-NBR PIC X (8)
>>>>>> NTRY
000651 IF END-ON-SEND
000654 TERM
o +
|STATUS: BREAK ON ENTRY TO A PROGRAM PROGRAM: DLGINQ DATE: DDMMMYYYY |
| STMT: 000082 OFF: 000F64 AMODE: 24 MODULE: DLGINQ TIME: HH:MM:SS |
| SOURCE: NTRY I
e +

Note:

If a RUN or STEP primary command is issued, the Painter source statement(s) are
executed along with the generated COBOL source, between lines 82 and 651, as one
statement.

To display the COBOL generated source code and display the next executable
statement

1 Type SET GEN ON; L * inthe primary command inputarea and press Enter. The
Program View screen, shown in Figure 143 displays.

Figure 143 « Program View Screen with Generated COBOL Source Code

File View Test Search List Options Help

Program View DLGINQ.DLGINQ -A
Command ===> Scroll ===> CSR
000576 MAIN--SECTION--PARA.
>>>>>> PERFORM APS-HOUSEKEEPING-PARA
000578 THRU APS-HOUSEKEEPING-PARA--EXIT.
000579 PERFORM APS-USER-MAIN-PARA THRU APS-USER-MAIN-PARA--EXIT.
000580 PERFORM APS-MAIN-PARA THRU APS-MAIN-PARA--EXIT. DEADCODE
000581 GOBACK. DEADCODE
000582 MAIN--SECTION--EXIT. DEADCODE
000583 EXIT PROGRAM. DEADCODE
000584 MAIN--SECTION--SXIT. DEADCODE
000585 GOBACK. DEADCODE
000586 *
000587 */*** END TP-ENTRY
000588 *
000589 EJECT
B et e +
ISTATUS: BREAK ON ENTRY TO A PROGRAM PROGRAM: DLGINQ DATE: DDMMMYYYY |
| STMT: 000577 OFF: 000F64 AMODE: 24 MODULE: DLGINQ TIME: HH:MM:SS |
| SOURCE: PERFORM APS-HOUSEKEEPING-PARA |
o +
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The generated COBOL source code statements are displayed. The chevrons appear
on the next executable statement.

2 To view only the Painter source code, type SET GEN OFF; L * and press Enter.

3  To execute the Painter code statement, type STEP and press Enter. The Program
View screen, shown in Figure 144, displays.

Figure 144 « Program View Screen with Program Painter Code

File View Test Search List Options Help
Program View DLGINQ.DLGINQ -A
Command ===> Scroll ===> CSR
000079 REC SAVE-PART-NBR PIC X (8
000082 NTRY
>>>>>> IF END-ON-SEND
000654 TERM
000662 ELSE-IF DLGI-ZCMD = '2'
000670 IF DLGI-PART-NBR-INPT > SPACES
000677 $DLG-VDEFINE ("01 PARTNO PIC X(08)"™)
000691 MOVE DLGI-PART-NBR TO PARTNO
000694 XCTL DLGUPD * PARM('&PARTNO"')
000721 SDLG-VDELETE ("PARTNO")
000742 ELSE
000745 XCTL DLGUPD
000774 SC-CLEAR DLGI
000783 ELSE-IF DLGI-ZCMD = SPACES
B et et et +
| STATUS: STOPPED BY STEP REQUEST PROGRAM: DLGINQ DATE: DDMMMYYYY |
| STMT: 000651 OFF: 001138 AMODE: 24 MODULE: DLGINQ TIME: HH:MM:SS |
| SOURCE: IF END-ON-SEND |
Bt e et T e +

To view the generated COBOL source code execution history

1 Type LIST TRACKING in the primary command input area and press Enter.

Or
Select List » Execution Tracking and press Enter.
Or

Select Source on the List Execution Tracking pop-up and press Enter.

The Execution Tracking screen shows the executed COBOL statements in
execution sequence.

2 Press PF3/PF15 to return to the Program View screen.

Note:

See "Testing Techniques" on page 143 for more information regarding SmartTest
testing features.
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Considerations with APS Program Painter Code

When SET GENERATED OFF is specified, the COBOL Intelligent Search commands
EXCLUDE, FINDXTND, HIGHLIGHT, and FLOW display the appropriate message for
the results at the generated COBOL level, but will not highlight and tag Program Painter
statements. The LPRINT command outputs the appropriate COBOL generated statements
meeting the criteria.

The counts and tracking facilities operate with the COBOL generated code regardless of
the GENERATED display setting. The Statement Counts and Execution Tracking screen
reflects information based on the generated COBOL program processing.

Considerations with APS Generated COBOL Code

The primary commands SCROLL and UPDATE function are not available when working
with Program Painter code. In general, all SmartTest screens appear the same whether the
GENERATED option is ON or OFF. The difference can be seen in the Program View
screen.

Note:

For further information on the SET GENERATED command, see the ASG-SmartTest
Reference Guide.

SmartTest and PL/I

SmartTest-PL/I provides an online, interactive testing environment with a full set of
features for PL/I applications. It is fully integrated with SmartTest and provides the
testing and debugging functions required, such as execution control, breakpoints, abend
interrupts, and changing/monitoring data. The only difference between using SmartTest
with PL/I rather than COBOL is certain analysis features that utilize COBOL intelligence
are limited. If you attempt to use a feature not available under PL/I, you receive a short
message notifying you that the data is not available.

SmartTest-PL/I enables you to work with the source level display of your programs in
Program View. When a lower level of detail is necessary, SmartTest-PL/I allows viewing
and manipulation of data and memory, and it allows execution control through pseudo
code.

Note:
See the ASG-SmartTest PL/I User’s Guide for additional information on SmartTest-PL/I.
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Help Facility

This chapter describes how to set up a SmartTest test session for the TSO execution
environment and contains these sections:

Topic Page

Introduction 275
Help Navigational Commands 277
Screen Help 278
Command Help 279
General Information 281
Specific Information 282
Help Abends 283

‘l\)
o0
~

Help Messages

Introduction

A comprehensive and context sensitive Help facility, including an online Help Tutorial, is
provided that answers most questions online. The Help Tutorial contains help
information for several types of topics, such as pull-downs, screens, pop-ups, commands,
messages, and abends. The Help Tutorial also includes a Table of Contents that describes
each major SmartTest function, and a comprehensive Index for viewing specific
information.
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The SmartTest online help facility can be reached through several means. Selecting Help
on the action bar displays the help pull-down. You can also access Help using these
methods:

. Typing H on the Primary Menu to reach the Help Table of Contents.
. Pressing PF1 or PF13.

. Typing HELP or question mark (?) in the command input area on any screen.

This table lists the various online help information provided by SmartTest, and the means
of accessing them:

Screen and pop-up help  Help for the current screen is requested by selecting Help »
Current screen. Help for the current screen or pop-up displays
by typing HELP, or by pressing PF1/13. No messages can
appear on the screen at the time this help is requested.

Command help Help for a command is requested by selecting Help » Specific
command, or by typing the command in the command input
area and pressing PF1/13. Typing HELP COMMANDS
displays a long message that lists most of the primary
commands. Once this message displays, pressing PF1/13
displays a complete list of all SmartTest commands. This list
of commands can also be accessed by selecting Help P All
commands. From the list of commands, information about a
particular command can be displayed by selecting the
appropriate number.

General Information General help information is requested by selecting Help »
Table of Contents, or typing TOC on any Help Tutorial screen,
to display the Help Table of Contents. Help information can
be viewed by pressing Enter or by selecting a menu option.

Specific Information Help for specific topics is requested by selecting Help »
Index, by selecting option I on the Help Table of Contents, or
by typing INDEX from within the Help Tutorial. Help for a
specific topic can be viewed by selecting the appropriate
index entry.




9 Help Facility

Help Topic Access

Abends Help for ESW user abends is available by selecting Help P
Common abends, or by typing HELP ABENDS. The Help
Tutorial Abends screen displays. Select Option 2 on this
screen to display the ASG Abend Codes screen, which lists all
the ESW user abends, and explanations for each abend.

Messages Help for a current message displays by selecting Help »
Current message. Help for a short message, displayed in the
upper right corner of the screen, is requested by typing HELP
or by pressing PF1/13. The corresponding long message
displays near the bottom of the screen. Help for a specific
message can be displayed by selecting Help » Specific
message, or by typing HELP msg#.

Help Navigational Commands

All of the online help topics listed in this table are contained in the Help Tutorial. Each
online help topic can be reached from anywhere within the Help Tutorial by going
through the Help Table of Contents or Index. After you access the Help Tutorial, there are
several commands available for navigating within the Help Tutorial. These are the

commands:
BACK Redisplay the previous Help Tutorial screen.
END Exit the Help Tutorial.
ENTER Display the next screen in a continuation series.
INDEX Display the first screen of the Help Index.
SKIP Go directly to the next subject
TOC Display the Help Table of Contents
UP Display the next higher-level subject.
Alpha character On an Index screen, entering an alphabetic character displays

the Index screen corresponding to that character.
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You can request help for the current screen by selecting Help » Current screen, by typing
HELP, or by pressing PF1/13. If any messages appear, help for the screen or pop-up
displays by typing HELP SCREEN. The Help Tutorial for the current screen displays, as
shown in Figure 145.

The Help Tutorial for each screen or pop-up describes all the options available on that
screen, lists descriptions of all the fields, and notes any special processing considerations.

Figure 145 « Pop-up Help Example

AEG—EMartTest - Re6.8 — Options - Product Allocations -————————————————-— HELF

The Options - Product Allocations pop-up is used to specify the allocation
paraneters for the Log, List, Punch, and Mork files. To access this pop-up
frod the Options pull-down, select Allocation, o enter the ALLOCDEF coWMand
on any Screen.

HWotel Hanagewent Class, Starage Class, and Data Class provide warious
paraneters for newly allocated data sets. These paraneters apply only if wou
hawve EHE active at wour =ite. Your systed addinistrator deterdines the valid
entries for these paraHeters.

The staorage Class and Wolue serial paradeters are Autually exclusive.

Field Deszcriptions

Loy File Zpecifu aither the Hanagedent Class and ftorage Class ok the
Generic unit and volune serial nurber for the Log file
that i=s allocated upon entry into ASG-EHartTest. The Log file
iz used for error Hessages and log coWdands.  File characteristic
are specified on the Options - Log<List<Punch Definition pop-up.

[HORE...press ENTER for Hore infordation.]
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Command Help

You can request help for a specific command by selecting Help » Specific command, by
typing the command in the command input area and pressing PF1/13, or by typing HELP
followed by the desired command name. A long message describing the command is
displayed. Pressing PF1/13 again displays the Help Tutorial screen for that command, as
shown in Figure 146. The Help Tutorial for each command displays the command syntax
diagram, and gives a description of each operand in the command. Entering the UP
command on a command help screen displays the Help Table of Contents.

Figure 146 « Command Help Example

AZG-EHartTest - RE.O ————————————— RECALL HEL|

The RECALL connand displaws the prewvious ASG prinary ar internal coddand,
Heszage, o pop-up. The last twenty cowdands that have been edecuted and the
last twenty Wessages that have been displaved are stacked. These cCoWwdands and
Heszages Can be displaved using RECALL. oOnce the desired coWdand is displayved
it can be edecuted again by pressing ENTER or changed prior to execution.

The RECALL coWAnand syntad is:

RECall 3
-COHMand | CHO- -NEXT-
-HEzsage | HaG- -PREL-
-POPUD

Hini UM Abbreviations are in CAPE

Default operands are highlighted

LEGEND: ———Fequired--—-—-—-—=-—--—-=-= =
|—optional-|

The following topic will be presented only if eXplicitly selected by nuMber:

1 - 0Operand Descriptions

For help on all SmartTest commands, select Help » All commands or type HELP
COMMANDS. A complete list of all SmartTest commands displays as shown in Figure 147
on page 280. From this list, you can access information about a particular command by
selecting the appropriate number.
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Figure 147 « ASG-SmartTest Commands Screen

AZE-EHartTest - RG.0 —---- AEG-ERartTest COMHAMDE HELF
The following will be presented in sequence, of Hay be selected by nudber:
1 - & [retain) 28 = FIND e = PROCEEE 55 - EET

2 - ADbD 21 - FIMDETHD 48 - PRODLUL 58 - ZETUP

3 - ALLIANCE 22 - FLOW 4l - QUALIFY 6B - STEP

4 - ALLOCDEF 23 - &0 iz - RECALL 6l - =TOP

5 = ANALYZE 24 = HELP 41 - REDO 2 = ESUBTRACT
& - BERANCH 25 - HIGH dd - REFRESH 63 - TE=T

T - BREAK 26 - KEEP d5 - REMAHE &d - TEETPOINT
& - CANCEL 27 - KEVE 45 - REPERT S - TOGELE

? = CONVERT 25 = LIZT 47 - REZET =15) - TRACE

18 - COPY 2% - LOCATE 43 - RETURN &7 - UPDATE

11 - CURRENT 30 - LPRINT 42 - RFIND 63— UZING

12 - DELETE 31 - LPUNCH S50 - RHIGH 69 - UTILITY
13 - DIEPLAY 32 - HARK 51 - RPREF T8 = UIEM

14 - DROP 33 - HERGE 52 - RECROLL 71 - WHEN

15 - END 3d - HOUE 53 - RTRACE T2 - WHERE

16 = ENVIRONHENT LS - PARHDEF Sd - RUM 73 = MIZARD
17 - EQUATE 36 - PREF 55 - EAVE T = ZO0HDATA
15 - EWCLUDE 37— PRINTLOG 56 - SCROLL TS - ZO0RIW
1% - EMECUTE 35 - PRINTLET 57 - SELECT TE - Z00RaUT
------ cur panel = UPTCHDE Preu panel = UPPPRTHE Last WEQ = suevaan. —————=

For some commands, on the Program View screen only, after the long message displays,
pressing PF1/13 displays NOTES giving specific examples for using the command. Once
the NOTES are displayed, as shown in Figure 148, pressing PF1/13 again displays the
Help Tutorial for that command. The Help NOTES displays for those commands where
specific examples are helpful.

Figure 148 « Help NOTES Example

File Wiew Test Search List Options Help

Progran Liew UIAPPLI
CoMnand === scroll ===} CIR
AZGAEASI RECALL REDIEPLAYE THE PREVIOUE CORHAND OR HEZSAGE.
=NOTE= +-———-——————- EdaHples -——-—-- RECALL ----—- Descriptions -———-—--—-—— +
=NOTE= RECALL Recalls the last comnand that was
=NOTE= entered in the pridary Coddand
=NOTE= area.
=NOTE= | REC H3G Recalls the last Wessage that was
=NOTE= displawed in the Hessage area.
=NOTE= | RECALL MEXT once recalling is started, NEXT
=NOTE= Hay be used to rewversa its
=NOTE= diFection.
=HNOTE= + t t
BaEgal =+ PROCE:SE OPTIONE INMEO0URCE Z0URCE NEST MOHACRO:
HOERaZ * PROCE:E: AGGREGATE E:D =THT GOSTHT:
QEEgET # PROCESS HARGINE(2,72,1] HARGINI('|'1:
OEggad # PROCESS OPT(@] ATTRIBUTES(FULL] MREF[FULLI;
HEEOES & PROCESS GOSTHT,LIST,MEST,LINECOUNT [55],0PTIONS, S0URCE, NOTEST S
Q98806 * PROCESE MOOPTIHIZE,MOFLOM,ATTRIEBUTES:
agaaa7
LT
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General Information

Request general help information by selecting Help » Table of contents, or by typing TOC
on any Help Tutorial screen. The Help Table of Contents, shown in Figure 149, displays.
Help information can be viewed by pressing Enter or by selecting a menu option.

Figure 149 « Help Table of Contents

AZG-EHartTest - RE.8 ————— HELF TRELE OF CONTENTZ HELI

The topics below represent general categories of infordation about the ASG-ESW
Testing-Debugeing codponent, ASG-SRartTest. To get help for a pull-down,
zelect the ACtion Bar topic. This Table of Contents Hay be pedisplaved frod
any HELP screen by entering the TOC CoMAand.
The following topics will ke presented only if edplicitly selected by nunber:

1 overview of ASG-SHartTest

2 Introduction to CUA

I The Action Bar

4 Custoner Support

5 ASG-SHartTest Release 6.9 SunHary of Rewisions

& Inded for AEG-3HartTest Help

—————— cur panel = VPTHTOC Prewv panel = UPPPRTHE Last nzg = ISRZ082 —————-
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Specific Information

Help for specific topics is requested by selecting Help » Index, by selecting option I on
the Help Table of Contents, or by typing INDEX from within the Help Tutorial. The Help
Index screen, shown in Figure 150 displays. Help for a specific topic can then be viewed
by selecting the appropriate Index entry.

On any Index screen, entering an alphabetic character displays the Index screen
corresponding to that character.

Figure 150 « Help Index Example

AZG-EHartTest — RE.O —————————- INDEX A - B HEL|

To select a topic, enter the two- or three-character identifier.

Al - ABENDE
A2 - ADD CoHHand Bl - BackTrack Facility
A3 - Address Etop Entry Ecreen E2 - BackTrack Uariable Hisztorw Pop-up
Ad - AKR DOirectory E3 - BackTrack Uariable Historw Ecreen
RS - HER Utilities Ed - ERAMCH CoWAand
A& - ALLOCDEF CoMnand BES - EREAK Connand
A7 - ALLIANCE ConAnand B& - Breakpoints List Screen
A% - ALTPCE Hessage Queus List
ECrean
A® - ALTPCE ZeqHent List fcreen

Al® - ANALYZE CamWHand
All - Analwze Options

Another inded page can be displayed by entering its letter.
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Help Abends

ESW products include help for these frequently encountered abend codes:
System abend codes such as 0C1, 0C4, x13, x22
ESW product abend codes

IMS abend codes

9 Help Facility

Help for System, ESW product, and IMS user abend codes is requested by selecting
Help » Common abends, by typing HELP ABENDS, or by typing ABENDS in the
command input area and pressing PF1/13. All of these actions displays the ABENDS
screen, as shown in Figure 151.

Figure 151 « ABENDS Screen

The

LS

AZG-ZRartTest - RE.O

== HEENDZ HEL

following topics will be presented only if edplicitly selected by nunber:

Fwsted Abends

AZGE Abends

IHE Abends o005 - 648

IHZ Abend=z &&54 - 231

IHE Abends 232 - 3415

On the ABENDS selection screen, enter the number of the set of abend codes you want to
view. Selecting Option 2 on the ABENDS screen displays the ASG Abend Codes screen,
shown in Figure 152. This screen lists all the ESW user abend messages, and

explanations for each message.

Figure 152 « ASGAbend Codes Screen

FE5
PET

T
ara
#r2
ard

®ECE
W aEcT!

®aCE
®'3CA'
WGt
®'3CE'

AZG-ZHAFtTEst - RE.Q ———————-——

AEG ABEND CODEE HELF

Abend codes in the range 00 - 29 (W' 354 - ¥'3EV'] bYpass ASG error
recopery, causing the abend to be handled by ISPF or by the swsted. If the
probled cannot be resolwed, call Custoder Support.

Unable to intercept prograd.

The AZG-Center AUTHORIZE password was not specified during

installation.

An internal error occurred during initialization.

A package load Aodule was called directly.

The A%GE Edit Honitor encountered a severe error.

An invalid VIASEAZE Wodule was found. The current product
ebpects a level of CEOSE or greater. Enter HELP 4238 for Aore

infarHation.

[continued]
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Help Messages

SmartTest messages are displayed in the long message area. This is the format for

messages:

ASGnnnnx text

where:

nnnn is the message number.

x is one of the severity levels listed in the table.

text is the long or short message text.

Severity Levels

This table describes the severity levels:

Level Message Type Description

I Informational Indicates that there is no required action.

W Warning Indicates a non-critical error condition exists.

E Error Indicates a critical error condition exists.

D Disaster Indicates that a serious error condition exists and the
product is unable to continue.

T Termination Indicates that the product terminated with the specified
error.

Short messages are displayed when available. Long messages are displayed if a short
message does not exist, or when help is requested immediately after a displayed short

message.
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Request help for a specific message by selecting Help » Specific message, or by typing
HELP followed by the message number. The Help Explanation and Action Panel for that
message displays, as shown in Figure 153.

Figure 153 « Help Explanation and Action Panel

HELF Edplanation and Action Panel
CoHHand ===k _ Ecroll ===} PAGE

Additional support Hay be found at our Meb Sitel weW.asg.coH
AZGAESE  END OF PROGRAM; UZE ERANCH BACKUP TO FOLLOW OTHER ERAMCHEE.

EXPLANATION:
This ig a warning Hessage indicating that BRAMCH has reached the
physical end of the progran.

ACTION:
If wou wish to branch to other paths, use BRAMCH BACKUP to reach
the desired decizion pnint and then use BERAMCH to follow another
path.

EOTTOH OF DATA

Printing Messages

All SmartTest messages or a range of messages can be printed using the VIASMPRT
program. The VIASMPRT program produces a listing of the specified messages that
includes:

. Message number

. Short message (if available)

. Long message

. Explanation of the message

. Action (if any)

JCL to execute the VIASMPRT program is in ASG.VIACEN xx.CNTL(VIASMPRT).

The entire message file is printed unless a specific range is specified in the PRM
parameter. For example:

PRM="'START=300, END=499
prints messages 300 through 499.
The ALL keyword can be specified in the PRM parameter to print all messages.
The default value for START is 1 and the default value for END is 5000. If only the
START value is entered, messages print starting at the message number specified and

ending with 5000. If only the END value is entered, messages print starting with 1 and
ending with the message number specified.
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The NOTES keyword specifies that any notes associated with a message are printed. The
default is NONOTES. Typically, notes are provided to show Center primary commands.

Figure 154 and Figure 155 on page 287 show the VIASMPRT JCL and the output from
the job.

Figure 154 « VIASMPRT JCL

//ASG JOB ( ),'ASG-CENTER VIASMPRT'

//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

//*

//* Ak hkhkhkhkhkhkhkhhkhhhkhhkhkhkhkrhk bk hkhkhkrhkhhkhkhkhkhkhkhhkhkhkhkhkhkrkhkhkhkhkhkhkrhkrhkhkhkhkhxhxkxkx*k
//* * ASG, INC. ASG-CENTER Rx.x December, 2001 *
//* * *
//* * UTILITY TO PRINT ASG MESSAGES *
//* * *
//* Ak hkhkhkhkhkhkhkhhkhhhkhhkhkhhkrhkhhkhkhkhkrkhkhhkhkhkhkhkhkhkhkhkhkhkhkhkrkhkhkhkhkhkhkrhkrhkhhkhkhxhxkxkx*k
//*

//VIASMPRT PROC ASG='ASG', HIGH LEVEL NODE OF ASG DATA SETS

// CENTER='VIACENxx', MIDDLE NODE OF ASG DATA SETS

// SYSOUT="*", PRINT OUTPUT MESSAGE CLASS

// PRM="" PARM FOR MESSAGES TO BE PRINTED
//*

//* Ak hkhkhkhkhkhkhkhhkhkhhkhhkhhhkrhkhhkhhkhkrhkhhkhkhkhkhkhkrhkhkhkhkhkhkrhkhkhkhkhkhkrhkrhkhhkhkhxhxkkx*k
//* * *
//* * MESSAGE PRINT UTILITY *
//* * *
//* * THIS PROGRAM WILL PRINT ALL OF THE MESSAGES IN THE ASG *
//* * MESSAGE FILE AND THE HELP TEXT ASSOCIATED WITH EACH *
//* * MESSAGE IT WILL PRINT THE ENTIRE FILE BY DEFAULT. YOU MAY *
//* * SELECT A GIVEN RANGE OF MESSAGES BY SPECIFYING THE OPTION- *
//* * AL PARAMETER KEYWORDS: START AND END. FOR EXAMPLE: *
//* * PRM="'START=300, END=499"' *
//* *  WILL PRINT MESSAGES NUMBER 300 THROUGH 499, INCLUSIVE. *
//* * THE DEFAULT VALUES FOR START AND END ARE 1 AND 99999 *
//* * RESPECTIVELY. CONSEQUENTLY THE PRM VALUE 'END=300' WILL *
//* * PRINT MESSAGES 1 THROUGH 300, AND THE PRM VALUE *
//* * 'START=4000' WILL PRINT MESSAGES 4000 THROUGH 99999. *
//* * *
//* * AN OPTIONAL KEYWORD, NOTES, WILL ALSO PRINT ANY NOTES *
//*  * ASSOCIATED WITH A MESSAGE. *
//* * *
//* * ADDITIONALLY, THE KEYWORD 'ALL' WILL EXPLICITLY PRINT ALL *
//* * MESSAGES. *
//* Ak hkhkhhkhkhkhkhhkhhhkhhkhkhkhkhhkhkhkhkhkhkrhk kb hkhkhkhkhkhkhkhkhkhkhkrhkhkhkhkhkhkrhkrhkhkhkhkhxhxkkx*k
//*

//*

//VIAMPRT EXEC PGM=VIASMPRT,REGION=4096K,

// PARM="'&PRM'

//STEPLIB DD DSN=&ASG..&CENTER. .LOADLIB,DISP=SHR
//VIAMSGS DD DSN=&ASG..&CENTER. .VIAMSGS, DISP=SHR
//SYSPRINT DD SYSOUT=&SYSOUT
//VIAPRINT DD SYSOUT=&SYSOUT
//VIALOG DD SYSOUT=&SYSOUT
//SYSUDUMP DD SYSOUT=&SYSOUT
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//*

// PEND

//*

//VIASMPRT EXEC VIASMPRT PRINT MESSAGES
//*

9 Help Facility

Figure 155 « VIASMPRT Output

PRINTING MESSAGES FROM 0771 TO 0772.

2 MESSAGES PRINTED.

END OF MESSAGE PRINT PROCESSING.

ASG0771 SUBSET 'COBOLII' IS NOT VALID IN A LANGLVL 1 OR 2 EDIT SESSION.

EXPLANATION:
The COBOL Edit session was selected to view a program as COBOL
LANGLVL1 (COBOL68) or LANGLVL2 (COBOL74), and the command entered
requested a target of SUBSET COBOLII.

ACTION:
If the program is COBOLII, then reenter the Edit screen with COBOLII
selected; then you may enter commands for SUBSET COBOLII.

ASG0772 THE EDITOR PARAMETER 'l' IS UNKNOWN.

EXPLANATION:
An invalid parameter was entered in the Editor Parms field of the

Edit Options panel.

ACTION:
Refer to the Reference Manual or the Reference Card for a list of

valid editor parameters.
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10

Introduction

COBOL Compiler Options

These tables list the COBOL compiler options used by SmartTest. Each table contains the
options that apply to a particular type of compiler, such as COBOL II or later.

Note:

A SmartTest Analyze automatically forces these options to their required settings, so
your standard compile/link JCL is usually acceptable. For the SYSPRINT listing, the
SmartTest Analyze tries to approximate the options provided by your site defaults and
JCL. For example, if you specify NOSOURCE, the SmartTest Analyze forces SOURCE
for the compile, then strips the source statements out of the output listing before printing.

This table describes the COBOL II (and later) compiler options:

Required

Compiler Option

Related
Option

Comments

LIST NOOFF Required to establish the location of verbs and
SET paragraph/section names.
MAP Required to establish the location of data items in the user’s
load module.
NONUM Required for compiler generated line numbers.
NOOFFSET LIST Required because OFFSET overrides LIST.
SOURCE Required.
NOOPTIMIZE Highly recommended for testing.
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This table describes the CA-OPTIMIZER II compiler options:

Required
Compiler
Option Comments
LIST NOOFF Required to establish the location of verbs and
SET paragraph/section names.
MDMAP Required to establish the location of data items in the user’s
load module.
NONUM Required for compiler generated sequence numbers.

NOOFFSET LIST Required because OFFSET overrides LIST.

SOURCE Required.

Compiler Limitations

COPYLIBs With Debug Limitations

Currently, Analyze ignores copybooks (i.e., does not expand) that are flagged as DEBUG
statements when the DEBUG option is not active. The COBOL compiler expands these
entries, flagging each expansion line as DEBUG (i.e., a comment line since DEBUG is
not active). The result is that the line numbers between the COBOL source and the
Analyze source are different after the point of the COPYLIB insertion. Such programs
produce sequence errors. These programs can be viewed by SmartTest, however,
STEPping, BREAKing, and viewing disassembled code can produce unpredictable
results.

TEST Option Limitations

290

The TEST compiler option adds object code to the program so that the load module
produced is usable by the debug tool for the product. If you specify the TEST option, it
can adversely effect the SmartTest STEP, LIST COUNTS, BREAK, and ZA commands,
as well as the pseudo code commands and statements.

NOTEST is the default and ASG recommends that you do not use the TEST option with
SmartTest.



10 COBOL Compiler Options

Compiler Optimization Limitations

SmartTest processes COBOL 11, and later releases, programs compiled with the
OPTIMIZE compiler option, with these limitations:

When testing with the ASM option ON, the disassembled code that displays for
repeated code segments (i.e., embedded PERFORMs or subprograms) are shown
only for the first occurrence of such code (i.e., the lowest address).

When inserting pseudo code into repeated code segments (i.e., embedded
PERFORMSs or subprograms), you may not insert user labels. This is because all
pseudo code variables and labels are global, and insertion of multiple labels (one for
each occurrence of the code) causes duplicate labels.

When inserting pseudo code into repeated code segments (i.e., embedded
PERFORMSs or subprograms), avoid the use of the &COUNT internal variable.
&COUNT maintains a separate instruction count for each separate occurrence of
the repeated code. Instead, create a pseudo code variable, increment it on each pass
through the pseudo code, and test the pseudo code variable rather than the
&COUNT variable.

When issuing the LIST COUNTS command, the default ordering is by execution
address, not line number as stated on the screen. The result is that the same
sequence of line numbers displays multiple times, once for each occurrence of
repeated code segments; and each repeated line has its own independent execution
count.

Certain source lines may appear to be unexecutable from the Program View screen,
and causes unexpected results for commands such as STEP, BREAK, and ZA
(Zoom Assembler).

Compiler optimization also affects the reliability of certain SmartTest data display
functions. These limitations result from compiling with the OPTIMIZE compiler option:

A variable value may reside in a register rather than in the storage where the
variable has been assigned. SmartTest displays the contents of the storage to which
the variable has been assigned.

In the object code, code associated with one statement can appear to be part of a
different statement.

After optimization, code generated for a statement is dependent on register values
loaded by code for preceding statements. Changing the path of flow in a program
with the GO command may therefore deprive statements of necessary input.

A breakpoint may not actually occur at the beginning of the code generated for the
statement at which it was set.
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For additional information on the effects of compiler optimization, see the Application
Programming Guide for your version of COBOL.

Note:

ANY compiler optimization can result in relocation, combination, or elimination of
underlying code generated for any COBOL statement. The STEP function and insertion
of pseudo code in SmartTest can therefore be affected.
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Glossary

ACB
See application control block (ACB).

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter. See "Introduction" on page 1 for more
information.

active program
A program that is being viewed and/or tested on the Program View screen. Also see
"qualified program" on page 299.

address command

A command that is entered in the hexadecimal address area within the status box or in any
address or offset field displayed on a SmartTest screen. These commands display specific
areas of memory such as the current word, 24-bit address, or the 31-bit address. A
message can also be displayed that indicates to where the 24-bit or 31-bit address points.
See the ASG-SmartTest Reference Guide for more information.

address stop
An absolute address and length of storage that is to be monitored during a test session. A
program interrupt occurs before the specified area is actually updated.

AKR
See "Application Knowledge Repository" on page 294.

alias

A dataname alias includes a Parent (higher level group item), a Child (lower level item), a
RENAMES or REDEFINES, or an 88 level item.

alias name

The name of a program entry point. Alias names are shown on the AKR Directory and
Module Directory screens.
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alias of

A field on a pop-up listing entries in the AKR. If the analyzed program contains and
ENTRY point, Alias Of is the name of the program which contains the ENTRY point. If
the name in the PROGRAM-ID statement was overridden at the time the analyze job was
submitted, Alias Of is the name that was entered in the AKR program name field on the
File - Analyze Submit pop-up.

analyze
The process used by SmartTest to prepare a COBOL or Assembler program for testing.
See "analyzer" on page 294.

analyzer

The batch component of SmartTest that executes complex algorithmic formulas to
analyze the complexities of a COBOL or Assembler program. It produces a detailed
analysis of the elements and relationships for a program, then places this information in
the Application Knowledge Repository (AKR). There are two analyzers. The Program
Analyzer analyzes COBOL programs. The Assembler Analyzer analyzes Assembler
programs. The PL/I Analyzer analyzes PL/I programs.

analyze options

Run-time options that control the Program Analyzer processing. Many of these options
are similar to the COBOL compiler options. Default values are established at installation
time and can be overridden by editing the Analyzer JCL or by using the Analyze screens.
"Analyze Options" on page 252 contains a complete description of each Analyze option.
Analyze Options are not valid for the Assembler Analyzer or the PL/I Analyzer.

analyzer summary
A summary of the run-time statistics and diagnostic messages that are produced when an
Analyze job completes.

application control block (ACB)
A control block for IMS/DC which contains the PSB and DBD, and is created by the
ACBGEN process.

Application Knowledge Repository

The Application Knowledge Repository component of SmartTest. The AKR is a BDAM
or VSAM file organization that contains all analysis information produced by the
Program Analyzer, the PL/I Analyzer, or Assembler Analyzer. SmartTest supports
concatenated AKRs.

application plan
See plan name.

Assembler analyzer
See analyzer.
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Batch terminal simulator (BTS)
An IBM product that allows execution of IMS/VS DB/DC applications in a TSO or batch
environment.

Batch test session

A SmartTest test session that is established in an MV batch region, to which an online
test session can be connected. This feature allows batch program testing to be performed
interactively.

breakpoint
An interruption that occurs during the execution of a program being tested. Breakpoints
result from a BREAK command or an error condition.

BTS
See Batch terminal simulator (BTS).

COBOL subset

COBOL verbs of a similar nature that have been grouped together. For example, READ,
WRITE, OPEN, and CLOSE are grouped into the 1O subset. The LIST SUBSETS
command can be entered to display all subsets online. See the LIST SUBSETS command
in the ASG-SmartTest Reference Guide for a complete description of each COBOL
subset.

command input area
The field on SmartTest screens where primary commands are entered, indicated by ===>
on the second line of the screen.

current cursor location
Refers to the COBOL source statement where command processing begins. The current
cursor location can be one of these based on the cursor position:

. If the cursor is in the command input area, the current location is the first source
code line on this screen.

. If the cursor is in the line command input area, the current location is the beginning
of that line.

. If the cursor is in the source code area, the current location is the cursor position.

cursor character

A substitution character that can be used in commands. Type the command and cursor
characters in the command input area, Place the cursor on the desired token, then press
Enter. SmartTest locates the cursor and reads the specified token as part of the command.
The cursor character is set on the Parameter Definition scree